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Get Started

Welcome to Workflow Help
This help system assists users in recognizing and using the features of workflows and eventing. Use the help sys-
tem to:

l Learn about the programming concepts related to workflows such as contracts, events, and entities
l Learn how to use the Workflow Composer
l Learn about workflow activities
l Review sample workflows

This help system supports the current Workflow Composer version and two prior versions. Help topics that
have been added or modified display a version selector at the top of the topic. Use the version selector to reveal
help content associated with prior versions.

Related Help Systems and APIs

https://help.campusmanagement.com/Content/Home.htm

https://www.mycampusinsight.com/Documentation-Center/Help/Help_Home/Content/helphome.htm (logon
required). The Object Library for Anthology Student is available under APIs > Anthology Student Object Library.

https://help.campusmanagement.com/Content/Home.htm
https://www.mycampusinsight.com/Documentation-Center/Help/Help_Home/Content/helphome.htm
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What's New

Version 4.0.1
l Added the option to change the Configuration upon launching Workflow Composer.

l Updated Install Packages (step 4) and added a note below the table in End-of-Life for Anthology Student
Activities (V1).

l When a new version Workflow Composer is installed, previously installed packages are automatically
uninstalled, and the user is reminded to install packages. See Package Manager and Workflow Composer.

Version 4.0
l Added note about CrmConnection string to ExecuteDataReader, ExecuteNonQuery, and ExecuteQuery.

l Note: Forms Builder 3.6 introduces the "CrmConnection" string in the web.config of Forms Renderer (see
Renderer Connection Strings). If you have created workflows with What's New activities, ensure that con-
nection strings in the activities match the updated web.config of Forms Renderer.

l Removed V1 activities. See End-of-Life for Anthology Student Activities (V1).

l Added Run Time Messages About V1 Activities.

l Added CRM Configuration option to Workflow Composer. See Configuration.

l Added Authentication for CampusLink API Calls and API Errors with SyRegistry Authentication.

l The status bar of Workflow Composer now displays the installed versions of Anthology Student and
Forms Builder. See Workflow Composer.

l Added CommandTimeout property to ExecuteDataReader, ExecuteNonQuery, and ExecuteQuery.

l Added new database event types for Anthology Student. See Anthology Student Database Events.

l Added Use the Http Header for Authentication.

l Added workflow example Create a Student Enrollment Period.

l Added Cloud Subscriptions to the Event Logs topic.

l Added the note about formatting the <DateTime> property using the Kendo library. See CreateTask (V2)
activity.

l Workflow Composer 4.x requires Microsoft .NET Framework 4.8. For more information, see

https://help.campusmanagement.com/fb/3.x/Content/ConnectionStrings.htm
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o https://dotnet.microsoft.com/download/dotnet-framework/thank-you/net48-web-installer

o https://support.microsoft.com/en-us/help/4503548/microsoft-net-framework-4-8-offline-installer-
for-windows

l Updated instructions for the ClickOnce installation. See Installation.

l Updated instructions for package installations. See Install Packages.

l Updated Note in Password field of CreatePortalAccount.

l Added ExecuteDataReader Example 3 and ExecuteQuery Example 2.

l Removed references to V1 activities.

l Product renaming and rebranding:

o CampusNexus Student is now Anthology Student

o CampusNexus Cloud is now Anthology Cloud.

https://dotnet.microsoft.com/download/dotnet-framework/thank-you/net48-web-installer
https://support.microsoft.com/en-us/help/4503548/microsoft-net-framework-4-8-offline-installer-for-windows
https://support.microsoft.com/en-us/help/4503548/microsoft-net-framework-4-8-offline-installer-for-windows
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Overview
Anthology Inc. enables customers to integrate products such as Anthology Student and Forms Builder. Cus-
tomers can leverage investments made into existing products and at the same time gain immediate value for
investments in next generation products that will feature a unified architecture and data model.

An event-driven architecture using tools like Microsoft Visual Workflow integrates existing products with a ser-
vice bus that customers may have already implemented at their institutions to synchronize data between sys-
tems. Workflow empowers users to easily write code to do specific tasks currently not available in existing
products or tasks that involve exchanging data between systems. Anthology Web Services are available to facil-
itate inserting data back into the existing systems.

Scenario

A student updates her phone number in Anthology Student Portal. In the current architecture, the update will be
propagated into Anthology Student.

With Workflow, the update event can be saved onto the service bus and other database systems deployed at the
institution (e.g., CRM1, LMS1, and POS1) will be updated automatically.

The key objectives of Workflow are:

l Ease of use
l Greater flexibility for the implementation of business processes
l Greater flexibility for the integration with other systems

Workflow uses out-of-the-box .NET functionality such as:

l Security
l Logging and Instrumentation
l Localization/Globalization
l Component Model (Inversion of Control/Dependency Injection Framework)
l Caching

The Event Broker and Workflows components provide the extended business functionality.

1Constituent Management System
1Learning Management System
1Point of Sales
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Event Driven Architecture
Anthology products are based on an event-driven architecture (EDA) in which a software element executes in
response to receiving one or more event notifications. The main components in this architecture are the Event
Broker and Workflows. Events are utilized in Workflows to perform specific activities in response to the events.
Each event can be used to trigger one or more activities.

Event Broker
The Event Broker is a software component that allows different software elements to work together. Service
Contracts and Event Contracts constitute the Event Broker.

There is no user interface for the Event Broker. It operates in the background and allows users to focuse on the
business logic.

Workflows
Workflows are discrete tasks based on business rules and requirements. Anthology provides workflow activities,
that is, 'chunks of code', for power users to compose tasks that are meaningful in a specific environment. Work-
flows also allow customers to audit or track business processes.

Workflows open the Anthology interfaces to:

l Customers
l Professional Services
l Third party vendors for integration with their systems

You can use Workflow Composer to create workflows. In Workflow Composer, expressions in the Designer must
be written in Visual Basic (.NET).

#Version%204.0_..2
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Required Skills
The Workflow Composer application is intended to be used by staff members with the following knowledge and
skills.

Prerequisite Knowledge
l Understanding of business processes

l Understanding of Anthology Student application and schema and/or CampusNexus CRM application and
schema

l Awareness of .NET technologies and understanding of VB.NET

o Creating variables, assigning data types, and a basic understanding of development languages

l Awareness of:

o Windows Workflow Foundation

o CSS themes

l SQL Knowledge

o Ability to create SQL jobs, call stored procedures and write queries

l General development knowledge of variables, arguments, control logic, exception handling, debugging,
etc.

Advanced Forms Builder and Workflow Development
Expertise in the following is recommended:

l AngularJS (expressions)

l OData

l REST (JSON)

l Bootstrap (themes)

l Workflow tracking and persistence

l TSQL skills to write stored procedures
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Security Enhancement for OData Queries
The focus of the security enhancement for OData queries are system integrations with Anthology Student APIs.
Integrations use Commands, REST services, and OData endpoints. Previously, all OData endpoints (queries)
were available to any authenticated user. If users (even API users) were authenticated, they had full access to all
the queries. This enhancement secures access to OData endpoints in the Query Model in the same manner as
in the Command Model APIs. If a user, outside of the Anthology Student web client UI, attempts to access a
Query Model to which they have no access, the controller will respond with a status "401 Unauthorized".

The OData endpoint security enhancement takes effect with the following releases:

l Anthology Student 21.2.0

l Faculty Workload Management (FWM) 1.2.0

l Financial Aid Automation (FAA) 8.2.0

l Regulatory 12.2.0

OData Query Authorization
In prior versions of these products, once a user (or 3rd party) was authenticated in Anthology Student, all OData
endpoints were available for use and all OData queries were available. Access to the Query Model was not
restricted via NetSqlAzMan (NSA) in the Security Console.

The OData endpoint security enhancement establishes NSA authorization for the Query Model by adding all
Query Model entities to the NSA configuration file. All query operations in NSA are contained in the new Task
"All Query Operations" in the Security Console. For backward compatibility, the Task “All Query Operations” has
been assigned to the CMC System Administrators Role. This task needs to be added to any other additional
roles where backwards compatibility is desired. For the future, individual organizations can create custom tasks
from the operations added to the model as needed and assign them to roles as required.

With this enhancement, access to queries is restricted and query operations for each entity are added.
Examples of the query operations include:

l Academics.Course.Query

l Common.Student.Query

l Crm.DocumentType.Query

The naming pattern for query operations is: <Module>.<Entity>.Query

Users executing OData queries will either need a QueryToken (cookie) provided by the Anthology Student web
client UI or authorization granted in NSA for specific Query Model entities requested in the query.

Note: Users logging in via the web client for Anthology Student will not be affected by this change. Access to the
various areas of the application continues to be controlled via the Tasks assigned in the Security Console.

The enhancement requiring OData query authorization may impact the following audiences:

https://www.mycampusinsight.com/Documentation-Center/Help/Help_Home/Content/models.htm
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l Partners doing integrations with Anthology Student

l Clients who have already leveraged this ability in prior versions of the product

l Client implementations that use custom logic created by our Professional Services team

l Professional Services teams working on integration projects

Configure OData Query Authorization
When you begin working with Anthology Student version 21.2 or any of the other product versions above, you
need to go into your Security Console and either:

l Grant everyone who needs access to this capability the Task All Query Operations. This is not the recom-
mended approach but mirrors existing functionality.

Note: The "All Query Operations" Task is not assigned to the Cmc System Administrators Role. The admin-
istrator Role (Group) already has an “All Operations” Task that includes the new query operations. This is
done automatically.

— OR —

l Build custom tasks for groups/roles and grant them access to the query operations they need. Query
operations would then be added to Tasks as necessary. You can filter the operations and entities to cre-
ate custom tasks. This is the recommended long term approach.
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One Task which includes all of the Operations could be added, for example, "System.Query.All" or similar.
This would enable the same behavior that is currently provided for users of the Anthology Student web
client UI, who currently have access to all entries in the OData Query Model.

Workflows and OData Query Authorization
Activities in Workflow Composer that use OData endpoints will fail if the APIUser does not have the necessary
OData authorization. By default, the APIUser is a member of the Administrator group which has the OData
authorization. However, if a client has a custom APIUser, this user will need access to the OData query oper-
ations.

All workflow activities with properties that are populated by OData queries will require OData query author-
izations.

Note: The ExecuteODataQuery<> activity will fail with a "401 Unauthorized" response if the APIUser does not
have access to any of the entities referenced in the query. If multiple entities are included in an OData query,
the user must be authorized to ALL of the entities in order for the query to execute.

Example

A user adds a “Create Task” activity to a workflow. This activity has drop-down list for Task Template and Task
Status which are populated by OData calls.

1. When the user's APIUserName in the SyRegistry table is "administrator", the drop-down lists are pop-
ulated without error because as the"‘administrator" user is part of the Administrators Group.
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2. When the APIUserName is a different account (user@campusmgmt.com), the CreateTask activity fails
with an "Access denied" error.
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3. After adding the account (user@campusmgmt.com) to the Administrators Group in the Security Console
and clearing the cache in the UI to remove the cached NSA items, the CreateTask activity works again.

Instead of adding the user account to the Administrators Group, the user account could have been gran-
ted specific access to each OData query operation.
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Workflow Composer

Workflow Composer UI
This topic describes the user interface (UI) of Workflow Composer. Some UI elements are visible when the applic-
ation is opened, while additional UI elements become available when a workflow file is loaded.

When the application is opened for the first time, the UI consists of a ribbon and several task panes or windows.
The ribbon organizes commands into logical groups. These groups appear on separate tabs in a strip across the
top of the window. The task panes include the Designer area where the workflow sequence is composed and
several resource panes.

The status bar displays the following:

l Version of Workflow Composer

l Name of the connected database

l Version of Anthology Student

l Version of Forms Builder

l Name of the activity selected in the Designer pane
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Installation
Workflow Composer is deployed via a ClickOnce application that allows self-updating Windows-based applic-
ations to be installed and run with minimal user interaction. You can install Workflow Composer with one click
on the Install button or launch it from a web site.
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Depending on the settings and antivirus/malware software installed on your machine as well as your corporate
policies, you may see a warning when installing Workflow Composer and its activity packages.

Proceed as follows:

1. Open the Control Panel, select Programs, and uninstall Workflow Composer.

2. Install Workflow Composer from the ClickOnce installation page.

If you receive a security message preventing you from running Workflow Composer:
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a. Navigate to User\<user name>\AppData\Local and search for WorkflowComposer.exe.

b. Right-click on WorkflowComposer.exe, select Properties, and click the Unblock check box.

3. Run Workflow Composer.

When the installation is completed, you are prompted to configure Workflow Composer. For more information,
see Configuration.

For details about the ClickOnce URL and login credentials, refer to https://filetransfer.campusmgmt.com
> softwareupdates > WorkflowComposer > WF_ComposerInstallationSteps.pdf.

Note: If you installed Workflow Composer using ClickOnce with auto update, previously installed packages are
removed and need to be reinstalled.

When a new version of Workflow Composer has been installed, the following message will remind you to rein-
stall any packages.

Click OK and proceed to install the needed Activities and Contracts .msi packages using Package Manager.
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For each .msi package that you install, you will be prompted to confirm that you want to allow the app to make
changes to your device.

Ribbon

The button displays a basic menu that lets you to create, open, and close a workflow, access this Help
system, Package Manager, or the About window.

The About window displays the following information:

l Version
l Database (name of Anthology Student or CampusNexus CRM database)
l Tracking Database
l Build Date
l Copyright

The or buttons on the top right show or hide the ribbon.

The Settings tab lets you reset the default layout of the task panes or select a color scheme (theme) for Work-
flow Composer.

Task Panes
The task panes include the following:

l Designer
l Toolbox
l Debug Properties
l Properties
l Error List
l Output

You can customize layout of the panes as follows:

l Move panes to different positions within the main window.
l Detach panes from the main window.
l Re-size panes.
l Hide panes.
l Close panes.
l Re-open panes.

Right-click the title bar of a pane and select from the following display settings for the current session:

l Float
l Auto Hide
l Hide
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When you have closed task panes, icons representing the panes appear at the bottom of the main window.
Hover over the icons to see the labels. Click an icon to re-open the associated pane.

Error List and Output Tabs
You can select to view the Error List or the Output tabs below the Designer pane. The Error List helps to identify
errors that may occur while building workflows in the Designer pane. For example, if an incorrect entity is used
in an expression, an error similar to the example below is displayed.

The Error List also indicates any problems encountered with data types for variables. For every activity that
requires a variable, an error is displayed until the correct variable is added to the workflow.

Additional UI Elements When a Workflow is Loaded
When a workflow file (.XAML) is loaded into the Workflow Composer, toolbars appear at the top and bottom of
the Designer pane.

l The toolbar at the top of the Designer pane displays breadcrumbs for the workflow elements, an
Expand All button, and a Collapse All button. The breadcrumbs appear when you double-click the icon
in the header bar of a workflow activity.

l The toolbar below the Designer pane displays buttons for Variables, Arguments, Imports, and pan/-
zoom controls.
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Click Variables to view, edit, or create variables to be used in the workflow. The variable details include:

l Name
l Variable type
l Scope
l Default

You have the option to create variables in this pane.

Click Arguments to view, edit, or create arguments to be used in the workflow. The argument details include:

l Name
l Direction
l Argument type
l Default value

Click Imports to view the list of the imported namespaces. The default namespaces include:

l Cmc.Core.ComponentModel
l Cmc.Core.EntityModel
l Cmc.Nexus (multiple namespaces depending on the activities used in the workflow)
l Microsoft.VisualBasic.Activities
l System.Activities (multiple namespaces)
l System.Windows.Markup

You have the option to enter or select additional namespaces for import.



Workflow Version 4.0.1 40 Help Guide

Note: If you copy and paste a Sequence from one workflow to another, you may need to recreate any asso-
ciated variables to ensure all namespaces are properly imported.

The pan/zoom controls enable you to pan and zoom the display in the Designer pane. Tooltips are provided
for these buttons.

Audits
The database for Workflow Composer 3.0.1.8 and later provides a WorkflowDefinitionVersion_Audit table
that logs workflow definition version changes. Records are inserted into the new table when workflow definition
versions are updated (enabled/disabled) and deleted.

Newly published (inserted) workflow definition versions are stored in the WorkflowDefinitionVersion table.
When a workflow definition version is first published (inserted) no audit records appear in the Work-
flowDefinitionVersion_Audit table. However, a View of the WorkflowDefinitionVersion_Audit provides details
of newly created workflow definition versions.

Workflow auditing is not supported for standalone CampusNexus CRM deployments.  

Queries
To query the View of the WorkflowDefinitionVersion_Audit in MS SQL Server Management Studio, you can
use Select statements such as:

select top 10 * from Vw_WorkflowDefinitionVersion_Audit order by DateLstMod desc

select * from Vw_WorkflowDefinitionVersion_Audit order by Comment
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select * from Vw_WorkflowDefinitionVersion_Audit where WorkflowDefinitionVersionID='nnnn'

Examples
To audit the status of your workflow versions, check the values in the IsEnabled and Comment columns of the
WorkflowDefinitionVersion_Audit view.

l When you create, enable, and publish a workflow version, IsEnabled is set to 1, and the Comment field
shows a record is inserted.

l When you disable a workflow version, IsEnabled is set to 0, and the Comment field shows that the record
is updated.

l When you delete a workflow version, IsEnabled is set to 0, and the Comment field shows that the record
is deleted.
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Coding for Activity Errors
To help troubleshoot workflow errors, we recommend that you wrap Anthology activities in a TryCatch activity
and use the ValidationMessageCollection property wherever it is available.

ValidationMessageCollection
Almost all Anthology activities provide the ValidationMessageCollection property. This property is designed to
detect and log .NET framework and WCF service call exceptions as well as parameter validation exceptions.

ValidationMessageCollection provides built-in arguments.

l In Forms Builder workflows, the argument to use is:

formInstance.validationMessages

l In eventing workflow for Anthology Student or CampusNexus CRM, the argument to use is:

args.validationMessages

In eventing workflows you can also specify the variable of type "Cmc.Core.Event-
ing.ValidationMessageCollection" (see Capture Validation Errors).

ValidationMessageCollection does not need to be newed up (i.e., a new ValidationMessageCollection is not
needed for the Default value). The property value will only be newed up if it is null; otherwise is it appended to
previous captured validation messages.

TryCatch
Anthology activities should be wrapped in a TryCatch activity to handle exceptions that are raised at run time.
This applies primarily to activities that write to the database (i.e., Save and Update activities). Lookup and Create
activities do not need to be embedded in a TryCatch activity.

The TryCatch workflow activity has three sections: Try, Catches, and Finally.

Try

Place the Anthology activity for which you want to provide error handling in the Try section. Our example uses a
ConvertApplicantToEnrollment activity. The Try section successfully completes if no exceptions are thrown from
it.

Catches

Select the exception type in the Catches section. In our example the type is System.Exception. You can add mul-
tiple catches where each catch handles a different exception type. System.Exception is the catch-all exception
and should always be the last exception in the list if you want to trap specific exceptions, otherwise more spe-
cific exceptions will never be caught. Catches cannot be reordered. They must be deleted and added in the cor-
rect order.
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After selecting the exception type, you can add an activity to the catch. In our example a WriteLine activity
writes exception messages to the console.

"Exception: " & exception.Message

Note: WriteLine activities are useful when testing workflows with the Run option. Otherwise, use LogLine activ-
ities with Level=Error.

The Catches section successfully completes if no exceptions are thrown from it.

Finally

The Finally section includes a Condition that checks if the ValidationMessageCollection has errors. The Condi-
tion in our example uses a variable named "valMsgColl" of type "Cmc.Core.Event-
ing.ValidationMessageCollection".

If an error is found, a WriteLine activity writes the text "Validation messages" to the console.

The ForEach activity ensures that invalid values in any field of the ConvertApplicantToEnrollment activity will res-
ult in a validation message, e.g.:

Validation messages
Student Id is not valid

Validation messages
Invalid Academic Advisor selected

The console will also display a message if an exception is caught, e.g.:

Validation messages
Validation Failed: Field: ProgramVersionId generated an exception during validation.
The following errors were encountered while processing the workflow tree:
'DynamicActivity': The private implementation of activity '1: DynamicActivity' has the following
validation error: Value for a required activity argument 'GradeLevelId' was not supplied...

The activities in the Finally section are executed when either the Try section or the Catches section successfully
completes.
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For more information, see:
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l https://docs.microsoft.com/en-us/dotnet/framework/windows-workflow-foundation/exceptions.

l https://docs.microsoft.com/en-us/visualstudio/workflow-designer/trycatch-activity-designer?view=vs-
2019

https://docs.microsoft.com/en-us/dotnet/framework/windows-workflow-foundation/exceptions
https://docs.microsoft.com/en-us/visualstudio/workflow-designer/trycatch-activity-designer?view=vs-2019
https://docs.microsoft.com/en-us/visualstudio/workflow-designer/trycatch-activity-designer?view=vs-2019
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Configuration

For details about the installation of Workflow Composer, please refer to Installation Manager Help.

Once Workflow Composer 4.x is installed, you need to specify whether it accesses the databases via direct con-
nections or via a Workflow Web API.

l In an Anthology Cloud 2.0 environment, configure the Workflow Web API Connection. The Workflow Web
API replaces the Citrix connections used previously in cloud environments.

l In on-premise or Azure (non-Anthology Cloud 2.0) environments, configure Direct Database Connections.

The configuration needs to be done only once when Workflow Composer is installed the first time. The settings
are retained during upgrades.

Workflow Composer 4.0.1 introduces the option to change the configuration upon launching the application.
You can choose to Connect to the previously configured environment or change the configuration to access a
different environment.

If you change the configuration, the following message appears. When you click OK, Workflow Composer will
restart and connect to the newly configured host. It will take a few seconds to start.

On initial start up, the Configuration window displays Connect and Exit buttons. When you select Connect after
you have configured the connection, Workflow Composer will launch and connect to the configured host. If you
select Exit, Workflow Composer will not launch.

Once Workflow Composer has been launched, the Configuration window displays Connect and Close buttons.
You can update the existing configuration and select Connect to continue working with the updated con-
figuration. If you click Close, the Configuration window will close.

After you click the button at the top of the Configuration window, you can open the Configuration window
again and change the configuration details if needed.

https://help.campusmanagement.com/IM/Content/WF/InstallingWF.htm
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Direct Database Connections
If you are using Workflow Composer with on-premises databases connections:

1. Select Direct connection with the database.

2. Specify the server names and database names for your database connections.
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l The Workflow Database is the database that supplies values to your workflow activities. It can be
an Anthology Student or CampusNexus CRM database.

l The Durable Instancing Database typically uses the same server and database as the Workflow
Database.

l (Optional) The Tracking Database is named "WorkflowTracking" by default. It can be on the same
server as the Workflow Database and the Durable Instancing Database.

3. In the API Key field, specify the key you use to access Anthology Activities and Contracts packages.

4. (Optional) In the CRM Configuration section, specify the following:

l CRM Main Database Server and Database

l CRM Web Client URL

By default, the CRM Configuration section will be blank.

Integrated security will be used for the connection information.

When the Server and Database are populated under the CRM Main Database, a connection string will be
created in the Workflow configuration file named CRMdbconnection.

<connectionStrings>
<clear />
<add name="LocalSqlServer" connectionString="data source-

e=.\SQLEXPRESS;Integrated Secur-
ity=SSPI;AttachDBFilename=|DataDirectory|aspnetdb.mdf;User Instance=true"

providerName="System.Data.SqlClient" />
<add name="dbConnection" connectionString="Data Source=<server>;Initial Cata-

log=<database>;Integrated Security=True;Application Name=&quot;Workflow Com-
poser&quot;"

providerName="System.Data.SqlClient" />
<add name="WorkflowDurableInstancingConnection" connectionString="Data Source-

e=<server>;Initial Catalog=<database>;Integrated Secur-
ity=True;Pooling=True;MultipleActiveResultSets=True;Application
Name=&quot;Workflow Composer&quot;"

providerName="System.Data.SqlClient" />
<add name="WorkflowTrackingConnection" connectionString="Data Source-

e=<server>;Initial Catalog=&quot;Workflow Tracking&quot;;Integrated Secur-
ity=True;Persist Security
Info=False;Pooling=True;MultipleActiveResultSets=True;Application Name-
e=&quot;Workflow Composer&quot;"

providerName="System.Data.SqlClient" />
<add name="CrmDbConnection" connectionString="Data Source=<server>;Initial

Catalog=<database>;Integrated Security=True;Persist Security Info-
o=False;Pooling=True;MultipleActiveResultSets=True;Application Name-
e=&quot;Workflow Composer&quot;"

providerName="System.Data.SqlClient" />
</connectionStrings>
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When the CRM Web Client URL is populated, an additional appSettings key will be added in the Workflow
configuration file.

<appSettings file="">
<clear />
<add key="DataMapperAssembly" value="Cmc.CampusLink.BusinessEntities, Cul-

ture=neutral, PublicKeyToken=<token>" />
<add key="ConfigureCampusNexusWcfProxy" value="true" />
<add key="ConfigureCVueNexusWcfProxy" value="true" />
<add key="apiKey" value="<key>" />
<add key="StudentWebClientUrl" value="https://<server>.<domain>:<port>" />
<add key="CrmWebClientUrl" value="https://<server>.<domain>:<port>/" />

</appSettings>

5. Click Save.

6. Click Yes to proceed. Workflow Composer will restart.

Workflow Web API Connection
If you are using Workflow Composer in an Anthology Cloud 2.0 environment:
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1. Select Use the Workflow Web API.

2. Specify your Student Web Client URL, i.e., https://<server>.<domain>:<port>. This URL provides access
to the server where the Workflow Web API is deployed.

The remaining fields are disabled.

Workflow Composer 3.1 and later supports dual tenancy in Azure AD. This enables Anthology support
staff to log in to a customer environment to diagnose an issue. Anthology staff append accoun-
t/login/cmc to the Anthology Student URL value to use a different authentication context for the same
environment.
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Tenant Student Web Client URL Sign in Logo

Azure AD Tenant (Customer)
https://<server>.<domain>:<port>.
campusnexus.cloud/

Support Tenant (Anthology
Staff)

https://<server>.<domain>:<port>.
campusnexus.cloud/account/login/cmc  

3. Click Save.

4. Click Yes to proceed. Workflow Composer will restart.

When you use the Workflow Web API, you must log in to your Anthology Cloud 2.0 account in the Azure Active
Directory (AAD).

In case of a service interruption or incorrect configuration, the following message will be displayed.

After you click OK, you can launch Workflow Composer again and the Configuration window will be displayed
again. You can change the Web API Configuration and log into your account.

Your user profile in the Anthology Cloud 2.0 AAD must be associated with a role.

l The Contributor role allows you to add/publish, delete, and edit workflows.

l The Reader role allows you to view workflows.

As a Reader, you can modify a workflow and save it to the file system. But you cannot publish it. If you try
to publish or delete a workflow or persisted instance, Workflow Composer returns the message: "You are
not authorized to perform this action."

If you are not associated with either role, you will need to contact a System Administrator as you will not have
access to the application.

Install Activities and Contracts
After you have configured Workflow Composer, install the Activities and Contracts required for you envir-
onment. See Package Manager.

For details about the installation of Workflow Composer, please refer to Installation Manager Help.

https://help.campusmanagement.com/IM/Content/WF/InstallingWF.htm
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Once Workflow Composer is installed, you need to specify whether it accesses the databases via direct con-
nections or via a Workflow Web API.

l In an Anthology Cloud 2.0 environment, configure the Workflow Web API Connection. The Workflow Web
API replaces the Citrix connections used previously in cloud environments.

l In on-premise or Azure (non-Anthology Cloud 2.0) environments, configure Direct Database Connections.

The configuration needs to be done only once when Workflow Composer is installed the first time. The settings
are retained during upgrades.

The System tab in the ribbon of Workflow Composer provides a Configuration option that enables you to
change the initial configuration.

Direct Database Connections

If you are using Workflow Composer with on-premises databases connections:

1. Select Direct connection with the database.

2. Specify the server names and database names for your database connections.

l The Workflow Database is the database that supplies values to your workflow activities. It can be
an Anthology Student or CampusNexus CRM database.

l The Durable Instancing Database typically uses the same server and database as the Workflow
Database.

l (Optional) The Tracking Database is named "WorkflowTracking" by default. It can be on the same
server as the Workflow Database and the Durable Instancing Database.

3. In the API Key field, specify the key you use to access Anthology workflow Activities and Contracts pack-
ages.

4. Click Save.
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5. Click Yes to proceed. Workflow Composer will restart.

Workflow Web API Connection

If you are using Workflow Composer in an Azure cloud environment with Anthology Cloud 2.0:
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1. Select Use the Workflow Web API.

2. Specify your Student Web Client URL, i.e., https://<server>.<domain>:<port>. This URL provides access
to the server where the Workflow Web API is deployed.

The remaining fields are disabled.



Workflow Version 4.0.1 55 Help Guide

Workflow Composer 3.1 and later supports dual tenancy in Azure AD. This enables Anthology support
staff to log in to a customer environment to diagnose an issue. Anthology staff append accoun-
t/login/cmc to the Anthology Student URL value to use a different authentication context for the same
environment.

Tenant Student Web Client URL
Sign in
Logo

Azure AD Tenant
(Customer)

https://<server>.<domain>:<port>.campusnexus.cloud/

Support Tenant
(Anthology Staff)

https://<server>.<domain>:<port>.campusnexus.cloud/account/login/cmc  

3. Click Save.

4. Click Yes to proceed. Workflow Composer will restart.

When you use the Workflow Web API, you must log in to your Anthology Cloud 2.0 account in the Azure Active
Directory (AAD).

In case of a service interruption or incorrect configuration, a message similar to the following will be displayed.
You will have the option to return to the Configuration window.

“The system is unable to perform authentication. You may need to contact your System Administrator.
However, the issue may be the configuration, would you like to review?"

Your user profile in the Anthology Cloud 2.0 AAD must be associated with a role.

l The Contributor role allows you to add/publish, delete, and edit workflows.

l The Reader role allows you to view workflows.

As a Reader, you can modify a workflow and save it to the file system. But you cannot publish it. If you try
to publish or delete a workflow or persisted instance, Workflow Composer returns the message: "You are
not authorized to perform this action."

If you are not associated with either role, you will need to contact a System Administrator as you will not have
access to the application.

Install Activities and Contracts

After you have configured Workflow Composer, install the Activities and Contracts required for you envir-
onment. See Package Manager.
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Contracts
Contracts describe a common data model that can be used to exchange data between service operations from
different application domains. The services do not have to share the same architectures or data types. They
only need to communicate with each other using the defined data contract.

Event Contracts and Service Contracts enable Anthology to exchange data between applications with different
architectures and data models, such as Anthology Student, CampusNexus CRM, and Forms Builder.

l Event Contracts define the endpoints that can raise events and respond to events.

l Service Contracts specify the operations supported by the service. An operation can be thought of as a
Web service method. Each method in the interface corresponds to a specific service operation.

Contracts are available for selection when you create a new workflow in Workflow Designer. The contracts are
located in the Cmc.Nexus.Contracts library. A contract will exist for each entity/class that exists in the Nexus
domain. Some examples of entities are Person, Group, and Organization. Each entity will have a list of events
that when raised can invoke a workflow.

When you create a workflow, you select an Entity and an Event. The events types available for selection are
filtered based on the selected entity.

The entities available for selection are based on the available contracts. Contracts are part of the installed Work-
flow packages. For more details, see Package Manager.

The option "Only show entity types that have the SupportedEvents attribute" is selected by default. This selec-
tion filters events that can trigger workflows. The option "Only show events supported by the selected entity
type" is also selected by default. This selection filters events based on the entity type.

Assign a Name to the new workflow, click OK, and begin building the workflow definition.

Note: Previously, Workflow Composer assigned names using the selected entity and event. Now you can assign
any name. The entity and event are displayed when the workflow is published. You can also view the entity and
event in the Debug Properties tab next to the Toolbox tab in the Designer.
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For more information about building workflow definitions, refer to Create Workflows and Sample Workflows.
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Create Workflows

Prerequisites
If Workflow Composer is configured to connect directly to the database, Insert and Update permissions for the
following database tables are required:

l WorkflowDefinition
l WorkflowDefinitionVersion

The permissions are required for the logged in user when using integrated security and for the login credentials
(username and password) specified if installing via Installation Manager and integrated security is not used.

Also ensure that you have installed the Activities and Contracts packages applicable to your environment. For
more information, see Package Manager.

Workflow Types
Workflow Composer can be used to create the following workflow types:

Sequence
l Most common type of workflow.
l Executes a set of child activities according to a single, defined ordering.

Flowchart

l Typically used to implement non-sequential workflows but can be used for sequential workflows if no
FlowDecision nodes are used. Flowchart components include:

o FlowStep – models one step of execution in the flowchart (simply a wrapper around a standard
activity).

o FlowDecision – branches execution based on a Boolean condition, similar to If.
o FlowSwitch – branches execution based on an exclusive switch, similar to Switch.

State Machine

l Allows you to model your workflow in an event-driven manner.

l Typically used for human workflow scenarios.

l A state machine can be in one state at any particular time.

o Initial State – represents the starting point of the state machine.
o Final State – represents the completion of the state machine.
o Transition – a directed relationship between two states which represents the response of the

state machine to an occurrence of an event.
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o Transition Action – an activity executed when performing a transition.
o Entry Action – an activity executed when entering the state.
o Exit Action – an activity executed when exiting the state.
o Trigger – a triggering activity that causes a transition to occur.
o Condition – a constraint which must evaluate to true after the trigger occurs for the transition to

complete.

State machine workflow are used with Forms Builder. See help for Forms Builder 3.x.

https://help.campusmanagement.com/FB/3.x/default.htm
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Create Workflows with Event Phase
The Cmc.Nexus eventing system was enhanced to raise events for custom service methods in 3 phases (Val-
idation, Execution, and Completion). Workflow Composer 3.0 and later allows you to select the applicable Event
Phase for service-based (non-CRUD) events.

Previously, all workflows were executed during the Execution Phase of a business process. There was no option
to add a workflow to be used as validation for an event. For example, it was not possible to inject business logic
into a transaction to cancel the execution of a workflow if the custom validation failed. Now, Workflow Com-
poser allows you to select the Validation, Execution, or Completion Phase when creating a workflow.

For any custom service-based workflows created before this enhancement, the workflows will continue to run
during the Execution Phase.

Event Phase Selection

Workflows Based on Custom Services

The "New Event Driven Workflow" window in Workflow Composer displays the Event Phase options when you to
select a service-based event associated with a custom service method, such as the Post Account Transaction
Charge Event associated with the Student Account Transaction Service.
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Under "Workflow to run during Event Phase" select one of the following:

l Validation Phase
l Execution Phase
l Completion Phase

The selected Event Phase will be embedded into the .xaml file and cannot be modified. Similar to the “Entity”
and “Event”, the "Event Phase" cannot be modified once created.

The event pipeline Execution Order is as follows:

A. Execute workflows published to the Validation Phase for the custom event name.
B. If the pipeline is not canceled, execute C# registered handlers for the custom event name.
C. If the pipeline is not canceled, execute workflows published to the Execution Phase for the custom event

name.
D. If the pipeline is not canceled, execute workflows published to the Completion Phase for the custom

event name.
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Workflow event handlers at the Validation Phase are registered at sequence (negative) -1048576 to ensure that
they run first. This allows the Validation workflow an opportunity to cancel the process if the Request properties
violate any custom business rules.

Workflows event handlers at the Completion Phase are registered at sequence 1048576(1024*1024). Explicitly
registering the workflow at this Execution Order ensures that the Completion Phase workflow runs last after all
other registered handlers. In the Completion Phase of the event, the args.Response will be populated with the
outcome/output of the business process. The process cannot be canceled at this point, but the output could be
used to post updates to other entities or integrated systems.

Example Workflow

Student Account Transaction Service <> Post Account Transaction Payment Event

We called this service method from a Forms Builder sequence that enables users to make payment online.

Validation Phase

1. When creating a workflow based on this event, select Validation Phase for executing the workflow.

2. (Optional) Insert a LogLine activity to mark the beginning of the Validation Phase.

3. Check if the TransactionAmount value is greater than a rule that the institution has for a certain trans-
action code (e.g., "Books", maximum charge amount is $25.00).

Use an If activity using Condition = args.Request.TransactionAmount > 25

4. If the TransactionAmount fails the rule, set a Validation Message using a CreateValidationItem activity.

5. Insert an Assign activity and specify args.CancelPipelineExecution = True.
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6. Publish the workflow.

7. Since the workflow now runs before anything is posted to the database, if the rule fails and the pipeline is
canceled, nothing will be posted to the database, and the Validation Message will be returned.

Completion Phase

1. When creating a workflow based on this event, select Completion Phase for executing the workflow.

2. (Optional) Insert a LogLine activity to mark the beginning of the Completion Phase.
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3. Before adding your Completion Phase activities, make sure the service method was successful.

This example checks whether the CreateValidationItem activity returned errors using Condition = Not
args.Response.ValidationMessages.HasErrors

4. If no errors are found, add your Completion Phase activities. This example sends an email message to
confirm receipt of the payment.

5. Publish the workflow.

6. The workflow runs after the TransactionAmount passed the max. amount rule and the payment is posted
to the database.

When a workflow with Event Phase is published, the selected Event Phase value is visible (but not editable) in
the "Publish New Workflow Definition Version" window.
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Workflows Based on Entities

All events for workflows based on entities will run during the Execution Phase. The default value of "Execution"
phase is stored to the workflow and is not editable. The Saving, Saved, Deleting, Deleted, Constructed events
continue to execute with Execution Order of 100. This ensures backward compatibility and reduces the com-
plexity of designing workflows for CRUD events. The services for CRUD operations already provide a way to can-
cel workflow execution using the Saving/Deleting events.

Event phases cannot be selected for entity-based CRUD events, such as Constructed, Deleted, Deleting, Saved,
and Saving events.

Event Phase Filter
When opening a workflow from the server, you can filter workflows by Event Phase.
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You can edit the filter to narrow the search results.
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Exception Handling
Exception handling refers to exceptions that are thrown from workflows as well as responses from the Antho-
logy API services when the Windows Communication Foundation (WCF) service returns validation messages.

Workflow Design Requires Exception Handling
The user who creates workflows is responsible for catching exceptions. Any unexpected and uncaught excep-
tions will abort workflows. For the guidelines on exception handling within workflows, refer to Coding for Activ-
ity Errors.

Exception Message Queues
Workflow exception messages are queued. Queues ensure that reliable messaging can occur between a client
and a service, even if the service is not available at the time of communication.

Anthology uses dead-letter queue and poison message handling provided by the WCF framework. For more
information, see http://msdn.microsoft.com/en-us/library/ms789035(v=vs.110).aspx.

If an error is found in a workflow, the message queue flags exceptions as EXTERNAL_DeadLetterQueue.

A log file on the application server provides detailed information about Compiler errors in the workflow.

The failed messages in the dead-letter queue are tried again. If the exception cannot be resolved, the first entry
is cleared from the dead letter queue. This ensures that the service broker is not locked in case of an exception.
Users can retry the transaction after the error is cleared.

In addition, the Service Broker queue processor code implements a Trace.WriteLinemechanism to handle
failed messages:

/// <summary>
/// Handle failed messages
/// </summary>
/// <param name="message"></param>
/// <param name="messageType"></param>
/// <param name="con"></param>
/// <param name="errorInfo"></param>

public static void SaveFailedMessage(string message, string messageType, SqlConnection con,
Exception errorInfo)

{
Trace.WriteLine("CVueExternalMessageProcessor Received Failed Message");

}

The default behavior of Service Broker is to disable a queue after the same message has thrown an exception
five times. Anthology provides a setting in the config file that prevents shutting down the queue.

<setting name="ShutdownQueueOnError" serializeAs="String">
<value>False</value>
</setting>

http://msdn.microsoft.com/en-us/library/ms789035(v=vs.110).aspx
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When this setting is set to True, the queue gets disabled. When this setting is set to False, the queue does not
get disabled. False is the recommended setting.
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Helpful Hints
The following hints may help when you begin creating and testing workflows.

Use Conditions
Workflows should start with a condition that determines if or when a workflow is executed. It is important to
use conditions because all workflows that are stored on a workstation are active. Proper conditions prevent con-
flicting or unintended changes to the database.

Check for Record Inserts and Changes

When working with workflows, it is important to understand that many of the records that are checked in the
workflow will have numerous updates from different sources for different reasons and the workflow will be
triggered multiple times. To ensure that the workflow is executed only when a specific value is changed, you can
use conditions to check the EntityState property or the HasChanged method on the entity.

Examples

l entity.HasChanged("Veteran")– checks if the veteran flag on a Person record was modified.

l entity.Prospects(0).HasChanged(“LeadTypeId”) – checks if the identifier of a Person record was
modified indicating that a new record was inserted.

l entity.HasChanged(StudentCourse.StatusProperty) – checks if the Status property on the Stu-
dent Course entity has changed.

In a condition statement for any entity you can select all the available properties that you are looking for
to have changed. In this example the entity is StudentCourse and the StatusProperty is selected.

To determine if a Student Course Status changed to "Withdrawal" (= "Drop" in Anthology Student, specify
the following condition:
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entity.HasChanged(studentcourse.StatusProperty) and entity.Status = Stu-
dentCourseStatus.Withdrawal

As a general rule do not use Save type activities in Saving events, only Saved events.

You can also use the entity.HasChanged condition to prevent infinite loops in the workflow.

The EntityState property applies to the entity to which it belongs. For example, the Person entity did not
change, but one of its child entities (Prospects) did. If you check the entity.Prospects(0).EntityState, it
should indicate Modified.

The EntityState property and the HasChanged()method are intended for different uses and have specific
meanings. The following are examples for a Person entity:

l entity.HasChanged() – indicates if any direct properties of the Person entity have changed. This does
not check any child entities or collections.

l entity.HasChanged(true) – checks the Person entity plus any child entities and collections. If any
property on the Person entity, or any of the entities in the collections (Students, Prospects) have
changed, it will return true. Use entity.HasChanged(true) in workflows to determine if anything has
changed within the model.

l entity.Prospects(0).HasChanged() – returns true if the first Prospects child entity of the Person
has any changes.

l entity.Prospects(0).EntityState – returns one of three values Added, Modified, or Removed and
only applies to the first Prospects entity in the Prospects collection.

For an activity that adds a record to an entity, every property will be dirty because the values are set from null to
something else or to an empty string. Therefore, you should check the EntityState in your workflow to
determine if a record is added. Insert a condition similar to the following:

If [  entity.EntityState = Cmc.Core.EntityModel.EntityState.Added ]
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l entity.EntityState – is an enumeration and contains one of three values Added, Modified, or
Removed. This gives the workflow developer more information about what has happened to the entity
during the process. This is specific to the entity to which the EntityState belongs.

Prevent Loops
Be careful not to create loops in your workflow statements.

Examples:

l If a workflow is triggered by a saving event, don't use a Save activity within the workflow.

l If a workflow is triggered by the posting of a charge, don't use a CreateCharge activity within the work-
flow.

Test Workflows for Saved Events
Although Workflow is distributed with logging turned off, you might want to enable logging during the workflow
design phase. See NLog for details about the logging configuration.

It is a good practice to insert at least one LogLine activity in workflows for Saved events. The LogLine text will
appear in the event log immediately after the event is raised.

Note: The LogLine activity requires the Cmc.Core.ServiceModuleHost.exe.config file to be set up to log to file and error as
shown below.
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Check the date.errors.log file regularly for any errors in your workflows. For more information, see Event
Logs.

Alternatively, you can test workflows for Saved events by including a Contact Manager CreateTask activity. You
can confirm that the workflow was executed by checking the Contact Manager UI.

Filter Events Based on Event Source
Every event has arguments. The arguments can be viewed in Intellisense by typing args. in the Workflow
Designer.

Event arguments have a connection context that specifies where the transaction came from. The context inform-
ation can be used to filter events. For example, you can set up a filter to handle only events that came from a
specific database trigger.
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Context Property
The Context property is a string that is set in the code when an event is raised. You can access the Context prop-
erty in the Workflow Designer, for example, when you specify arg. in the Expression field of a Switch activity.

The Context property is useful when a workflow is associated with a sequence of forms such as the Enrollment
Wizard in Anthology Student. When the user clicks Next after completing Step 1 in the Enrollment Wizard, a Per-
son Saving event is raised and the Context is set to a string, in this case, “Enrollment Wizard: Student Selection”.
You can use a conditional statement to check the value of Context and validate fields in Step 1. Within the work-
flow, as you proceed through validating fields in the sequence of steps, check the Context string using each
Case of the Switch activity. See the sample workflow Enrolling Students Using the Enrollment Wizard.

Without the Context property, if the workflow validated a property that was picked in Step 4 of the wizard and
the event was triggered for Step 1, unexpected behavior or null reference exceptions may occur.

Note that the Enrollment Wizard uses a Person Saving entity contract, so if you have a validation for the Student
Master form (e.g., on Nickname) you should also add a context sensitive If statement in that workflow. Con-
text in that case is “Student Saving Com”. Otherwise some validation you have for the Student Master could
show up on every step of the Enrollment Wizard on fields that are not even available there.
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Another use case for the Context property are workflows that deal with PostCharge or AdjustCharge trans-
action. The Context property can be used to determine the type of event.

Retrieve an Enum Value
For entities containing enumerations (i.e., a predefined list of values), use the Enum.GetName method to
retrieve an enum value.

Example:

The following expression retrieves the value of the TransactionType enumeration in the Cmc.Nex-
us.Sis.StudentAccounts contract:

https://msdn.microsoft.com/en-us/library/system.enum.getname(v=vs.110).aspx
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[Enum].GetName(GetType(Cmc.Nex-
us.Sis.StudentAccounts.TransactionType),entity.TransactionType)

In the case of the TransactionType enumeration, the Enum.GetNamemethod enables you to capture the
Transaction Type value and perform another workflow activity when this value is found.

The log shows the mapping of the TransactionType enum value of "2" to the Transaction Type of "DebitAd-
justment".

Another commonly used property to retrieve an enumeration is EntityState as shown below:
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Type Casting
You can convert data types using the TryCast operator. The example below shows how the Loan Sched-
uledDisbursement data type can be converted to the more specific DirectLoanScheduledDisbursement.

Clear a Workflow Instance Id
To clear a Workflow Instance Id value in a workflow, use the following syntax:

Note: The API does not allow you to set the Guid value to all 0s. Therefore, the 1 appears at the end.
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Capture Validation Errors
In activities that provide a ValidationMessages field defined as InOutAr-
gument<ValidationMessageCollection>, you can create a variable of type ValidationMessageCollection and
use the variable to capture error messages as shown in the example below, where the name of the variable is
"validation".

Note: If you are updating legacy activities to the new object model, be sure to update the variable type for val-
idation messages. Many of the legacy activities use the variable type 'ValidationMessage', while the new object
model uses the variable type ' ValidationMessageCollection'. It is not enough to create a variable in the new
object model, you also need to instantiate the variable.

Copy/Paste Sequences
If you copy and paste a Sequence from one workflow to another, you may need to recreate any associated vari-
ables to ensure all namespaces are properly imported.
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Check for StudentCourse.Status Changes
If you are using the Status property in workflows that check for StudentCourse.Status changes, use a logic pat-
tern containing the CTYPE function with multiple combinations of possible status changes.

In our example, the FlowDecision activity contains a condition that checks whether the Stu-
dentCourse.StatusProperty entity has changed and whether the original Status value was NotTaken (case a),
Registered (case b), or CurrentlyAttending (case c). The CTYPE function changes the original Status values to a
new Status values for each case.

entity.HasChanged(studentcourse.StatusProperty)

AND (CTYPE(entity.OriginalValues("Status"), StudentCourseStatus) = StudentCourseStatus.NotTaken

AND entity.Status = StudentCourseStatus.Registered)

OR (CTYPE(entity.OriginalValues("Status"), StudentCourseStatus) = StudentCourseStatus.Registered

AND entity.Status = StudentCourseStatus.NotTaken)

OR (CTYPE(entity.OriginalValues("Status"), StudentCourseStatus) = StudentCourseStatus.CurrentlyAttending

AND entity.Status = StudentCourseStatus.Withdrawal)

For different Status changes, replace the Status values as shown in the following pattern:

Where:

l status1a = original status (case a)
l status2a = new status (case a)
l status1b = original status (case b)
l status2b = new status (case b)
l status1c = original status (case c)
l status2c = new status (case c)
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entity.HasChanged(studentcourse.StatusProperty)

AND (CTYPE(entity.OriginalValues("Status"), StudentCourseStatus) = StudentCourseStatus.status1a

AND entity.Status = StudentCourseStatus.status2a)

OR (CTYPE(entity.OriginalValues("Status"), StudentCourseStatus) = StudentCourseStatus.status1b

AND entity.Status = StudentCourseStatus.status2b)

OR (CTYPE(entity.OriginalValues("Status"), StudentCourseStatus) = StudentCourseStatus.status1c

AND entity.Status = StudentCourseStatus.status2c)

Improve Search Performance on "Browse for Types..."
When you need to select the Browse for Types... option in Workflow Composer, the search performance is
improved if you copy and paste the entirety of the type to be searched into the "Browse and Select a .Net Type"
window.

Example

You need to browse for a variable type named "ValidationMessageCollection". The quickest way to locate the
variable type is:

1. Open Notepad.
2. Type ValidationMessageCollection.
3. Copy/paste ValidationMessageCollection into Type Name field of the "Browse and Select a .Net

Type" window.

How to Initialize an Array
You can initialize an array in an Assign activity.

Examples
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l Boolean array:

New Boolean() {false, false}

—OR—

{false,false}

l Integer array

New Integer() {1, 2, 4, 8}

l Nested array

{{1,2},{3,4}}

You don’t have to worry about the size of the array. The number of values it will have defines the size.

To access these array elements, note that the index always starts at 0.

AndAlso Operator
You can combine expressions using operators. The And operator evaluates expressions on both sides. The
AndAlso operator evaluates the right side if and only if the left side is true. The right way of exiting the eval-
uation (and preventing "Object reference not set to instance" errors) is to use AndAlso.

Example

studentEntity IsNot Nothing AndAlso studentEntity.CountryId.HasValue AndAlso studentEntity.CountryId.Value
> 0
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Host Processes
The hosts involved in the workflow vary depending on the Anthology configuration and environment. The Ser-
viceModuleHost, ServiceBrokerServiceModule, and the WorkflowServiceModule are required to host workflow
processes. Application servers and clients vary.

Host Process Description

ServiceModuleHost.exe Windows service responsible for hosting plugin modules to simplify deployment
and maintenance of processes that run in the background. For more information,
see Service Module Host.

ServiceBrokerServiceModule Responsible for monitoring SQL Server Service Broker Queues for messages.
Currently, message handlers are implemented to raise EventService events and
trigger schedule-based workflows.

WorkflowServiceModule Responsible for executing runnable workflows that have been persisted using the
Delay activity. This process waits for suspended workflows (a.k.a. long running)
to resume. It queries the database every 10 seconds.

This process waits for suspended workflows (a.k.a. long running) to resume. It
queries the database every 10 seconds. It requires a valid handle in the database
to ensure that the process is valid and connected to the database. The process
refreshes a lock within the database table: [Sys-
tem.Activities.DurableInstancing].[LockOwnersTable] every 30
seconds. If the lock becomes expired or if it is not found, the module will start to
throw exceptions regarding the lock being Freed or Invalid.

CampusVue.exe Desktop Client for Anthology Student

w3wp.exe IIS hosted application server. Events are raised through ASP.NET or WCF.

WorkflowComposer.exe Allows power users to create and publish workflows and track workflow
instances.

API Authentication for Workflow Activities
Installation Manager accepts the API Username and Password to allow applications other than Anthology Stu-
dent to execute Anthology Student workflow activities. The API Username and Password values are specified on
the Anthology Student tab in the Forms Builder Settings screen of Installation Manager. The API Username and
Password are written to the SyRegistry table within the Anthology Student database (with selected encryption
mechanism). The API Username and Password are no longer written to the web.config file and to the app config
of the Service Module Host for Workflow Composer.
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Package Manager
The Package Manager application is integrated in Workflow Composer. Package Manager displays workflow
packages accessible by the configured customer. The packages contain contracts, entities, events, and activities
related to workflows and eventing for CampusNexus CRM, Anthology Student, and Forms Builder. The packages
must be installed before you can start creating workflows.

Note: If you installed Workflow Composer using ClickOnce with auto update, previously installed packages are
removed and need to be reinstalled.

When a new version of Workflow Composer has been installed, the following message will remind you to rein-
stall any packages.

Click OK and proceed to install the needed Activities and Contracts .msi packages using Package Manager.

For each .msi package that you install, you will be prompted to confirm that you want to allow the app to make
changes to your device.

Install Packages
1. Right-click the Workflow Composer icon on your desktop and select Run as administrator.

2. Click Package Manager in the toolbar of Workflow Composer. Because Workflow Composer cannot be
updated while it is running, Package Manager prompts you to close the Workflow Composer.

Depending on the settings and antivirus/malware software installed on your machine as well as your
corporate policies, you may see a warning when installing Workflow Composer and its activity pack-
ages.

3. Click Yes to proceed. The Package Manager window is displayed.

Note: Check the URL of the Package Manager Host for your environment. If necessary, change the URL
and click Update before trying to install packages.
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4. In the Available Packages pane, click for the package to install. A progress bar displayed while the
selected package is being downloaded and extracted to the appropriate location. When the installation is
complete, click Done to close Package Manager.

You can install only one version of a specific package type. For example, if you installed "Activities and
Contracts (CRM) 12.0.0", you cannot have "Activities and Contracts (CRM) 13.0.0" on the same instance of
Workflow Composer at the same time. "Activities and Contracts (CRM) 13.0.0" will overwrite "Activities
and Contracts (CRM) 12.0.0".

For each version of Anthology Student, Package Manager provides Activities and Contracts for the legacy
namespaces and the new namespaces. The Activities and Contracts packages for legacy namespaces are
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labeled V1, while the Activities and Contracts for new namespaces are labeled V2. For more information,
see About the New Object Model.

Note: Anthology Student 21.0 (and later) Activities and Contracts are required when using Workflow Com-
poser with Web API connection. Earlier versions of Activities and Contracts are incompatible.
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With Workflow Composer 4.x and Anthology Student 22.x0 and later, you need to install both the V2 Activ-
ities and Contracts and the V1 Contract packages. V1 Activities are not supported in 22.x and later.

If you have workflows with V1 Activities, warning messages will be displayed when you select or run a work-
flow. See Run Time Messages About V1 Activities.

If workflows that contain V1 Activities have not been updated prior to upgrading to Anthology Student 22.x
and installing 22.x Activities and Contracts packages, perform the following steps:

1. Uninstall the V1 and V2 packages for 22.x.

2. Import an earlier version of V1 and V2 packages (e.g., 21.x).

3. Update the workflows to replace the V1 activities (see Actions Required).

4. Re-import the 22.x packages.

The packages for Anthology Student 22.x and later will only contain the V1 Contracts and not the Activities.
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5. Restart Workflow Composer. The contracts, entities, events, and activities associated with the down-
loaded packages are now available in Workflow Composer.

Uninstall Packages
1. Right-click the Workflow Composer icon on your desktop and select Run as administrator.

2. Click Package Manager in the toolbar of Workflow Composer.

3. Click Yes to close Workflow Composer. Package Manager displays check marks for any previously
installed packages.

4. In the Currently Installed Packages pane, click for the package to uninstall. A progress bar dis-
played while the selected package is being removed. Click Done to close Package Manager.

5. Restart Workflow Composer. The uninstalled packages are no longer available.
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Persisted Workflows
The Workflow application enables you to open, refresh, and terminate persisted workflows. Persisted workflows
may contain Delay or Bookmark activities or are started by a Scheduled event. These workflows reside in the
database and are idle until the delay, bookmark, or scheduled events occur.

1. In Workflow Composer on the Home tab of the ribbon, click Open Persisted Workflow .

2. The Open Persisted Workflow window is displayed. You can sort and filter the grid as needed.

In Workflow Composer 3.0 and later, the Persisted Workflow grid has an additional "Username" column.
This column is populated only for workflows associated with Forms Builder sequences. 

3. Select a workflow instance.

4. Click Open to view the workflow definition. You can edit and save the workflow.
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The process retrieves and displays data from durable instancing (not tracking); However, if a record is
selected and the Open button is clicked, the process attempts to retrieve tracking data. If the tracking
database is not configured, the process will continue without error and will still open the persisted work-
flow.

5. Click Refresh to update the grid of persisted workflows.

6. Click Terminate to stop a workflow. Click Yes to confirm. The workflow instance is removed from the
grid.

7. Click Cancel to close the Open Persisted Workflow window.

Note:

Workflow tracking relies on three database strings that are configured in the configuration file for the Ser-
viceModuleHost.exe. For more information, see Connection Strings.

a. dbConnection
b. WorkflowDurableInstancingConnection
c. WorkflowTrackingConnection

The dbConnection and WorkflowDurableInstancingConnection should point to the same SIS database,
e.g., a Anthology Student database. The WorkflowTrackingConnection should point to a specific tracking
database (different than the SIS database).
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Save and Publish Workflows
The Workflow application enables you to save a local copy of a workflow and publish it when it is ready to be
run by the workflow engine.

The option to save to the local file system is intended to be used during the design phase and for file sharing
purposes. Workflows that are stored locally are not used by the workflow engine.

To save a workflow locally, click Save or Save As... on the Home tab of the Designer.

Workflows that are ready to be run by the workflow engine must be published. Published workflows are stored
in the database. During publishing, you have the option to enable the workflow. The workflow engine runs only
workflows that are published and enabled. Multiple versions of a workflow can be saved to the database. If
another workflow with same Entity.Event and Name is found, the publishing process increments the workflow
version. Only one version of a particular workflow can be enabled at a time.

1. Open a workflow definition in Workflow Composer. See View, Enable, and Delete Workflows.

2. On the Home tab, click Publish. The "Publish New Workflow Definition Version" window is displayed.

The Name, Entity, Event, and Execution Event Phase fields are automatically populated based on the
information that was gathered when the workflow definition was created. For more information about
Event Phases, see Create Workflows with Event Phase.
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3. If you want the workflow to be run as soon as the event occurs on the entity, select Enable This Work-
flow Version, otherwise leave the check box cleared.

Enabling the workflow disables any other version of the same workflow that may be currently enabled.

4. Click Publish.
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View, Enable, and Delete Workflows
Workflow Composer enables you to open and view workflow definitions from a local file system or from an
SQL Server database table. Workflows stored in the database can be enabled and disabled.

View Workflows from File or Server
To open a workflow from the file system, click Open in the File section of the ribbon and navigate to the loc-
ation where your workflow files are stored.

To open a workflow from the database, click Open in the Server section of the ribbon. The "Open Workflow
Definition From Server" window displays a grid with information about workflows that have been published to
the database. To load a workflow definition into the Designer, select the workflow in the grid and click Open.

Workflows are grouped by entities and events in the "Open Workflow Definition From Server" window. Expand
the entity and event groups to view the following information about each workflow:

l Version
l Enabled
l Delete
l Published by (Windows identity of the user who is signed in to the Workflow Composer workstation
l Source (Windows identity of the workstation where the workflow came from)
l Date modified
l Event Phase
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You can sort the grid by workflow Name and filter by Event Phase. For more information about Event Phases,
see Create Workflows with Event Phase.

You can also manipulate the grid in the Open Workflow Definition From Server window. Hover over the column
headings to access column filter and sort controls. Drag column headers to rearrange or remove columns.

Enable a Workflow
Select or clear the Enabled check box to choose which workflow is currently active and will be selected by the
workflow engine to execute when a new instance of this workflow is invoked. For workflows that have multiple
versions, only one version at a time can be enabled. Click Save when you have changed the enabled status.

Workflow Versioning
When you open, modify, and publish a workflow version, the version number of the workflow is automatically
incremented, and the new version is added to the grid.

You can modify long running workflows when needed without disrupting any instances of the workflow that are
in process and persisted to the data store. The execution of any currently persisted workflows is completed
using the definition of the older version and invokes new instances of the workflow using the latest definition.

The WorkflowIdentity class supports the versioning and dynamic update functionality of Workflows and enables
hosting multiple versions of the same workflow.

Delete Workflow Definitions
The 'Open Workflow Definition from Server' window enables you to delete workflow definitions that are stored
in the database. You can select multiple revisions of a single workflow, all revisions of workflow, and workflow
revisions of multiple different contracts at same time. When you select the Delete check box, you are prompted
to confirm that you want to permanently delete the selected workflows/revisions.

If at least one instance of any of the selected workflow revisions is a long running workflow and still is in pro-
cess, a message states that one or more instances of one of the selected workflow revisions is still in process. If
you proceed with the Delete operation, all in process instances of workflows associated with any of the selected
workflow revisions are deleted as well as the selected workflow revisions.

http://msdn.microsoft.com/en-us/library/system.activities.workflowidentity(v=vs.110).aspx
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Workflow Execution Scenarios
A workflow continuously executes activities until there are no more activities to execute or until all currently
executing activities are waiting for input. The input can come from a user, an external system, or an expiring
timer. While waiting for input, the workflow becomes idle. A host can unload workflows that have gone idle and
reload them to continue execution when the input arrives. To unload the workflow when it becomes idle, the
host must persist the workflow instance.

Persistence of the workflow instances and associated data is required in the following scenarios:

l A workflow is started within an application, unloaded due to a Bookmark, and resumed from the same
application.

l A workflow is started within an application server, unloaded due to a Delay, and resumed from the applic-
ation server.

l A workflow is started based on a Schedule, unloaded due to a Delay, and resumed from the application
server.

l A workflow is started based on a Schedule, unloaded due to a Bookmark, and resumed from the applic-
ation server.

The hosts involved in the workflow vary depending on the Anthology configuration and environment. For more
information about the hosts, see Host Processes.

Bookmark
Bookmarks are the mechanism that enables a workflow activity to passively wait for input without holding onto
a workflow thread. A bookmark is the point at which execution can be resumed (and through which input can
be delivered) within a workflow instance. External code is responsible for resuming the bookmark with relevant
data. Multiple bookmarks can be scheduled at the same time.

For information about creating different bookmark types, see CreateBookmark and CreateBookmark<>.

To see how CreateBookmark and ResumeBookmark activities can be used in a workflow, refer to:

l Create a Long Running Workflow
l Wake up the Long Running Workflow
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Delay
A Delay activity creates a timer for a specified duration. The workflow instance is unloaded until the timer
expires.

Other activities related to workflow persistence include:

l StateMachine
l State
l FinalSate
l Persist
l NoPersistScope
l Pick
l PickBranch
l Parallel

For more information about these activities, see Generic Activities.

Schedule
Event scheduling can be used to start a workflow on a recurring schedule. For more information see Event
Scheduling.

The web client for Anthology Student 20.0 and later enables you to set up schedules to trigger workflows. In the
web client, select the Processes tile, locate System Administrator in the tree, and select Background Processes.
On Background Processes page, add or edit jobs and then schedule the jobs so that they are executed as a back-
ground process.
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Workflow Tracking
Workflow Composer provides a visual workflow tracking feature that is built based on the workflow tracking
infrastructure available in the .NET Framework. Workflow tracking enables you to observe the execution of a
workflow instance at runtime.

1. Tracking records are emitted from a workflow at the workflow instance level and when activities within
the workflow execute.

2. Tracking profiles are used to specify which tracking information is emitted for a workflow instance. The
queries defined within the tracking profile section define the kinds of events that are returned by the sub-
scription. For example, a tracking profile might subscribe to Started and Completed workflow event
statuses. If no profile is specified, all tracking events are emitted. Tracking profiles are XML elements
within a standard .NET framework config file. A Workflow Tracking Profile Editor UI is also available.
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3. A workflow tracking participant needs to be added to the workflow host to subscribe to tracking records.
The tracking participant subscribes to TrackingRecord objects. It contains the logic to process a Track-
ingRecord (for example, writing to a file). The .NET Framework provides an ETW (Event Tracing for Win-
dows) tracking participant with a basic profile that is installed in the machine.config file. Anthology also
provides an SQL tracking participant that stores the tracking records and permits retrieval of the tracking
records.

For more information about the workflow tracking and tracing infrastructure in .NET, see http://msdn.-
microsoft.com/en-us/library/ee513992(v=vs.110).aspx.

Note:

Workflow tracking relies on three database strings that are configured in the configuration file for the Ser-
viceModuleHost.exe. For more information, see Connection Strings.

a. dbConnection
b. WorkflowDurableInstancingConnection
c. WorkflowTrackingConnection

The dbConnection and WorkflowDurableInstancingConnection should point to the same SIS database,
e.g., an Anthology Student database. The WorkflowTrackingConnection should point to a specific tracking
database (different than the SIS database).

http://msdn.microsoft.com/en-us/library/ee513992(v=vs.110).aspx
http://msdn.microsoft.com/en-us/library/ee513992(v=vs.110).aspx
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The tracking process retrieves and displays data from the tracking database. If the tracking database is not
configured, Workflow Composer will display a user friendly message.

Workflow Tracking Example
After you have set up your environment for workflow tracking, use Workflow Composer for visual workflow
tracking. You can:

l View workflows that are currently executing.
l View workflows that executed in the past.
l Select and replay workflows.
l Refresh the display in the Current and Historical windows.

You can troubleshoot a workflow and determine if it is executing properly based on the data being passed or
returned from every activity step in a given workflow.

1. Open the Workflow Designer and click Open Tracked Workflow.

The Completed Workflows window is displayed. Each record indicates the following.

l Instance Id
l Workflow (.xaml file name)
l State (e.g., closed, executing, idle, unloaded, completed, aborted, terminated)
l Time

You can sort, filter, and rearrange the columns in the grids.

2. Select a record and click Open. The definition of the workflow instance is loaded into the Designer pane.
You can select a workflow instance and click Replay to execute the workflow again, click Refresh to
update the Completed Workflow instances, or click Close to unload the workflow from the Designer
pane.
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3. Click on the Workflow Activities tab below the Toolbox. The Workflow Activities pane is displayed. It con-
tains records for the Activity steps in the currently loaded workflow.

4. In the Workflow Activities pane, click on the Activity step that you want to examine. The selected Activity
step is highlighted in the Designer pane.

5. Click on the Debug Properties tab.
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6. In the Debug Properties pane, click to the left of Workflow Activity State Data to inspect the details
of the Arguments and Variables declared at the time of the execution of the Activity step selected in the
Workflow Activities tab.
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7. Click the icons to inspect the details of the Arguments and Variables declared at the time of the exe-
cution of the workflow Activity step selected in the Workflow Activities tab.

Notes:

l Use the visual workflow tracking feature only when needed to avoid any performance impacts.

l Define an appropriate tracking profile to limit the number of tracking records that are emitted at runtime.
For more information about tracking profiles, see http://msdn.microsoft.com/en-us/library/ee513989
(v=vs.110).aspx.

l To clean up the Workflow Tracking database when it gets too large, refer to Resources > Workflow Track-
ing DB Cleanup Script.

http://msdn.microsoft.com/en-us/library/ee513989(v=vs.110).aspx
http://msdn.microsoft.com/en-us/library/ee513989(v=vs.110).aspx
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NewWorkflows

About the New Object Model
Beginning with Workflow 2.2, a new object model supports Anthology Student version 17.1 and later. The new
object model introduces new namespaces for Anthology Student modules.

Old Namespace New Namespace

Cmc.Nexus.Workflow.<modulename>

Example:

Cmc.Nexus.Workflow.Sis.Academics

Cmc.Nexus.<modulename>.Workflow

Example:

Cmc.Nexus.Academics.Workflow

The new services, namespaces, and entities are documented in the Anthology Student Object Library.

With the release of Anthology Student 21.0 in October 2019, the EOL date for Anthology Student Activities (V1) is
scheduled for October 2020 and the EOS date is scheduled for April 2021. For more information, see End-of-Life
for Anthology Student Activities (V1).

End-of-Life Announcement for Anthology Student Activities (V1)

New and Migrated Activities
The activities in the toolbox of Workflow Composer are sorted by namespace. Any new activities that have been
developed since the introduction of the new object model are added to the corresponding namespaces in the
toolbox.

Activities that were developed in the old object model and are required to support events raised out of Antho-
logy Student were migrated to new namespaces.

Example:

The CreateStudentSportsService activity was migrated from Cmc.Nexus.Workflow.Sis.StudentServices to
Cmc.Nexus.StudentServices.Workflow.

If you are creating a new workflow using this activity, use the activity from the new namespace Cmc.Nex-
us.StudentServices.Workflow.

For help about the migrated activity, refer to "CreateStudentSportsService (V2)" in the New Workflows help sec-
tion.

Help about the older variant of the activity is found in "CreateStudentSportsService (V1)" in the Legacy Work-
flows help section.

The toolbox in Workflow Composer will provide both variants of the CreateStudentSportsService activity until all
legacy workflows have been migrated.
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The LookupServiceListItem, LookupAreaOfStudy, and LookupListItem activities were not migrated. The func-
tionality of these activities is incorporated into the LookupReferenceItem activity in Cmc.Nex-
us.Common.Workflow. Use the LookupReferenceItem activity for any new or migrated workflows.

The LookupGroup activity in Cmc.Nexus.Workflow is migrated to LookupStudentGroup in Cmc.Nex-
us.Common.Workflow.

For detailed information about the entities and properties associated with new and migrated activities, refer to
the Anthology Student Object Library instead of mapping tables provided in the Legacy Workflows help section.

Events
Events raised out of the standard interface for Anthology Student are supported only in the new object model.

Events raised out of the legacy interface for Anthology Student are supported in the legacy model (using legacy
contracts, activities, and entity mapping tables). However, the legacy model will be phased out. Any new work-
flows for events raised out of the legacy interface for Anthology Student 17.1 and later should be migrated to
use the new object model.

Contracts
The contracts that the legacy services/activities were developed against are not migrated. Instead, the contracts
that the legacy services/activities use become part of the new object model/command model.

The legacy contracts will be supported for a designated length of time allowing for customers to adjust any
applicable workflows to use the new entities and their corresponding contracts. The specific steps/process for
how affected workflows are updated/modified will need to be determined.

If you are migrating from an older version of Anthology Student to a newer version, you may need to work with
two instances of Workflow Composer where one instance uses the V1 and V2 packages of the older Anthology
Student version and the second instance uses the V1 and V2 packages for the new Anthology Student version.

When all workflows are migrated to use the new activities, uninstall the old contracts. A new user from Antho-
logy Student 17.1 forward should never install the old contracts/activities.

Converted Entities
In the new object model, the conversion of entity values is no longer required. The CVueIdToPersonIdActivity
and PersonIdToCVueIdActivity are no longer needed, and the following conversion formulas no longer apply:

For Student:

l PersonId = (SyStudentId * 10 ) + 1

Other entities:

l SyStaffId + '2'
l SyAddressId + ‘3’
l PlEmployerContactId + ‘4’
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l AmAgencyContactId + ‘5’
l SyOrganizationContactId + ‘6’
l AmOnlineApplicantId + ‘7’

For Student Group: GroupId = (SyGroupsId * 10 ) + 1

Note: In new and migrated workflows, the Campus (Id) property replaces the Business Unit (Id) property.
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CampusNexus CRM Events
The following events are specific to CampusNexus CRM.

l Saving events are triggered just prior to data being saved.

l Saved events are triggered just after data is saved

l Deleting events are triggered just prior to data being deleted.

l Deleted events are triggered just after data is saved

These events apply to all operational objects except the Account object.

Note: In the current release, the Prospect object is renamed to Lead.

Cmc.NexusCrm.Contracts.dll
All operational and reference objects are wrapped in the assembly file Cmc.NexusCrm.Contracts.dll. Whenever
new properties are created in CampusNexus CRM or an existing property definition (metadata) is changed, this
assembly is regenerated. Workflows for CampusNexus CRM require the events and objects contained in the
Cmc.NexusCrm.Contracts.dll to be available in Workflow Composer.

To regenerate the assembly after any metadata changes, perform the following steps:

1. On the IIS Server of the Web Client for CampusNexus CRM, restart the Cmc.Crm.Workspaces applic-
ation.

2. Navigate to the URL of the Web Client for CampusNexus CRM.

3. Copy the regenerated Cmc.NexusCrm.Contracts.dll from the \bin folder of the Web Client to the install-
ation path of Workflow Composer.

CampusNexus CRM Namespaces
Entities of operational objects will be available under this contract in the following namespaces:

l Cmc.NexusCrm.Common.Entities

l Cmc.NexusCrm.Enrollment.Entities

l Cmc.NexusCrm.Events.Entities

The following figure is an example of a namespace:
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The following table indicates the list of objects supported in the above namespaces:

ObjectName Namespace
Events can occur in

Web Client Portal iServices

Account Cmc.NexusCrm.Common.Entities NA NA NA

Academic Progress Cmc.NexusCrm.Enrollment.Entities Y Y Y

Address Cmc.NexusCrm.Common.Entities Y Y Y

Address Type Cmc.NexusCrm.Common.Entities Y Y Y

Area of Interest Cmc.NexusCrm.Common.Entities Y Y Y

Area of Study Cmc.NexusCrm.Common.Entities Y Y Y

Contact Cmc.NexusCrm.Common.Entities Y Y Y

Country Cmc.NexusCrm.Common.Entities Y Y Y

Course History Cmc.NexusCrm.Enrollment.Entities Y Y Y

Custom Objects Cmc.NexusCrm.Common.Entities Y Y Y

Document Status Cmc.NexusCrm.Common.Entities Y Y Y

Document Status Type Cmc.NexusCrm.Common.Entities Y Y Y

CRM Objects and Namespaces
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ObjectName Namespace
Events can occur in

Web Client Portal iServices

Education Level Cmc.NexusCrm.Common.Entities Y Y Y

Enrollment Cmc.NexusCrm.Enrollment.Entities Y Y Y

Ethnic Group Cmc.NexusCrm.Common.Entities Y Y Y

Event Cmc.NexusCrm.Events.Entities Y Y Y

Goal Cmc.NexusCrm.Enrollment.Entities Y Y Y

Lead Cmc.NexusCrm.Common.Entities Y Y Y

Lead Source Cmc.NexusCrm.Common.Entities Y Y Y

Lead Type Cmc.NexusCrm.Common.Entities Y Y Y

Nationality Cmc.NexusCrm.Common.Entities Y Y Y

Participant Cmc.NexusCrm.Events.Entities Y Y Y

Program Cmc.NexusCrm.Common.Entities Y Y Y

Program Level Cmc.NexusCrm.Common.Entities Y Y Y

Program Version Cmc.NexusCrm.Common.Entities Y Y Y

Program Version Start Date Cmc.NexusCrm.Common.Entities Y Y Y

Region Cmc.NexusCrm.Common.Entities Y Y Y

Shift Cmc.NexusCrm.Common.Entities Y Y Y

State Cmc.NexusCrm.Common.Entities Y Y Y

Term Cmc.NexusCrm.Common.Entities Y Y Y

Test Cmc.NexusCrm.Common.Entities Y Y Y

Test Score Cmc.NexusCrm.Enrollment.Entities Y Y Y

Limitations:

l For the Event object, only the Get operation is supported.

l For the Participant object, only the Get and Update operations are supported.

l For all other objects, the Get, Create, and Update operations are supported.

l The Delete operation is not supported in all objects listed in the table.

l For external properties in all objects, only the Get activity is supported.
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Deleting Events
Deleting events are triggered just before records are deleted. These events are used in scenarios where a user
or an administrator needs to be notified prior to the deletion of a record.

For the handler written in .NET code to raise a validation, the second parameter, EventArgs, must be type casted
to ValidationEventArgs.

Example for the Lead entity:

eventService.GetEvent<DeletingEvent>().RegisterHandler<Lead>(((lead, args) =>
{

      var msg = (ValidationEventArgs) args;
      msg.ValidationMessages.Add("Not a valid ID");
   }
   ));

Anthology Student Database Events
In Workflow Composer 4.0 and later, the Service Module Host raises two new database events for Anthology Stu-
dent:

l The Database Row Deleted Event occurs after a row in a database is deleted.

l The Database Row Saved Event occurs after a row in a database is updated or inserted.

Previously, for some entities in the Anthology data model, the events raised from Anthology Student (standard
interface) were insufficient to notify external systems of changes to a given entity. With the introduction of the
new database events, additional data changes can be captured via raised events to support various integrations
between Anthology Student and other systems.

Several Anthology Student contract entities are updated to serialize/deserialize the payload for the new data-
base events. The first tables and entities that will support the new database event types are listed below. Other
tables/entities will be added in the future.

Table Entity Event Added in Workflow 4.0

AdClassSched Class Section Entity Database Row Deleted Event 
Database Row Saved Event

AdConcentrationByEnrollment Student Area Of Study Entity Database Row Deleted Event 
Database Row Saved Event

SyStatChange Student School Status History Entity Database Row Saved Event

The new database events can be selected in Workflow Composer to create workflows for these entities.

Class Section Entity (Cmc.Nexus.Academics.Contracts > Cmc.Nexus.Academics.Entities)
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Student Area Of Study Entity (Cmc.Nexus.Academics.Contracts > Cmc.Nexus.Academics.Entities)
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Student School Status History Entity (Cmc.Nexus.Common.Contracts > Cmc.Nexus.Common.Entities)
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Event Details

Multiple Triggers

Database Row Saved/Deleted events trigger workflows multiple times due to other processes, triggers, and
stored procedures that affect the database record. If a user had included an email notification in these work-
flows, multiple notifications would be received for each Database Row Saved/Deleted event.

Database Row Saved Events:

l On the Class Section entity, the workflow is triggered 8 times.
l On the Student Area Of Study entity, the workflow is triggered 8 times.
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l On the Student School Status History entity, the workflow is triggered 4 times.

Database Row Deleted Events:

l On the Class Section entity, the workflow is triggered 4 times.
l On the Student Area Of Study entity, the workflow is triggered 0 times. The event fires if the record is
deleted manually in the database. The workflow just sets the record to inactive (Active=0) as shown
below.

Logging

Workflow logs for database row events will not include values for date created and date modified. The
DateTime values will only appear in the database after the event is fired. The workflow just logs the event
object.

2021-01-14 14:40:18.6921 67 Error Cmc.Core.Workflow.Activities.LogLine
Student AOS SAVED
2021-01-14 14:40:18.6921 67 Error Cmc.Core.Work-
flow.Activities.LogObject {

"IsExcludedCrmIntegration": false,
"Id": 3524,
"AreaOfStudyId": 43,
"CreatedByUserId": 2,

"CreatedDateTime": "0001-01-01T00:00:00",
"DropByUserId": 0,
"DropDate": null,
"Gpa": null,
"IsActive": true,
"LastModifiedDateTime": "0001-01-01T00:00:00",
"LastModifiedUserId": 2,
"ProgramVersionAreaOfStudyId": 428,
"RowVersion": null,

"StudentAreaOfStudyParentId": 0,
"StudentEnrollmentPeriodId": 15627,
"OriginalState": "H4sIAAAAAAAEALWUTWuEMBBA/8rivcb-

t3sQV7HYP0l0UbJde-
gxndQD5kMtZNf31dC6UXeyjklJDJvJcJk2QFIvdV9wL+wtUIVecIpem58a9+gM1NK+P20ZVoSBlz7RU0d7GWLVpnO4p-
bq9ljkuzYNmENoORKfnKS1rAF7KJvQip/GNM0xdMut-
tjfE7f-
s/XxqFuyDNI64aSHKs5XjLIG8FBm7j9myZSNTI9U+Ih-
whYvkSWs1d-
hxYIvOoaGoUPwj/MfALx5N8cYBDDM9o-
hIL50RUvyA4Kgj7dWjQLEAXVpCHp-
ceiiA6sQdna2QnQQR7KpqtHMF+gLo5ipCd9adDIZ+aWqO80JI2dGgVUrPs3p+9Fb818X+/n7yL2iiMkifBAAA",

"SecureState":
"H4sIAAAAAAAEAD3MQQrCMBAAwK9I7mZTey-
sqeFb-
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poSJel5C0C01Ss-
isxvl6s4ANm9qec-
sfb+7Ood56-
frPUumOGKst7q4zSvMkQ9qElk6ALaTC8g6kM2JkxdtU4CdMS00BgaXCWd6o1CKsMas-
fkNH/6OUokurUx6/sIHH9TKs7ZYiC0brFBw/juQnSpcAAAA=",

"ExtendedProperties": [],
"EntityState": 0

}
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Cmc.Nexus.Models
The following table shows entity mapping for the LookupReferenceItem activity (reference item query model).

Reference Item
Type

Entity Database Table

Account Statuses Cmc.Nexus.Models.StudentAccounts.AccountStatus SaAcctStatus

Address Types Cmc.Nexus.Models.Common.AddressType SyAddrType

Agencies Cmc.Nexus.Models.Common.Agency AmAgency

Applicant Types Cmc.Nexus.Models.Admissions.ApplicantType AmApplicantType

Area of Study Types Cmc.Nexus.Models.Academics.AreaOfStudyType AdConcentrationType

Areas Of Study Cmc.Nexus.Models.Academics.AreaOfStudy AdConcentration

Athletic Status Cmc.Nexus.Models.StudentServices.AthleticStatus SsAthleticStatus

Billing Methods Cmc.Nexus.Models.StudentAccounts.BillingMethod SaBillingMethod

Books for Course Cmc.Nexus.Models.Academics.Books BsItem

Campuses Cmc.Nexus.Models.Common.Campus SyCampus

Catalog Years Cmc.Nexus.Models.Academics.CatalogYear AdCatalogYear

CitizenCodes Cmc.Nexus.Models.Common.Citizen AmCitizen

Counties Cmc.Nexus.Models.Common.County SyCounty

Countries Cmc.Nexus.Models.Common.Country SyCountry

Customer Banks Cmc.Nexus.Models.StudentAccounts.Bank SaBank

Disability Statuses Cmc.Nexus.Models.StudentServices.DisabilityStatus SsDisabilityStatus

Document Statuses Cmc.Nexus.Models.Crm.DocumentStatus CmDocStatus

Document Types Cmc.Nexus.Models.Crm.DocumentType CmDocType

Employment
Statuses

Cmc.Nexus.Models.CareerServices.EmploymentStatus PlEmpStatus

Ethnicities Cmc.Nexus.Models.Common.Ethnicity AmRace

Fund Sources Cmc.Nexus.Models.FinancialAid.FundSource FaFundSource

Genders Cmc.Nexus.Models.Common.Gender AmSex

Grade Levels Cmc.Nexus.Models.Academics.GradeLevel AdGradeLevel

Grade Scales Cmc.Nexus.Models.Academics.GradeScale AdGradeScale
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Reference Item
Type

Entity Database Table

Lead Source Cat-
egories

Cmc.Nexus.Models.Admissions.LeadCategory AmLeadCat

Lead Sources Cmc.Nexus.Models.Admissions.LeadSource AmLeadSrc

Lead Types Cmc.Nexus.Models.Admissions.LeadType AmLeadType

Marital Statuses Cmc.Nexus.Models.Common.MaritalStatus AmMarital

Modules Cmc.Nexus.Models.Common.Module SyModule

Nationalities Cmc.Nexus.Models.Common.Nationality AmNationality

Previous Education
Codes

Cmc.Nexus.Models.Admissions.PreviousEducation AmPrevEduc

Programs Cmc.Nexus.Models.Academics.Program AdProgram

SAP Statuses Cmc.Nexus.Models.Academics.SapStatus AdSapStatus

School Start Dates Cmc.Nexus.Models.Academics.SchoolStartDate AdStartDate

School Status
Change Reasons

Cmc.Nexus.Models.Academics.SchoolStatusChangeReason AdReason

Service Types Cat-
egories

Cmc.Nexus.Models.StudentServices.ServiceTypeCategory SsServiceCategory

Shifts Cmc.Nexus.Models.Academics.Shift AdShift

Sports Cmc.Nexus.Models.StudentServices.Sport SsSports

Staff Cmc.Nexus.Models.Common.Staff SyStaff

Staff Groups Cmc.Nexus.Models.Common.StaffGroup SyStaffGroup

Subsidiary Account
Types

Cmc.Nexus.Models.StudentAccounts.SubsidiaryAccountType SaSubsidiary

System School
Statuses

Cmc.Nexus.Models.Common.SystemSchoolStatus SyStatus

Task Results Cmc.Nexus.Models.Crm.TaskResult CmEventResult

Task Statuses Cmc.Nexus.Models.Crm.TaskStatus CmEventStatus

Task Templates Cmc.Nexus.Models.Crm.TaskTemplate CmTemplate

Task Types Cmc.Nexus.Models.Crm.TaskType CmEventType

Transaction Codes Cmc.Nexus.Models.StudentAccounts.BillingTransactionCode SaBillCode
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CMC Activities
Workflow Designer is built using the Windows Workflow Foundation (WF) in the .NET Framework. It contains
Microsoft's built-in (generic) workflow activities and activities created specifically for Anthology Inc. products
(CMC Activities).

The workflow activities designed for Anthology are grouped by namespaces. The activities include lookup func-
tions that return values that can in turn be used within other activities in the workflow, activities related to spe-
cific products such as CampusNexus CRM and Anthology Student, and common activities such as creating
validation messages or sending email. CMC activities are used in conjunction with Generic Activities.

Properties for activities are generally defined using expressions in VB .NET code or variables. Some fields have
drop-down lists and helpers that enable you to select properties.

Filter Option for Assemblies
Many workflow activities require the user to browse for and select a .NET type from the Anthology domain
model. To improve the performance of the "Browse for Types..." action, the list of assemblies from which a user
can select types is filtered down to just those that need to be used in Workflow Composer.

The "FilterUsableAssemblies" setting in the WorkflowComposer.exe.config file controls the filtering of assem-
blies. The default setting for the "FilterUsableAssemblies" value is True.

<setting name="FilterUsableAssemblies" serializeAs="String">
<value>True</value>
</setting>

If you need a namespace or type which is being filtered out, set the "FilterUsableAssemblies" value to False
and restart Workflow Composer.

Note: When the filter option is disabled, the performance of the "Browse for Types..." action will be noticeably
slower. To compensate for the performance loss, see Improve Search Performance on "Browse for Types...".
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Activities for CampusNexus CRM
The activities in the Cmc.NexusCrm.Common.Workflow namespace are available when the Activities and Con-
tracts (CRM) package is installed using the Package Manager.

Prerequisite for CampusNexus CRM Workflows

The generated CampusNexus CRM contracts need to be copied to Workflow Composer for building and cre-
ating workflows. As a best practice, when CampusNexus CRMmetadata is changed, the generated con-
tracts assembly file (Cmc.NexusCrm.Contracts.dll) must be copied from the \bin folder of the Web Client for
CampusNexus CRM to the installation path of Workflow Composer.

If an existing workflow includes a property that is not available in the current generated contracts, the admin-
istrator needs to manually edit the workflow and remove the property.
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Cmc.NexusCrm.Common.Workflow

Workflow activities specific to CampusNexus CRM are grouped under the Cmc.NexusCrm.Common.Workflow
namespace. The activities include get functions that enable you to retrieve attachments and related entities,
and a lookup function that returns contact ID values that are consumed in Forms Builder.
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GetAttachment<>

The GetRelatedEntity<> activity must be included in the workflow before the GetAttachment<> activity, and
the GetEntity<> activity must precede the GetRelatedEntity<> activity. Attachments in the tab retrieved from
the GetRelatedEntity<> activity are retrieved in the GetAttachment<> activity.

The GetAttachment<> activity retrieves attachments from the Id of the tab that is retrieved in the
GetRelatedEntity<> activity.

When you select the 'Browse for Type' option, the list of assemblies and associated entities is displayed. Find
and select the entity and click OK.

After you have selected an entity, the name of the entity is inserted in the DisplayName field, e.g., GetAt-
tachment <Attachment>. Proceed to specify the entity to be retrieved.

Scenario

To retrieve the attachment in an encrypted format, you are required to create a sequence of three activities:
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l GetEntity<> — this activity retrieves the instance of the object record.

l GetRelatedEntity<> — this activity retrieves the ID of the tab from which you want to retrieve the attach-
ment.

l GetAttachment<> — the ID of the tab serves as an input parameter. This activity then retrieves the attach-
ment in an encrypted form.

Properties

Property Value Required Notes

DisplayName String No Specify a name for the activity or accept the
default.

Entity InOutArgument<Entity> Yes Specify the entity identifier using a
VB expression or variable.

GetAttachment<> Properties
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GetRelatedEntity<>

The GetEntity<> activity must precede the GetRelatedEntity<> activity.

The GetRelatedEntity<> activity retrieves logical identifiers of records in the specified recordlist tab of the object
record that was retrieved in the GetEntity<> activity.

For an object, the GetRelatedEntity<> activity retrieves the following details:

From a RecordList tab:

1. Instance Id of the Object
2. Row Id of the RecordList Property Value
3. RecordList Property Values

From a tab of a Many-To-Many relationship without relationship properties:

1. BaseObject Instance Id
2. Related Object Instance Id

From a tab of a Many-To-Many relationship with relationship properties:

1. BaseObject Instance Id
2. Related Object Instance Id
3. Associated relationship property value

When you select the 'Browse for Type' option, the list of assemblies and associated entities is displayed. Find
and select the entity and click OK.
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After you have selected an entity, the name of the entity is inserted in the DisplayName field, e.g.,
GetRelatedEntity <Contact>. Proceed to specify the entity to be retrieved, and the related entity name details.
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Properties

Property Value Required Notes

DisplayName String No Specify a name for the activity or accept
the default.

Entity InOutArgument<Entity> Yes Specify the entity identifier using a
VB expression or variable.

RelatedEntityName String Yes Specify the logical identifier of the related
entity that can be retrieved.

GetRelatedEntity<> Properties
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LookUpContact<>

The LookUpContact<> activity retrieves the Id of contact records based on the value specified in the UserName
parameter. This activity can be used in workflows that are specific to Forms Builder. Ensure that you do not use
this activity in other workflows.

The retrieved ID serves as an input parameter in activities such as GetEntity<> or SaveEntity<>.

Properties

Property Value Required Notes

ContactId InOutArgument<Int32> Yes Specify the Id of the Contact that will be retrieved
in the activity using a VB expression or variable.

DisplayName String No Specify a name for the activity or accept the
default.

UserName InArgument<String> Yes Specify the registered user name of the student
using a VB expression or variable.

LookUpContact<> Properties
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Sample CRMWorkflows
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Add a Lead

Matt Grammer is applying to the Engineering Department of Northside School of Engineering to pursue an
undergraduate program in electrical engineering. When Matt submits his details on the website, a lead record is
automatically created. Additionally, the associated contact record will be implicitly created by CampusNexus
CRM.

1. Launch Workflow Composer.

2. Click New Event Workflow.

3. In the Name field, type a name for the workflow, e.g., CreateLead.

4. In the Entities area:

a. Click next to Cmc.NexusCrm.Common.Entities

b. Select Void (VoidEntity). Select the entity which will trigger this workflow.

5. In the Events area, click Saving (SavingEvent). Ensure that you select the appropriate event for the entity
selected in the previous step.

6. Click OK. The sequence is created in the Designer pane.

Create an Entity

7. In the Toolbox, under Cmc.Core.Workflow.Activities.EntityModel, select the CreateEntity<> activity and
drop it into the sequence. The Select Types window is displayed.

8. In the TEntity drop-down list, select Browse for Types. The Browse and Select a .Net Type window is dis-
played.

9. Select Lead and click OK twice. The Lead object is added to the CreateEntity<> activity in the sequence.

10. In the Variables pane, create a variable to hold the Lead instance object called leadinstance. In the Vari-
able type field, select Browse for type and select Cmc.NexusCrm.Common.Entities.Lead.

11. In the Result field of the Properties pane, specify the name of the variable created above, e.g., lead-
instance.

Assign Values to the Lead’s Properties

12. From the Toolbox, drop an Assign activity into the sequence.

a. In the To field, type the name of the variable created earlier (leadinstance) and append the lead’s
Name property to the variable.

b. Type the name of the lead as “Matt Grammer”.

13. To assign values to the lead’s email address, gender, campus, and team properties, perform the Assign
operation as described in the previous step. Type the following values for each property:
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To Value

leadinstance.Email “Mattg@mail.com”

leadinstance.Gender 1

leadinstance.Campus 1

leadinstance.Team 3

Associate a Related Entity to the Created Entity

14. Prior to associating the lead with an ethnic group record, create a variable for the ethnic group to be asso-
ciated with the lead, e.g., ethnicGroup, and select Com.NexusCrm.Common.Entities.Link under Vari-
able type.

15. In the Default column, type the value New Link(). The variable is created.

16. Perform the Assign operation again and add the following details:

To Value

ethnicGroup.Id 5

This step adds the Id of the ethnic group that will be associated with the lead.

17. Perform the Assign operation to initialize the ethnic group collection in the lead instance. Type the fol-
lowing details:

To Value

leadInstance.EthnicGroup New EntityCollection(Of Link)

18. To add the ethnic group created in step 17 to the ethnic group collection, drop the AddToCollection<>
activity into the Designer pane.

19. Type or select the following details in the Properties tab:

Property Value

Collection leadInstance.EthnicGroups

Item ethnicGroup

TypeArgument Cmc.NexusCrm.Common.entities.Link

20. From Cmc.Core.workflow.Activities.EntityModel in the Toolbox, drag the SaveEntity<> activity to the
Designer pane. The Select Types dialog is displayed.

21. In the TEntity dropdown list, select Cmc.Nexus.Crm.Common.Entities.Lead and click OK.

22. In the Properties area, type the following values:
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l DisplayName – type an appropriate display name.
l Entity – select leadInstance.
l ValidationMessages – this field is optional.

23. Click Publish. The New Workflow Definition Version window is displayed.

24. If you want the workflow to be run as soon as the event occurs on the entity, select Enable This Work-
flow Version, otherwise leave the check box cleared.

25. Click Save, then Cancel to close the publisher window.
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Add Attachments to a Contact Record

To complete his admission formalities, Matt Grammer, a lead at Northside School of Engineering, attaches cop-
ies of recommendation letters and previous education grades in his email to the university. When Matt sends
these details, the attachments are automatically added to the Attachments tab of Matt’s contact record.

1. Launch Workflow Composer.

2. Click New Event Workflow.

3. In the Name field, type a name for the workflow (e.g., AddingAttachment)

4. In the Entities area:

a. Click next to Cmc.Core.Eventing.

b. Select Void (VoidEntity). Select the appropriate entity for which the workflow must be triggered.

5. In the Events area, click Saving (SavingEvent). In this step, ensure that you select the appropriate event
for the entity selected in the previous step.

6. Click OK. The sequence is created in the Designer pane.

Retrieve the Contact Entity and its Associated Previous Education Records

7. In the Variables pane, create a variable for the contact object, e.g., contact, and select Cmc.Nex-
usCrm.Common.Entities.Contact in the Variable type column

8. In the Toolbox, under Cmc.Core.Workflow.Activities.EntityModel, select the GetEntity<> activity and drop
it into the Designer pane. The Select Types dialog box is displayed.

a. In the TEntity drop-down list, select Browse for Types. The Browse and Select a .Net Type window
is displayed.

b. In the Type Name field, type Contact. The Contact object is selected under Cmc.Nex-
usCrm.Common.Entities.

c. Click OK twice. The Contact object is added to the GetEntity<> activity in the sequence.

d. In the Toolbox, specify the entity identifier in the EntityId field.

e. In the Result field, type the name of the variable created previously (contact). This entity will be
retrieved in this workflow activity.

9. In the Toolbox, under Cmc.NexusCrm.Common.Workflow, select the GetRelatedEntity<> activity and
drop it into the Designer pane. The Select Types dialog box is displayed.

a. In the TEntity drop-down list, select Cmc.NexusCrm.Common.Entities.Contact and click OK.

b. In the Toolbox, select the parent entity in the ParentEntity field, e.g., contact.
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c. In the Type Name field, type Contact. The Contact object is selected under Cmc.Nex-
usCrm.Common.Entities.

d. In the RelatedEntityName field, type the name of the related tab that needs to be fetched, e.g.,
ContactPreviousEducations.

Create a New Previous Education Record

10. In the Variables pane, create a variable for the lead, e.g., previousEducation, and select Cmc.Nex-
usCrm.Common.Entities.ContactPreviousEducation.

11. In the Toolbox, under Cmc.Core.Workflow.Activities.EntityModel, select the CreateEntity<> activity and
drop it into the sequence. The Select Types window is displayed.

a. In the TEntity drop-down list, select Browse for Types. The Browse and Select a .Net Type window
is displayed.

b. Select ContactPreviousEducation and click OK twice. The Lead object is added to the
CreateEntity<> activity in the sequence.

c. In the Result field of the Properties pane, specify the name of the variable created above, e.g., pre-
viousEducation.

Assign Relationship Property Values to the Previous Education Record

12. From the Toolbox, drop an Assign activity for each row in the following table and type the indicated val-
ues:

To Value

previousEducation.ContactPreviousEducationId 1

previousEducation.Gpa 4

In this step, the details of the new previous education record are set. The contact will be associated with
the account instance assigned to previouEducation.ContactPreviousEducationId.

13. To add the previous education record to the previous education collection, drop the AddToCollection<>
activity into the Designer pane.

14. Type or select the following details in the Properties tab:

l Collection — AddToCollection<ContactPreviousEducation>
l Item — previousEducation
l TypeArgument — Cmc.NexusCrm.Common.entities.ContactPreviousEducation

Retrieve Attachments of the Contact Record

15. In the Toolbox, under Cmc.NexusCrm.Common.Workflow, select the GetRelatedEntity<> activity and
drop it into the Designer pane. The Select Types dialog box is displayed.
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a. In the TEntity drop-down list, select Browse for Types. The Browse and Select a .Net Type window
is displayed.

b. In the Type Name field, type Contact. The Contact item is selected in Cmc.Nex-
usCrm.Common.Entities.

c. Click OK twice.

d. In the Toolbox, select the parent entity in the ParentEntity field, e.g., contact.

e. In the Type Name field, type Contact. The Contact object is selected under Cmc.Nex-
usCrm.Common.Entities.

f. In the RelatedEntityName field, type the name of the related tab that needs to be fetched, e.g.,
“Attachments”.

Set Attachment File Name and File Content

16. In the Variables pane, create a variable called marksAttachment. In the Variable type column, select
Cmc.NexusCrm.Common.Entities.Attachment.

17. In the Default column, type new Attachment().

18. From the Toolbox, drop an Assign activity for each row in the following table and type the indicated val-
ues:

To Value

marksAttachment.FileName “School Marks.doc”

marksAttachment.FileBlob System.IO.File.ReadAllBytes(“<path of the School Marks.doc file>”)

Add the Attachment to the Retrieved Contact Record

19. To add the School Marks.doc file to the Attachment tab, drop the AddToCollection<> activity into the
Designer pane.

20. Type or select the following details in the Properties tab:

l Collection — contact.Attachments
l DisplayName — AddToCollection<Attachment>
l Item —marksAttachment
l TypeArgument — Cmc.NexusCrm.Common.Entities.Attachment

21. From Cmc.Core.Workflow.Activities.EntityModel in the Toolbox, drag the SaveEntity<> activity to the
Designer pane. The Select Types dialog is displayed.

22. In the TEntity drop-down list, select Cmc.Nexus.Crm.Common.Entities.Contact and click OK.

23. In the Properties area, type the following values:
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l DisplayName — type an appropriate display name.
l Entity — type contact.
l ValidationMessages — this field is optional.

24. Click Publish. The New Workflow Definition Version window is displayed.

25. If you want the workflow to be run as soon as the event occurs on the entity, select Enable This Work-
flow Version, otherwise leave the check box cleared.

26. Click Save, then Cancel to close the publisher window.
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Register Participants

This sample workflow demonstrates how to register participant(s) using a workflow. This sample demonstrates
how to register a lead record as a participant.

Prerequisite

Event support should be enabled for the Entity from Business Administrator. For information about enabling
Event support, see CampusNexus CRM Business Administrator Help.

Business Flow

1. A participant record is created when an instance of the object for which Event support is enabled is
added to an event.

2. When a participant is registered for an event through workflow:

l For a paid event (Event.EventType=”Paid”), the participant status is marked as Pending until the
participant pays for the event.

The participant is blocked to attend the event for a limited duration (configurable through the
Talisma-ClearBlockedParticipant 7EE38D20-D097-11d2-BE17-00C04FCCE602 <database name> job.
If the money is not paid within the duration, the participant’s status will be set to Payment failed,
and the participant will be cleared from the blocked state.

l The user must explicitly call the UpdateEntity<> of the Participant Object to update the status for
the added participants.

l For a free event, the participant status is set implicitly to Registered.

3. The Available Seats Calculation is based on Event.ParticipantLimit – Number of participants blocked for
the event.

Notes:

l The Allow registration for the series property is not applicable in workflows. During event registration,
participants will be added only to the main event and not to any sub-events.

l For object instances other than instances of the Contact object, during event registration the Primary Par-
ticipant entity (Lead or custom object) must be associated with a contact. Event registration will fail if the
association is not created.

Register Lead Entities in an Event

1. In the Variables pane, create a variable for the Lead Service, e.g., Leadsvc.

In the Variable type column, select Cmc.NexusCrm.Common.Services.ILeadService.

2. In the Toolbox, under Cmc.Core.Workflow.Activities, select the GetServiceInstance<> activity and drop it
into the Designer pane. The Select Types dialog box is displayed.
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a. In the TService drop-down list, select Browse for Types. The Browse and Select a .Net Type win-
dow is displayed.

b. In the Type Name field, type ILeadService. The ILeadService is selected under Cmc.Nex-
usCrm.Common.Services.

c. Click OK twice. The ILeadService is added to the GetServiceInstance<> activity in the sequence.

d. In the Result field, type the name of the variable created previously (Leadsvc). This service will be
retrieved in this workflow activity.

3. In the Variables pane, create a variable (e.g., request).

In the Variable type column:

a. Select Browse for Types. The Browse and Select a .Net Type window is displayed.

b. In the Type Name field, type RegisterParticipantRequest<T> under Cmc.Nex-
usCrm.Core.Contracts.Services.Common and select Cmc.NexusCrm.Common.Entities.Lead from
the T drop-down.

c. In the Default column, specify new RegisterParticipantRequest(of Lead).

4. In the Toolbox, under Primitives, select the Assign activity and drop it into the current workflow
sequence.

a. In the To field, specify request.EventID.

b. In the Value field, specify <Id of the Event>.

Add a Primary Participant to the Event

The primary participant (lead) can be passed from a form or retrieved through a workflow. If it’s passed from a
form, pass the argument name lead as the primary participant parameter to the above method. If it has to be
retrieved from the system, based on business requirements, use the GetEntity<> activity to retrieve the lead.

1. In the Toolbox, under Primitives, select the Assign activity and drop it into the workflow sequence.

a. In the To field, specify request.PrimaryParticipant.

b. In the Value field, specify lead (Either the variable/argument as appropriate).

Add a Secondary Participant to the Event

In this example, to set the secondary participant to the request, data will be retrieved from the system using the
GetEntity<> activity. However, data can also be retrieved from a form.

1. In the Variables pane, create another variable for the Lead object, e.g., LeadSecondary.

In the Variable type column, select Cmc.NexusCrm.Common.Entities.Lead.
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2. In the Toolbox, under Cmc.Core.Workflow.Activities.EntityModel, select the GetEntity<> activity and drop
it into the Designer pane. The Select Types dialog box is displayed:

a. In the TService drop-down list, select Browse for Types. The Browse and Select a .Net Type win-
dow is displayed.

b. In the Type Name field, type Lead. The Lead object is selected under Cmc.Nex-
usCrm.Common.Entities.

c. Click OK twice. The Contact object is added to the GetEntity<> activity in the sequence.

d. In the EntityId field, specify another Lead Id (the lead you want to register in the event).

e. In the Result field, type the name of the second variable (LeadSecondary). This entity will be
retrieved in this workflow activity.

3. In the Variables pane, create a variable for a collection of the lead entity, e.g., LeadCollection.

In the Variable type column:

a. Select Browse for Types. The Browse and Select a .Net Type window is displayed.

b. In the Type Name field, type Collection<T> under System.Collections.ObjectModel and select
Cmc.NexusCrm.Common.Entities.Lead from the T drop-down.

c. In the Default column, specify new RegisterParticipantRequest(of Lead).

4. In the Toolbox, under Collection, select the AddToCollection<> activity and drop it into the workflow
sequence.

In the right pane:

a. In the Collection field, specify LeadCollection.

b. In the Item field, specify LeadSecondary.

c. In the TypeArgument field, specify Cmc.NexusCrm.Common.Entities.Lead.

Note: Repeat steps 2 and 4 of the previous procedure for each Lead instance you want to register in the
event as part of group registration.

5. In the Toolbox, under Primitives, select the Assign activity and drop it into the workflow sequence.

a. In the To field, specify request.SecondaryParticipants.

b. In the Value field, specify LeadCollection.
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6. In the Variables pane, create a variable e.g., response.

In the Variable Type column:

a. Select Browse for Types. The Browse and Select a .Net Type window is displayed.

b. In the Type Name field, type RegisterParticipantResponse under Cmc.Nex-
usCrm.Core.Contracts.Services.Common.

7. In the Toolbox, under Primitives, select the Assign activity and drop it into the workflow sequence.

a. In the To field, specify response.

b. In the Value field, specify reqLeadSvc.RegisterParticipantsForEvent(request).
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Check for Duplicate Records

You can create a workflow to filter the creation of duplicate records for entities that are available in OData. This
functionality can be achieved through the ExecuteODataQuery<> activity.

Business Scenario

An institution wants to prevent the creation of new leads as lead records are already available in the database.
The filter criteria to check for a duplicate lead can be:

l Firstname and lastname and email and mobile
— OR —

l Firstname and lastname and email
— OR —

l Firstname and lastname and mobile
— OR —

l Email and mobile
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Create a Workflow With the Above Logic
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1. Declare the following variables in the order in which they are specified and include their indicated values:

Variable Type Scope Value

baseODataUrl String Sequence https://<Forms Builder Renderer URL>/ap-
i/ApiProxy/CRM/

dupCheckEntity String Sequence "Leads?"

Note: For a different object, replace this string with the
name of the object as it appears in OData.

oDataSelectClause String Sequence "$select=LeadId"

Note: For a different object, replace this value with the
identifier of the object.

firstCondition

(First condition in the
business scenario)

String Sequence "FirstName eq '" & lead.FirstName & "' and LastName
eq '" & lead.LastName & "' and Email eq '" & lead.E-
mail & "' and Mobile eq '"& lead.Mobile & "' "

secondCondition

(Second condition in the
business scenario)

String Sequence "FirstName eq '" & lead.FirstName & "' and LastName
eq '" & lead.LastName & "' and Email eq '" & lead.E-
mail & "' "

thirdCondition

(Third condition in the
business scenario)

String Sequence "FirstName eq '" & lead.FirstName & "' and LastName
eq '" & lead.LastName & "' and Mobile eq '" &
lead.Mobile & "' "

fourthCondition

(Fourth condition in the
business scenario)

String Sequence "Email eq '" & lead.Email & "' and Mobile eq '" &
lead.Mobile & "' "

oDataFilterClause

(Collates all the filter con-
ditions)

String Sequence "$filter=(" & firstCondition & " or " & secondCondition &
" or " & thirdCondition & " or " & fourthCondition & ")"

oDataOrderbyClause

(Will list the most
recently created duplic-
ate lead record)

String Sequence "$orderby=CreatedOn desc"

segmentTerminator String Sequence "&"

oDataQuery

(Finally constructed
OData query)

String Sequence baseODataUrl & dupCheckEntity &
oDataSelectClause & segmentTerminator & oDataFil-
terClause & segmentTerminator &
oDataOrderbyClause

Note: Highlighted elements must be replaced appropriately if the base object is not Lead.

2. Add the CreateEntity<Lead> activity in the Entry section.
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3. Declare a Boolean variable (for example, Duplead) and set its default value to False.

4. In the Transition(s) section, click Next and add the ExecuteODataQuery<Lead> activity.

5. In the OData Query field, type oDataQuery.

6. Add a Sequence to the ExecuteODataQuery<Lead> activity which includes logic to identify if a duplicate
lead is found.

For example:

7. Include an If condition with the following logic:

l If the value of the Duplead flag is unchanged, a new Lead record will be created.

l If a duplicate lead is found, the value of the Duplead flag will be changed to True and the included
validation message “Lead already exists” will be displayed.

For example:
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Activities for Anthology Student
The activities in this section are designed for use with Anthology Student.
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Cmc.Nexus.Academics.Workflow
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ConvertApplicantToEnrollment (V2)

The ConvertApplicantToEnrollment activity enables you to promote an Applicant record to an Enrollment and
invoke the enrollment business logic.

If you use the ConvertApplicantToEnrollment (V2) activity with Anthology Student Activities and Contracts (V1)
(instead of V2), the EnrollmentWebServiceUrl key needs to be set.

To verify this in the Desktop client, navigate to Setup > System > File Server & Services, click Configure Web Ser-
vice Locations, and select the Other tab.

Use Case

When an online application is submitted through Forms Builder, an Applicant record is created that leverages
the student statuses associated with the configured Applicant Category statuses. Once the student is approved
for enrollment, typically the Anthology Student user would use the Enrollment Wizard and populate the enroll-
ment with the existing information. Instead of having a user go through the Enrollment Wizard, a workflow can
detect an approval from a Contact Manager activity, Document Status event, or Group Membership event and
then, using the ConvertApplicantToEnrollment activity promote the applicant record to a full enrollment.



Workflow Version 4.0.1 145 Help Guide



Workflow Version 4.0.1 146 Help Guide



Workflow Version 4.0.1 147 Help Guide

Properties

Property Value Required Notes

AcademicAdvisorId InAr-
gument<Nullable><Int32>>

No* Specify the Academic Advisor Id
using a VB expression or variable.
* Note: The Academic Advisor Id is
required or optional depending on a
setting in Anthology Student:

l The Academic Advisor Id is
optional when 'Advisor
Selection' is cleared under
Setup > Academic Records
> Enrollment.

l The Academic Advisor Id is
required when 'Advisor
Selection' is selected under
Setup > Academic Records
> Enrollment.

Applic-
ationReceivedDate

InArgument<DateTime> Yes Specify the date when the stu-
dent’s application was received
using a VB expression or variable.

BillingMethodId InArgument<Int32> Yes Specify the database identifier for
the Billing Method using a
VB expression or variable.

CampusId InArgument<Int32> Yes Specify the database identifier for
the Campus in which the student is
enrolled using a VB expression or
variable.

CatalogYearId InArgument<Nullable><Int32> No Specify the catalog year identifier
using a VB expression or variable.

Note: This property is available
only in the V2 version of the activ-
ity, i.e., in the Cmc.Nex-
us.Academics.Workflow
namespace.

DisplayName String No Specify a name for the activity or
accept the default.

EnrollDate InArgument<DateTime> Yes Specify date when the student is
enrolled into the Program using a
VB expression or variable.

ConvertApplicantToEnrollment Properties
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Property Value Required Notes

EnrollId InArgument<Int32> Yes Specify the Student Enrollment
Period Id using a VB expression or
variable.

ExpectedStartDate InArgument<DateTime> Yes Specify the date that the student is
expected to start using a
VB expression or variable.

GradeLevelId InArgument<Int32> Yes Specify the database identifier for
Grade Level for this enrollment
using a VB expression or variable.

GraduationDate InArgument<DateTime> No Specify the Graduation Date using
a VB expression or variable.

MidpointDate InArgument<DateTime> No Specify the Midpoint Date using a
VB expression or variable.

ProgramVersionId InArgument<Int32> Yes Specify the database identifier for
Program Version for this enroll-
ment using a VB expression or vari-
able.

ShiftId InArgument<Int32> Yes Specify the database identifier for
the Shift from the AdShift table
(Day, Night, etc.) using a
VB expression or variable.
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Property Value Required Notes

StartDateId InAr-
gument<Nullable><Int32>>

No* Specify the database identifier for
the Start Date using a
VB expression or variable.
* Note: The Start Date Id is required
or optional depending on settings in
Anthology Student:

Required:

o If ''Require Start Date' is
selected under Setup > Aca-
demic Records > Settings.

o If Mid-
pointDate/GraduationDate
are not specified.

Optional:

o If 'Require Start Date' is set
to 'Not Required' under
Setup > Academic Records
> Settings.

o If Mid-
pointDate/GraduationDate
are specified.

StartTermId InArgument<Nullable><Int32> No Specify the start term year iden-
tifier using a VB expression or vari-
able.

Note: This property is available
only in the V2 version of the activ-
ity, i.e., in the Cmc.Nex-
us.Academics.Workflow
namespace.

StudentId InArgument<Int32> Yes Specify a Student Id using a
VB expression or variable.

StudentStatusId InArgument<Int32> Yes Specify the Student Status Id using
a VB expression or variable.

ValidationMessages InOutArgument
<Val-
idationMessageCollection>

No Specify a variable that can be used
to capture validation messages.
For more information, see Capture
Validation Errors.
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CreateStudentCourse (V2)

The CreateStudentCourse activity enables you to create a Student Course so that the student can be registered
in that course.

This activity creates an instance of a Student Course; it does not save it to the database. The workflow can
include other activities that manipulate the Student Course before it is saved. To persist the Student Course in
the database, insert a SaveStudentCourse (V2) activity.

Properties

Property Value Required Notes

ClassSectionId InArgument<Int32> Yes Specify the Class Section Id
using a VB expression or vari-
able.

DisplayName String No Specify a name for the activity or
accept the default.

CreateStudentCourse Properties
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Property Value Required Notes

StudentCourse OutArgument
<StudentCourseEntity>

Yes The Student Course created by
this workflow activity. This is a
variable that can be used as
input for subsequent activities in
the workflow. Specify the vari-
able's name, type, and scope
(and default if applicable) in the
Variables pane of the Designer
window.

To identify the variable type, in
the Variable type field of the Vari-
ables pane, select Browse for
Types.... In the 'Browse and
Select a .NET Type' window, nav-
igate to Cmc.Nex-
us.Academics.Contracts
> Cmc.Nexus.Academics.Entiti-
es, select StudentCourseEntity,
and click OK.

See StudentCourseEntity Class
in the Anthology Student Object
Library.

Stu-
dentEnrollmentPeriodId

InArgument<Int32> Yes Specify the Student Enrollment
Period Id using a VB expression
or variable.

StudentId InArgument<Int32> Yes Specify the Student Id using a
VB expression or variable.

ValidationMessages OutArgument
<Val-
idationMessageCollection>

No Specify a variable that can be
used to capture validation mes-
sages. For more information, see
Capture Validation Errors.
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LookupClassSections (V2)

The LookupClassSections activity is a lookup function that finds the Course Id for a class section based on a spe-
cified Course Name and Term Id. The activity includes a Search tool that returns Course Names and Course
Codes. When you select a Course in the Search tool, the selected item is inserted into the Course Name field of
the LookupClassSections activity and the Search tool is closed. You can use this lookup function during a course
registration activity.

Use Case

A workflow detects when a student's status changes from any status to an enrolled status and automatically
registers the student into an introductory course (Intro101). The LookupClassSections activity is used in the
workflow to determine the Course Id (that is, the ClassSectionId of the StudentCourse) for the Intro101 course
in the applicable term.
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Properties

Property Value Required Notes

Class Section List OutArgument
<ClassSectionEntity[]>

Yes The LookupClassSections activity
returns an array of class sections
associated with a course. Specify a
course name in the Course Name
field or click the Search button to
find a course and select it.

This is a variable that can be used
as input for subsequent activities in
the workflow. Specify the variable's
name, type, and scope (and default
if applicable) in the Variables pane
of the Designer window.

To identify the variable type, in the
Variable type field of the Variables
pane, select Array of [T]. In the
'Select Types' window, select
Browse for Types, and click OK. In
the 'Browse and Select a
.NET Type' window, navigate to
Cmc.Nexus.Academics.Contracts
> Cmc.Nexus.Academics.Entities
, select ClassSectionEntity, and
click OK.

See ClassSectionEntity Class in
the Anthology Student Object
Library.

Course Id InArgument<Int32> Yes The Course Id is a variable cap-
tured from an event.

DisplayName String No Specify a name for the activity or
accept the default.

Term Id InArgument<Int32> No The Term Id is a variable captured
from an event.

The Terms property is a collection.
See ClassSectionEntity.Terms
Property in the Anthology Student
Object Library.

LookupClassSections Properties
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Property Value Required Notes

ValidationMessages OutArgument
<Val-
idationMessageCollection>

No Specify a variable that can be used
to capture validation messages.
For more information, see Capture
Validation Errors.
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LookupCurrentEnrollmentPeriod (V2)

The LookupCurrentEnrollmentPeriod activity is a function that captures the Student Id from an event and
returns the current enrollment period for the student. Use this lookup function when you need to know the cur-
rent enrollment period in a workflow that has preceding activities containing the Student Id.

Properties

Property Value Required Notes

DisplayName String No Specify a name for the activity or
accept the default.

LookupCurrentEnrollmentPeriod Properties
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Property Value Required Notes

Student Enrollment
Period

OutArgument
<Stu-
dentEnrollmentPeriodEntity>

Yes The current enrollment period
returned by the lookup function.
This is a variable that can be used
as input for subsequent activities
in the workflow. Specify the vari-
able's name, type, and scope (and
default if applicable) in the Vari-
ables pane of the Designer win-
dow.

To identify the variable type, in the
Variable type field of the Variables
pane, select Browse for Types....
In the 'Browse and Select a
.NET Type' window, navigate to
Cmc.Nex-
us.Academics.Contracts
> Cmc.Nexus.Academics.Entitie-
s, select Stu-
dentEnrollmentPeriodEntity and
click OK.

See Stu-
dentEnrollmentPeriodEntity Class
in the Anthology Student Object
Library.

Student Id InArgument<Int32> Yes The Student Type Id captured
from an event.

ValidationMessages OutArgument
<ValidationMessageCollection>

No Specify a variable that can be
used to capture validation mes-
sages. For more information, see
Capture Validation Errors.
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LookupEnrollmentPeriods (V2)

The LookupEnrollmentPeriods activity is a function that captures the Student Id from an event and returns a list
of all enrollment periods. Use this lookup function when you need to know the enrollment periods in a work-
flow that has preceding activities containing the Student Id.

Properties

Property Value Required Notes

DisplayName String No Specify a name for the activity or
accept the default.

LookupEnrollmentPeriods Properties
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Property Value Required Notes

Student Enrollment
Period

OutArgument
<Stu-
dentEnrollmentPeriodEntity[]>

Yes A list of all enrollment periods
returned by the lookup function.
This is a variable that can be used
as input for subsequent activities in
the workflow. Specify the vari-
able's name, type, and scope (and
default if applicable) in the Vari-
ables pane of the Designer win-
dow.

To identify the variable type, in the
Variable type field of the Variables
pane, select Array of [T]. In the
'Select Types' window, select
Browse for Types, and click OK.
In the 'Browse and Select a
.NET Type' window, navigate to
Cmc.Nex-
us.Academics.Contracts
> Cmc.Nexus.Academics.Entities
, select Stu-
dentEnrollmentPeriodEntity, and
click OK.

See Stu-
dentEnrollmentPeriodEntity Class
in the Anthology Student Object
Library.

Student Id InArgument<Int32> Yes The Student Id captured from an
event.

ValidationMessages OutArgument
<ValidationMessageCollection>

No Specify a variable that can be used
to capture validation messages.
For more information, see Capture
Validation Errors.
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LookupProgramVersion

The LookupProgramVersion activity is a function that captures the Program Version Id, Campus Id, Program Id,
and Start Date Id from an event and returns the Program Version. The lookup can be applied to Degree Pro-
grams or Non Degree Programs.

You can use this lookup function to retrieve a specific program version record when a new enrollment is saved
from the workflow.

Properties

Property Value Required Notes

CampusId InArgument<Int32> No Select a value in the drop-down list
of the activity in the Designer win-
dow.

DisplayName String No Specify a name for the activity or
accept the default.

LookupProgramVersion Properties
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Property Value Required Notes

IsDegreeProgram InArgument<Boolean> Yes A Boolean expression that specifies
whether the Program Version is
associated with a Degree Program.
The default value is false, that is,
Non Degree Program.

Program Version OutArgument<ReferenceItem> Yes The Program Version returned by
the lookup function. This is a vari-
able that can be used as input for
subsequent activities in the work-
flow. Specify the variable's name,
type, and scope (and default if applic-
able) in the Variables pane of the
Designer window.

To identify the variable type, in the
Variable type field of the Variables
pane, select Browse for Types.... In
the 'Browse and Select a .NET Type'
window, navigate to Cmc.Nex-
us.Common.Contracts
> Cmc.Nexus.Common.Services,
select ReferenceItem, and click OK.

Program Version Id InArgument<Int32> Yes This Id is populated by the activity
based on your selections in the Cam-
pus Id, Program, Program Version,
and Start Date fields.

ProgramId InArgument<Int32> No This Id is populated by the activity
based on your selections in the Cam-
pus Id, Program, Program Version,
and Start Date fields.
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Property Value Required Notes

Start Date OutArgument<ReferenceItem> No The Start Date returned by the
lookup function. This is a variable
that can be used as input for sub-
sequent activities in the workflow.
Specify the variable's name, type,
and scope (and default if applicable)
in the Variables pane of the
Designer window.

To identify the variable type, in the
Variable type field of the Variables
pane, select Browse for Types.... In
the 'Browse and Select a .NET Type'
window, navigate to Cmc.Nex-
us.Common.Contracts
> Cmc.Nexus.Common.Services,
and select ReferenceItem.

StartDateId InArgument<Int32> No This Id is populated by the activity
based on your selections in the Cam-
pus Id, Program, Program Version,
and Start Date fields.
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LookupTerms (V2)

The LookupTerms activity is a function that captures the Campus Id from an event and returns the Terms for a
specified time period.

Use Cases

You could use this activity in a workflow on a Saving event since the Expected Start Date is entered on the Stu-
dent Master form. The workflow could check whether a valid term start date is entered and provide a validation
message.

Another way to use LookupTerms is to create a workflow with a ForEach loop that lists Term start dates within a
certain time period of Expected Start Date. The list of Term start dates could be displayed in an Information mes-
sage.

Properties

Property Value Required Notes

Campus Id InArgument<Int32> No Select a value in the drop-down list
of the activity in the Designer win-
dow.

LookupTerms Properties
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Property Value Required Notes

DisplayName String No Specify a name for the activity or
accept the default.

High Start Date InArgument<DateTime> Yes The High Start Date captured from
an event.

Note: You can capture a range of
dates by specifying different values
in the High Start Date and Low
Start Date fields. If you are not
checking for a range of dates, use
the same value in the High Start
Date and Low Start Date fields.

Low Start Date InArgument<DateTime> Yes The Low Start Date captured from
an event.

Terms List OutArgument<TermEntity[]> Yes The Term List returned by the
lookup function.

To identify the variable type, in the
Variable type field of the Variables
pane, select Array of [T]. In the
'Select Types' window, select
Browse for Types, and click OK. In
the 'Browse and Select a
.NET Type' window, navigate to
Cmc.Nexus.Academics.Contracts
> Cmc.Nexus.Academics.Entities
, select TermEntity, and click OK.

See TermEntity Class in the Antho-
logy Student Object Library.

ValidationMessages OutArgument
<Val-
idationMessageCollection>

No Specify a variable that can be used
to capture validation messages.
For more information, see Capture
Validation Errors.
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SaveStudentCourse (V2)

The SaveStudentCourse activity enables you to Register or Unregister a Student Course. You can also transfer
students who have been registered for a course from one class section to another class section using the Trans-
ferClassSection action in the SaveStudentCourse activity.

SaveStudentCourse is used after a CreateStudentCourse (V2) activity has created a Student Course instance.
SaveStudentCourse will persist a Student Course instance in the database.
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Properties

Property Value Required Notes

Action InArgument
<CourseAction>

Yes Select one of the following
options:

l Register
l Unregister
l TransferClassSection

When the action Trans-
ferClassSection is selected, the
StudentCourseId and Trans-
ferToClassSectionId are
required.

DisplayName String No Specify a name for the activity or
accept the default.

ParentTermId InArgument<Int32> No Use this value when a Par-
ent/Child relationship has been
defined for the terms at your insti-
tution and you want to register a
student into a Child term. The
ParentTermId value is the AdTer-
mId of the Parent term in Antho-
logy Student.

You can use LookupTerms (V2)
to pass the Id into the SaveStu-
dentCourse activity.

Note: This value is used only
with the Register Action when
registering a student into a child
term.

SaveStudentCourse Properties
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Property Value Required Notes

StudentCourse InArgument
<StudentCourseEntity>

Conditional The Student Course created by
this workflow activity. This is a
variable that can be used as
input for subsequent activities in
the workflow. Specify the vari-
able's name, type, and scope
(and default if applicable) in the
Variables pane of the Designer
window.

Note: This value is used only
with the Register and Unregister
Actions.

To identify the variable type, in
the Variable type field of the Vari-
ables pane, select Browse for
Types.... In the 'Browse and
Select a .NET Type' window, nav-
igate to Cmc.Nex-
us.Academics.Contracts
> Cmc.Nexus.Academics.Entiti-
es, select StudentCourseEntity,
and click OK.

See StudentCourseEntity Class
in the Anthology Student Object
Library.

StudentCourseId InArgument<Int32> Conditional The StudentCourseId is the Stu-
dentCourse.Id (which is AdEn-
rollSched.AdEnrollSchedID in
Anthology Student for the current
class).

This value is used only with the
TransferClassSection Action.

Trans-
ferToClassSectionId

InArgument<Int32> Conditional The TransferToClassSectionId is
the ClassSection.Id of the class
into which you want to transfer
students (mapped to
AdClassSched.AdClassSchedId
in Anthology Student).

Note: This value is used only
with the TransferClassSection
Action.
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Property Value Required Notes

ValidationMessages OutArgument
<Val-
idationMessageCollection>

No Specify a variable that can be
used to capture validation mes-
sages. For more information, see
Capture Validation Errors.
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Cmc.Nexus.Admissions.Workflow
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CreateApplicant

You can use the CreateApplicant activity to dynamically create Applicant records in Anthology Student based on
the data retrieved from an online form.

The CreateApplicant activity creates an instance of an Applicant record; it does not save the record to the data-
base. The workflow can include other activities that manipulate the record before it is saved. To persist the
Applicant record in the database, insert a SaveApplicant activity.
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The following variable definitions are used in the CreateApplicant example above.
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The variables are populated by using lookup activities preceding the CreateApplicant activity in the workflow.

Properties

Property Value Required Notes

ApplicantEntity OutArgument
<ApplicantEntity>

Yes The Applicant created by this
workflow activity. This is a vari-
able that can be used as input for
subsequent workflow activities.

To identify the variable type, in the
Variable type field of the Variables
pane, select Browse for Types....
In the 'Browse and Select a
.NET Type' window, navigate to
Cmc.Nex-
us.Admissions.Contracts
> Cmc.Nexus.Admissions.Entiti-
es, and select ApplicantEntity.

See ApplicantEntity Class in the
Anthology Student Object Library.

ApplicantTypeId InArgument<Int32> No Specify the Applicant Type Id
using a VB expression or variable.

Applic-
ationReceivedDate

InArgument<DateTime> No Specify the application received
date using a VB expression or vari-
able.

BillingMethodId InArgument<Int32> No Specify the Billing Method Id
using a VB expression or variable.

CampusId InArgument<Int32> Yes Select a value in the drop-down
list of the activity in the Designer
window.

DisplayName String No Specify a name for the activity or
accept the default.

ExpectedStartDate InArgument<DateTime> No Specify the expected start date
using a VB expression or variable

GradeLevelId InArgument<Int32> No Specify the database identifier for
the Grade Level using a
VB expression or variable.

CreateApplicant Properties
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Property Value Required Notes

ProgramVersionId InArgument<Int32> No Specify the Area of Study Id using
a VB expression or variable.

SchoolStatusId InArgument<Int32> Yes Specify the Student Status Id
using a VB expression or variable

ShiftId InArgument<DateTime> No Specify the identifier for the shift
using a VB expression or variable.

StartDateId InArgument<DateTime> No Specify the identifier for the stu-
dent's start date using a
VB expression or variable

StartTermId InArgument<DateTime> No Specify the identifier for the stu-
dent's start term using a
VB expression or variable.

StudentId InArgument<Int32> Yes Specify the Student Id using a
VB expression or variable.

ValidationMessages OutArgument
<Val-
idationMessageCollection>

No Specify a variable that can be
used to capture validation mes-
sages. For more information, see
Capture Validation Errors.
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CreatePortalAccount

The CreatePortalAccount activity automates the creation of AD and Portal accounts based on the triggering
event. For example, a Portal account can be created when a specific status change occurs or when a new applic-
ant/lead completes a form.

The supported authentication methods include STS, AD, and Azure AD.

The StudentEntity Saved Event is the preferred event to call the CreatePortalAccount activity especially for AD
and Azure AD authentication.

Use Case

An institution uses Anthology Student and implements a workflow with CreatePortalAccount activity to create a
Portal account when a New Lead is created. A common scenario is that the activity is triggered by a Stu-
dentEntity Saved Event (web client) or Person Saved Event (desktop client), however, the workflow could also be
triggered by a different event.

Properties

Property Value Required Notes

AddUserToActiveDirectory InArgument<Boolean> Yes if AD or
Azure AD is
used

A Boolean expression that specifies
whether the user needs to be added
to the Active Directory. The default
value is False.

Set this value to True if Active Dir-
ectory (AD) or Azure AD is used in
your Portal.

Prerequisite: If the Portal is
deployed in an AD environment, a
username and password for a "Stu-
dent Active Directory User" must be
configured in the Portal Admin Con-
sole . The CreatePortalAccount activ-
ity uses the "Student Active Directory
User" account as an impersonation
account to call the Create/Update
WebPortalAccountService APIs.

AdGuId InArgument<Guid> Yes if AD or
Azure AD is
used

Specify the globally unique identifier
(GUID) (stored in wpUser.GUID of
the Portal database) using a
VB expression or variable.

CreatePortalAccount Properties
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Property Value Required Notes

CampusId InArgument<Int32> Yes Specify the database identifier for the
student's Campus using a
VB expression or variable.

DisplayName String No Specify a name for the activity or
accept the default.

Email InArgument<String> No Specify the student's email address
using a VB expression or variable.

FirstName InArgument<String> No Specify the student's first name using
a VB expression or variable.

LastName InArgument<String> No Specify the student's last name using
a VB expression or variable.

NewId OutArgument<Int32> No Specify the new Id using a
VB expression or variable. This value
will be used if the activity is used to
update a Student Portal account.

Password InArgument<String> Yes Specify a value for the initial pass-
word using a VB expression or vari-
able.

Note: The initial password must com-
ply with the given password rules.
The CreatePortalAccount activity will
fail if the password is not strong
enough and doesn’t follow all rules,
especially in Azure AD envir-
onments. An uppercase letter, lower-
case letter, number, and symbol may
all have to be used. Even when the
strong password requirement dis-
abled in Anthology Student (least
restrictive), AzureAD may still block
risky passwords.

StudentId InArgument<Int32> Yes Specify a student identifier (i.e.,
syStudentId from the syStudent
table) using a VB expression or vari-
able.
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Property Value Required Notes

UserCode InArgument<String> Yes Specify a unique user code (stored in
wpUser.UserCode of the Portal data-
base) using a VB expression or vari-
able.

This will be the student's login Id for
the Student Portal.

Note: In Azure AD environments a
domain name may need to be spe-
cified, e.g.:
entity.FirstName + "." +
entity.LastName + "@<server>.cam-
pusnexus.cloud"

ValidationMessages InOutArgument
<ValidationMessage
Collection>

No Specify a variable that can be used
to capture validation messages. For
more information, see Capture Val-
idation Errors.

Example: Create Portal Account from a StudentEntity Saved Event in AD Environment

This is an example of Anthology Student eventing workflow for a StudentEntity Saved event in an AD envir-
onment. With a few minor changes to the example, a Person Saved Event can be used.

l If you are using the Web Client for Anthology Student, select the StudentEntity Saved Event when cre-
ating the workflow.

l If you are using the Desktop Client for Anthology Student, select the Person Saved Event when creating
the workflow.

The workflow runs when a new lead or new student is added. It creates a username as "first.last" with password
"nexus123$".

Note: If you want to create a Portal account based on a Forms Builder sequence being completed, you will need
to create the form sequence and supporting workflow that will perform the status change or create the New
Lead record. The status change or creation of a New Lead record will be the trigger for a separate workflow that
will then create the Portal and/or AD account. For example, if a New Lead Record is created via a Forms Builder
sequence, a separate workflow using the StudentEntity Saved Event would then trigger and create the Portal
and/or AD account.
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l The workflow is organized in a sequence named
"Create Portal Account based on Lead" that contains
a Flowchart.

l The Flowchart has a Start node, Decision node, and
sequences named:

o "Find Lead Status"
o "Create Portal Account"
o "End Workflow"

l "Find Lead Status" contains a LookupRefernceItem
activity that checks for the "New Lead" status.

l The Decision evaluates a condition statement to true/-
false:

To check for a new student, specify:

Entity.EntityState =
Cmc.Core.EntityModel.EntityState.Added
and Entity.SchoolStatusId = Lead.Id

l The "False" branch leads to the "End Workflow"
sequence with a TerminateWorkflow activity.

Create Portal Account Sequence

l The "True" branch leads to the "Create Portal
Account" sequence with the following activities:

l ExecuteDataReader

The ExecuteDataReader named "Find Campus"
finds the sycampusid. The Query CommandText in
the Query section is as follows:

"select sycampusid from systudent
where systudentid = " & entity.Id

The Assign activity in the Query section assigns the
sycampusid found in the database to the "campus"
variable.

DirectCast(CurrentRow("sycampusid"),
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Variables:

int32)

l Assign

The Assign activity below ExecuteDataReader
assigns the value "new System.Guid" to the
"guidPortal" variable.

l CreatePortalAccount

Note: In an Azure AD environment make sure that
the CreatePortalAccount activity in the "StudentEntity
Saved" workflow has a fully qualified name in the
UserCode property, e.g., first.last@<server>cus-
tomer.campusnexus.cloud,

Usage in AD and Azure AD Environments with Forms Builder

In addition to specific Properties for the CreatePortalAccount in AD and Azure AD environments, please note the
following requirements/limitations:

AD Environments with Forms Builder
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In AD environments, the CreatePortalAccount activity within a Forms Builder workflow (i.e., not as directed in
the separate StudentEntity Saved Event workflow) will function only if a 2nd Portal connection string is added to
the Renderer web.config file.

The original connection string in the Renderer web.config is:

<add name="PortalConnection" providerName="System.Data.SqlClient" con-
nectionString="Data Source=...

The added connection string for the CreatePortalAccount activity is:

<add name="dbConnectionPortal" providerName="System.Data.SqlClient" con-
nectionString="Data Source=...

Azure AD Environments

When you use Forms Builder to create a New Lead in Anthology Student and you want to create a Portal
account and/or AD account, you must create a separate workflow using the StudentEntity Saved Event.

a. Forms Builder will create the New Lead.

b. "StudentEntity Saved" workflow logic will trigger and create the accounts.

It is best practice, if you want to trigger the account creation based on status change, to always have a separate
workflow when Forms Builder is involved to avoid duplicates.
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CreateProspectInquiry

You can use the CreateProspectInquiry activity to dynamically create an instance of a ProspectInquiryEntity
record based on the data retrieved from an online Request for Information (RFI) form.

The CreateProspectInquiry activity does not save the record to the database. The workflow can include other
activities that manipulate the record before it is saved. To persist the record in the database, use a SavePro-
spectInquiry activity.
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Properties

Property Value Required Notes

AssignedAd-
missionsRepId

InArgument<Int32> Yes Specify the assigned Admissions
Representative Type Entity Id
using a VB expression or vari-
able.

CampusId InArgument<Int32> Yes Select a value in the drop-down
list of the activity in the Designer
window.

CreateProspectInquiry Properties
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Property Value Required Notes

City InArgument<String> Conditional Specify name of the city in the
student's address, if address
information is provided, using a
VB expression or variable.

DateOfBirth InArgument<DateTime> Conditional Specify the student's date of birth
using a VB expression or vari-
able.

DisplayName String No Specify a name for the activity or
accept the default.

EmailAddress InArgument<String> Conditional Specify the student's email
address, if provided, using a
VB expression or variable.

FirstName InArgument<String> Yes Specify the student's first name
using a VB expression or vari-
able.

LastName InArgument<String> Yes Specify the student's last name
using a VB expression or vari-
able.

LeadDate InArgument<DateTime> Yes Specify the lead date using a
VB expression or variable.

LeadSourceId InArgument<Int32> Conditional Specify the lead source identifier,
if provided, using a
VB expression or variable.

LeadTypeId InArgument<Int32> Conditional Specify the lead type identifier, if
provided, using a VB expression
or variable.

PostalCode InArgument<String> Conditional Specify the student's postal
code, if provided, using a
VB expression or variable.

PreviousEducationId InArgument<Int32> Conditional Specify the student's previous
education identifier, e.g., high
school, if provided, using a
VB expression or variable.
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Property Value Required Notes

ProspectInquiryEntity OutArgument
<ProspectInquiryEntity>

Yes The Prospect Inquiry Entity cre-
ated by this workflow activity.
This is a variable that can be
used as input for subsequent
workflow activities.

To identify the variable type, in
the Variable type field of the Vari-
ables pane, select Browse for
Types.... In the 'Browse and
Select a .NET Type' window, nav-
igate to Cmc.Nex-
us.Admissions.Contracts
> Cmc.Nexus.Admissions.Entiti-
es, select ProspectInquiryEntity
and click OK.

See ProspectInquiryEntity Class
in the Anthology Student Object
Library.

SchoolStatusId InArgument<Int32> Yes Specify the Student Status Id
using a VB expression or vari-
able.

Ssn InArgument<String> Conditional Specify the student's social secur-
ity number, if provided, using a
VB expression or variable.

State InArgument<String> Conditional Specify name of the state in the
student's address, if address
information is provided, using a
VB expression or variable.

StreetAddress InArgument<String> Conditional Specify the student's street
address, if address information is
provided, using a VB expression
or variable.

ValidationMessages OutArgument
<Val-
idationMessageCollection>

No Specify a variable that can be
used to capture validation mes-
sages. For more information, see
Capture Validation Errors.
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CreateStudentPreviousEducation

You can use the CreateStudentPreviousEducation activity to dynamically create an instance of a record in the
amProspectPrevEduc table. The previous education data can be high school or college information. The data
can be retrieved from an online application form or directly inserted in the activity (and its properties).

The CreateStudentPreviousEducation activity does not save the record to the database. The workflow can
include other activities that manipulate the record before it is saved. To persist the record in the database, use a
SaveStudentPreviousEducation activity.

The example below shows the activity and properties for the selection Type = High School.
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The example below shows the activity and properties for the selection Type=College.
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Properties

Property Value Required Notes

CollegeGPA InArgument<Decimal> No Specify the student's College
GPA, if provided, using a
VB expression or variable, for
example 4.0d.

CollegeGraduationDate InArgument<DateTime> No Specify the student's College
Graduation Date, if provided,
using a VB expression or vari-
able.

CollegeId InArgument<Int32> Conditional Specify the College Identifier, if
provided, using a
VB expression or variable.

The College Id is required if the
selection for previous education
Type = College; it is optional for
Type = High School.

DisplayName String No Specify a name for the activity
or accept the default.

CreateStudentPreviousEducation Properties
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Property Value Required Notes

HighSchoolGPA InArgument<Decimal> Conditional Specify the student's High
School GPA using a
VB expression or variable, for
example 3.5d.

The High School GPA is
required if the selection for pre-
vious education Type = High
School; it is optional for Type =
College.

HighSchoolGradu-
ationDate

InArgument<DateTime> No Specify the student's High
School Graduation Date, if
provided, using a
VB expression or variable.

HighSchoolId InArgument<String> Conditional Specify the High School Iden-
tifier using a VB expression or
variable.

The High School Id is required if
the selection for previous edu-
cation Type = High School; it is
optional for Type = College.

IsHighSchool InArgument<Boolean> Yes A Boolean expression that spe-
cifies whether the selection for
previous education Type = High
School (default) or College.

OrganizationContactId InArgument<String> No Specify the Organization
Contact Identifier using a
VB expression or variable.

The OrganizationContactId is
not required when creating the
previous education entity; how-
ever, if your institution wants to
include this in the workflow,
refer to the workflow sequence
below. This sequence gives
you an example of how to look
up a high school, get the con-
tact id for that organization, and
pass it to the CreateStu-
dentPreviousEducation activity.

StudentId InArgument<String> Yes Specify a Student Id using a
VB expression or variable.
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Property Value Required Notes

Stu-
dentPreviousEducation

OutArgument
<Stu-
dentPreviousEducationEntity>

Yes The Student Previous Edu-
cation Entity created by this
workflow activity. This is a vari-
able that can be used as input
for subsequent workflow activ-
ities.

To identify the variable type, in
the Variable type field of the
Variables pane, select Browse
for Types.... In the 'Browse and
Select a .NET Type' window,
navigate to Cmc.Nex-
us.Admissions.Contracts
> Cmc.Nexus.Admissions.Enti-
ties, and select Stu-
dentPreviousEducationEntity.

See Stu-
dentPreviousEducationEntity
Class in the Anthology Student
Object Library.

ValidationMessages OutArgument
<Val-
idationMessageCollection>

No Specify a variable that can be
used to capture validation mes-
sages. For more information,
see Capture Validation Errors.

Get OrganizationContactId Sequence

The following workflow sequence provides a query to obtain the OrganizationContactId for a high school.

The sequence uses the following variables:
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1. Use a LookupHighSchools activity.
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2. Add an ExecuteDataReader activity to the sequence. Specify a CommandText (String) expression as
shown below.

3. Drag an Assign activity into the ExecuteDateReader activity. Associate the ContactId value with the SyStu-
dentOrganizationContactId that was retrieved by the ExecuteDateReader activity.

4. Add a CreateStudentPreviousEducation activity to the sequence. Associate the OrganizationContactId
with the ContactId from the Assign activity.
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LookupCollege

The LookupCollege activity returns an array of Colleges based on filter criteria. The values are retrieved from
the amCollege table in the Anthology Student database. The filters (in arguments) include City, Code, Name,
State, and ZIP. At least one of the in arguments is required (C1).

Properties

Property Value Required Notes

City InArgument<String> C1 Specify name of the city of the col-
lege location using a
VB expression or variable.

LookupCollege Properties
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Property Value Required Notes

Code InArgument<String> C1 Specify code of the college using
a VB expression or variable.

Colleges OutArgument<College[]> Yes The array of colleges retrieved by
this workflow activity.

To identify the variable type, in the
Variable type field of the Variables
pane, select Array of [T]. In the
'Select Types' window, select
Browse for Types, and click OK.
In the 'Browse and Select a
.NET Type' window, navigate to
Cmc.Nexus.Models.Admissions,
select College, and click OK.

See CollegeEntity Class in the
Anthology Student Object Library.

DisplayName String No Specify a name for the activity or
accept the default.

Name InArgument<String> C1 Specify the name of the college
using a VB expression or variable.

State InArgument<String> C1 Specify name of the state of the
college location using a
VB expression or variable.

ValidationMessages OutArgument
<ValidationMessageCollection>

No Specify a variable that can be
used to capture validation mes-
sages. For more information, see
Capture Validation Errors.

Zip InArgument<String> C1 Specify the ZIP code of the col-
lege location using a
VB expression or variable
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LookupHighSchools

The LookupHighSchools activity returns an array of HighSchools based on filter criteria. The values are retrieved
from the amHighSchool table in the Anthology Student database. The filters (in arguments) include City, Code,
Name, State, and ZIP. At least one of the in arguments is required (C1).

Properties

Property Value Required Notes

City InArgument<String> C1 Specify name of the city of the
high school location using a
VB expression or variable.

LookupHighSchools Properties
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Property Value Required Notes

Code InArgument<String> C1 Specify code of the high school
using a VB expression or variable.

DisplayName String No Specify a name for the activity or
accept the default.

HighSchools OutArgument<HighSchool[]> Yes The array of high schools
retrieved by this workflow activity.

To identify the variable type, in the
Variable type field of the Variables
pane, select Array of [T]. In the
'Select Types' window, select
Browse for Types, and click OK.
In the 'Browse and Select a
.NET Type' window, navigate to
Cmc.Nexus.Models.Admissions,
select HighSchool, and click OK.

See HighSchoolEntity Class in
the Anthology Student Object
Library.

Name InArgument<String> C1 Specify the name of the high
school using a VB expression or
variable.

State InArgument<String> C1 Specify name of the state of the
high school location using a
VB expression or variable.

ValidationMessages OutArgument
<ValidationMessageCollection>

No Specify a variable that can be
used to capture validation mes-
sages. For more information, see
Capture Validation Errors.

Zip InArgument<String> C1 Specify the ZIP code of the high
school location using a
VB expression or variable
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SaveApplicant

The SaveApplicant activity saves an Applicant record that was created with the CreateApplicant activity.

Properties

Property Value Required Notes

Applicant InOutAr-
gument<ApplicantEntity>

Yes Specify the Applicant entity to be
saved using a VB expression or
variable.

To identify the variable type, in the
Variable type field of the Variables
pane, select Browse for Types....
In the 'Browse and Select a
.NET Type' window, navigate to
Cmc.Nex-
us.Admissions.Contracts
> Cmc.Nexus.Admissions.Entitie-
s, and select ApplicantEntity.

See ApplicantEntity Class in the
Anthology Student Object Library.

DisplayName String No Specify a name for the activity or
accept the default.

ValidationMessages OutArgument
<ValidationMessageCollection>

No Specify a variable that can be used
to capture validation messages.
For more information, see Capture
Validation Errors.

SaveApplicant Properties
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SaveProspectInquiry

The SaveProspectInquiry activity saves a record that was created with the CreateProspectInquiry activity.

The result of the SaveProspectInquiry activity depends on whether the data passed in by the activity exists in
the Anthology Student database and whether multiple inquiries are allowed in Anthology Student.

a. If the name and address data passed in the SaveProspectInquiry does not exist in Anthology Student, a
SyStudent record (that includes a Prospect record) and SyStudentInquiry record will be created as an
instance of a prospect.

b. If the name and address data passed in the SaveProspectInquiry exist in Anthology Student and multiple
inquiries are allowed in Anthology Student, the existing SyStudent record is looked up and a new value is
saved in the prospect collection (SyStudentInquiry).

c. If the name and address data passed in the SaveProspectInquiry exist in Anthology Student and multiple
inquiries are not allowed in Anthology Student, the SyStudent record is updated with the values passed in
by the activity.

To check the setting for multiple inquiries in Anthology Student, navigate to Setup > Campus Locations > select
a campus > Add/Edit (button) > Allow... (tab). If "Track Multiple Lead Inquiries" is selected, the duplicate check
function is enabled (see case b).

Note

The Leads web service provides the following configuration options in the <appSettings> section of the web.-
config file:

<add key="NewLeadSingleDuplicateHandling" value="I" />

—OR—

<add key="NewLeadSingleDuplicateHandling" value="E" />

Where value="I" indicates that prospect inquiry records are checked for duplicates and written to the SyStudent
and SyStudentInquiry tables as described above (cases a, b, and c).

If the Leads API is configured with key value=E, duplicate prospect inquiry records are written to the electronic
leads table (AmElectronicLeads). Regardless if a single or multiple duplicates are found, the prospect will always
be processed and added to the AmElectronicLeads table. For more information, see "Duplicate Lead Validation,
Configuration, and Interpreting the Response" in the Service Catalog.

https://www.mycampusinsight.com/support/CampusNexus Service Catalog/Default.htm#Admissions/Methods_Leads.htm
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Properties

Property Value Required Notes

DisplayName String No Specify a name for the activity or
accept the default.

ProspectInquiryEntity OutArgument
<ProspectInquiryEntity>

Yes The Prospect Inquiry Entity created
by this workflow activity. This is a
variable that can be used as input
for subsequent workflow activities.

To identify the variable type, in the
Variable type field of the Variables
pane, select Browse for Types....
In the 'Browse and Select a
.NET Type' window, navigate to
Cmc.Nex-
us.Admissions.Contracts
> Cmc.Nexus.Admissions.Entitie-
s, and select Pro-
spectInquiryEntity.

See ProspectInquiryEntity Class in
the Anthology Student Object
Library.

ValidationMessages OutArgument
<Val-
idationMessageCollection>

No Specify a variable that can be used
to capture validation messages.
For more information, see Capture
Validation Errors.

SaveProspectInquiry Properties
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Database Fields

The SaveProspectInquiry activity can update the following fields in the database:

l Required fields:

o StudentEntity.FirstName

o StudentEntity.LastName

o StudentEntity.SchoolStatusId

o ProspectInquiryEntity.CampusId

o ProspectInquiryEntity.LeadDate

o ProspectInquiryEntity.AssignedAdmissionsRepId

l Optional fields:

o ProspectInquiryEntity.LeadSourceId

o ProspectInquiryEntity.LeadTypeId

o StudentEntityEntity.DateOfBirth

o StudentEntityEntity.Ssn

o StudentEntityEntity.StreetAddress

o StudentEntityEntity.PostalCode

o StudentEntityEntity.EmailAddress

o StudentEntityEntity.State

o StudentEntityEntity.PreviousEducationId

o StudentEntityEntity.WorkPhoneNumber

o StudentEntityEntity.CitizenId

o StudentEntityEntity.AlienNumber

o StudentEntityEntity.City

o StudentEntityEntity.CountyId

o StudentEntityEntity.DriverLicenseNumber

o StudentEntity.NationalityId

o StudentEntity.NickName

o StudentEntity.OtherEmailAddress

o StudentEntity.OtherPhoneNumber
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SaveStudentPreviousEducation

The SaveStudentPreviousEducation activity saves a record that was created with the CreateStu-
dentPreviousEducation activity.

Properties

Property Value Required Notes

DisplayName String No Specify a name for the activity or
accept the default.

Stu-
dentPreviousEducation

OutArgument
<Stu-
dentPreviousEducationEntity>

Yes The Student Previous Education
Entity created by this workflow
activity. This is a variable that
can be used as input for sub-
sequent workflow activities.

To identify the variable type, in
the Variable type field of the Vari-
ables pane, select Browse for
Types.... In the 'Browse and
Select a .NET Type' window,
navigate to Cmc.Nex-
us.Admissions.Contracts
> Cmc.Nexus.Admissions.Entit-
ies, and select Stu-
dentPreviousEducationEntity.

SaveStudentPreviousEducation Properties
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Property Value Required Notes

ValidationMessages OutArgument
<Val-
idationMessageCollection>

No Specify a variable that can be
used to capture validation mes-
sages. For more information,
see Capture Validation Errors.
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Cmc.Nexus.Common.Workflow
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AssignStudentAdvisor (V2)

The AssignStudentAdvisor (V2) activity enables you to assign a student advisor to a student. The activity derives
the Advisor type (Academic = AD, Admissions = AM, etc.) based on the Staff Group selection. See Stu-
dentAdvisorEntityClass in the Anthology Student Object Library.

The AssignStudentAdvisor (V2) activity typically follows a LookupAdvisor (V2) activity, which uses the Module
Type (e.g., Financial Aid), Staff Group (e.g., Financial Aid Advisors), Campus, and Advisor to determine the
StaffGroupMember entity.

Properties



Workflow Version 4.0.1 204 Help Guide

Property Value Required Notes

DisplayName String No Specify a name for the
activity or accept the
default.

StaffGroupId InArgument<Int32> Yes Specify the Staff
Group Id using a
VB expression or vari-
able

StaffId InArgument<Int32> Yes Specify the Staff Id
using a VB expression
or variable

StudentEnrollmentPeriodId InArgument<Int32> Yes Specify the Student
Enrollment Period Id
using a VB expression
or variable

ValidationMessages OutArgument
<ValidationMessageCollection>

No Specify a variable that
can be used to capture
validation messages.
For more information,
see Capture Validation
Errors.

AssignStudentAdvisor Properties
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LookupAdvisor (V2)

The LookupAdvisor (V2) activity looks up staff members that are flagged as an advisor in Anthology Student. The
returned StaffGroupMember entity can be filtered by Staff Group, Campus, and Module Type (Academic = AD,
Admissions = AM, etc.). The AssignStudentAdvisor (V2) activity can be used to assign the returned
StaffGroupMember entity to a student.

If your institution assigns advisors as AD Advisor, an FA Advisor, a CS Advisor, etc. when a student enrolls, use
the LookupStudentAdvisors (V2) activity instead of the LookupAdvisor (V2) activity.
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Properties

Property Value Required Notes

Advisor enum Yes Select a value in the drop-down list of
the activity in the Designer window.
Advisors are filtered based on Cam-
pus.

— OR —

Specify the StaffId using a
VB expression or variable.

Campus enum Yes Select a value in the drop-down list of
the activity in the Designer window.

DisplayName String No Specify a name for the activity or
accept the default.

Module Type enum Yes Select a value in the drop-down list of
the activity in the Designer window.

Staff Group enum Yes Select a value in the drop-down list of
the activity in the Designer window.
Staff Groups are filtered based on
Module Type selection.

— OR —

Specify the StaffGroupId using a
VB expression or variable.

StaffGroupId InArgument<String> Yes Specify the Staff Group Id using a
VB expression or variable.

— OR —

Select a value in the drop-down list of
the activity in the Designer window.

LookupAdvisor Properties
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Property Value Required Notes

StaffGroupMember OutArgument
<StaffGroupMemberEntity>

Yes The LookupAdvisor activity returns the
StaffGroupMember entity based on
the selected Staff Group, Campus,
and Module Type (Academic = AD,
Admissions = AM, etc.) filter. The Id
field (mapped to
SyStaffByGroup.SyStaffByGroupId) is
returned as "0".

This is a variable that can be used as
input for subsequent activities in the
workflow. Specify the variable's name,
type, and scope (and default if applic-
able) in the Variables pane of the
Designer window.

To identify the variable type, in the
Variable type field of the Variables
pane, select Browse for Types.... In
the 'Browse and Select a .NET Type'
window, navigate to Cmc.Nex-
us.Common.Contracts
> Cmc.Nexus.Common.Entities,
select StaffGroupMemberEntity, and
click OK.

StaffId InArgument<Int32> Yes Specify the Staff Id using a
VB expression or variable.

— OR —

Select a value in the drop-down list of
the activity in the Designer window.
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LookupReferenceItem

If you are using Workflow Composer with the Web Client for Anthology Student in an HTTPS environment, the
LookupReferenceItem activity will fail unless you change the bindings in the WorkflowComposer.exe.config
from HTTP to HTTPS. The WorkflowComposer.exe.config file is found in the C:\\Program Files
(x86)\CMC\Workflow folder.

Edit the <bindings> as highlighted below:

<bindings>
<!-- the binding named commonBinding will be applied to all service clients-->
<basicHttpsBinding>
<binding name="commonBinding" maxReceivedMessageSize="1073741824" closeTimeout="0:03:00"
receiveTimeout="00:3:00" sendTimeout="00:3:00"/>
</basicHttpsBinding>
</bindings>

The LookupReferenceItem activity can be used to retrieve a list of records from a selected Reference Item Type
and allows you to select one of the records. This enables you to reference specific reference record data for use
within a workflow. One common use for this is to populate the value of an attribute that is part of an entity
record that will be created/updated within the workflow logic when an instance of the workflow is executed.

After you select the Reference Item Type from the drop-down list, the Reference Item drop-down list is pop-
ulated with valid values for the selected Reference Item Type.

When a database contains multiple instances of the reference item type, e.g., in multiple campuses, a list of
associated campus codes for each item is displayed in the Associated Campus(es) field so that the users can
ensure that they are selecting the correct instance of the reference items for that workflow.

The example below shows Applicant Types as the Reference Item Type.
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The example below shows Address Types as the Reference Item Type.
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Properties

Property Value Required Notes

DisplayName String No Specify a name for the activity or
accept the default.

ItemId InArgument<Int32> Yes The Item Id of the Reference Item
selected to be looked up.

ReferenceItem OutArgument<ReferenceItem> Yes The Reference Item returned by
the lookup function. This is a vari-
able that can be used as input for
subsequent activities in the work-
flow. Specify the variable's name,
type, and scope (and default if
applicable) in the Variables pane
of the Designer window.

To identify the variable type, in the
Variable type field of the Variables
pane, select Browse for Types....
In the 'Browse and Select a
.NET Type' window, navigate to
Cmc.Nexus.Common.Contracts
> Cmc.Nexus.Common.Services
, select ReferenceItem, and click
OK.

ReferenceItemType InArgument<String> No The Reference Item Type cap-
tured from an event. Select a
value in the drop-down list of the
activity in the Designer window.

See Cmc.Nexus.Models for the
mapping of entities.

ValidationMessages OutArgument
<ValidationMessageCollection>

No Specify a variable that can be
used to capture validation mes-
sages. For more information, see
Capture Validation Errors.

LookupReferenceItem Properties

The properties of the ReferenceItem class are mapped to the following entities:

l Code - <TableName>.Code

l Id - <Tablename>.<Tablename>ID example: AmApplicantTypeID

l IsActive - <Tablename>.Active

l Name - <Tablename>.Descrip
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LookupStudentAdvisors (V2)

The LookupStudentAdvisors activity captures the Student Enrollment Period Id from an event and returns the
Advisors that are currently assigned to a student. In most situations, the EnrollmentPeriod will only be asso-
ciated with a single Advisor type. The Advisor type (Academic = AD, Admissions = AM, etc.) is selected in Module
field of the lookup activity.

Based on the EnrollmentPeriod and Module, the LookupStudentAdvisors activity returns the staff member's
FirstName, LastName, Module, and GroupName.

A use case for this activity is to assign a document or task to a staff member to follow up with a student when a
specific event occurs, for example, the student is put on academic probation.

Properties

Property Value Required Notes

DisplayName String No Specify a name for the activity
or accept the default.

Module InArgument<String> Yes Select a value in the drop-down
list of the activity in the Designer
window.

LookupStudentAdvisors Properties
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Property Value Required Notes

StudentAdvisors OutArgument
<StudentAdvisorEntity[]>

Yes The LookupStudentAdvisors
activity returns an array of stu-
dent advisors associated with a
Module and Stu-
dentEnrollmentPeriodId.

This is a variable that can be
used as input for subsequent
activities in the workflow. Spe-
cify the variable's name, type,
and scope (and default if applic-
able) in the Variables pane of
the Designer window.

To identify the variable type, in
the Variable type field of the
Variables pane, select Array of
[T]. In the 'Select Types' win-
dow, select Browse for Types,
and click OK. In the 'Browse
and Select a .NET Type' win-
dow, navigate to Cmc.Nex-
us.Common.Contracts
> Cmc.Nexus.Common.Entitie-
s, select StudentAdvisorEntity,
and click OK.

See StudentAdvisorEntity Class
in the Anthology Student Object
Library.

Stu-
dentEnrollmentPeriodId

InArgument<Int32> Yes Specify the Student Enrollment
Period Id using a VB expression
or variable.

ValidationMessages OutArgument
<Val-
idationMessageCollection>

No Specify a variable that can be
used to capture validation mes-
sages. For more information,
see Capture Validation Errors.
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LookupStudentGroup (V2)

The LookupStudentGroup activity is a function that captures the Group Id from an event and returns the Group
(name).

On the 'Search for Group' tab, click the Search button to find a student group.

Or, use the 'Enter VB Expression' tab to find a group.
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Properties

Property Value Required Notes

DisplayName String No Specify a name for the activity or accept the
default.

GroupId InArgument<Int32> Yes Specify the Group Id captured from an event
using a VB expression or variable.

StudentGroup OutArgument
<StudentGroupEntity>

Yes The Student Group (name) returned by the
lookup function, for example "Leads". This is a
variable that can be used as input for sub-
sequent activities in the workflow. Specify the
variable's name, type, and scope (and default if
applicable) in the Variables pane of the Designer
window.

To identify the variable type, in the Variable type
field of the Variables pane, select Browse for
Types.... In the 'Browse and Select a .NET Type'
window, navigate to Cmc.Nex-
us.Common.Contracts
> Cmc.Nexus.Common.Entities, select Stu-
dentGroupEntity, and click OK.

See StudentGroupEntity Class in the Anthology
Student Object Library.

LookupStudentGroup Properties
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ManageGroupMembership (V2)

The ManageGroupMembership activity enables you to automate the addition (or removal) of a student group
member. The activity captures a Group Id and a Student Id from an event.

Use the LookupStudentGroup (V2) activity to capture the Group Id from an event and to identify the Group
(name).
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Properties

Property Value Required Notes

Action InArgument<GroupAction> Yes A drop-down list enabling you to select
an action to take when the event occurs.
The options are:

l Add to Group

See AddStu-
dentToGroupRequest Class in
the Anthology Student Object
Library.

l Remove from Group

See RemoveStu-
dentFromGroupRequest Class in
the Anthology Student Object
Library.

DisplayName String No Specify a name for the activity or accept
the default.

Group Id InArgument<Int32> Yes The Group Id captured from an event.

Student Id InArgument<Int32> Yes The Student Id captured from an event.

Val-
idationMessages

OutArgument
<Val-
idationMessageCollection>

No Specify a variable that can be used to
capture validation messages. For more
information, see Capture Validation
Errors.

ManageGroupMembership Properties
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SaveStudentPortalUserAssociation

The SaveStudentPortalUserAssociation activity creates a wpUserRelation record in the Portal database. The
wpUserRelation record establishes a relation between a wpUser record in the Portal database and an syStudent
record in the Anthology Student database. The wpUserRelation enables a student or staff user to log into the
Portal. The record contains four columns for each user:

l wpUserID (Web Port User Id)
l Relation Type (Staff or Student)
l C2kID (Student ID)
l CampusID

The example below shows the SaveStudentPortalUserAssociation activity in a workflow for a form created in
Forms Builder. The activity is triggered after a prospect enters his or her personal information. If the form is
completed without errors and the PropectInquiry entity is saved, a wpUserRelation record is created and the
prospect gains access to the Portal.
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Properties

Property Value Required Notes

DisplayName String No Specify a name for the activity
or accept the default.

PortalUserName InArgument<String> Yes Specify the PortalUserName
using a VB expression or vari-
able.

StudentId InArgument<Int32> Yes Specify a Student Id using a
VB expression or variable.

ValidationMessages InOutArgument
<ValidationMessageCollection>

No Specify a variable that can be
used to capture validation
messages. For more inform-
ation, see Capture Validation
Errors.

SaveStudentPortalUserAssociation Properties

UpdateStudentStatusToActive (V2)

You can use the UpdateStudentStatusToActive activity to change the school status of a student to an Active
(A) category so that you can trigger status changes when certain conditions occur.

For example, you could change the status 'Being Processed' or 'Temp Out' to 'Active' when specific events occur.
You can use a LookupReferenceItem activity with "Reference Item Type = School Status" and "Reference Item =
<status>" to find the status within the Active category that is to be changed in the workflow.

Status categories in Anthology Student are defined in the Setup > Status Codes > Status Codes tab. To determ-
ine Active category status values in the database, use the following SQL query:

Select S.Category, SS.*

from SySchoolStatus SS(nolock)

JOIN SyStatus S(nolock) ON SS.SyStatuSID = S.SyStatusID

Where S.Category = 'A' Order by ss.Descrip
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Properties

Property Value Required Notes

BeginDate InArgument<DateTime> Yes Specify a date using a
VB expression or variable.

Comment InArgument<String> No Specify a comment if applic-
able.

DisplayName String No Specify a name for the activity
or accept the default.

EnrollId InArgument<Int32> Yes Specify the Enroll Id using a
VB expression or variable.

ReasonId InArgument<Int32> No Specify the Reason Id using a
VB expression or variable.

StudentId InArgument<Int32> Yes Specify a Student Id using a
VB expression or variable.

UpdateStudentStatusToActive Properties
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Property Value Required Notes

StudentStatusId InArgument<Int32> Yes Specify the Student Status Id
using a VB expression or vari-
able.

ValidationMessages InOutArgument
<ValidationMessageCollection>

No Specify a variable that can be
used to capture validation
messages. For more inform-
ation, see Capture Validation
Errors.

UpdateStudentStatusToApplicant (V2)

You can use the UpdateStudentStatusToApplicant activity to change the school status of a student from a Lead
or Applicant category to an Applicant Processing (C) category so that you can trigger status changes when cer-
tain conditions occur.

For example, you could change the status 'Being Processed' to 'Applicant' when a student is added to the Applic-
ants groups. You can use a LookupReferenceItem activity with "Reference Item Type = School Status" and "Refer-
ence Item = <status>" to find the status within the Future Start category that is to be changed in the workflow.

Status categories in Anthology Student are defined in the Setup > Status Codes > Status Codes tab. To determ-
ine Applicant category status values in the database, use the following SQL query:

Select S.Category, SS.*

from SySchoolStatus SS(nolock)

JOIN SyStatus S(nolock) ON SS.SyStatuSID = S.SyStatusID

Where S.Category = 'C' Order by ss.Descrip

To determine StudentId values, use the following SQL query:

Select SyStudentId, syschoolstatusid, addenrollid, * from AdEnroll where SySchoolStatusID IN (Select SS.sy-
schoolstatusid

from SySchoolStatus SS(nolock)

JOIN SyStatus S(nolock) ON SS.SyStatuSID = S.SyStatusID

Where S.Category = 'C')
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Properties

Property Value Required Notes

Comment InArgument<String> No Specify a comment if
applicable.

DisplayName String No Specify a name for the
activity or accept the
default.

EffectiveDate InArgument<DateTime> Yes Specify a date using a
VB expression or vari-
able. For example, to
change the School
Status whenever the
event occurs, specify:
DateTime.Now

StudentEnrollmentPeriodId InArgument<Int32> Yes Specify the Student
Enrollment Period Id
using a VB expression
or variable.

StudentId InArgument<Int32> Yes Specify a Student Id
using a VB expression
or variable.

UpdateStudentStatusToApplicant Properties
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Property Value Required Notes

StudentStatusId InArgument<Int32> Yes Specify the
Student Status Id
using a VB expression
or variable.

ValidationMessages InOutArgument
<ValidationMessageCollection>

No Specify a variable that
can be used to capture
validation messages.
For more information,
see Capture Validation
Errors.

UpdateStudentStatusToDrop (V2)

You can use the UpdateStudentStatusToDrop activity to change the school status of a student to a Permanent
Out (P) category so that you can trigger status changes when certain conditions occur.

For example, you could change the status 'Active' to 'Drop' when a student withdraws from all classes. You can
use a LookupReferenceItem activity with "Reference Item Type = School Status" and "Reference Item = <status>"
to find the status that is to be changed in the workflow.

Status categories in Anthology Student are defined in the Setup > Status Codes > Status Codes tab. To determ-
ine Permanent Out category status values in the database, use the following SQL query:

Select S.Category, SS.*

from SySchoolStatus SS(nolock)

JOIN SyStatus S(nolock) ON SS.SyStatuSID = S.SyStatusID

Where S.Category = 'P' Order by ss.Descrip
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Properties

Property Value Required Notes

Comment InArgument<String> No Specify a comment if applic-
able.

DeterminationDate InArgument<DateTime> Yes Specify the Determination
Date using a VB expression
or variable.

DisplayName String No Specify a name for the activity
or accept the default.

EnrollId InArgument<Int32> Yes Specify the Enroll Id using a
VB expression or variable.

LdaDate InArgument<DateTime> Yes Specify the Last Date of
Attendance (LDA) using a
VB expression or variable.

ReasonId InArgument<Int32> Yes Specify the Reason Id using a
VB expression or variable.

UpdateStudentStatusToDrop Properties
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Property Value Required Notes

StudentStatusId InArgument<Int32> Yes Specify the Student Status Id
using a VB expression or vari-
able.

ValidationMessages InOutArgument
<ValidationMessageCollection>

No Specify a variable that can be
used to capture validation
messages. For more inform-
ation, see Capture Validation
Errors.

UpdateStudentStatusToEnrolled (V2)

You can use the UpdateStudentStatusToEnrolled activity to change the school status of a student to an Enrolled
(E) category so that you can trigger status changes when certain conditions occur.

For example, you could change the status 'Application Received' or 'Pending Applicant' to 'Enrolled' when spe-
cific events occur. You can use a LookupReferenceItem activity with "Reference Item Type = School Status" and
"Reference Item = <status>" to find the status within the Enrolled category that is to be changed in the work-
flow.

Status categories in Anthology Student are defined in the Setup > Status Codes > Status Codes tab. To determ-
ine Enrolled category status values in the database, use the following SQL query:

Select S.Category, SS.*

from SySchoolStatus SS(nolock)

JOIN SyStatus S(nolock) ON SS.SyStatuSID = S.SyStatusID

Where S.Category = 'E' Order by ss.Descrip

Note: You can update a student's status to NDS Enrolled Status (SyStatus.Category = 'X') using the Activities and
Contracts package for Anthology Student 21.0.
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Properties

Property Value Required Notes

Comment InArgument<String> No Specify a comment if applic-
able.

DisplayName String No Specify a name for the activity
or accept the default.

EnrollId InArgument<Int32> Yes Specify the Enroll Id using a
VB expression or variable.

ReasonId InArgument<Int32> No Specify the Reason Id using a
VB expression or variable.

StudentId InArgument<Int32> Yes Specify a Student Id using a
VB expression or variable.

UpdateStudentStatusToEnrolled Properties
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Property Value Required Notes

StudentStatusId InArgument<Int32> Yes Specify the Student Status Id
using a VB expression or vari-
able.

ValidationMessages InOutArgument
<ValidationMessageCollection>

No Specify a variable that can be
used to capture validation
messages. For more inform-
ation, see Capture Validation
Errors.

UpdateStudentStatusToGraduate (V2)

You can use the UpdateStudentStatusToGraduate activity to change the school status of a student to a Gradu-
ate (P - Permanent Out) category so that you can trigger status changes when certain conditions occur.

For example, you could change the status 'Active' to 'Graduate' when a student graduates. You can use a Look-
upReferenceItem activity with "Reference Item Type = School Status" and "Reference Item = <status>" to find
the status within the Active category that is to be changed in the workflow.

Status categories in Anthology Student are defined in the Setup > Status Codes > Status Codes tab. To determ-
ine Graduate category status values in the database, use the following SQL query:

Select S.Category, SS.*

from SySchoolStatus SS(nolock)

JOIN SyStatus S(nolock) ON SS.SyStatuSID = S.SyStatusID

Where S.Category = 'P' Order by ss.Descrip
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Properties

Property Value Required Notes

Comment InArgument<String> No Specify a comment if applic-
able.

DisplayName String No Specify a name for the activity
or accept the default.

EnrollId InArgument<Int32> Yes Specify the Enroll Id using a
VB expression or variable.

GradDate InArgument<DateTime> Yes Specify the Graduation Date
using a VB expression or vari-
able.

LdaDate InArgument<DateTime> Yes Specify the Last Date of
Attendance (LDA) using a
VB expression or variable.

ReasonId InArgument<Int32> No Specify the Reason Id using a
VB expression or variable.

UpdateStudentStatusToGraduate Properties
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Property Value Required Notes

StudentId InArgument<Int32> Yes Specify a Student Id using a
VB expression or variable.

StudentStatusId InArgument<Int32> Yes Specify the Student Status Id
using a VB expression or vari-
able.

ValidationMessages InOutArgument
<ValidationMessageCollection>

No Specify a variable that can be
used to capture validation
messages. For more inform-
ation, see Capture Validation
Errors.

UpdateStudentStatusToLead (V2)

You can use the UpdateStudentStatusToLead activity to change the school status of a student in a Lead status
to another Lead category (L - Lead) so that you can trigger status changes when certain conditions occur.

For example, you could change the status 'New Lead' to 'Interviewed' when a student is added to the Applicants
groups. You can use a LookupReferenceItem activity with "Reference Item Type = School Status" and "Reference
Item = <status>" to find the status within the Lead category that is to be changed in the workflow.

Status categories in Anthology Student are defined in the Setup > Status Codes > Status Codes tab. To determ-
ine Lead category status values in the database, use the following SQL query:

Select S.Category, SS.*

from SySchoolStatus SS(nolock)

JOIN SyStatus S(nolock) ON SS.SyStatuSID = S.SyStatusID

Where S.Category = 'L' Order by ss.Descrip

To determine StudentId values, use the following SQL query:

Select SyStudentId, syschoolstatusid, adenrollid, * from AdEnroll where SySchoolStatusID IN (Select SS.sy-
schoolstatusid

from SySchoolStatus SS(nolock)

JOIN SyStatus S(nolock) ON SS.SyStatuSID = S.SyStatusID

Where S.Category = 'L')
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Properties

Property Value Required Notes

DisplayName String No Specify a name for the activity
or accept the default.

StudentId InArgument<Int32> Yes Specify a Student Id using a
VB expression or variable.

StudentStatusId InArgument<Int32> Yes Specify the Student Status Id
using a VB expression or vari-
able.

ValidationMessages InOutArgument
<ValidationMessageCollection>

No Specify a variable that can be
used to capture validation
messages. For more inform-
ation, see Capture Validation
Errors.

UpdateStudentStatusToLead Properties

UpdateStudentStatusToTempOut (V2)

You can use the UpdateStudentStatusToTempOut activity to change the school status of a student to a Tem-
porary Out (T) category so that you can trigger status changes when certain conditions occur.

For example, you could change the status 'Active' to 'Temporary Out' when a student requests a medical leave.
You can use a LookupReferenceItem activity with "Reference Item Type = School Status" and "Reference Item =
<status>" to find the status within the Active category that is to be changed in the workflow.

Status categories in Anthology Student are defined in the Setup > Status Codes > Status Codes tab. To determ-
ine Temporary Out category status values in the database, use the following SQL query:

Select S.Category, SS.*
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from SySchoolStatus SS(nolock)

JOIN SyStatus S(nolock) ON SS.SyStatuSID = S.SyStatusID

Where S.Category = 'T' Order by ss.Descrip

Properties

Property Value Required Notes

BeginDate InArgument<DateTime> Yes Specify the Begin Date of the
Temporary Out status using a
VB expression or variable.

Comment InArgument<String> No Specify a comment if applic-
able.

DisplayName String No Specify a name for the activity
or accept the default.

EnrollId InArgument<Int32> Yes Specify the Enroll Id using a
VB expression or variable.

UpdateStudentStatusToTempOut Properties
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Property Value Required Notes

ReasonId InArgument<Int32> No Specify the Reason Id using a
VB expression or variable.

ReturnDate InArgument<DateTime> Yes Specify the Return Date using
a VB expression or variable.

StudentId InArgument<Int32> Yes Specify a Student Id using a
VB expression or variable.

StudentStatusId InArgument<Int32> Yes Specify the Student Status Id
using a VB expression or vari-
able.

ValidationMessages InOutArgument
<ValidationMessageCollection>

No Specify a variable that can be
used to capture validation
messages. For more inform-
ation, see Capture Validation
Errors.
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Cmc.Nexus.Crm.Workflow
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CreateDocument (V2)

The CreateDocument activity enables you to create a student document in a workflow. The CreateDocument
activity is typically used in conjunction with a LookupReferenceItem activity to retrieve the Document Type asso-
ciated with a Document Type Id.

This activity creates an instance of a Document; it does not save it to the database. To persist the Document in
the database, insert a SaveDocument (V2) activity.

Note: The Activities and Contracts packages for Anthology Student version 18.0.2 and later modify the CreateDocument (V2)
activity as follows:

l The Module selection is no longer required. The Module Id is derived from the selected Document Type.
The Module field is retained in the user interface for backward compatibility only.

l It is no longer necessary to use Assign activities for the DocumentImage, OriginalFileName, ImageType,
and IsDocumentAddedManually properties.
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Properties

Property Value Required Notes

Award Year InArgument<String> No Award Year related to the doc-
ument.

Date Received InArgument<Nullable<DateTime>> No Specify a date using a
VB expression or variable.
For example, to create the
document whenever the event
occurs, specify:
DateTime.Now

Date Requested InArgument<Nullable<DateTime>> Yes Specify a date using a
VB expression or variable.

Date Sent InArgument<Nullable<DateTime>> No Specify a date using a
VB expression or variable.

CreateDocument Properties
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Property Value Required Notes

DisplayName String No Specify a name for the activity
or accept the default.

Document OutArgument<DocumentEntity> Yes This is a variable that can be
used in subsequent workflow
activities.

To identify the variable type,
in the Variable type field of the
Variables pane, select
Browse for Types.... In the
'Browse and Select a
.NET Type' window, navigate
to Cmc.Nex-
us.Crm.Contracts . Cmc.Nex-
us.Crm.Entities, select
DocumentEntity and click
OK.

See DocumentEntity Class in
the Anthology Student Object
Library.

Document Type InArgument<Int32> Yes Select a value in the drop-
down list of the activity in the
Designer window.

Due Date InArgument<Nullable<DateTime>> No Specify a date using a
VB expression or variable.
For example, to specify a due
date that is 30 days after the
event occurred, specify:
DateTime.Now.AddDays
(30)

Expiration Date InArgument<Nullable<DateTime>> No Specify a date using a
VB expression or variable.

Module Id InArgument<Int32> No The Module Id is derived auto-
matically from the Document
Type selection.

Notes InArgument<String> No Specify a note related to the
Document being created.
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Property Value Required Notes

Status InArgument<Int32> Yes Select a value in the drop-
down list of the activity in the
Designer window.

StudentId InArgument<Int32> No Specify a Student Id using a
VB expression or variable.

ValidationMessages OutArgument
<ValidationMessageCollection>

No Specify a variable that can be
used to capture validation
messages. For more inform-
ation, see Capture Validation
Errors.

WorkFlowInstance InArgument<Guid> No Specify the Id associated with
the workflow instance to
resume using a
VB expression or variable.

To identify the variable type,
in the Variable type field of the
Variables pane, select
Browse for Types.... In the
'Browse and Select a
.NET Type' window, navigate
to mscorlib > System, select
Guid, and click OK.

To remove a Work-
flowInstance value, see Clear
a Workflow Instance Id.
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CreateTask (V2)

Prerequisite: When this activity is used with Anthology Student 21.2.0 and later, the APIUser must have
authorization to access to the entity requested in the OData query. For more information, see Security
Enhancement for OData Queries.

The CreateTask activity enables you to create an Anthology Student Contact Manager activity, a CampusNexus
CRM Interaction, an appointment, or a notification.

The out argument 'Task' is a variable that calls the newTask() function. The newTask() function can be used in
workflows for multiple applications, such as Anthology Student and Anthology CRM.

The CreateTask activity creates an instance of a Task; it does not save the Task to the database. The workflow
can include other activities that manipulate the Task before it is saved. To persist the Task in the database,
insert a SaveTask (V2) activity.

Notes: 

l In Workflow Composer 3.0 with Anthology Student 21.0 and later, the "Email Subject" property is added
to the CreateTask activity.

l Anthology Student 21.2 and later uses the Kendo library instead of Moment.js to format the <DateTime>
property. The differences between Kendo and Moment.js affect the code used to return current date and
time values.

o DateTime.Now (Moment.js) returns the current date and time, e.g., 2011-07-01 10:09.45310.

o DateTime.Today (Kendo) returns the current date with the time components set to zero, e.g.,
2011-07-01 00:00.00000.

If you receive validation errors related to date and time values in your workflows, replace DateTime.Now
with DateTime.Today.
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Properties

Property Value Required Notes

Assign To InArgument<Int32> Yes Specify the Owner User Id
using a VB expression or vari-
able.

Email Subject InArgument<string> No Enter a string that indicates
the email subject.

DisplayName String No Specify a name for the activity
or accept the default.

Due Date InArgument<DateTime> Yes Specify a date using a
VB expression or variable.

CreateTask Properties



Workflow Version 4.0.1 240 Help Guide

Property Value Required Notes

Note InArgument<String> No Specify a note related to the
Task using a VB expression or
variable, for example:

"Check out" &
entity.FirstName & "
"& entity.LastName

Priority InArgument<TaskPriority> Yes Select a value in the drop-
down list of the activity in the
Designer window.

Related To InArgument<Int32> Yes Specify a Student Id using a
VB expression or variable.

Start Date InArgument<DateTime> No The time the Task is sched-
uled to begin. Only the time
portion of this value is rel-
evant. Specify a value using a
VB expression or variable.

Subject InArgument<String> Yes Enter a string that indicates
the Task subject.

Task OutArgument<TaskEntity> Yes This is a variable that can be
used in subsequent workflow
activities.

To identify the variable type, in
the Variable type field of the
Variables pane, select
Browse for Types.... In the
'Browse and Select a
.NET Type' window, navigate
to Cmc.Nexus.Crm.Contracts
. Cmc.Nexus.Crm.Entities,
select TaskEntity, and click
OK.

See TaskEntity Class in the
Anthology Student Object
Library.

Task Status InArgument<Int32> Yes Select a value in the drop-
down list of the activity in the
Designer window.
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Property Value Required Notes

Task Template InArgument<Int32> Yes Select a value in the drop-
down list of the activity in the
Designer window. The drop-
down list retrieves values from
the CmTemplate table. If you
know the Task Template Id,
specify the Id value in the
Properties pane.

ValidationMessages OutArgument
<ValidationMessageCollection>

No Specify a variable that can be
used to capture validation
messages. For more inform-
ation, see Capture Validation
Errors.

WorkFlowInstance InArgument<Guid> No Specify the Id associated with
the workflow instance to
resume using a VB expression
or variable.

To identify the variable type, in
the Variable type field of the
Variables pane, select
Browse for Types.... In the
'Browse and Select a
.NET Type' window, navigate
to mscorlib > System, select
Guid, and click OK.

To remove a Work-
flowInstance value, see Clear
a Workflow Instance Id.
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LookupStudentDocuments

The LookupStudentDocuments activity returns the documents associated with a particular student. You can use
this activity to modify the attributes of a Student Document using a workflow.

For example, you can look up a Document Type using a LookupReferenceItem activity and then use a Look-
upStudentDocuments activity to look up the students to whom the document has been associated via a Contact
Manager activity. Based on an event, you can then change the document status or perform other activities, e.g.,
close a Contact Manager activity.

Properties

Property Value Required Notes

DisplayName String No Specify a name for the activity
or accept the default.

LookupStudentDocuments Properties
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Property Value Required Notes

Document Type Id InArgument<Int32> Yes The DocumentTypeId cap-
tured from an event.

Documents List OutArgument<DocumentEntity[]> Yes The Document returned by
the lookup function. This is a
variable that can be used as
input for subsequent activities
in the workflow. Specify the
variable's name, type, and
scope (and default if applic-
able) in the Variables pane of
the Designer window.

To identify the variable type,
in the Variable type field of the
Variables pane, select Array
of [T]. In the 'Select Types'
window, select Browse for
Types, and click OK. In the
'Browse and Select a
.NET Type' window, navigate
to Cmc.Nexus.Crm.Contract
> Cmc.Nexus.Crm.Entities,
select DocumentEntity, and
click OK.

See DocumentEntity Class in
the Anthology Student Object
Library.

Student Id InArgument<Int32> Yes The Student Id captured from
an event.

ValidationMessages OutArgument
<ValidationMessageCollection>

No Specify a variable that can be
used to capture validation
messages. For more inform-
ation, see Capture Validation
Errors.
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LookupStudentTasks (V2)

The LookupStudentTasks activity returns the Student Tasks associated with a particular student. You can use
this activity to modify the attributes of a Student Task using a workflow.

For example, you can look up a task (Contact Manager activity) that has already been associated with a student
and based on an event and change the status or result of an activity using a workflow.
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Properties

Property Value Required Notes

DisplayName String No Specify a name for the activity
or accept the default.

Student Id InArgument<Int32> Yes The Student ID captured from
an event.

Task Template Id InArgument<Int32> No The TaskTemplateId captured
from an event. If this property
is left blank, all tasks are
returned.

Task List OutArgument<TaskEntity[]> Yes The Task returned by the
lookup function. This is a vari-
able that can be used as input
for subsequent activities in the
workflow. Specify the vari-
able's name, type, and scope
(and default if applicable) in
the Variables pane of the
Designer window.

To identify the variable type,
in the Variable type field of the
Variables pane, select Array
of [T]. In the 'Select Types'
window, select Browse for
Types, and click OK. In the
'Browse and Select a
.NET Type' window, navigate
to Cmc.Nexus.Crm.Contract
> Cmc.Nexus.Crm.Entities,
select TaskEntity, and click
OK.

See TaskEntity Class in the
Anthology Student Object
Library.

ValidationMessages OutArgument
<ValidationMessageCollection>

No Specify a variable that can be
used to capture validation
messages. For more inform-
ation, see Capture Validation
Errors.

LookupStudentTasks Properties
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SaveDocument (V2)

The SaveDocument activity enables you to save a document record (INSERT mode). The document will be asso-
ciated with a Person record.

You can also use this activity to modify an existing document record (UPDATE mode).

Notes:

l You can modify the following fields using the SaveDocument activity:

o ApprovalDate
o DocumentStatusId
o DueDate
o ExperiationDate
o Note
o ReceivedDate
o RequestDate
o SentDate

l If you update the PersonId, the StudentId or ProspectId must be updated as well because these fields ref-
erence the same student (SyStudentId).

l You cannot delete existing values (that is, fields that have a value cannot be set to NULL).



Workflow Version 4.0.1 247 Help Guide

Properties

Property Value Required Notes

DisplayName String No Specify a name for the activity
or accept the default.

SaveDocument Properties
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Property Value Required Notes

Document InOutArgument<DocumentEntity> Yes Specify the Document using a
VB expression or variable.

To identify the variable type, in
the Variable type field of the
Variables pane, select
Browse for Types.... In the
'Browse and Select a
.NET Type' window, navigate
to Cmc.Nexus.Crm.Contracts
. Cmc.Nexus.Crm.Entities,
select DocumentEntity, and
click OK.

See DocumentEntity Class in
the Anthology Student Object
Library.

ValidationMessages OutArgument
<ValidationMessageCollection>

No Specify a variable that can be
used to capture validation
messages. For more inform-
ation, see Capture Validation
Errors.
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SaveTask (V2)

The SaveTask activity enables you to save a Task (INSERT mode) and display a validation message.

SaveTask is used after a CreateTask (V2) activity has created a Task instance. Save Task will persist a Task
instance in the database by calling the API.

You can also use this activity to modify an existing task record (UPDATE mode). The following fields can be
updated (corresponding Contact Manager Service API fields in parenthesis):

l DueDate
l Note (Comments)
l OwnerUserId (AssignedStaffId)
l Priority
l StartDate
l Subject
l TaskResultId (ActivityResultId)
l TaskStatusId (ActivityStatusId)
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Properties

Property Value Required Notes

DisplayName String No Specify a name for the activity
or accept the default.

SaveTask Properties
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Property Value Required Notes

Task InOutArgument<TaskEntity> Yes Specify the entity to be saved
using a VB expression or vari-
able.

To identify the variable type, in
the Variable type field of the
Variables pane, select
Browse for Types.... In the
'Browse and Select a
.NET Type' window, navigate
to Cmc.Nexus.Crm.Contracts
. Cmc.Nexus.Crm.Entities,
select TaskEntity, and click
OK.

See TaskEntity Class in the
Anthology Student Object
Library.

ValidationMessages OutArgument
<ValidationMessageCollection>

No Specify a variable that can be
used to capture validation
messages. For more inform-
ation, see Capture Validation
Errors.
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Cmc.Nexus.FinancialAid.Workflow
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LookupIsir

The LookupIsir activity returns all fields in the Institutional Student Information Records (ISIR) entity. This activity
enables you to create workflows around ISIR specific events.

The optional input values of the LookupIsir activity can be used as follows:

l LookupIsir based on ISIR Match Id (Conditionally required input value marked C1 in the table below)

l LookupIsir based on ISIR Main Id (IsirSummaryId property) (Conditionally required input value marked
C2 in the table below)

l LookupIsir based on Award Year, SSN, and ISIR Transaction Id (Conditionally required input values
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marked C3 in the table below)

Properties

Property Value Required Notes

AwardYear InArgument<String> Conditional
C3

Specify the Award Year using a
string, for example, "2015-16".

DisplayName String No Specify a name for the activity or
accept the default.

LookupIsir Properties
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Property Value Required Notes

Isir OutArgument<IsirMessage> Yes The ISIR returned by the lookup
function. This is a variable that can
be used as input for subsequent
activities in the workflow. Specify
the variable's name, type, and
scope (and default if applicable) in
the Variables pane of the Designer
window.

To identify the variable type, in the
Variable type field of the Variables
pane, select Browse for Types....
In the 'Browse and Select a
.NET Type' window, navigate to
Cmc.Nex-
us.FinancialAid.Contracts >
Cmc.Nex-
us.FinancialAid.Services, and
select IsirMessage.

See IsirMessage Class in the
Anthology Student Object Library.

IsirMatchId InArgument<Int32> Conditional
C1

Specify the Id used to match ISIRs
to Anthology Student Master
records

IsirSsn InArgument<String> Conditional
C3

Specify the SSN associated with
ISIR records.

IsirSummaryId InArgument<Int32> Conditional
C2

Specify the ISIR Main Id.

IsirTrans-
actionIdentifier

InArgument<String> Conditional
C3

Specify the ISIR Transaction Id.

ValidationMessages InOutArgument
<Val-
idationMessageCollection>

No Specify a variable that can be
used to capture validation mes-
sages. For more information, see
Capture Validation Errors.
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UpdateISIRVerificationDependent

The UpdateISIRVerificationDependent activity is used to submit ISIR verification data for a dependent student.
For a given award year, the activity captures the dependent student verification data.

The activity will only save the data submitted by the student or parent in Anthology Student. The Financial Aid
staff at the institution will be responsible for performing the manual ISIR verification process.

When the UpdateISIRVerificationDependent activity is executed, the following occurs:

l The verification values are updated in Anthology Student. If corrections are pending, the update of values
is not allowed.

l Field codes (SAR) are identified based on the award year schema.

l The values for each field are validated (compared with default values on the schema).

l After all validations have passed, a new record is written to the faisirverification table. If the record
exists, the values are updated.

l The updated values are displayed on the ISIR verification form in Anthology Student.

See UpdateISIRVerificationDependent Example for an example of how this activity can be integrated in a work-
flow.
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Properties

Property Value Required Notes

AwardYear InArgument<String> Yes Specify the Award Year using a
VB expression or variable.
Format: “XXXX-XX”. Example:
“2015-16”.

DisplayName String No Specify a name for the activity or
accept the default.

FatherIncome InArgument<String> No Specify the Father's Income
Earned FromWork using a
VB expression or variable.
Valid field content: -9999999 to
9999999

IsirMainId InArgument<Int32> Yes Specify the ISIR Main Id using a
VB expression or variable.

UpdateISIRVerificationDependent Properties
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Property Value Required Notes

IsirVerification OutArgument
<IsirVerificationEntity[]>

Yes The UpdateISIRVeri-
ficationIndependent activity returns
an array of ISIR Verification values
associated with the Award Year
and ISIR Identification.

This is a variable that can be used
as input for subsequent activities in
the workflow. Specify the variable's
name, type, and scope (and
default if applicable) in the Vari-
ables pane of the Designer win-
dow.

To identify the variable type, in the
Variable type field of the Variables
pane, select Array of [T]. In the
'Select Types' window, select
Browse for Types, and click OK. In
the 'Browse and Select a
.NET Type' window, navigate to
Cmc.Nexus.FinancialAid.Entities,
select IsirVerificationEntity, and
click OK.

See IsirVerificationEntity Class in
the Anthology Student Object
Library.

MotherIncome InArgument<String> No Specify the Mother's Income
Earned FromWork using a
VB expression or variable.
Valid field content: -9999999 to
9999999

OutputMessage OutArgument<String> No Specify the Output Message using
a VB expression or variable.

ParentChildSupportPaid InArgument<String> No Specify the Parent's Child Support
Paid using a VB expression or vari-
able.
Valid field content: 0000000 to
9999999
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Property Value Required Notes

ParentChildSupportReceive InArgument<String> No Specify the Parent's Child Support
Received using a VB expression or
variable.
Valid field content: 0000000 to
9999999

ParentCombatPay InArgument<String> No Specify the Parent's Combat Pay
using a VB expression or variable.
Valid field content: 0000000 to
9999999

ParentCoOpEarning InArgument<String> No Specify the Parent's Co-op Earning
Pay using a VB expression or vari-
able.
Valid field content: 0000000 to
9999999

ParentEducationCredit InArgument<String> No Specify the Parent's Educational
Credits using a VB expression or
variable.
Valid field content: 0000000 to
9999999

ParentFoodStamps InArgument<String> No Specify whether the Parent Sup-
plemental Nutrition Assistance Pro-
gram (SNAP) applies.
Valid field content: Yes or No

ParentGrantAid InArgument<String> No Specify the Parent's Grant/Schol-
arship Aid using a VB expression
or variable.
Valid field content: 0000000 to
9999999

ParentGross InArgument<String> No Specify the Parent's Adjusted
Gross Income using a
VB expression or variable.
Valid field content: 0000000 to
9999999

ParentIncomeTax InArgument<String> No Specify the Parent's U.S. Income
Tax Paid using a VB expression or
variable.
Valid field content: 0000000 to
9999999
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Property Value Required Notes

ParentInterestIncome InArgument<String> No Specify the Parent's Interest
Income using a VB expression or
variable.
Valid field content: 0000000 to
9999999

ParentIRADistributions InArgument<String> No Specify the Parent's IRA Dis-
tributions using a VB expression or
variable.
Valid field content: 0000000 to
9999999

ParentIRAPayments InArgument<String> No Specify the Parent's IRA Payments
using a VB expression or variable.
Valid field content: 0000000 to
9999999

ParentMilitaryAllowance InArgument<String> No Specify the Parent's Military/Clergy
Allowances using a VB expression
or variable.
Valid field content: 0000000 to
9999999

ParentNeedBased
Employment

InArgument<String> No Specify the Parent's Need-Based
Employment using a
VB expression or variable.
Valid field content: 0000000 to
9999999

ParentNumCollege InArgument<String> No Specify the Parent's Number in Col-
lege using a VB expression or vari-
able.
Valid field content: 0 to 9

ParentNumFamily InArgument<String> No Specify the Parent's Number of
Family Members using a
VB expression or variable.
Valid field content: 00 to 99

Par-
entOtherUntaxedIncome

InArgument<String> No Specify the Parent's Other
Untaxed Income using a
VB expression or variable.
Valid field content: 0000000 to
9999999
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Property Value Required Notes

ParentPensionPayments InArgument<String> No Specify the Parent's Pension Pay-
ments using a VB expression or
variable.
Valid field content: 0000000 to
9999999

ParentTaxFiled InArgument<String> No Specify the Parent's Tax Return
Filed status using a VB expression
or variable.
Valid field content: 1, 2, or 3
Where:
1 = Already completed
2 = Will file
3 = Will not file

ParentTaxFormType InArgument<String> No Specify the Parent's Type of Tax
Form Used using a VB expression
or variable.
Valid field content: 1, 2, 3, or 4.
Where:
1 = IRS 1040
2 = IRS 1040A or 1040 EZ
3 = Foreign tax return
4 = Tax return from Puerto Rico, a
U.S. territory, or freely associated
state

ParentUntaxedPension InArgument<String> No Specify the Parent's Untaxed Pen-
sions using a VB expression or vari-
able.
Valid field content: 0000000 to
9999999

ParentVetNonEducation
Benefits

InArgument<String> No Specify the Parent's Veterans Non-
education Benefits using a
VB expression or variable.
Valid field content: 0000000 to
9999999

SignedByFlag InArgument<String> No Specify the Signed By Flag using a
VB expression or variable.
Valid field content: 

SpouseIncome InArgument<String> No Specify the Spouse's Income
Earned FromWork using a
VB expression or variable.
Valid field content: -9999999 to
9999999
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Property Value Required Notes

StudChildSupportPaid InArgument<String> No Specify the Student's Child Sup-
port Paid using a VB expression or
variable
Valid field content: 0000000 to
9999999

StudChildSupportReceive InArgument<String> No Specify the Student's Child Sup-
port Received using a
VB expression or variable.
Valid field content: 0000000 to
9999999

StudCombatPay InArgument<String> No Specify the Student's Combat Pay
using a VB expression or variable.
Valid field content: 0000000 to
9999999

StudCoOpEarning InArgument<String> No Specify the Student's Co-op Earn-
ing Pay using a VB expression or
variable.
Valid field content: 0000000 to
9999999

StudEducationCredits InArgument<String> No Specify the Student's Educational
Credits using a VB expression or
variable.
Valid field content: 0000000 to
9999999

StudentFoodStamps InArgument<String> No Specify whether the Student Sup-
plemental Nutrition Assistance Pro-
gram (SNAP) applies.
Valid field content: 1 or 2
Where:
1 = Yes
2 = No

StudentGross InArgument<String> No Specify the Student's Adjusted
Gross Income using a
VB expression or variable.
Valid field content: 0000000 to
9999999

StudentIncome InArgument<String> No Specify the Student's Income
Earned FromWork using a
VB expression or variable.
Valid field content: 0000000 to
9999999
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Property Value Required Notes

StudentIncomeTax InArgument<String> No Specify the Student's U.S. Income
Tax Paid using a VB expression or
variable.
Valid field content: 0000000 to
9999999

StudentNumCollege InArgument<String> No Specify the Student's Number in
College using a VB expression or
variable.
Valid field content: 1 to 9

StudentNumFamily InArgument<String> No Specify the Student's Number of
Family Members using a
VB expression or variable.
Valid field content: 1 to 9

StudentTaxFiled InArgument<String> No Specify the Student's Tax Return
Filed status using a VB expression
or variable.
Valid field content: 1, 2, or 3
Where:
1 = Already completed
2 = Will file
3 = Will not file

StudentTaxFormType InArgument<String> No Specify the Student's Type of 2014
Tax Form Used using a
VB expression or variable
Valid field content: 1, 2, 3, or 4.
Where:
1 = IRS 1040
2 = IRS 1040A or 1040 EZ
3 = Foreign tax return
4 = Tax return from Puerto Rico, a
U.S. territory, or freely associated
state

StudentTaxFormType
TaxReturnDate

InArgument<String> No Specify whether the Student Tax
Return was Signed and Dated.
Valid field content: Y or N
Where:
Y = Yes
N = No

Note: This property is required if
the StudentTaxFormType property
is populated.
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Property Value Required Notes

StudGrantAid InArgument<String> No Specify the Student's Grant/Schol-
arship Aid using a VB expression
or variable.
Valid field content: 0000000 to
9999999

StudInterestIncome InArgument<String> No Specify the Student's Interest
Income using a VB expression or
variable.
Valid field content: 0000000 to
9999999

StudIraDistributions InArgument<String> No Specify the Student's IRA Dis-
tributions using a VB expression or
variable.
Valid field content: 0000000 to
9999999

StudIraPayments InArgument<String> No Specify the Student's IRA Pay-
ments using a VB expression or
variable.
Valid field content: 0000000 to
9999999

StudMilitaryAllowance InArgument<String> No Specify the Student's Mil-
itary/Clergy Allowances using a
VB expression or variable.
Valid field content: 0000000 to
9999999

StudNeedBased
Employment

InArgument<String> No Specify the Student's Need-Based
Employment using a
VB expression or variable.
Valid field content: 0000000 to
9999999

StudOtherNonReported
MoneyReceived

InArgument<String> No Specify the Student's Other Non-
Reported Money using a
VB expression or variable.
Valid field content: 0000000 to
9999999

StudOtherUntaxedIncome InArgument<String> No Specify the Student's Other
Untaxed Income using a
VB expression or variable.
Valid field content: 0000000 to
9999999
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Property Value Required Notes

StudPensionPayments InArgument<String> No Specify the Student's Pension Pay-
ments using a VB expression or
variable.
Valid field content: 0000000 to
9999999

StudUntaxedPension InArgument<String> No Specify the Student's Untaxed Pen-
sions using a VB expression or vari-
able.
Valid field content: 0000000 to
9999999

StudVetNonEducation
Benefits

InArgument<String> No Specify the Student's Veterans
Noneducation Benefits using a
VB expression or variable.
Valid field content: 0000000 to
9999999

ValidationMessages InOutArgument
<Val-
idationMessageCollection>

No Specify a variable that can be used
to capture validation messages.
For more information, see Capture
Validation Errors.

UpdateISIRVerificationDependent Example

The UpdateISIRVerificationDependent activity can be used in a workflow sequence as follows:

1. Optional: Insert a WriteLine activity to mark the beginning of the sequence with a Text field similar to the
following:

"START THE WORKFLOW"

2. Insert an Assign activity to assign a value to a string variable named "studentid".

The "studentid" value (e.g., "3400035") could be retrieved from a form created in Forms Builder.

3. Insert an Assign activity to assign a value to a string variable named "awardyear".

The "awardyear" value (e.g., "2016-17") could be retrieved from a form created in Forms Builder.

4. Insert an ExecuteDataReader activity to query the database for the social security number associated
with the student identifier.

The CommandText for the query could be similar to the following:

"SELECT SSN FROM SyStudent where SyStudentId=" + studentid

5. In the ExecuteDataReader activity, insert a Sequence that contains two Assign activities.
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l In the first Assign activity, assign the value CurrentRow("ssn").ToString() to a string variable
named "ssn".

l In the second Assign activity, assign the value ssn.Replace("-", "") to the "ssn" variable.

This assignment replaces the "-" characters is the ssn value.

6. Insert an Assign activity that assigns an SQL statement to a string variable named "sqlGetTranId".

The SQL statement could be similar to the following:

"SELECT TOP 1 TransactionId FROM FaISIRAllvw WHERE CurrentSSN= " + ssn + " AND
AwardYear='" + awardyear + "' ORDER BY TransactionId DESC"

7. Insert another ExecuteDataReader activity to retrieve a value for the transaction identifier.

The CommandText could be similar to the following:

sqlGetTranId

8. In the ExecuteDataReader activity, insert an Assign activity that assigns the value CurrentRow("Trans-
actionId").ToString() to a string variable named "TransId".

9. Insert a LookupIsir activity. Specify a variable named "isir" as the out argument.

Use the following input variables:

l "awardyear" (assigned in step 3)
l "ssn" (assigned in step 5)
l "TranId" (assigned in step 8)

10. Insert the UpdateISIRVerificationDependent activity.

l Specify a variable named "i" as the out argument.
l Specify the variable "awardyear" in the AwardYear property.
l Specify the following expression in the IsirMainId property: Cint(isir.IsirSummaryId). This
expression converts the ISIR Main Id to an integer.

l Specify any other applicable properties.

11. Insert an If activity with the following Condition:

i.Length > 0

This condition checks if any IsirVerificationEntity values were returned by the UpdateISIRVeri-
ficationDependent activity.

12. In the Then branch of the If activity, insert a ForEach activity with the following properties:

TypeArgument: Cmc.Nexus.FinancialAid.Entities.IsirVerificationEntity

Values: i

13. In the ForEach activity, insert a WriteLine activity with the following text:
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"OUTPUT: " + " ISIRMAIN ID: " + item.IsirSummaryId.ToString + " FIELD NUMBER: " +
item.FieldNumber + " NEW VALUE: " + item.NewValue

The following steps capture errors in the workflow.

14. Insert an If activity with the following Condition:

v.HasErrors

Where "v" is a variable of type ValidationMessageCollection.

15. In the Then branch of the If activity, insert a ForEach activity with the following properties:

TypeArgument: Cmc.Core.Eventing.ValidationMessage

Values: v

16. Add a sequence into the ForEach activity and insert the following activities into the sequence:

l LogLinewith the following Text: Environment.NewLine &"ERROR VALIDATION: " &
item.Message

l WriteLine with the following Text: Environment.NewLine &"ERROR VALIDATION: " &
item.Message

17. In the Else branch of the If activity, insert a WriteLine activity with the text: "NO ERROR"

18. Optional: Add a final WriteLine activity to the workflow with the following text: "END WORKFLOW"

The following image summarizes the Variables used in the workflow:

The following image shows the Arguments associated with the workflow:
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UpdateISIRVerificationIndependent

The UpdateISIRVerificationIndependent activity is used to submit ISIR verification data for an independent stu-
dent. For a given award year, the activity captures the independent student verification data.

The activity will only save the data submitted by the student in Anthology Student. The Financial Aid staff at the
institution will be responsible for performing the manual ISIR verification process.

When the UpdateISIRVerificationIndependent activity is executed, the following occurs:

l The verification values are updated in Anthology Student. If corrections are pending, the update of values
is not allowed.

l Field codes (SAR) are identified based on the award year schema.

l The values for each field are validated (compared with default values on the schema).

l After all validations have passed, the faisirverification table is updated accordingly.

l The updated values are displayed on the ISIR verification form in Anthology Student.

See UpdateISIRVerificationIndependent Example for an example of how this activity can be integrated in a work-
flow.
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Properties

Property Value Required Notes

AwardYear InArgument<String> Yes Specify the Award Year using a
VB expression or variable.
Format: “XXXX-XX”. Example:
“2015-16”.

DisplayName String No Specify a name for the activity or
accept the default.

HighSchoolCom-
pletionStatus

InArgument<String> No Specify the High School Com-
pletion Status using a
VB expression or variable.
Valid field content: “True” or
“False”

Note: Inserts or updates to this
field are allowed only if the stu-
dent belongs to Verification
Group V4 or V5. Otherwise, the
workflow returns the error "Stu-
dent does not belong to a valid
Verification Group (V4 or V5).”

IdentityStatement
EducationalPurpose

InArgument<String> No Specify the Identity/Statement of
Educational Purpose using a
VB expression or variable.
Valid field content: “True” or
“False”

Note: Inserts or updates to this
field are allowed only if the stu-
dent belongs to Verification
Group V4 or V5. Otherwise, the
workflow returns the error "Stu-
dent does not belong to a valid
Verification Group (V4 or V5).”

IsirMainId InArgument<Int32> Yes Specify the ISIR Main Id using a
VB expression or variable.

UpdateISIRVerificationIndependent Properties
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Property Value Required Notes

IsirVerification OutArgument
<IsirVerificationEntity[]>

Yes The UpdateISIRVeri-
ficationIndependent activity
returns an array of
ISIR Verification values asso-
ciated with the Award Year and
ISIR Identification.

This is a variable that can be
used as input for subsequent
activities in the workflow. Specify
the variable's name, type, and
scope (and default if applicable)
in the Variables pane of the
Designer window.

To identify the variable type, in
the Variable type field of the Vari-
ables pane, select Array of [T].
In the 'Select Types' window,
select Browse for Types, and
click OK. In the 'Browse and
Select a .NET Type' window,
navigate to Cmc.Nex-
us.FinancialAid.Entities, select
IsirVerificationEntity, and click
OK.

See IsirVerificationEntity Class
in the Anthology Student Object
Library.

OutputMessage OutArgument<String> No Specify the Output Message
using a VB expression or vari-
able.

SpouseIncome InArgument<String> No Specify the Spouse's Income
Earned FromWork using a
VB expression or variable.
Valid field content: -9999999 to
9999999

StudChildSupportPaid InArgument<String> No Specify the Student's Child Sup-
port Paid using a VB expression
or variable
Valid field content: 0000000 to
9999999
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Property Value Required Notes

StudChildSupportReceive InArgument<String> No Specify the Student's Child Sup-
port Received using a
VB expression or variable.
Valid field content: 0000000 to
9999999

StudCombatPay InArgument<String> No Specify the Student's Combat
Pay using a VB expression or
variable.
Valid field content: 0000000 to
9999999

StudCoOpEarning InArgument<String> No Specify the Student's Co-op
Earning Pay using a
VB expression or variable.
Valid field content: 0000000 to
9999999

StudEducationCredits InArgument<String> No Specify the Student's Edu-
cational Credits using a
VB expression or variable.
Valid field content: 0000000 to
9999999

StudentFoodStamps InArgument<String> No Specify whether the Student Sup-
plemental Nutrition Assistance
Program (SNAP) applies.
Valid field content: 1 or 2
Where:
1 = Yes
2 = No

StudentGross InArgument<String> No Specify the Student's Adjusted
Gross Income using a
VB expression or variable.
Valid field content: 0000000 to
9999999

StudentIncome InArgument<String> No Specify the Student's Income
Earned FromWork using a
VB expression or variable.
Valid field content: 0000000 to
9999999

StudentIncomeTax InArgument<String> No Specify the Student's U.S.
Income Tax Paid using a
VB expression or variable.
Valid field content: 0000000 to
9999999
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Property Value Required Notes

StudentNumCollege InArgument<String> No Specify the Student's Number in
College using a VB expression
or variable.
Valid field content: 1 to 9

StudentNumFamily InArgument<String> No Specify the Student's Number of
Family Members using a
VB expression or variable.
Valid field content: 1 to 9

StudentTaxFiled InArgument<String> No Specify the Student's Tax Return
Filed status using a
VB expression or variable.
Valid field content: 1, 2, or 3
Where:
1 = Already completed
2 = Will file
3 = Will not file

StudentTaxFormType InArgument<String> No Specify the Student's Type of
2014 Tax Form Used using a
VB expression or variable.
Valid field content: 1, 2, 3, or 4.
Where:
1 = IRS 1040
2 = IRS 1040A or 1040 EZ
3 = Foreign tax return
4 = Tax return from Puerto Rico,
a U.S. territory, or freely asso-
ciated state

StudentTaxFormType
TaxReturnDate

InArgument<String> No Specify whether the Student Tax
Return was Signed and Dated.
Valid field content: Y or N
Where:
Y = Yes
N = No

Note: This property is required if
the StudentTaxFormType prop-
erty is populated.

StudGrantAid InArgument<String> No Specify the Student's
Grant/Scholarship Aid using a
VB expression or variable.
Valid field content: 0000000 to
9999999
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Property Value Required Notes

StudInterestIncome InArgument<String> No Specify the Student's Interest
Income using a VB expression
or variable.
Valid field content: 0000000 to
9999999

StudIraDistributions InArgument<String> No Specify the Student's IRA Dis-
tributions using a VB expression
or variable.
Valid field content: 0000000 to
9999999

StudIraPayments InArgument<String> No Specify the Student's IRA Pay-
ments using a VB expression or
variable.
Valid field content: 0000000 to
9999999

StudMilitaryAllowance InArgument<String> No Specify the Student's Mil-
itary/Clergy Allowances using a
VB expression or variable.
Valid field content: 0000000 to
9999999

StudNeedBasedEm-
ployment

InArgument<String> No Specify the Student's Need-
Based Employment using a
VB expression or variable.
Valid field content: 0000000 to
9999999

StudOtherNonReported
MoneyReceived

InArgument<String> No Specify the Student's Other Non-
Reported Money using a
VB expression or variable.
Valid field content: 0000000 to
9999999

StudOtherUntaxedIncome InArgument<String> No Specify the Student's Other
Untaxed Income using a
VB expression or variable.
Valid field content: 0000000 to
9999999

StudPensionPayments InArgument<String> No Specify the Student's Pension
Payments using a
VB expression or variable.
Valid field content: 0000000 to
9999999
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Property Value Required Notes

StudUntaxedPension InArgument<String> No Specify the Student's Untaxed
Pensions using a VB expression
or variable.
Valid field content: 0000000 to
9999999

StudVetNonE-
ducationBenefits

InArgument<String> No Specify the Student's Veterans
Noneducation Benefits using a
VB expression or variable.
Valid field content: 0000000 to
9999999

ValidationMessages InOutArgument
<Val-
idationMessageCollection>

No Specify a variable that can be
used to capture validation mes-
sages. For more information,
see Capture Validation Errors.

UpdateISIRVerificationIndependent Example

The UpdateISIRVerificationIndependent activity can be used in a workflow sequence as follows:

1. Optional: Insert a WriteLine activity to mark the beginning of the sequence with a Text field similar to the
following:

"START THE WORKFLOW"

2. Insert an Assign activity to assign a value to a string variable named "studentid".

The "studentid" value (e.g., "3400035") could be retrieved from a form created in Forms Builder.

3. Insert an Assign activity to assign a value to a string variable named "awardyear".

The "awardyear" value (e.g., "2016-17") could be retrieved from a form created in Forms Builder.

4. Insert an ExecuteDataReader activity to query the database for the social security number associated
with the student identifier.

The CommandText for the query could be similar to the following:

"SELECT SSN FROM SyStudent where SyStudentId=" + studentid

5. In the ExecuteDataReader activity, insert a Sequence that contains two Assign activities.

l In the first Assign activity, assign the value CurrentRow("ssn").ToString() to a string variable
named "ssn".

l In the second Assign activity, assign the value ssn.Replace("-", "") to the "ssn" variable.

This assignment replaces the "-" characters is the ssn value.

6. Insert an Assign activity that assigns an SQL statement to a string variable named "sqlGetTranId".
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The SQL statement could be similar to the following:

"SELECT TOP 1 TransactionId FROM FaISIRAllvw WHERE CurrentSSN= " + ssn + " AND
AwardYear='" + awardyear + "' ORDER BY TransactionId DESC"

7. Insert another ExecuteDataReader activity to retrieve a value for the transaction identifier.

The CommandText could be similar to the following:

sqlGetTranId

8. In the ExecuteDataReader activity, insert an Assign activity that assigns the value CurrentRow("Trans-
actionId").ToString() to a string variable named "TransId".

9. Insert a LookupIsir activity. Specify a variable named "isir" as the out argument.

Use the following input variables:

l "awardyear" (assigned in step 3)
l "ssn" (assigned in step 5)
l "TranId" (assigned in step 8)

10. Insert the UpdateISIRVerificationIndependent activity.

l Specify a variable named "i" as the out argument.
l Specify the variable "awardyear" in the AwardYear property.
l Specify the following expression in the IsirMainId property: Cint(isir.IsirSummaryId). This
expression converts the ISIR Main Id to an integer.

l Specify any other applicable properties.

11. Insert an If activity with the following Condition:

i.Length > 0

This condition checks if any IsirVerificationEntity values were returned by the UpdateISIRVeri-
ficationIndependent activity.

12. In the Then branch of the If activity, insert a ForEach activity with the following properties:

TypeArgument: Cmc.Nexus.FinancialAid.Entities.IsirVerificationEntity

Values: i

13. In the ForEach activity, insert a WriteLine activity with the following text:

"OUTPUT: " + " ISIRMAIN ID: " + item.IsirSummaryId.ToString + " FIELD NUMBER: " +
item.FieldNumber + " NEW VALUE: " + item.NewValue

The following steps capture errors in the workflow.

14. Insert an If activity with the following Condition:

v.HasErrors

Where "v" is a variable of type ValidationMessageCollection.
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15. In the Then branch of the If activity, insert a ForEach activity with the following properties:

TypeArgument: Cmc.Core.Eventing.ValidationMessage

Values: v

16. Add a sequence into the ForEach activity and insert the following activities into the sequence:

l LogLinewith the following Text: Environment.NewLine &"ERROR VALIDATION: " &
item.Message

l WriteLine with the following Text: Environment.NewLine &"ERROR VALIDATION: " &
item.Message

17. In the Else branch of the If activity, insert a WriteLine activity with the text: "NO ERROR"

18. Optional: Add a final WriteLine activity to the workflow with the following text: "END WORKFLOW"

The following image summarizes the Variables used in the workflow:

The following image shows the Arguments associated with the workflow:
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Cmc.Nexus.FormsBuilder.Workflow

Workflows created by Forms Builder version 3.x or later use workflow activities from the Cmc.Nex-
us.FormsBuilder.Workflow namespace. Please refer to Forms Builder help for information about these activ-
ities.

https://help.campusmanagement.com/FB/3.x/Content/Workflow/WorkflowActivities.htm
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Cmc.Nexus.StudentAccounts.Workflow

CreateCharge (V2)

Use the CreateCharge activity to post a Charge to an account associated with a Student Id.

The Charge (StudentAccountTransactionEntity) is the output of the workflow activity. You specify input prop-
erties such as Charge Code, Transaction Type, Student or Prospect Id, Transaction Date, Post Date, Description,
Student Enrollment Period, and Reference.

You can use this activity to automate the process of posting charges when a condition that you create is true. A
condition could be, for example, a change in enrollment, a grade change, or any other applicable event.

This activity creates an instance of a Charge; it does not save it to the database. To persist the Charge in the
database, insert a SaveCharge (V2) activity.



Workflow Version 4.0.1 282 Help Guide

Properties

Property Value Required Notes

Amount InArgument<Decimal> Yes Specify the charge amount, for
example, 98.50d.

Campus InArgument<Int32> Yes Specify the Campus Id using a
VB expression or variable.

Charge OutArgument
<Stu-
dentAccountTransactionEntity>

Yes The Charge that is posted to the
account. This is a variable that can be
used as input for subsequent workflow
activities.

To identify the variable type, in the
Variable type field of the Variables
pane, select Browse for Types.... In
the 'Browse and Select a .NET Type'
window, navigate to Cmc.Nex-
us.StudentAccounts.Contracts
> Cmc.Nexus.StudentAccounts.Enti-
ties, select Stu-
dentAccountTransactionEntity, and
click OK.

See Stu-
dentAccountTransactionEntity Class
in the Anthology Student Object
Library.

Charge Code InArgument<String> Yes Select a value in the drop-down list of
the activity in the Designer window.

Description InArgument<String> Yes Specify a description of the Charge
using a string, for example, "Activ-
ity fee".

DisplayName String No Specify a name for the activity or
accept the default.

Enrollment Perio-
d

InArgument<Int32> No Specify the student enrollment period
to which the Charge applies using a
VB expression, for example,
entity.Id.

Post Date InArgument<DateTime> Yes Specify the date when the Charge is
posted using a VB expression, for
example, DateTime.Now.

CreateCharge Properties
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Property Value Required Notes

Prospect OutArgument<Int32> No Specify the Prospect Id using a
VB expression or variable, for
example, entity.Id.

Reference InArgument<String> No Specify a reference for the Charge
using a string, for example, "Engin-
eering Lab".

Student InArgument<Int32> Yes Specify the Student Id using a VB
expression, for example, entity.Id.

Term InArgument<Nullable<Int32>> No Specify the Term Id using a
VB expression or variable.

Transaction Date InArgument<DateTime> Yes Specify the transaction date using a
VB expression, for example,
DateTime.Now.

Transaction Type InArgument<String> Yes Select a value in the drop-down list of
the activity in the Designer window.

SaveCharge (V2)

Use the SaveCharge activity to save a charge transaction and display a validation message.
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Properties

Property Value Required Notes

Charge Trans-
action

InOutArgument
<Stu-
dentAccountTransactionEntity>

Yes The Student Account charge trans-
action returned by the activity. This is
a variable that can be used as input
for subsequent activities in the work-
flow. Specify the variable's name,
type, and scope (and default if applic-
able) in the Variables pane of the
Designer window.

To identify the variable type, in the
Variable type field of the Variables
pane, select Browse for Types.... In
the 'Browse and Select a .NET Type'
window, navigate to Cmc.Nex-
us.StudentAccounts.Contracts
> Cmc.Nexus.StudentAccounts.Ent-
ities, select Stu-
dentAccountTransactionEntity, and
click OK.

See Stu-
dentAccountTransactionEntity Class
in the Anthology Student Object
Library.

DisplayName String No Specify a name for the activity or
accept the default.

Val-
idationMessages

InOutArgument
<ValidationMessageCollection>

No Specify a variable that can be used to
capture validation messages. For
more information, see Capture Val-
idation Errors.

SaveCharge Properties
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Cmc.Nexus.StudentServices.Workflow

CreateStudentDisabilityDetail (V2)

The CreateStudentDisabilityDetail activity creates an instance of a Student Disability Service record that can be
passed to a SaveStudentDisabilityDetail (V2) activity.

Use Cases

l A workflow adds a disability service to a student enrolled in a term when the student selects a service
available in Anthology Student from a Forms Builder form.

l A workflow adds a disability service record when the Disability Status is changed in the Student Master
form in Anthology Student.
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Properties

Property Value Required Notes

Disability Status Id InArgument<Int32> Yes Select a value in the drop-down list of
the activity in the Designer window.

CreateStudentDisabilityDetail Properties



Workflow Version 4.0.1 287 Help Guide

Property Value Required Notes

Disability Type Ids InArgument<String> Yes Select one or more values in the
drop-down list of the activity in the
Designer window.

Disabled? InArgument<Boolean> Yes Select a value in the drop-down list of
the activity in the Designer window.
The default value is No.

DisplayName String No Specify a name for the activity or
accept the default.

Note InArgument<String> No Specify a comment if applicable.

Priority Registration? InAr-
gument<Nullable<Boolean>>

No A Boolean expression that specifies
whether Priority Registration is
required. The default value is null.

Registration Assist-
ance?

InAr-
gument<Nullable<Boolean>>

No A Boolean expression that specifies
whether Registration Assistance is
required. The default value is null.

Stu-
dentDisabilityDetail

OutArgument
<Stu-
dentDisabilityDetailEntity>

Yes The Student Disability Detail value
returned by the activity. This is a vari-
able that can be used as input for sub-
sequent activities in the workflow.
Specify the variable's name, type,
and scope (and default if applicable)
in the Variables pane of the Designer
window.

To identify the variable type, in the
Variable type field of the Variables
pane, select Browse for Types.... In
the 'Browse and Select a .NET Type'
window, navigate to Cmc.Nex-
us.StudentServices.Contracts
> Cmc.Nexus.StudentService.Entiti-
es, select Stu-
dentDisabilityDetailEntity and click
OK.

See StudentDisabilityDetailEntity
Class in the Anthology Student
Object Library.

Student Id InArgument<Int32> Yes Specify a Student Id using a VB
expression or variable.
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CreateStudentServiceType

Anthology Student enables users to configure non-academic, optionally billable, services for students. These ser-
vices are associated with configurable service categories, for example, housing, meal plans, and so on. For bil-
lable school services that are not included in those provided by Anthology Student, users can add School-
Defined Services and then create and associate Custom Fields with a Student Service. Anthology Student stores
values entered in the Custom Fields on each instance of a service per student.

You can use the CreateStudentServiceType activity to create an instance of a Student Service Type record when
a specific event occurs and pass it to a SaveStudentServiceType activity to persist the record in the database.

Example

From the Student Portal, a form sequence is created to add a meal plan. A student logs into the portal and clicks
the link to add a meal plan. The first form verifies the student's current basic information (e.g., name, email).
The student clicks Next, the form raises an event, and a workflow retrieves and displays the meal plan options.
The student chooses a meal plan and the form raises another event. The workflow adds the service to the stu-
dent record.
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Properties

Property Value Required Notes

DisplayName String No Specify a name for the activity or
accept the default.

Enrollment Id InArgument<Int32> Yes Specify the Enrollment Id using a
VB expression or variable.

CreateStudentServiceType Properties
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Property Value Required Notes

Service Id InArgument<Int32> Yes Specify the Service Id using a
VB expression or variable.

Note: You can use a Look-
upServiceType activity to retrieve a Ser-
vice Type Id.

Student Id InArgument<Int32> Yes Specify the Student Id using a
VB expression or variable.

Student Service
Association Id

InArgument<Int32> Conditional If Custom Fields are defined for student
services at your institution, specify the
Student Service Association Id using a
VB expression or variable.

The values are stored in the table:
SsStu-
dentServiceCustomFieldAssociation.
The entity name is Ser-
viceTypeCustomFieldEntity.

You can use a ForEach<> activity to
capture the values of the Ser-
viceTypeCustomFieldEntity.
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Property Value Required Notes

Student Service
Type

OutArgument
<StudentServiceTypeEntity>

Yes The Student Service Type value
returned by the activity. This is a vari-
able that can be used as input for sub-
sequent activities in the workflow.
Specify the variable's name, type, and
scope (and default if applicable) in the
Variables pane of the Designer win-
dow.

To identify the variable type, in the Vari-
able type field of the Variables pane,
select Browse for Types.... In the
'Browse and Select a .NET Type' win-
dow, navigate to Cmc.Nex-
us.StudentServices.Contracts
> Cmc.Nexus.StudentService.Entities
, select StudentServiceTypeEntity,
and click OK.

See StudentServiceTypeEntity Class in
the Anthology Student Object Library.

Term Id InArgument<Int32> Yes Specify the Term Id using a
VB expression or variable.

Val-
idationMessages

OutArgument
<Val-
idationMessageCollection>

No Specify a variable that can be used to
capture validation messages. For more
information, see Capture Validation
Errors.

CreateStudentSportsService (V2)

The CreateStudentSportsService activity creates an instance of a Student Sports Service record that can be
passed to a SaveStudentSportsService (V2) activity.

Use Cases

l A workflow adds a sports service to a student enrolled in a term when the student selects a service avail-
able in Anthology Student from a Forms Builder form.

l A workflow adds a sports service record when a student is added to a sport group in Anthology Student.
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Properties

Property Value Required Notes

AthleticIdentifier InArgument<String> No * Specify the Athletic Identifier using a
VB expression or variable.

If the Athletic Identifier is not supplied,
the CreateStudentSportsService activ-
ity will look up if one exists in the
SyStudent table for that student.

* The Athletic Identifier is required if it
has not already been defined.

AthleticStatusId InArgument<Int32> Yes Select a value in the drop-down list of
the activity in the Designer window.

DisplayName String No Specify a name for the activity or
accept the default.

RecruitmentTypeId InArgument<Int32> Yes Select a value in the drop-down list of
the activity in the Designer window.

RemainingEligibility InArgument<Int32> Yes Specify the Remaining Eligibility using
a VB expression or variable.

SportId InArgument<Int32> Yes Select a value in the drop-down list of
the activity in the Designer window.

CreateStudentSportsService Properties
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Property Value Required Notes

Stu-
dentAthleticDetail

OutArgument
<Stu-
dentAthleticDetailEntity>

Yes The Student Athletic Detail value
returned by the activity. This is a vari-
able that can be used as input for sub-
sequent activities in the workflow.
Specify the variable's name, type, and
scope (and default if applicable) in the
Variables pane of the Designer win-
dow.

To identify the variable type, in the
Variable type field of the Variables
pane, select Browse for Types.... In
the 'Browse and Select a .NET Type'
window, navigate to Cmc.Nex-
us.StudentServices.Contracts
> Cmc.Nexus.StudentServices.Entiti-
es, select StudentAthleticDetailEntity
and click OK.

See StudentAthleticDetailEntity Class
in the Anthology Student Object
Library.

StudentId InArgument<Int32> Yes Specify a Student Id using a
VB expression or variable.

TermId InArgument<Int32> Yes Specify the Term Id using a
VB expression or variable.

CreateStudentVeteranDetail (V2)

The CreateStudentVeteranDetail activity creates an instance of a Student Veteran Service record that can be
passed to a SaveStudentVeteranDetail (V2) activity.

Use Cases

l A workflow adds a veteran service to a student enrolled in a term when the student selects a service avail-
able in Anthology Student from a Forms Builder form.

l A workflow adds a veteran service record when the Veteran Status is changed in the Student Master form
in Anthology Student.
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Properties

Property Value Required Notes

DisplayName String No Specify a name for the activity or accept
the default.

Last Certified
Term

InArgument<Nullable<Int32>> No A Boolean expression that specifies the
Last Certified Term. The default value is
null.

CreateStudentVeteranDetail Properties
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Property Value Required Notes

Student Vet-
eran Detail

OutArgument
<StudentVeteranDetailEntity>

Yes The Student Veteran Detail value
returned by the activity. This is a variable
that can be used as input for subsequent
activities in the workflow. Specify the vari-
able's name, type, and scope (and default
if applicable) in the Variables pane of the
Designer window.

To identify the variable type, in the Vari-
able type field of the Variables pane,
select Browse for Types.... In the
'Browse and Select a .NET Type' window,
navigate to Cmc.Nex-
us.StudentServices.Contracts
> Cmc.Nexus.StudentServices.Entities,
select StudentVeteranDetailEntity and
click OK.

See StudentVeteranDetailEntity Class in
the Anthology Student Object Library.

StudentId InArgument<Int32> Yes Specify a Student Id using a
VB expression or variable.

Veteran Bene-
fits

InArgument<Int32> Yes Select one or more values in the drop-
down list of the activity in the Designer
window.

Veteran Cer-
tification Type

InArgument<Nullable<Int32>> No A Boolean expression that specifies a Vet-
eran Certification Type. The default value
is null.

Veteran Types InArgument<String> Yes Select one or more values in the drop-
down list of the activity in the Designer
window.
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LookupServiceType

The LookupServiceType activity is a lookup function that returns the ServiceTypeEntity from the SsService table
within the Anthology Student database. Examples of student service types are parking passes, private tutoring,
season tickets to a sporting event, meal plans, and so on. The ServiceTypeEntity can be used as input for the
CreateStudentServiceType activity.

If CustomFields exist for the ServiceTypeEntity, the LookupServiceType activity can return the values of the Cus-
tomFields collection from the SsStudentServiceCustomField table in Anthology Student database. See Ser-
viceTypeCustomFieldsEntity Class in the Anthology Student Object Library.

In the example below, the condition ServType.CustomFields.Count > 0 checks for CustomFields. If Cus-
tom Fields are found, the ForEach<> activity checks each field in the ServiceTypeCustomFieldsEntity. The sub-
sequent LogLine activity captures the values of the CustomFields collection.
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Properties

Property Value Required Notes

DisplayName String No Specify a name for the activity or
accept the default.

LookupServiceType Properties
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Property Value Required Notes

ServiceType OutAr-
gument<ServiceTypeEntity>

Yes The ServiceTypeEntity returned by
the lookup function. This is a variable
that can be used as input for sub-
sequent activities in the workflow. Spe-
cify the variable's name, type, and
scope (and default if applicable) in the
Variables pane of the Designer win-
dow.

To identify the variable type, in the
Variable type field of the Variables
pane, select Browse for Types.... In
the 'Browse and Select a .NET Type'
window, navigate to Cmc.Nex-
us.StudentServices.Contracts
> Cmc.Nexus.StudentServices.Entiti-
es, select ServiceTypeEntity and
click OK.

See ServiceTypeEntity Class in the
Anthology Student Object Library.

ServiceTypeId InArgument<Int32> No The ServiceTypeId captured from an
event.

In this example above, the Ser-
viceTypeId is obtained using a Look-
upReferenceItem activity with a
Reference Item Type selection of "Ser-
vice Type". The variable "Look-
upServType" is assigned to the
LookupReferenceItem OutArgument.
The Id associated the Look-
upServType variable is used as input
for LookupServiceType.

Val-
idationMessages

OutArgument
<Val-
idationMessageCollection>

No Specify a variable that can be used to
capture validation messages. For
more information, see Capture Val-
idation Errors.
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SaveStudentDisabilityDetail (V2)

The SaveStudentDisabilityDetail activity saves a Student Disability Detail record that was created with the
CreateStudentDisabilityDetail (V2) activity.

Note: If a record exists in the SsStudentDisabilityDetail table for the StudentId supplied in the CreateStu-
dentDisabilityDetail activity, the SaveStudentDisabilityDetail activity updates the student's record.

Properties

Property Value Required Notes

DisplayName String No Specify a name for the activity or
accept the default.

SaveStudentDisabilityDetail Properties
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Property Value Required Notes

Stu-
dentDisabilityDetail

InOutArgument
<Stu-
dentDisabilityDetailEntity>

Yes Specify the StudentDisabilityDetail
entity to be saved using a VB expres-
sion or variable.

To identify the variable type, in the
Variable type field of the Variables
pane, select Browse for Types.... In
the 'Browse and Select a .NET Type'
window, navigate to Cmc.Nex-
us.StudentServices.Contracts
> Cmc.Nexus.StudentService.Entiti-
es, select Stu-
dentDisabilityDetailEntity and click
OK.

See StudentDisabilityDetailEntity
Class in the Anthology Student
Object Library.

ValidationMessages InOutArgument
<Val-
idationMessageCollection>

No Specify a variable that can be used to
capture validation messages. For
more information, see Capture Val-
idation Errors.
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SaveStudentServiceType

The SaveStudentServiceType activity saves a Student Service Type record that was created with the CreateStu-
dentServiceType activity.

Properties

Property Value Required Notes

DisplayName String No Specify a name for the activity or
accept the default.

SaveStudentServiceType Properties
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Property Value Required Notes

Stu-
dentServiceType

InOutArgument
<StudentServiceTypeEntity>

Yes The Student Service Type value
returned by the activity. This is a vari-
able that can be used as input for sub-
sequent activities in the workflow.
Specify the variable's name, type, and
scope (and default if applicable) in the
Variables pane of the Designer win-
dow.

To identify the variable type, in the Vari-
able type field of the Variables pane,
select Browse for Types.... In the
'Browse and Select a .NET Type' win-
dow, navigate to Cmc.Nex-
us.StudentServices.Contracts
> Cmc.Nexus.StudentService.Entitie-
s, select StudentServiceTypeEntit
and click OK.

See StudentServiceTypeEntity Class
in the Anthology Student Object
Library.

ValidationMessages InOutArgument
<Val-
idationMessageCollection>

No Specify a variable that can be used to
capture validation messages. For
more information, see Capture Val-
idation Errors.

SaveStudentSportsService (V2)

The SaveStudentSportsService activity saves a Student Sports Service record that was created with the
CreateStudentSportsService (V2) activity.
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Properties

Property Value Required Notes

DisplayName String No Specify a name for the activity or
accept the default.

SaveStudentSportsService Properties
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Property Value Required Notes

Stu-
dentAthleticDetail

InOutArgument
<Stu-
dentAthleticDetailEntity>

Yes Specify the StudentAthleticDetail
entity to be saved using a VB expres-
sion or variable.

To identify the variable type, in the
Variable type field of the Variables
pane, select Browse for Types.... In
the 'Browse and Select a .NET Type'
window, navigate to Cmc.Nex-
us.StudentServices.Contracts
> Cmc.Nexus.StudentServices.Entiti-
es, select
StudentAthleticDetailEntity, and click
OK.

See StudentAthleticDetailEntity Class
in the Anthology Student Object
Library.

ValidationMessages InOutArgument
<Val-
idationMessageCollection>

No Specify a variable that can be used to
capture validation messages. For
more information, see Capture Val-
idation Errors.

SaveStudentVeteranDetail (V2)

The SaveStudentVeteranDetail activity saves a Student Veteran Detail record that was created with the
CreateStudentVeteranDetail (V2) activity.
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Properties

Property Value Required Notes

DisplayName String No Specify a name for the activity or
accept the default.

SaveStudentVeteranDetail Properties
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Property Value Required Notes

Stu-
dentVeteranDetail

InOutArgument
<Stu-
dentVeteranDetailEntity>

Yes Specify the StudentVeteranDetail
entity to be saved using a VB expres-
sion or variable.

To identify the variable type, in the
Variable type field of the Variables
pane, select Browse for Types.... In
the 'Browse and Select a .NET Type'
window, navigate to Cmc.Nex-
us.StudentServices.Contracts
> Cmc.Nexus.StudentServices.Entiti-
es, select Stu-
dentVeteranDetailEntity, and click
OK.

See StudentVeteranDetailEntity Class
in the Anthology Student Object
Library.

ValidationMessages InOutArgument
<Val-
idationMessageCollection>

No Specify a variable that can be used to
capture validation messages. For
more information, see Capture Val-
idation Errors.
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Cmc.Core.Workflow.Activities
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AddToDictionary<>

The AddToDictionary<> activity maps a key type (TKey) to a value type (TValue) in the dictionary. You select the
.NET data type for the TKey and TValue, for example, Int32, String, Boolean, Array, Object, etc.

This workflow example uses the following variable definitions:
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Properties

Property Value Required Notes

Dictionary InArgument<IDictionary<selected
data type,selected data type>>

Yes Specify the Dictionary using a
VB expression or variable. Refer
to the image below for the Vari-
able type selection.

DisplayName String No Specify a name for the activity or
accept the default.

Key InArgument<selected data type> Yes Specify the Key using a
VB expression or variable.

Select the data type when you
add the activity to the workflow.

Value InArgument<selected data type> Yes Specify the Value using a
VB expression or variable.

Select the data type when you
add the activity to the workflow.

AddToDictionary<> Properties

To see how AddToDictionary<> can be used in a workflow, refer to:

l Populate Fields in a Forms Builder Form
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CreateBookmark

The CreateBookmark activity creates a named bookmark in a workflow at the point where the workflow exe-
cution can be resumed at a later time. This activity is used to persist a workflow instance. Once a workflow is
persisted, it can continue execution using the ResumeBookmark activity or the IWork-
flowEngine::ResumeBookmark method in .NET.

Properties

Property Value Required Notes

BookmarkName InArgument<String> Yes Specify the BookmarkName using a
VB expression or variable. More than one book-
mark can be executing at a time; therefore, this
property is used to uniquely identify the book-
mark associated with this activity.

DisplayName String No Specify a name for the activity or accept the
default.

CreateBookmark Properties

https://msdn.microsoft.com/en-us/library/ee149798(v=vs.110).aspx
https://msdn.microsoft.com/en-us/library/ee149798(v=vs.110).aspx
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Property Value Required Notes

Result OutArgument
<IDictionary
<String,Object>>

Yes Specify the Result using a VB expression or vari-
able. The Result value is passed from a call to
ResumeBookmark or IWork-
flowEngine::ResumeBookmark.

The following image shows how to browse and
select the variable type.

To see how CreateBookmark can be used in a workflow, refer to:

l Create a Long Running Workflow
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CreateBookmark<>

The CreateBookmark<> activity creates a named bookmark where the workflow execution can be resumed at a
later time and through which data can be delivered.

The only difference between CreateBookmark and CreateBookmark<> is that CreateBookmark<> allows an
input argument. You select the .NET data type for the input, for example, Int32, String, Boolean, Array, Object,
etc.

Properties

Property Value Required Notes

BookmarkName InArgument<String> Yes Specify the BookmarkName using a
VB expression or variable.

DisplayName String No Specify a name for the activity or accept the
default.

CreateBookmark<> Properties
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Property Value Required Notes

Result OutArgument<selected
data type>

Yes Specify the Result using a VB expression or
variable.

Select the data type when you add the activ-
ity to the workflow.



Workflow Version 4.0.1 315 Help Guide

CreateValidationItem

The CreateValidationItem activity enables you to display a message in the UI when a workflow is executed.

This activity can only be used with Saving events.

If the same event triggers multiple validation items, the validation messages are consolidated in one message
box titled "Custom Validation Message".

Properties

Property Value Required Notes

DisplayName String No Specify a name for the activity or
accept the default.

Message InArgument<String> Yes Specify the text of the validation
message, for example:

"Please enter a mobile
phone number."

CreateValidationItem Properties
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Property Value Required Notes

Messages InArgument
<ICollection<ValidationMessage>>

Yes In the Messages field of the Prop-
erties pane, enter the following
VB code:

args.ValidationMessages

Message Type ValidationMessageType Yes Select a value in the drop-down
list of the activity in the Designer
window. The options are:

l Error
l Information
l Warning

Result OutArgument<ValidationMessage> No If necessary, specify the out argu-
ment using a VB expression or
variable.

To see how CreateValidationItem can be used in a workflow, refer to:

l Custom Field Validations on Each Step of Enrollment Wizard.
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ExecuteDataReader

The ExecuteDataReader activity enables you to create workflows that perform two steps:

1. Execute an SQL query.
2. Execute activities in the query result.

If the query successfully connects to the data source, it queries the database and executes the activities in the
body once per data row returned.

In general, the connection strings used during workflow execution are retrieved from the web.config of
the product that triggers workflow execution.

Only if you want to run a workflow with ExecuteDataReader, ExecuteNonQuery, or ExecuteQuery activ-
ity in test mode using the Run option in Workflow Composer, would you need to manually add the con-
nection string to the Workflow Composer web.config file.
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Properties

Property Value Required Notes

CommandText InArgument<String> Yes Enter a command that specifies the query
to perform on the target data source and
is expected to return a result set.

Note: Supply an SQL query that will only
return one set of rows from one table. Do
not attempt to return multiple sets of data
since this activity will only utilize the first
set of data rows returned.

Example

"Select * from Messages"

CommandTimeout InArgument<Int32> No You can adjust the CommandTimeout
value if the activity needs to execute long-
running SQL statements.  

The default and minimum command
timeout is 30 seconds. The maximum is
1800 (30 minutes).

ConnectionStringName InArgument<String> No Enter the name of a connection string that
has been configured in the CONFIG file of
the host application that is executing the
workflows (see Connection Strings).

If none is specified, this activity attempts
to connect to a connection string named
DbConnection.

Note: Forms Builder 3.6 introduces the
"CrmConnection" string in the web.config
of Forms Renderer (see Renderer Con-
nection Strings). If you have created
workflows with ExecuteDataReader activ-
ities, ensure that connection strings in the
activities match the updated web.config of
Forms Renderer.

DisplayName String No Specify a name for the activity or accept
the default.

ExecuteDataReader Properties

ExecuteDataReader Example 1

This example retrieves rows from the database and writes the results to the console.

https://help.campusmanagement.com/fb/3.x/Content/ConnectionStrings.htm
https://help.campusmanagement.com/fb/3.x/Content/ConnectionStrings.htm
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1. Open a workflow or create a new workflow.

2. Drag the ExecuteDataReader activity into your workflow.

3. Specify the values for the input arguments or map them to workflow variables.

4. Add activities into the body of this activity.
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Tip: The activities in the body of this activity will be executed once per every row returned from the data-
base query.

You can access the data in each row as a variable called CurrentRow.

You can then use the data in each row using the format: CurrentRow(“ColumnName”).

5. Run the workflow.

Result:

The query successfully connects to the data source, queries the database, and executes the activities in
the body once per data row returned.

ExecuteDataReader Example 2

This example retrieves a value from a single row in the database and uses the retrieved value in an assignment
statement.

1. Open a workflow or create a new workflow.

2. Create two variables to hold the query statement and the value retrieved from the database.

l query
l studentIdVar

3. Drag an Assign activity into a sequence.

Assign the following value to a string named query:

“select * from systudent where systudentid = “& studentIdVar

4. Drag the ExecuteDataReader activity into your sequence.



Workflow Version 4.0.1 321 Help Guide

5. In the Query field of the ExecuteDataReader activity, specify query (the name of the string assigned in the
previous step).

6. Drop an Assign activity into the body of the ExecuteDataReader activity.

Assign the following value to a string named First:

CurrentRow("FirstName").toString()

Note:

The data type returned by the query must be specified in the assignment.

l To get a string field value from a database row, the expression.ToString() is needed.

l To get an integer value, the assignment would be like this: Convert.ToInt32(CurrentRow(“dbIn-
tegerField”))

Without the type conversion, the assignment statement fails with the following error:

The following image shows the completed workflow section:
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ExecuteDataReader Example 3

The following example uses the ExecuteDataReader activity in the context of a Forms Builder sequence. The
form sequence prompts the user to enter his/her contact details, select a program, and e-sign an enrollment
agreement.

1. The LookupUser activity captures the UserName from the formInstance.UserName argument and
returns the studentid.

2. The GetEntity activity takes the studentid value and returns the studentEntity value.

3. Two Assign activities associate the student name and address fields of the studentEntity with values
passed from the form sequence via the StudentName and Address arguments.
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4. The third Assign activity associates the DeliveryMethod argument from the form sequence with the Deliv-
eryMethodText variable in the workflow. The variable can be assigned a default string, e.g., "Program is
blended (hybrid) including on-ground and online delivery".

5. The ExecuteDataReader runs the following query on the Anthology Student database to retrieve the
enrollment ID for the student ID:

"select adenrollid from adenroll where systudentid = " & studentid

In Anthology Student, the adenrollid from the AdEnroll table is used as the enrollment identifier if an
applicant record is converted to an enrollment record.

6. The Assign activity within in the ExecuteDataReader assigns the following value to the EnrollID:

DirectCast(CurrentRow("adenrollid"), int32)

7. The GetEntity activity below the ExecuteDataReader uses the EnrollID value to retrieve the Applic-
antEntity.
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8. Next, the workflow retrieves the enrollment agreement document for the student from the database,
presents the document to the student for e-signature, and saves the signed document.

For more examples of workflows with ExecuteDataReader, see:

l Register Students into a Course
l Wake up the Long Running Workflow
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ExecuteNonQuery

The ExecuteNonQuery activity enables you to execute SQL statements that INSERT, UPDATE, or DELETE data in a
given data source. For more information, see ExecuteNonQuery Example.

In general, the connection strings used during workflow execution are retrieved from the web.config of
the product that triggers workflow execution.

Only if you want to run a workflow with ExecuteDataReader, ExecuteNonQuery, or ExecuteQuery activ-
ity in test mode using the Run option in Workflow Composer, would you need to manually add the con-
nection string to the Workflow Composer web.config file.
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Properties

Property Value Required Notes

CommandText InArgument<String> Yes Enter a command that specifies the activ-
ity to perform on the target data source –
and should not be expected to return a
result set. This activity allows commands
that INSERT, UPDATE, or DELETE
records in the target database.

Example

INSERT INTO Messages (Message)
VALUES ('New message added')

CommandTimeout InArgument<Int32> No You can adjust the CommandTimeout
value if the activity needs to execute long-
running SQL statements.  

The default and minimum command
timeout is 30 seconds. The maximum is
1800 (30 minutes).

ConnectionStringName InArgument<String> Yes Enter the name of a connection string that
has been configured in the CONFIG file of
the host application that is executing the
workflows (see Connection Strings).

If none is specified, this activity attempts
to connect to a connection string named
DbConnection.

Note: Forms Builder 3.6 introduces the
"CrmConnection" string in the web.config
of Forms Renderer (see Renderer Con-
nection Strings). If you have created
workflows with ExecuteNonQuery activ-
ities, ensure that connection strings in the
activities match the updated web.config of
Forms Renderer.

DisplayName String No Specify a name for the activity or accept
the default.

ExecuteNonQuery Properties

https://help.campusmanagement.com/fb/3.x/Content/ConnectionStrings.htm
https://help.campusmanagement.com/fb/3.x/Content/ConnectionStrings.htm
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Property Value Required Notes

TotalRowsAffected OutArgument<Int32> Yes The output argument contains the total
number of rows affected by the execution
of the SQL command in the database.

Example

If a DELETE command was entered as
input argument and 12 rows were deleted
from a table, the resulting value is '12'.

ExecuteNonQuery Example

1. Open a workflow or create a new workflow.

2. Drag the ExecuteNonQuery activity into your workflow.

3. Specify the values for the input arguments or map them to workflow variables.

4. Create a workflow variable of data type Int32 that will be mapped to the result of the query execution.

In this example, we created a new variable called RowsAffectedCount.

5. Configure the output argument in the activity named TotalRowsAffected to the new workflow variable
RowsAffectedCount.
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6. Run the workflow.

Result: If the query successfully connects to the data source, it populates your local variable with the total
rows affected by the query.

To see how ExecuteNonQuery can be used in a workflow, refer to:

l Create a Long Running Workflow
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ExecuteODataQuery<>

Prerequisite: When this activity is used with Anthology Student 21.2.0 and later, the APIUser must have
authorization to access to the entity requested in the OData query. For more information, see Security
Enhancement for OData Queries.

The ExecuteODataQuery<> activity returns an OData query against the query model. The result of the OData
query can be used as input for subsequent workflow activities.

The results of the OData query are available in the body of the activity. The results are iterated, and each item
returned is available using the item variable. The ExecuteODataQuery<> is useful when you want to retrieve a
list of students, courses, or any entity, and you want to perform the same activity using each entity returned in
the list.

For example, you could use this activity to:

l Get a class roster for student’s in a class section and send an email to each student.

l Get a list of all student’s in a student group or hold group and charge each one a late fee.

Note: This activity does not return entities. A conversion assignment needs to be made to bind query result to
the entity model. Once bound, the data can be edited. For an example of how to bind OData query results to a
grid in a form sequence, see the Forms Builder help topic Grid Bound to Results of ExecuteODataQuery Activity.

When ExecuteODataQuery<> activity is dropped into the Designer pane, the workflow dialog prompts for the
<TQuery>, which is the model type to query against. The Browse for Type... option must be used to select the
query model type.

All query model types are located in the Cmc.Nexus.Models namespace.

https://help.campusmanagement.com/FB/3.x/Content/Grid_OData.htm
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The model type selected in the Cmc.Nexus.Models namespace must match the primary type for your OData
query. For example, if the primary type in the OData query is <Students>, the TQuery model type must also be
<Students>.

Note: The Cmc.Nexus.Models.{module}.{type} namespace for the selected model type must be available in
Workflow Composer so that the results of the OData query can be assigned. Otherwise an error message will be
displayed. To avoid errors such as “'<entity>' is not defined”, in the body of the ExecuteODataQuery<> activity,
add any activity (e.g., WriteLine or LogLine) with specific value to be written or logged. e.g., item.FirstName (or
whatever is applicable for the OData query). Adding an activity ensures that the Imports required for the selec-
ted namespace are set properly. If you do not include an activity in the body of the ExecuteODataQuery<> activ-
ity, add the required namespace to the Imports tab in Workflow Composer.

To create an OData query, you can use the Web Client for Anthology Student. It is easiest to get the OData query
results in a browser first to verify that the query is valid and that it returns the expected results. Once you have
the desired query and results, paste the query into the QueryText field in the Properties pane of the
ExecuteODataQuery<> activity. Enclose the query string in double quotes.

Example

"http://<localhost>/Cmc.Nexus.Web/ds/campusnexus/Student/Shifts?$orderby=Name"
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Optionally, the query results can also be stored in variables.

l The raw JSON string result is available via the RawODataResults property.

l If the total count of items returned by the query is needed, the ItemCount property can be used.

l The collection of items can be saved to a variable by providing the properly typed variable in the Res-
ultsCollection property.

For the ExecuteODataQuery<Shift> example, the variable type needs to be IEnumerable<Shift>. The vari-
able must have a default value of new List(of cmc.Nexus.Models.Academics.Shift).

To view the query result with the above property settings in the Output pane, insert a WriteLine activity
that displays "Count " & shiftCount.

Navigational properties are also available in the results. For example, if the main query is on the Students type,
the Person navigation property will be available to get the Person. FullName. A requirement for using the
properties is that the OData query must include an $expand parameter to expand the navigation property.

Example
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Query to select the top 10 students and expand the Person property, selecting just the FullName:

http://<studentwebclientbaseurl>/ds/campusnexus/Students?$select=Id&$expand=Person($se-
lect=FullName)&$top=10

Within the workflow, the FullName can be accessed as item.Person.FullName.

Properties

Property Value Required Notes

DisplayName String No Specify a name for the
activity or accept the
default.

ItemCount OutArgument<Int32> No This property can be used
to capture the total count
of items returned by the
query.

QueryText InArgument<String> Yes Specify the OData query
string. Make sure the
string is enclosed in
double quotes.

RawODataResults OutArgument<String> No This property can be used
to provide the raw JSON
string result.

Result OutArgument<TQuery> No This property is not sup-
ported. Please use the
ResultsCollection prop-
erty.

ResultsCollection InOutArgument<IEnumerable<TQuery>> No Use this property to save
the collection of items to a
variable. The variable
type must be IEnu-
merable<TQuery>) and a
default value must be
defined.

ExecuteODataQuery Properties

ExecuteODataQuery<> Example

1. Drag the ExecuteODataQuery<> activity from the “Cmc.Core.Workflow.Activities” namespace into the
Designer pane.

2. Select Browse for Types … in the TQuery drop-down list.
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3. Navigate to the Cmc.Nexus.Models namespace. For this example, we will use the Shift model in the Aca-
demics namespace. Selecting “Shift” means that the OData query will be written using “Shifts” as the
primary model.

4. Click OK to close the Select Types dialog.

5. Paste the OData query into the QueryText field of the Properties pane. Make sure to add the string value
surrounded by double quotes. In our example, the OData query is:

"http://<studentwebclientbaseurl>/ds/campusnexus/Shifts?$orderby=Name"

6. To capture the query results in the Output pane of Workflow Composer, drop a WriteLine activity into
the body of the ExecuteODataQuery<> activity. Specify item.Name in the Text field of the WriteLine activ-
ity.

7. Click . The Name of each shift is written to the Output pane.
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ExecuteQuery

The ExecuteQuery activity enables you to create workflows that perform SQL queries into an ADO.NET data
source to return a result set of data from a given data source.

If the query result is not empty, the workflow can be programmed to iterate over the result set and execute
logic for each data record by using a ForEach<T> activity.

In general, the connection strings used during workflow execution are retrieved from the web.config of
the product that triggers workflow execution.

Only if you want to run a workflow with ExecuteDataReader, ExecuteNonQuery, or ExecuteQuery activ-
ity in test mode using the Run option in Workflow Composer, would you need to manually add the con-
nection string to the Workflow Composer web.config file.

Properties

Property Value Required Notes

CommandText InArgument<String> Yes Enter a command that specifies the query
to perform on the target data source and
is expected to return a result set.

Example:

"Select * from Messages"

ExecuteQuery Properties

http://msdn.microsoft.com/en-us/library/ee855662(v=vs.110).aspx
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Property Value Required Notes

CommandTimeout InArgument<Int32> No You can adjust the CommandTimeout
value if the activity needs to execute long-
running SQL statements.  

The default and minimum command
timeout is 30 seconds. The maximum is
1800 (30 minutes).

ConnectionStringName InArgument<String> Yes Enter the name of a connection string that
has been configured in the CONFIG file of
the host application that is executing the
workflows (see Connection Strings).

If none is specified, this activity attempts
to connect to a connection string named
DbConnection.

Note: Forms Builder 3.6 introduces the
"CrmConnection" string in the web.config
of Forms Renderer (see Renderer Con-
nection Strings). If you have created
workflows with ExecuteQuery activities,
ensure that connection strings in the activ-
ities match the updated web.config of
Forms Renderer.

Data OutArgument<Int32> No The output argument contains the data
returned by the query. It may return one
or more System.Data.DataTable objects
depending on the results of the query exe-
cution.

DisplayName String No Specify a name for the activity or accept
the default.

ExecuteQuery Example 1

1. Open a workflow or create a new workflow.

2. Drag the ExecuteQuery activity into your workflow.

3. Specify the values for the input arguments or map them to workflow variables.

https://help.campusmanagement.com/fb/3.x/Content/ConnectionStrings.htm
https://help.campusmanagement.com/fb/3.x/Content/ConnectionStrings.htm
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4. Create a workflow variable of data type System.Data.DataSet that will be mapped to the OutArgument
of the query.

5. Map the OutArgument named Data to the new workflow variable.

6. Import the following namespaces into the workflow:

l System.Data
l System.Linq.Expression
l System.Xml

These namespaces are needed to allow the ForEach<T> activity to easily iterate over the results in each
System.Data.DataTable object returned.

To import the namespaces:

a. Click the Imports pane in the Workflow Designer.
b. Click on the right side of the "Enter or Select namespace" field.
c. Type the name of the namespace you want to import.
d. Select the namespace and press Enter.
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7. Add a ForEach<T> activity to your workflow.

Configure TypeArgument = System.Data.DataRow.

You can assign the Values variable to each DataTable returned as shown below.

8. Configure the ForEach<T> activity to assign a name to each row as it iterates through the rows returned
from the database.

In the example shown here, each row is assigned the variable name of item. Access the values returned
in each row by using the format: item(“ColumnName”)
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9. Run the workflow.

Result:

l If the query successfully connects to the data source, the activity populates your local variable with
the rows returned by the query.

l The ForEach<T> activity iterates over each row stored in the local variable. It executes the activities
within the body of the ForEach activity per each row in the DataTable.

ExecuteQuery Example 2

The following example uses the ExecuteQuery activity in the context of a Forms Builder sequence. In the first
form, the ExecuteQuery activity queries the database for a student's registration bill details by term and dis-
plays the data in a grid where each row represents a term.

1. The LookupUser activity captures the UserName from the formInstance.UserName argument and
returns the SyStudentID value.

2. The GetEntity activity takes the SyStudentID and returns the studentEntity.

3. The Assign activity assigns the value studentEntity.Ssn.Remove(1,7) to studentEntity.Ssn. This
formats the SSN to display only the last 4 digits. It starts at 1 and removes 7 digits. This includes the
dashes (111-11-1111). So that leaves the last 4 of the SSN.
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4. The ExecuteQuery activity queries the Anthology Student database for the student's registration billl
details using the following SQL statement:

STRING.Format("Select Distinct AdTerm.Descrip AS termSelect, SaTrans.AdTermId AS ter-
mSelectID from SaTrans join AdTerm on SaTrans.AdTermId = AdTerm.AdTermId WHERE SyStu-
dentID = {0}",studententity.Id)

The ExecuteQuery activity stores the retrieved data in a variable named "RegistrationBill". The variable
type is a DataSet.



Workflow Version 4.0.1 340 Help Guide

5. Next, a ForEach activity parses the data output from the ExecuteQuery using the value Regis-
trationBill.Tables(0).AsEnumerable with the TypeArgument System.Data.DataRow.

We are basically using the returned RegistrationBill DataSet, and in the ForEach activity we are looping
through each row and then doing something with the data (e.g., assigning values).

6. The Body section of the ForEach activity includes three Assign activities that assign the following values to
variables:

Variable Value

varList New NameIdObject

varListId item("termSelect").ToString

varListName CINT(item("termSelectId"))

7. The AddToCollection activity associates the varList variable with the NamedIdObject.

8. The Assign activity below the AddToCollection activity assigns the value varTermSelect.toArray to the
myTerms argument. The value of this argument will be passed back to the form sequence and displayed
in a grid row on the form.
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GetServiceInstance<>

The GetServiceInstance activity retrieves an instance of a service from the service locator and provides the cap-
ability to execute service operations within the Anthology Student service suite.

The services and methods are documented in the Object Library. The Object Library is provided in compiled
HTML (CHM) format and can be downloaded locally. Log on to https://www.-
mycampusinsight.com/Documentation-Center/Help/Help_Home/Content/helphome.htm and select APIs >
Object Library > Command Model and Query Model.

The following operations invoked using the GetServiceInstance activity have gone through additional testing
and have been proved out for use from Workflow Composer, but all methods are called internally by the applic-
ation and should work.

l IStudentService - Check Duplicate Campus Student

l IStudentAccountTransactionService - Post Account Transaction Payment

To find available services, in Workflow Composer click New Event Workflow and select a service in the Entities
pane. The bold text in the Events pane indicates the events supported by a selected service, for example, Check-
DuplicateCampusStudentEvent. When called via the GetServiceInstance activity, the Check-
DuplicateCampusStudentEvent becomes the CheckDuplicateCampusStudent method call on the
iStudentService in the workflow. This screenshot shows how to find all available service methods.

https://www.mycampusinsight.com/Documentation-Center/Help/Help_Home/Content/helphome.htm
https://www.mycampusinsight.com/Documentation-Center/Help/Help_Home/Content/helphome.htm
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When you drag the GetServiceInstance activity into the Designer window, you are prompted to select the service

type (TService). Click .

When you select the 'Browse for Type' option, the list of assemblies and associated services is displayed. Find
and select the service and click OK.
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After you have selected a service, the name of the service is inserted into the DisplayName field, e.g., GetSer-
viceInstance<IStudentGroupService>. Proceed to specify the Name and Result.

In the example above, the GetServiceInstance activity is associated with a variable (grpSvc) that detects the IStu-
dentGroupService.

The workflow sequence continues with an Assign activity that assigns the variable from GetServiceInstance activ-
ity to the "expiredGroupsResponse" value. The Assign activity invokes the ListExpiredStudentGroups method of
the iStudentGroupService. See IStudentGroupService Methods in the Anthology Student Object Library. The end
result is that the workflow captures all expired student groups.
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Properties

Property Value Required Notes

DisplayName String No Specify a name for the activity or accept the default.

Name InArgument<String> No Specify a name for the service using a VB expression
or variable.

Result OutArgument<Service> No The service retrieved by this workflow activity. This is
a variable that can be used as input for subsequent
workflow activities.

To identify the variable type, in the Variable type field
of the Variables pane, select Browse for Types.... In
the 'Browse and Select a .NET Type' window, nav-
igate to the service that matches the previously selec-
ted service type, for example,
Cmc.Nex-
us.Common.Services.IStudentGroupService and
click OK.

GetServiceInstance<> Properties
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IStudentService - Check Duplicate Campus Student

You can use the GetServiceInstance<> activity to invoke the IStudentService method. One of the operations that
can be executed using the IStudentService method is the CheckDuplicateCampusStudent operation. The
response will indicate whether one or more potential duplicate students are found or not.

Duplicate Lead Process Configuration

In the Anthology Student desktop client, navigate to Setup > Campus Locations > select a campus > Add/Edit
(button) > Allow... (tab). Click Duplicate Lead Process Configuration button and review the settings on the
Duplicate Search, Duplicate Criteria, and Duplicate Processing tabs.
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The duplicate search process is based on the criteria settings against records for the configured status cat-
egories and campuses.

Workflow Example

1. In Workflow Composer, create the following Variables. Be sure to use the indicated variable types and
defaults.
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2. Drag the GetServiceInstance activity into the workflow, click , and select Browse for Type.

Select IStudentService and click OK.

3. In the Result field of the GetServiceInstance property window, specify the variable of type IStu-
dentService created above.
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4. Drag Assign activities into the workflow for each field you want to check for duplicates. The available
duplicate check criteria include the following fields.

Student Entity Field  
Assign Activity

To Value

First Name CheckDupeRequest.FirstName

Variable created in
your workflow or hard-
coded value

Last Name CheckDupeRequest.LastName

Phone CheckDupeRequest.Phone

Work Phone CheckDupeRequest.WorkPhone

Email CheckDupeRequest.EMail

ZIP Code CheckDupeRequest.PostalCode

HS Graduation Year CheckDupeRequest.HighSchoolGraduationYear  

CheckDupeRequest.IsDupNamePhoneCheckRequired False

Duplicate Check Criteria

To check for duplicates on all of the fields listed above, an Assign activity is required for each field. You
can choose to check for duplicates only on selected fields. The following is an example of Assign activity
properties for the HS Graduation Year field, where "2005" is a hard-code a value.

5. Drag an Assign activity into the workflow to assign the response to the duplicate check.

l In the "To" field specify: CheckDupeResponse (This is a variable created above.)

l In the "Value" field specify: StudSvc.CheckDuplicateCampusStudent(CheckDupeRequest)
(Where "StudSvc" is a variable created above.)
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6. To capture the result of the duplicate check, insert WriteLine, LogLine, or any other activities as appro-
priate for your workflow.

As a quick way to determine if any duplicates found for further processing is to check the count of stu-
dents returned, add an If activity and specify the following condition: Check-
DupeResponse.Students.Count > 0
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IStudentCourseService - Drop Course

You can use the GetServiceInstance<> activity to invoke the IStudentCourseService method to update a student
course record in the Anthology Student database.

The workflow example below is associated with a Forms Builder form that allows students to submit an online
form to drop a course to which they have previously been enrolled. The workflow creates and saves a doc-
ument of the course drop request form and removes the dropped course from the student's course list.

Workflow Example

1. In Workflow Composer, create the following Variables. Be sure to use the indicated variable types and
defaults.

Notes: 

l For the StuDrop variable type, browse to Cmc.Nexus.Crm.Entities.DocumentEntity.

l For the DropSvc variable type, browse to Cmc.Nexus.Academics.Services.IStudentCourseService.
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l For the DropStudentCourseRequest variable type, browse to Cmc.Nex-
us.Academics.Services.DropStudentCourseRequest.

l For the StudentCourseResponse variable type, browse to Cmc.Nex-
us.Academics.Services.StudentCourseResponse.

2. To exchange data with Forms Builder, the workflow uses the following arguments:

3. The first state/form finds the student record and assigns the student's name:

l LookupUser determines studentid value.

l GetEntity<StudentEntity> uses the studentid and returns the studentEntity.

l Assign Name assigns studentEntity.FirstName + " " + studentEntity.LastName to the Full-
name argument.
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4. The transition contains a WaitForFormBookmark activity (labeled "Submit"), a sequence with a number of
activities to process the course drop request (see next step), and the validation condition Not formIn-
stance.ValidationMessages.HasErrors.

https://help.campusmanagement.com/FB/3.x/Content/Workflow/WaitForFormBookmark.htm
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5. The "Process Drop Request" sequence creates a file of the course drop request form submitted by the
student.

l The Persist activity precedes the PrintUrlToPdf activity to explicitly request that the workflow per-
sists its data to a file.

l The PrintUrlToPdf activity creates a file named Pdf (see Variables).

l The "Add to Doc Center" sequence adds the Pdf file to the student's records in the Document
Center (see next step).

l The "Drop Course" sequence removes the course from the students course list (see below).

https://help.campusmanagement.com/FB/3.x/Content/Workflow/PrintUrlToPdf.htm
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6. The "Add to Doc Center" sequence creates and saves the Pdf file of the student's course drop request.

l CreateDocument takes the Pdf variable as in-argument, returns the StuDrop (DocumentEntity)
variable, and uses the studentid variable (see Variables).

It also specifies values for the following properties:

o Date Requested (datetime.Today)
o Due Date (datetime.Today)
o Document Type (use drop-down to select, e.g., 148)
o Image FileName ("StudentDropCourse.pdf")
o Notes (e.g., "Student Drop Course Form Submitted Online")
o Status (use drop-down to select, e.g., "On File")

l Assign Received Date assigns the value "datetime.Today" to StuDrop.ReceivedDate.

l Assign Approved Date assigns the value "datetime.Today" to the StuDrop.ApprovedDate.

l SaveDocument saves the StuDrop (DocumentEntity).
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7. The "Drop Course" sequence removes the course from the student's course list and assigns required
properties.

l GetEntity<StudentCourseStatusChangeReasonEntity> takes the stu-
dentCourseStatusChangeReasonEntity.Id value and returns stu-
dentCourseStatusChangeReasonEntity.

l GetEntity<StudentEnrollmentPeriodEntity> takes the studentEnrollmentPeriodEntity.Id value and
returns studentEnrollmentPeriodEntity.

l GetEntity<StudentCourseEntity> takes the studentCourseEntity.CourseId value and returns stu-
dentCourseEntity.

l GetServiceInstance<IStudentCourseService> returns the DropSvc variable.

l Assign activities set the following values:
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To Value

DropRequest.LetterGrade "WF"

DropRequest.DropDate datetime.Today

DropRequest.StudentEnrollmentScheduleId studentCourseEntity.Id

DropRequest.DropReasonId studentCourseStatusChangeReasonEntity.Id

DropResponse DropSvc.DropStudentCourse(DropRequest)
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Note: Insert LogLine and LogObject activities at various points in the workflow as needed.
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IStudentAccountTransactionService - Post Account Transaction Payment

The GetServiceInstance<> activity can be used to invoke the IStudentAccountTransactionService method. One of
the operations that can be executed using the IStudentAccountTransactionService method is the PostAc-
countTransactionPayment operation. The response will indicate whether a student payment was received.

Workflow Example

1. In Workflow Composer, create the following Variables. Be sure to use the indicated variable types and
defaults.

2. Drag the GetServiceInstance activity into the workflow, click , and select Browse for Type.

Select IStudentAccountTransactionService and click OK.
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3. In the Result field of the GetServiceInstance property window, specify the variable of type IStu-
dentAccountTransactionService created above.

4. Drag Assign activities into the workflow for the following functions of the postRequest operation.
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Assign Activity
Notes

To Value

postRequest.StudentId studentId

Variable cre-
ated in your
workflow or
hard-coded
value (see
Notes)

postRequest.TransactionAmount depositEntity.Amount

postRequest.TransactionDate depositEntity.DepositReceivedDate

postRequest.PaymentType Specify a Payment Type code (enclosed in
quotation marks). The system-defined codes
in Anthology Student are:

l "C" for Cash
l "E" for EFT
l "H" for Check
l "N" for Non-Cash
l "R" for Credit Card

postRequest.PaymentMode PaymentMode.Normal

postRequest.StudentEnrollmentPeriodId currEnroll.Id

Insert a LookupCurrentEnrollmentPeriod (V2)
activity above the Assign statement for
postRequest.StudentEnrollmentPeriodId to
retrieve the current enrollment period asso-
ciated with the studentId.

If Cash Drawer Sessions are used, three additional assignments are required:

CashDrawerId

CashDrawerSessionId

CashierId

Assignments for Student Payment Transactions

Notes:

When the GetServiceInstance activity is inserted into the workflow, you can use Intellisense on the vari-
ables in the Assign statements to see the available options. Type the request followed by a period to trig-
ger Intellisense. Use the down arrow key to scroll through the available values and press Enter to select a
value. The tooltip shows the variables and valid data types.



Workflow Version 4.0.1 363 Help Guide

Once the main method has been selected, Intellisense can then be used to see how to call (typically with
a request and returning a response) the variable. Note the tooltip.

5. Drag an Assign activity into the workflow to assign the response to the account transaction request.

l In the "To" field specify: postResponse (This is a variable created in above.)

l In the "Value" field specify: AcctSvc.PostAccountTransactionPayment(PostRequest) (Where
"postRequest" is a variable created above.)
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6. To capture the result of the service response, insert WriteLine, LogLine, or any other activities as appro-
priate for your workflow.

For example, you can use a LogLine activity with the following properties to capture the response after
the call to the Student Account Transaction Service.

l Level: Error

l Text: Newtonsoft.Json.JsonConvert.SerializeObject(postRe-
sponse,Newtonsoft.Json.Formatting.Indented)
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GetWorkflowInstanceId

The GetWorkflowInstanceId activity retrieves the workflow instance id of the currently executing workflow. This
activity is used within long running workflows prior to the CreateBookmark activity. The Id returned from this
activity needs to be passed into the ResumeBookmark activity.

Properties

Property Value Required Notes

DisplayName String No Specify a name for the activity or accept the default.

Result OutArgument<Guid> Yes The OutArgument holds the workflow instance Id
associated with this workflow. The variable type for
the OutArgument is System.Guid.

GetWorkflowInstanceId Properties

To see how GetWorkflowInstanceId can be used in a workflow, refer to:

l Create a Long Running Workflow



Workflow Version 4.0.1 366 Help Guide

Http

You can use the Http activity to integrate the Anthology platform with external systems. The activity supports
REST and SOAP web services. It enables posting messages, retrieving data, returning status results, and other
actions related to a specific resource.

Anthology applications use this activity to post messages to the Azure Service Bus and Azure Logic Apps,
Microsoft Flow and Office 365, as well as any other external Web APIs. Anthology Student Finance, HR & Payroll
uses this activity to integrate Anthology Student and Microsoft Dynamics 365.

The Http activity will execute (send) a request and you will get a response from the Url end-point that is being
posted to. For the SendToAzureServiceBus activity, the workflow logic cannot depend on getting an immediate
result from the process –- all you will know is that the message was successfully queued. If you want to get or
post data and want to know the result immediately (synchronously), use the Http activity. For more information,
see example Http vs. SendToAzureServiceBus.

Properties

Property Value Required Notes

Body InArgument<String> No Represents data to be transferred
in the HTTP request to the server.

DisplayName String No Specify a name for the activity or
accept the default.

Headers InArgument<StringDictionary> No Represents the name/value pairs
that are transferred in the request.

Http Activity Properties
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Property Value Required Notes

MediaType InArgument<String> Yes The media type of the body of the
request. (e.g., “application/json”).
Media type is typically used with
POST, PUT, PATCHmeth-
ods/verbs.

Method InArgument<String> Yes HTTP method that indicates the
action to be performed for a given
resource: GET, POST, PUT,
HEAD, DELETE, PATCH,
CONNECT, OPTIONS, TRACE

ResponseBody OutArgument<String> No The response body returned from
the server.

ResponseStatusCode OutArgument<HttpStatusCode> No Represents the HTTP response
status code issued by the server in
response to the request (e.g., 200,
401, 500, etc.).

URI InArgument<String> Yes The Universal Resource Identifier
to which the request will be made
(e.g., “https://www.host.-
com/resource”).

Examples

Invoke an Azure Logic App

The workflow example below is available on GitHub. Refer to the instructions at https://-
github.com/campusmanagement/workflow-samples/blob/master/README.md.

This example shows how the Http activity can be used to invoke an Azure logic app. The xaml file is available
here: Cmc.Nexus.Crm.Entities.TaskEntity_SavingEvent_Sample - Azure Logic Apps.xaml.

https://github.com/campusmanagement/workflow-samples/blob/master/README.md
https://github.com/campusmanagement/workflow-samples/blob/master/README.md
https://github.com/campusmanagement/workflow-samples/blob/master/Azure/Cmc.Nexus.Crm.Entities.TaskEntity_SavingEvent_Sample - Azure Logic Apps.xaml
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1. The SerializeToJson activity serializes an input argument object named "entity" and produces the output
string named "message".

2. The next activity is an Http activity. It:

l Uses the serialized "message" string as input argument in the Body property.
l Defines the input as MediaType = "application/json".
l Invokes the "POST" method.
l Creates the output argument named "responseBody".
l Sends the output to URI = "https://logicAppUrl" using the POST method.
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3. The If activity validates the output from the Http activity using the following Boolean condition:

not string.IsNullOrEmpty(responseBody)

The string.IsNullOrEmpty(responseBody) method checks whether the specified string (i.e., responseBody)
is null or an empty string ("").

l If the condition is met (i.e., the responseBody string is empty), the CreateValidationItem activity cre-
ates an error message.
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l If the condition is not met, the responseBody string is sent to the URI specified in the Http activity

Invoke an Azure Function

The workflow example below is available on GitHub. Refer to the instructions at https://-
github.com/campusmanagement/workflow-samples/blob/master/README.md.

This example shows how the Http activity can be used to invoke an Azure function. The xaml file is available
here: Cmc.Nexus.Crm.Entities.TaskEntity_SavingEvent_Sample - Azure Functions.xaml.

1. The SerializeToJson activity serializes an input argument object named "entity" and produces the output
string named "message".

https://github.com/campusmanagement/workflow-samples/blob/master/README.md
https://github.com/campusmanagement/workflow-samples/blob/master/README.md
https://github.com/campusmanagement/workflow-samples/blob/master/Azure/Cmc.Nexus.Crm.Entities.TaskEntity_SavingEvent_Sample - Azure Functions.xaml
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2. The next activity is an Http activity. It:

l Uses the serialized "message" string as input argument in the Body property.
l Defines the input as MediaType = "application/json".
l Invokes the "POST" method.
l Creates the output argument named "responseBody".
l Sends the output to URI = "https://azureFunctionUrl" using the POST method.

3. The If activity validates the output from the Http activity using the following Boolean condition:

not string.IsNullOrEmpty(responseBody) AND responseBody <> """"""

The string.IsNullOrEmpty(responseBody) method checks whether the specified string (i.e., responseBody)
is null or an empty string ("").
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l If the condition is met (i.e., the responseBody string is empty), the CreateValidationItem activity cre-
ates an error message.

l If the condition is not met, the responseBody string is sent to the URI specified in the Http activity

Use the Http Header for Authentication

The Headers field in the Http activity can be used to pass an authentication key for API calls. The value in the
Headers field is based on the StringDictionary class.

a. Our first example uses basic authentication.

A variable of Type StringDictionary is defined as follows:

new StringDictionary() From {{"Authorization","Basic <Authentication Key>"}}
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The variable is specified in the Headers field of the Http activity.

b. Our second example uses an ApiKey for authentication.

A StringDictionary variable is defined as follows:

An Assign activity is used to assign a value to the variable:

new StringDictionary() From {{"ApiKey", "<Authentication Key>" }}
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The variable is specified in the Headers field of the Http activity.

Note: In VB.Net, the name/value pair of the API key is translated to lowercase before it is added to the
string dictionary. For more information, see StringDictionary Class. This can cause authentication to fail.
However, in Anthology Student 22.0 and later, if passing the ApiKey name/value pair in the header of the
Http activity, any casing will be accepted.

Http vs. SendToAzureServiceBus

To demonstrate the difference between the Http and SendToAzureServiceBus activities, we created a workflow
that multiplies two numbers (24 x 365) and returns the result (8,760).

l The Http activity returns the result immediately to a workflow variable.

l The SendToAzureServiceBus activity sends the result to the service bus where it is processed by an applic-
ation that is listening for messages. Then response is sent to the email address specified in the request.

https://docs.microsoft.com/en-us/dotnet/api/system.collections.specialized.stringdictionary?view=netframework-4.8
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In more complex scenarios, the response from the service bus listener process could be a call back into
another system –- or the service bus listener would forward the message to a 3rd party application to be
posted to that system.

The workflow uses the following variables:

Http Activity
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The Http activity:

l Uses the string assignments (nbr1 and nbr2) as input arguments in the Body property.
l Defines the input as MediaType = "application/json".
l Invokes the "POST" method.
l Creates the output argument named "httpResponseBody".
l Creates the output argument named "httpResponseStatus" whose value is checked in the If Condition.
l Sends the output to a Uri on an Azure web site that hosts an API.

The API multiplies the numbers 2 numbers in the request Body (nbr1 and nbr2) and returns the result.
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SendToAzureServiceBus Activity

The SendToAzureServiceBus activity:

l Sends the string assignments (nbr1 and nbr2) and "emailTo" variable to the Azure Service Bus.
l Specifies the path for the Azure Service Bus as "mathqueue".
l Specifies the user's service name space and access key in Azure.

In Azure, the message is placed in the "mathqueue" and processed.
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When the service bus request is processed, an email is sent to the user.



Workflow Version 4.0.1 379 Help Guide

LogLine

The LogLine activity uses the Anthology logging infrastructure as opposed to the WriteLine (see Primitives),
which only writes to the Windows console. LogLine is useful for processes such as IIS, Anthology Student, and
Windows services that are not executing in console mode.

Properties

Property Value Required Notes

DisplayName String No Specify a name for the activity or accept the default.

Level LoggerLevel Yes Select a trace level from the drop-down list. The
options are:

l Trace
l Debug
l Information
l Warning
l Error
l Fatal

Text InArgument<String> Yes Input text string to include in the log file.

LogLine Properties

To see how LogLine can be used in a workflow, refer to:

l Check Approved Grants for Comments
l Create a Long Running Workflow

For information about configuring logging, refer to NLog.
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LogObject

The LogObject activity initializes a new instance of the LogLine class. Use this activity to log everything being cre-
ated on an entity.

Properties

Property Value Required Notes

DisplayName String No Specify a name for the activity or accept the default.

Level LoggerLevel Yes Select a trace level from the drop-down list. The
options are:

l Trace
l Debug
l Information
l Warning
l Error
l Fatal

Object InArgument<Object> Yes Specify the name of an object in the Anthology data
model, e.g., studentEntity.

LogObject Properties
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PostToFacebook

The PostToFacebook activity enables you to display information on a Facebook page.

Properties

Property Value Required Notes

AccessToken InArgument<String> Yes Specify the login for the Facebook page.

DisplayName String No Specify a name for the activity or accept the default.

Message InArgument<String> Yes Specify the message to be posted, for example,
"Check out our Fall Schedule"

PageId InArgument<String> Yes Specify the URL of the Facebook page where the
message is to be posted.

PostToFacebook Properties
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ResumeBookmark

The ResumeBookmark activity is used to resume a workflow that has been persisted via the CreateBookmark
activity.

Properties

Property Value Required Notes

BookmarkName InArgument<String> Yes Specify the name of the bookmark to resume.

DisplayName String No Specify a name for the activity or accept the
default.

Value InArgument<Object> No Specify an optional argument to pass to the
workflow when it resumes.

WorkflowInstanceId InArgument<Guid> Yes Specify the Id associated with the workflow
instance to resume using a VB expression or
variable. The variable type for the InAr-
gument is System.Guid.

ResumeBookmark Properties

To see how ResumeBookmark can be used in a workflow, refer to:
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l Create a Long Running Workflow
l Wake up the Long Running Workflow
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SendMail

The SendMail activity enables you to send an email message. The email is sent using the SMTP service defined
in the configuration file (app.config or web.config) of the host where the workflows are installed.

This email service does not use the messaging service that is integrated in Anthology Student. To send email
through Anthology Student using the Anthology Student tracking system, use the CreateTask (V2) activity and
create Contact Manager task that sends email.

Properties

Property Value Required Notes

Body InArgument<String> Yes Specify the body text of the message using a
VB expression or variable.

DisplayName String No Specify a name for the activity or accept the
default.

SendMail Properties
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Property Value Required Notes

From InArgument<String> Yes Specify the email address of the sender using a
VB expression or variable.

IsBodyHtml InArgument<Boolean> No Specify whether the body text is formatted in
HTML (optional).

Subject InArgument<String> Yes Specify the subject of the message using a
VB expression or variable.

To InArgument<String> Yes Specify the email address of the receiver using a
VB expression or variable, for example:

entity.Emails(0).EmailAddress

SendMail Example

You can use the SendMail activity to notify one or multiple persons of an event. The message can contain any
body text, including values that are obtained from other activities in the workflow.

Drag a SendMail activity into the sequence and specify the From, To, Subject, and Body values.

Notes:

l Multiple email addresses, separated by commas, can be specified in the To field.

l In our example the Body field contains a VB expression that lists a number of values obtained from the
event, e.g., ID, Skill ID, Student Placement Summary ID, and State. The values are converted to text strings
and separated by Environment.Newline expressions.
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The expression in the Body field is shown here with line breaks for clarity:

"**Student Skill Event**" &
Environment.NewLine &
" ID: " &
entity.Id.ToString() &
Environment.NewLine &
" Skill ID: " &
entity.SkillId.ToString() &
Environment.NewLine &
" Student Placement Summary ID: " &
entity.StudentPlacementSummaryId.ToString() &
Environment.NewLine &
Environment.NewLine &
" Other Entity Data" &
Environment.NewLine &
" State: " &
entity.EntityState.ToString()

Tip: Use a text editor, e.g., Notepad, to build expressions and paste them into the Expression Editor in
Workflow Designer.



SerializeToJson

The SerializeToJson activity initializes a new instance of the SerializeToJson class. The activity serializes an
object to JSON.

Properties

Property Value Required Notes

DisplayName String No Specify a name for the activity or accept the
default.

Object InArgument<Object> Yes Specify the object to be serialized.

Result OutArgument<String> Yes The JSON string created by this workflow activ-
ity. This is a variable that can be used as input
for subsequent workflow activities.

SerializeToJson Properties



Cmc.Core.Workflow.Activities.Azure
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SendToAzureServiceBus

The SendToAzureServiceBus activity sends messages to the Azure Service Bus. Service bus messages are sent
asynchronously, i.e., you place a message on the queue, and at some point a subscriber/listener of that queue
will handle the message.

For the SendToAzureServiceBus activity, the workflow logic cannot depend on getting an immediate result from
the process –- all you will know is that the message was successfully queued. If you want to get or post data and
want to know the result immediately (synchronously), use the Http activity. The Http activity will execute (send)
a request and you will get a response from the Url end-point that is being posted to. For more information, see
example Http vs. SendToAzureServiceBus.

Properties

Property Value Required Notes

DisplayName String No Specify a name for the activ-
ity or accept the default.

Message InArgument<String> Yes The message sent to the
Azure Service Bus.

QueueOrTopicPath InArgument<String> Yes The queue or topic path for
the Azure Service Bus.

ResponseBody OutArgument<String> No The response body returned
from the server.

SendToAzureServiceBus Properties
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Property Value Required Notes

ResponseStatusCode OutArgument<HttpStatusCode> No The response status code.
Represents the HTTP
response status code
issued by the server in
response to the request
(e.g., 200, 401, 500, etc.).
Initializes a new instance of
the Http class.

ServiceNamespace InArgument<String> No The service namespace.
See Note.

SharedAccessKey InArgument<String> No The shared access key. See
Note.

SharedAccessKeyName InArgument<String> No The name of the shared
access key. See Note.

Note:

The properties ServiceBusNamespace, SharedAccessKey, and SharedAccessKeyName are not required; how-
ever, if they are not provided, the activity will pull these settings from the web.config appSettings section. This is
to allow workflows to be reused from environment to environment without modification.

Below is an example of the web.config app settings:

<add key="azureServiceBus:serviceNamespace" value="nexus-student-integration-bus" />

<add key="azureServiceBus:sharedAccessKeyName" value="SendSharedAccessKey" />

<add key="azureServiceBus:sharedAccessKey" value="ZRXqcCfXQaGMi0FXTp6iNtFjMXKG+adnZTO3CcNAqDA="
/>

  Clients using their own Azure Subscription (customer side) need to specify the Service Bus settings applic-
able to their environment.

Examples

Send Message

The following workflow example shows how the activity can be used to send messages to the Azure Service Bus.

The workflow Cmc.Nexus.Crm.Entities.TaskEntity_SavedEvent_Sample%20-%20Azure%20Service%20Bus.xaml is
available on GitHub.

https://github.com/campusmanagement/workflow-samples/blob/master/Azure/Cmc.Nexus.Crm.Entities.TaskEntity_SavedEvent_Sample - Azure Service Bus.xaml
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1. The SerializeToJson activity serializes an input argument object named "entity" and produces the output
string named "message".

2. The SendToAzureServiceBus activity uses the serialized "message" string as input argument and creates
the output argument named "tasks".
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Http vs. SendToAzureServiceBus

To demonstrate the difference between the Http and SendToAzureServiceBus activities, we created a workflow
that multiplies two numbers (24 x 365) and returns the result (8,760).

l The Http activity returns the result immediately to a workflow variable.

l The SendToAzureServiceBus activity sends the result to the service bus where it is processed by an applic-
ation that is listening for messages. Then response is sent to the email address specified in the request.

In more complex scenarios, the response from the service bus listener process could be a call back into
another system –- or the service bus listener would forward the message to a 3rd party application to be
posted to that system.

The workflow uses the following variables:

Http Activity
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The Http activity:

l Uses the string assignments (nbr1 and nbr2) as input arguments in the Body property.
l Defines the input as MediaType = "application/json".
l Invokes the "POST" method.
l Creates the output argument named "httpResponseBody".
l Creates the output argument named "httpResponseStatus" whose value is checked in the If Condition.
l Sends the output to a Uri on an Azure web site that hosts an API.

The API multiplies the numbers 2 numbers in the request Body (nbr1 and nbr2) and returns the result.
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SendToAzureServiceBus Activity

The SendToAzureServiceBus activity:

l Sends the string assignments (nbr1 and nbr2) and "emailTo" variable to the Azure Service Bus.
l Specifies the path for the Azure Service Bus as "mathqueue".
l Specifies the user's service name space and access key in Azure.

In Azure, the message is placed in the "mathqueue" and processed.
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When the service bus request is processed, an email is sent to the user.
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Cmc.Core.Workflow.Activities.EntityModel
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CreateEntity<>

The CreateEntity<> activity invokes the New method of an entity service to create an instance of an entity. To
save the instance of the created entity, use the SaveEntity<> activity.

When you drag the CreateEntity<> activity into the Designer window, you are prompted to select the entity type
(TEntity).

When you select the 'Browse for Type' option, the list of assemblies and associated entities is displayed. Find
and select the entity and click OK.

After you have selected an entity, the name of the entity is inserted into the DisplayName field, e.g.,
CreateEntity<TaskEntity>. Proceed to specify the Result.
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Properties

Property Value Required Notes

DisplayName String No Specify a name for the activity or accept the
default.

Result OutArgument<Entity> Yes The entity created by this workflow activity. This is
a variable that can be used as input for sub-
sequent workflow activities.

To identify the variable type, in the Variable type
field of the Variables pane, select Browse for
Types.... In the 'Browse and Select a .NET Type'
window, navigate to the entity that matches the pre-
viously selected entity type, for example,
Cmc.Nexus.Crm.Entities.TaskEntity and click
OK.

CreateEntity<> Properties

If you are working with the ApplicantEntity in Anthology Student, refer to Create/Save ApplicantEntity and
Update Derived Fields.
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DeleteEntity<>

The DeleteEntity<> activity invokes the Delete method of an entity service to delete an instance of an entity.

Note: The DeleteEntity<> activity does not support the deletion of CampusNexus CRM entities.

When you drag the DeleteEntity<> activity into the Designer window, you are prompted to select the entity type.

When you select the 'Browse for Type' option, the list of assemblies and associated entities is displayed. Find
and select the entity and click OK.

After you have selected an entity, the name of the entity is inserted into the DisplayName field, e.g.,
DeleteEntity<StudentGroupEntity>. Proceed to specify the entity to be deleted and, optionally, a validation mes-
sage.

Properties

Property Value Required Notes

DisplayName String No Specify a name for the activity or accept the
default.

Entity InOutArgument<Entity> Yes Specify the entity previously retrieved with a
GetEntity<> activity using a VB expression or
variable.

DeleteEntity<> Properties
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Property Value Required Notes

Messages InArgument
<ICollection
<ValidationMessage>>

No Specify the validation message to be displayed
when the entity is deleted.

Specify a variable that can be used to capture
validation messages. For more information, see
Capture Validation Errors.
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GetEntity<>

The GetEntity<> activity invokes the Get method of an entity service to retrieve an instance of an entity.

When you drag the GetEntity<> activity into the Designer window, you are prompted to select the entity type
(TEntity).

When you select the 'Browse for Type' option, the list of assemblies and associated entities is displayed. Find
and select the entity and click OK.

Note: The GetEntity<> activity is not supported for the StudentAdvisors entity because the primary key for this
entity consists of two properties. To work with the StudentAdvisors entity, use the StudentAdvisorService –
GetStudentAdvisors operation.

After you have selected an entity, the name of the entity is inserted into the DisplayName field, e.g.,
GetEntity<StudentGroupEntity>. Proceed to specify the EntityId and Result.
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Properties

Property Value Required Notes

DisplayName String No Specify a name for the activity or accept the default.

EntityId InArgument<Int32> Yes Specify the entity identifier using a VB expression or
variable.

Result OutArgument<Entity> Yes The entity retrieved by this workflow activity. This is a
variable that can be used as input for subsequent
workflow activities.

To identify the variable type, in the Variable type field
of the Variables pane, select Browse for Types.... In
the 'Browse and Select a .NET Type' window, nav-
igate to the entity that matches the previously selec-
ted entity type, for example,
Cmc.Nexus.Common.Entities.StudentGroupEntity
and click OK.

GetEntity<> Properties

Note: Before you use this activity, make sure that both the entity you want to work with and a matching ser-
vice are available and enabled in Workflow Designer. To check this, click New Event Workflow, select the filter
"Only show entity types that have the SupportedEvents attribute", and locate the entity type, for example, Student
Group. In this case Workflow Designer shows that both the Student Group (StudentGroupEntity) and the cor-
responding Student Group Service (iStudentGroupService) are enabled. This indicates that the GetEntity activity is
supported for the selected entity type.
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GetEntityCollection<>

Prerequisites

The GetEntityCollection<> activity is available in Workflow Composer version 2.7 and later and requires the fol-
lowing minimum versions of activities and contracts:

l Anthology Student version 20.0.x

— OR —

l CampusNexus CRM version 12.2.x

The minimum Cmc.Core.dll version installed in Program Files (x86)\CMC\Workflow must be 5.1.167 or greater.

Note: If you use the activity with Student 19.0 and Workflow Composer 2.7, you won’t see any errors in Work-
flow Composer (because it has minimum Cmc.Core.dll version), but you’ll see a server error at runtime.

Purpose

The GetEntityCollection<> activity provides the ability to retrieve a collection of values (i.e., rows in a database
table) for a given entity by passing in an array of Ids. The activity returns an array of entities in the “Entities” out-
put argument.

When you drag the GetEntityCollection<> activity into the Designer window, you are prompted to select the
entity type (TEntity).



Workflow Version 4.0.1 406 Help Guide

When you select the 'Browse for Type' option, the list of assemblies and associated entities is displayed. Find
and select the entity and click OK.

Note that the in and out arguments for the activity are of type ICollection.

Properties

Property Value Required Notes

DisplayName String No Specify a name for the
activity or accept the
default.

Entities OutArgument<ICollection<Entity>> Yes Specify the entity array
using a VB expression or
variable.

GetEntityCollection<> Properties
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Property Value Required Notes

EntityIds InArgument<ICollection<Int32>> Yes Specify the entity iden-
tifier array using a
VB expression or vari-
able.

ResponseItems OutArgument<ICollection
<EntityServiceResponse<Entity>>>

No This is an optional output
argument for items
retrieved by the activity.
This is a variable that can
be used as input for sub-
sequent workflow activ-
ities.

To identify the variable
type, in the Variable type
field of the Variables
pane, select Browse for
Types.... In the 'Browse
and Select a .NET Type'
window, navigate to the
entity that matches the
previously selected entity
type and click OK.

ValidationMessages InArgument
<ICollection<ValidationMessage>>

No Specify a variable that
can be used to capture
validation messages. For
more information, see
Capture Validation
Errors.

Get/Save EntityCollection Example

This workflow example is associated with a Forms Builder sequence that retrieves a collection of records for the
StudentRelationshipAddressEntity and exposes the records in a grid control. The user of the form sequence is
allowed to add and edit data in the grid. The new and modified records are saved to the database.

1. In Form Designer, create a form using the Grid component.

2. Bind the Grid component to the workflow using the Model property value vm.models.myAddresses.
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3. Configure the Columns property to allow the user to add, edit, and delete data.

4. In Sequence Designer, add the form to a sequence and open the workflow for the sequence.

5. In Workflow Composer, create the variables shown below.
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6. Create an argument of type ICollection<StudentRelationshipAddressEntity> for the myAddresses
model value that binds the grid to the workflow. The path to browse to the argument type
is: System.Collections.Generic.ICollection<Cmc.Nexus.Common.Entities.StudentRelationshipAddressEntit-
y>.

7. The GetEntityCollection<> activity needs a list of ids for the collection of the same entity type to retrieve.
To achieve this, drag an ExecuteQuery activity into the Entry section of the Welcome form. This activity
retrieves a set of document ids for a student from the database and returns the data in a variable named
addrSet (see variables created above).

The Command property is defined as "select syaddressid from syaddress where systudentid =
51850" where the systudentid value is hard-coded. Use a variable for the systudentid as appropriate in
your environment.
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8. Drag a ForEach<> activity below the ExecuteQuery activity. The ForEach<> is activity converts the dataset
type argument returned by ExecuteQuery to a collection of Int32 ids to pass to GetEntityCollection<>
activity using the Values property addrSet.Tables(0).AsEnumerable.
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9. Drag an AddToCollection<> activity into the Body section of the ForEach<> activity. The AddToCollection
activity adds items to the collection when users enter new data on the form.

The collection is defined by the variable addrs of type List<Int32> with a default value of new List(Of
Int32).

The Item property value CINT(item("SyAddressId")) converts the data to integers.

10. Drag a GetEntityCollection<> activity below the ForEach<> activity. The GetEntityCollection<> activity
uses the StudentRelationshipAddressEntity.

The input argument is the addrs variable.

The output argument is the myAddresses argument that binds the grid to the workflow.
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11. Drag a ForEach<> activity into the Next transition following the form the contains the Grid component.

The Values property holds the myAddresses argument that binds the grid to the workflow.

This instance of the ForEach activity gathers all rows in the grid including rows that were added by the
form user.
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12. Drag an If activity into the Body section of the ForEach<> activity. Specify the following condition to detect
if an item was added to the StudentRelationshipAddressEntity:
item.EntityState = Cmc.Core.EntityModel.EntityState.Added

Drag an Assign activity into the Then branch to the associate the hard-coded studentid with the
itemEntityState array.

Add another Assign activity to set the item.Id to -1. This assign statement ensures that a new item is
appended to the array. The last element of an array is the length of the array - 1.
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13. Drag a SaveEntityCollection<> activity into last Next transition of the sequence. The activity will handle
add, edit and delete of any entity in the. In our example, the activity saves the changes passed in through
myAddresses to the ICollection<StudentRelationshipAddressEntity>.
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14. Finally, in the Condition field of the last Next transition, specify not formIn-
stance.ValidationMessages.HasErrors to catch any form errors.
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SaveEntity<>

The SaveEntity<> activity uses an entity service to save an instance of an entity that was updated or created
using a CreateEntity<> activity.

When you drag the SaveEntity<> activity into the Designer window, you are prompted to select the entity type.

When you select the 'Browse for Type' option, the list of assemblies and associated entities is displayed. Find
and select the entity and click OK.

After you have selected an entity, the name of the entity is inserted into the DisplayName field, e.g.,
SaveEntity<TaskEntity>. Proceed to specify the entity to be saved and, optionally, a validation message.

Properties

Property Value Required Notes

DisplayName String No Specify a name for the activity or accept the
default.

Entity InOutArgument<Entity> Yes Specify the entity previously created with a
CreateEntity<> activity using a VB expression
or variable.

SaveEntity<> Properties
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Property Value Required Notes

Messages InArgument
<ICollection
<ValidationMessage>>

No Specify the validation message to be displayed
when the entity is saved.

Specify a variable that can be used to capture
validation messages. For more information, see
Capture Validation Errors.

The following properties are mandatory to save the following CampusNexus CRM entities:

CRM Entity Mandatory Property

Contact One of the following properties:
l Name
l First Name
l Middle Name
l Last Name

Lead Team ID
One of the following properties:

l Name
l First Name
l Middle Name
l Last Name

Account Account name

Custom Object (Global) Name

Custom Object (Team) Name
Team ID

Custom Object (Shared) Name
Shared to

Mandatory Properties for CRM Entities

If you are working with the ApplicantEntity in Anthology Student, refer to Create/Save ApplicantEntity and
Update Derived Fields.
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Create/Save ApplicantEntity and Update Derived Fields

When the CreateEntity<> and SaveEntity<> activities are used with the ApplicantEntity in Anthology Student, the
workflow must include a number of Assign activities to ensure that a record is added to the AdEnroll table the
same way as when the Anthology Student client is used to add an applicant record. In addition, it is necessary to
retrieve the IApplicantServerice event using the GetServiceInstance<> activity (steps 6 and 7) to update the
derived fields.

The following steps are required in the workflow:

1. Drag a CreateEntity<ApplicantEntity>activity into the sequence to create an instance of the Applic-
antEntity record.

The Result value "A" is defined as a variable with the following attributes. This variable is referenced in
the Assign activities below.

2. Use Assign activities to populate the following required fields:

l StudentId
l CampusId
l AssignedAdmissionsRepId
l SchoolStatusId
l LastModifiedUserId
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3. Use Assign activities to populate the following optional fields:

l ProgramId
l ProgramVersionId
l StartDateId
l StartTermId
l EnrollmentStatusId
l ShiftId
l GradeLevelId
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With these assignments the workflow calculates values for the remaining ApplicantEntity fields and
passes the values to the SaveEntity<ApplicantEntity> activity.

The values are calculated (derived) for the following fields:

l BillingMethodId
l GradeScaleId
l ClockHoursRequired
l CreditHoursRequired
l ExpectedStartDate
l MidpointDate
l GraduationDate
l CatalogYearId
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Note: If the Program Version has more than one Catalog, the logic identifies the CatalogYearID
whose Start Date is nearest to the selected Program Version Start Date.

4. Insert a SaveEntity<ApplicantEntity> activity into the workflow. This activity populates the entire applic-
ant record in the AdEnroll table using the assigned and calculated (derived) values.

5. Optionally, add an If condition to the workflow to catch validation errors. In our example "V" is a variable
of type Cmc.Core.EventingValidationMessageCollection.

6. Drag a GetServiceInstance activity into the workflow. The Select Types dialog is displayed.

Click Browse for Types, select IApplicantService, and click OK.
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The Display Name of the GetServiceInstance activity is updated to GetServiceInstance<IApplicantService>.

In the Result property, specify a variable of type Cmc.Nexus.Admissions.ServiceIApplicantService.

7. Drag two Assign activities below the GetServiceInstance activity. Assign request and response variables
for the applicant service defaults.
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Notes:

l When an Applicant record is added and the Note field is not assigned, the Status History Comment text
box in Anthology Student displays the hardcoded string "Added Applicant record".

l When an Applicant record is added and the Note field is assigned in the workflow, the Status History
Comment text box in Anthology Student displays the text of entity.Note that was passed into the work-
flow.
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Create/Save StudentEntity

When the CreateEntity<> and SaveEntity<> activities are used with the StudentEntity in Anthology Student, the
IsActive value in the SyStudent table is automatically set to true (1). This allows further activities on the stu-
dent record to be executed, for example, Create/Save StudentPreviousEducationEntity.
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SaveEntityCollection<>

Prerequisites

The SaveEntityCollection<> activity is available in Workflow Composer version 2.7 and later and requires the fol-
lowing minimum versions of activities and contracts:

l Anthology Student version 20.0.x

— OR —

l CampusNexus CRM version 12.2.x

The minimum Cmc.Core.dll version installed in Program Files (x86)\CMC\Workflow must be 5.1.167 or greater.

Note: If you use the activity with Student 19.0 and Workflow Composer 2.7, you won’t see any errors in Work-
flow Composer (because it has minimum Cmc.Core.dll version), but you’ll see a server error at runtime.

Purpose

The SaveEntityCollection<> provides the ability to pass in an entity collection retrieved using the GetEntityCol-
lection<> activity and save the data for each instance of the collection.

When you drag the GetEntityCollection<> activity into the Designer window, you are prompted to select the
entity type (TEntity).
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When you select the 'Browse for Type' option, the list of assemblies and associated entities is displayed. Find
and select the entity and click OK.

Note that the in and out arguments for the activity are of type ICollection.

Properties

Property Value Required Notes

DisplayName String No Specify a name for the
activity or accept the
default.

Entities InArgument<ICollection<Entity>> Yes Specify the input entity
array using a
VB expression or vari-
able.

SaveEntityCollection<> Properties
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Property Value Required Notes

OutputEntities OutArgument<Icollection<Entity>> No Specify the output entity
array using a
VB expression or vari-
able.

ResponseItems OutArgument<ICollection
<EntityServiceResponse<Entity>>>

No The items saved by this
workflow activity. This is a
variable that can be used
as input for subsequent
workflow activities.

To identify the variable
type, in the Variable type
field of the Variables
pane, select Browse for
Types.... In the 'Browse
and Select a .NET Type'
window, navigate to the
entity that matches the
previously selected entity
type and click OK.

ValidationMessages InArgument
<ICollection<ValidationMessage>>

No Specify a variable that
can be used to capture
validation messages. For
more information, see
Capture Validation
Errors.

For more information, see Get/Save EntityCollection Example.
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Events in the New Object Model
The Anthology object model defines a collection of classes and interfaces through which entities can be manip-
ulated. An entity represents a person, place, or thing such as a course, task, or campaign. Entities only contain
the properties associated with itself such as first name, last name, or city. The verbs associated with an entity
(e.g. Save, PostFinalGrades, or AddToCampaign) are exposed by a corresponding service or EntityService.

EntityModel
All entities in Anthology inherit from the Cmc.Core.EntityModel.Entity abstract base class. The Entity base class
contains all the logic required for maintaining the state of an entity and its children while it is being modified in
business logic, on the client, or by an external system. Each entity is defined through its properties and the
methods it supports. The exposed (public) properties and methods of an entity can be manipulated through
workflows.

The following are examples of properties and methods that can be associated with an entity.

Properties

l EntityState — gets or sets the state of an entity

o Added — the entity is new, an INSERT database operation will be performed
o Removed — the entity has been removed, a DELETE operation will be performed
o Modified — the entity has been modified, an UPDATE database operation will be performed
o Unchanged — the entity is unchanged, no database operation will be performed

l ExtendedProperties — represents a collection of dynamic entity properties such as School Defined Fields.

l ModifiedProperties — represents a read-only collection of property names that have been modified since
the entity was last retrieved.

l OriginalState — represents the entity’s original state serialized in a byte[]. This property is used to round-
trip the entity state from the client to the server and is not intended to be updated directly in code.

l OriginalValues — represents the original values of an entity as a dictionary.

Methods

l AcceptChanges — accepts all current changes and sets the entity’s state to Unchanged. This does not per-
form a database operation.

l GetOriginalValue — gets the original value of a specified property

l HasChanged — returns true if an entity (or its children) have changed; else false
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Events Raised by EntityState Changes

The EntityState property is exposed in many Anthology entities. This property supports create, retrieve, update,
delete (CRUD) operations or commands. The create, update, and delete operations raise events associated with
the affected entities. Workflows can be triggered by any create, update, or delete operation. Retrieve or get
operations do not trigger events.

The CreateEntity<>, DeleteEntity<>, GetEntity<>, and SaveEntity<> activities in Workflow Composer under
Cmc.Core.Workflow.Activities.EntityModel enable you to access the EntityState property of exposed entities and
to manipulate and persist the state of an entity in the database.

Event Handlers

The object model provides event handlers for all entities. The event handlers support event services for each
entity.

The Event Broker listens for incoming events from clients, determines the name of the event, forwards the
event to the configured event handler, and, if required, returns a response to the event.

Event messages contain enough basic information to be handled without the need to retrieve additional data
from APIs.

The events that are exposed to the Event Broker can be consumed in custom code (for example, C# event hand-
lers) or workflows that automate tasks and enable data to be exchanged between systems.

Anthology events are grouped in the following categories:

l Constructed events enable new objects to be added to the database.
l Deleting or Deleted events enable objects to be deleted.
l Saving or Saved events enable objects to be inserted/updated.

Saving events and Deleting events are captured and visible at the UI level. VB .NET code is required to intercept
these events. Typically, data validation occurs typically occurs. Saving and Deleting event workflows must be
stored on the host that is running the application on which the event is captured, for example, Anthology Stu-
dent.

Saved events and Deleted events are captured at the database trigger level when a transaction is committed to
the database. These events are only visible in the event log of the Windows Service NextGen Nexus Event Work-
flows. Saved and Deleted event workflows must be stored on a host that has a direct database connection, for
example, COM Server.

Constructed events enable new objects to be added. Constructed events are captured and visible at the UI level
when the components of a record are assembled. No data validation occurs. VB .NET code is required to inter-
cept these events.
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EntityServices
The Anthology object model contains numerous entity services such as the Cmc.Nexus.Academics.Services that
support custom commands. The Cmc.Nexus.Academics.Services, for example, raise the Cmc.Nex-
us.Academics.Events which contain custom commands related to the Academics module. The event handlers of
the entities contain business logic applicable to the entities. The event handlers can be extended using work-
flows, for example workflows that send emails to advisors when a student unregisters from a class.

Selecting Events in Workflow Composer
The 'New Event Driven Workflow' window in Workflow Composer enables you to select the events that will trig-
ger your workflow.

The Entities filter option Only show entity types that have the SupportedEvents attribute is selected by
default. The SupportedEvents attribute indicates what type of events are supported by an entity or service.
When any one of the supported events is enabled, the entity is visible to Workflow Composer and considered
public.

The Events filter option Only show events supported by the selected entity type is also selected by default
and makes it easier to find supported events after selecting an Entity.

The Entities pane below shows the entities in the Cmc.Nexus.Academics.Entities namespace. The Events pane
shows the events that are available (Constructed, Deleted, Deleting, Saved, Saving events) when Student Course
(StudentCourseEntity) is selected in the Cmc.Nexus.Academics.Entities namespace.
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EntityServices are typically associated with custom events and business rules that apply to an entity. The events
are associated with an EntityService are displayed in the Events pane when you select a service in the Entities
pane.

The Entities pane below shows the services in the Cmc.Nexus.Academics.Entities namespace. The Events pane
shows the events that are available (Register for Class Event, Transfer Class Section Event, and Unregister From
Class Event) when Registration Service (IRegistrationService) is selected in the Cmc.Nexus.Academics.Entities
namespace.
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The public Anthology Student entities and event services are documented in the Anthology Student Object
Library. Use to the library to look up details about Anthology entities including classes, properties, event argu-
ments, methods, and fields while building workflows.
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Generic Activities
Workflow Designer is built using the Windows Workflow Foundation (WF) in the .NET Framework. It contains
Microsoft's built-in (generic) workflow activities and activities created specifically for Anthology products (CMC
Activities).

The Microsoft WF activity library contains the activities described below. These activities are used in conjunction
with the CMC Activities developed for Anthology.

For detailed information about WF features first introduced in .NET 4.5 refer to http://msdn.microsoft.com/en-
us/library/vstudio/hh305677(v=vs.110).aspx.

Collection
Collection activities are used to work with collection objects in a workflow. The .NET Framework has system-
provided activities for adding and removing items from a collection, testing for the existence of an item in a col-
lection, and clearing a collection. ExistsInCollection and RemoveFromCollection have an OutArgument of type
Boolean, which indicates the result.

Activity Description

AddToCollection<> Adds an item to a specified collection.

ClearCollection<> Clears all items from a specified collection.

ExistsInCollection<> Returns true if an item exists in a collection.

RemoveFromCollection<> Removes an item from a specified collection and returns true if the item was suc-
cessfully removed.

Collection Activities

For more information, see http://msdn.microsoft.com/en-us/library/vstudio/ee358729(v=vs.100).aspx.

Control Flow
The .NET Framework provides several activities for controlling flow of execution within a workflow. Some of
these activities (such as Switch and If) implement flow control structures similar to those in programming envir-
onments such as Visual C#, while others (such as Pick) model new programming structures.

Note that while activities such as the Parallel and ParallelForEach activities schedule multiple child activities for
execution simultaneously, only a single thread is used for a workflow. Each child activity of these activities
executes sequentially and successive activities do not execute until previous activities either complete or go
idle. As a result, these activities are most useful for applications in which several potentially blocking activities
must execute in an interleaved fashion. If none of the child activities of these activities go idle, a Parallel activity
executes just like a Sequence activity, and a ParallelForEach activity executes just like a ForEach activity. If, how-
ever, asynchronous activities (such as activities that derive from AsyncCodeActivity) or messaging activities are

http://msdn.microsoft.com/en-us/library/vstudio/hh305677(v=vs.110).aspx
http://msdn.microsoft.com/en-us/library/vstudio/hh305677(v=vs.110).aspx
http://msdn.microsoft.com/en-us/library/vstudio/ee358729(v=vs.100).aspx
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used, control will pass to the next branch while the child activity waits for its message to be received or its asyn-
chronous work to be completed.

Activity Description

DoWhile Executes the contained activities once and continues to do so while a condition is true.

ForEach<> Executes an embedded statement in sequence for each element in a collection. ForEach is
similar to the keyword foreach but is implemented as an activity rather than a language
statement.

If Executes contained activities if a condition is true and can execute activities contained in
the Else property if the condition is false.

Parallel Executes contained activities in parallel.

ParallelForEach<> Executes an embedded statement in parallel for each element in a collection.

Pick Provides event-based control flow modeling.

PickBranch Represents a potential path of execution in a Pick activity.

Sequence Executes contained activities in sequence.

Switch<> Selects one choice from a number of activities to execute, based on the value of a given
expression.

While Executes contained activities while a condition is true.

Control Flow Activities

For more information about the classes, methods, and properties associated with each activity, refer to
http://msdn.microsoft.com/en-us/library/vstudio/ee358737(v=vs.100).aspx.

Error Handling
The .NET Framework provides several system-provided activities for implementing error handling and recovery.

Activity Description

Rethrow Rethrows the last exception thrown from within a TryCatch activity.

Throw Throws an exception.

TryCatch Implements exception handling.

Error Handling Activities

For more information, see http://msdn.microsoft.com/en-us/library/vstudio/ee358726(v=vs.100).aspx.

http://msdn.microsoft.com/en-us/library/vstudio/ee358737(v=vs.100).aspx
http://msdn.microsoft.com/en-us/library/vstudio/ee358726(v=vs.100).aspx
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State Machine
The .NET Framework provides several system-provided activities and activity designers for creating state
machine workflows.

Activity Description

FinalState Represents a terminating state in a state machine. FinalState is an activity designer that when
used creates a State preconfigured as a terminating state. For more information, see FinalState
Activity Designer.

State Represents a state in a state machine.

StateMachine Executes contained activities using the familiar state machine paradigm.

Transition Represents the transition between two states. There is no Toolbox item for Transition; transitions
are created on the workflow designer by dragging and dropping a line between two states, or by
dropping a state on the triangles that appear when one state is hovered over another.

State Machine Activities

For more information, see http://msdn.microsoft.com/en-us/library/vstudio/gg983475(v=vs.100).aspx.

Flowchart
The .NET Framework provides several system-provided activities for controlling execution and branching within
a Flowchart.

Activity Description

Flowchart Executes contained activities using the familiar Flowchart paradigm.

FlowDecision A specialized FlowNode that provides the ability to model a conditional node with two outcomes.

FlowSwitch<> A specialized FlowNode that allows modeling a switch construct, with one expression of a type
defined in the activity’s type specifier and a single outcome for each match.

Flowchart Activities

For more information, see http://msdn.microsoft.com/en-us/library/vstudio/ee358753(v=vs.100).aspx.

Messaging
Messaging activities allow workflows to send and receive WCF messages. By adding messaging activities to a
workflow you can model any arbitrarily complex message exchange patterns (MEP).

Activity Description

CorrelationScope Creates and configures a CorrelationScope activity that provides implicit man-
agement of child messaging activities with a CorrelationHandle object.

Messaging Activities

http://msdn.microsoft.com/en-us/library/vstudio/gg983475(v=vs.100).aspx
http://msdn.microsoft.com/en-us/library/vstudio/ee358753(v=vs.100).aspx
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Activity Description

InitializeCorrelation Creates and configures an InitializeCorrelation activity that is used to initialize
correlation without sending or receiving a message.

Receive Creates and configures a Receive activity that receives a message from a ser-
vice.

ReceiveAndSendReplyFactory Creates a pre-configured pair of Send and ReceiveReply activities within a
Sequence activity.

Send Creates and configures a Send activity that sends a message to a service.

SendAndReceiveReplyFactory Creates a pre-configured pair of Receive and SendReply activities within a
Sequence activity.

TransactedReceiveScope Creates and configures a TransactedReceiveScope activity which enables the
flow of transactions into a workflow.

For more information, see http://msdn.microsoft.com/en-us/library/ee829543(v=vs.110).aspx.

Primitives
The .NET Framework provides several system-provided activities that provide a convenient mechanism for per-
forming common tasks.

Activity Description

Assign Assigns a value to a variable at the current scope.

Delay Puts one path of execution into an idle state, possibly allowing the workflow to be unloaded.

InvokeDelegate Executes a delegate that derives from ActivityDelegate and is exposed as a property.

InvokeMethod Executes a public method of a CLR object.

WriteLine Writes a specified string to the console or a specified TextWriter object.

Activities for Primitives

For more information, see http://msdn.microsoft.com/en-us/library/vstudio/ff742828%28v=vs.100%29.aspx.

Runtime
The .NET Framework provides several system-provided activities for accessing the features of the workflow
runtime, such as persistence and termination.

Activity Description

NoPersistScope A container activity that prevents child activities from persisting.

Runtime Activities

http://msdn.microsoft.com/en-us/library/ee829543(v=vs.110).aspx
http://msdn.microsoft.com/en-us/library/vstudio/ff742828(v=vs.100).aspx
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Activity Description

Persist Explicitly requests that the workflow persist its data to a durable storage medium (i.e., writ-
ing to a file).

TerminateWorkflow Terminates the running workflow instance.

For more information, see http://msdn.microsoft.com/en-us/library/vstudio/ee358752(v=vs.100).aspx.

Transaction
The .NET Framework has several system-provided activities for modeling transactions, compensation, and can-
cellation. These programming models allow the workflow to continue forward progress in the event of changes
in business logic and error handling.

Activity Description

CancellationScope Associates cancellation logic, in the form of an activity, with a main path of exe-
cution, also expressed as an activity.

CompensableActivity Supports compensation of its child activities.

Compensate Explicitly invokes the compensation handler of a CompensableActivity.

Confirm Explicitly invokes the confirmation handler of a CompensableActivity.

TransactionScope Demarcates a transaction boundary.

TransactedReceiveScope Scopes the lifetime of a transaction that is initiated by a received message. The
transaction may be flowed into the workflow on the initiating message or created by
the dispatcher when the message is received.

Note: The TransactedReceiveScope is located in the Messaging section of the Tool-
box.

Transaction Activities

For more information, see http://msdn.microsoft.com/en-us/library/vstudio/ee358756(v=vs.100).aspx.

http://msdn.microsoft.com/en-us/library/vstudio/ee358752(v=vs.100).aspx
http://msdn.microsoft.com/en-us/library/vstudio/ee358756(v=vs.100).aspx
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Legacy Workflows

About Legacy Workflows
Beginning with Workflow 2.2, a new object model supports Anthology Student version 17.1 and later. The new
object model introduces new namespaces for Anthology Student modules.

Old Namespace New Namespace

Cmc.Nexus.Workflow.<modulename>

Example:

Cmc.Nexus.Workflow.Sis.Academics

Cmc.Nexus.<modulename>.Workflow

Example:

Cmc.Nexus.Academics.Workflow

The new services, namespaces, and entities are documented in the Anthology Student Object Library.

With the release of Anthology Student 21.0 in October 2019, the EOL date for Anthology Student Activities (V1) is
scheduled for October 2020 and the EOS date is scheduled for April 2021. For more information, see End-of-Life
for Anthology Student Activities (V1).

End-of-Life Announcement for Anthology Student Activities (V1)

New and Migrated Activities
The activities in the toolbox of Workflow Composer are sorted by namespace. Any new activities that have been
developed since the introduction of the new object model are added to the corresponding namespaces in the
toolbox.

Activities that were developed in the old object model and are required to support events raised out of Antho-
logy Student were migrated to new namespaces.

Example:

The CreateStudentSportsService activity was migrated from Cmc.Nexus.Workflow.Sis.StudentServices to
Cmc.Nexus.StudentServices.Workflow.

If you are creating a new workflow using this activity, use the activity from the new namespace Cmc.Nex-
us.StudentServices.Workflow.

For help about the migrated activity, refer to "CreateStudentSportsService (V2)" in the New Workflows help sec-
tion.

Help about the older variant of the activity is found in "CreateStudentSportsService (V1)" in the Legacy Work-
flows help section.

The toolbox in Workflow Composer will provide both variants of the CreateStudentSportsService activity until all
legacy workflows have been migrated.
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The LookupServiceListItem, LookupAreaOfStudy, and LookupListItem activities were not migrated. The func-
tionality of these activities is incorporated into the LookupReferenceItem activity in Cmc.Nex-
us.Common.Workflow. Use the LookupReferenceItem activity for any new or migrated workflows.

The LookupGroup activity in Cmc.Nexus.Workflow is migrated to LookupStudentGroup in Cmc.Nex-
us.Common.Workflow.

For detailed information about the entities and properties associated with new and migrated activities, refer to
the Anthology Student Object Library instead of mapping tables provided in the Legacy Workflows help section.

Events
Events raised out of the standard interface for Anthology Student are supported only in the new object model.

Events raised out of the legacy interface for Anthology Student are supported in the legacy model (using legacy
contracts, activities, and entity mapping tables). However, the legacy model will be phased out. Any new work-
flows for events raised out of the legacy interface for Anthology Student 17.1 and later should be migrated to
use the new object model.

Contracts
The contracts that the legacy services/activities were developed against are not migrated. Instead, the contracts
that the legacy services/activities use become part of the new object model/command model.

The legacy contracts will be supported for a designated length of time allowing for customers to adjust any
applicable workflows to use the new entities and their corresponding contracts. The specific steps/process for
how affected workflows are updated/modified will need to be determined.

If you are migrating from an older version of Anthology Student to a newer version, you may need to work with
two instances of Workflow Composer where one instance uses the V1 and V2 packages of the older Anthology
Student version and the second instance uses the V1 and V2 packages for the new Anthology Student version.

When all workflows are migrated to use the new activities, uninstall the old contracts. A new user from Antho-
logy Student 17.1 forward should never install the old contracts/activities.

Converted Entities
In the new object model, the conversion of entity values is no longer required. The CVueIdToPersonIdActivity
and PersonIdToCVueIdActivity are no longer needed, and the following conversion formulas no longer apply:

For Student:

l PersonId = (SyStudentId * 10 ) + 1

Other entities:

l SyStaffId + '2'
l SyAddressId + ‘3’
l PlEmployerContactId + ‘4’



Workflow Version 4.0.1 441 Help Guide

l AmAgencyContactId + ‘5’
l SyOrganizationContactId + ‘6’
l AmOnlineApplicantId + ‘7’

For Student Group: GroupId = (SyGroupsId * 10 ) + 1

Note: In new and migrated workflows, the Campus (Id) property replaces the Business Unit (Id) property.
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End-of-Life for Anthology Student Activities (V1)
On announcing the General Availability (GA) of a major or minor release version of a software product, Antho-
logy Inc. also announces the End-of-Life (EOL) date and End-of-Support (EOS) date for other versions, if applic-
able. Anthology’s policy is to support the newly released GA version as well as the two major or minor release
versions immediately preceding the new GA version.

With the release of Anthology Student 21.0 in October 2019, the EOL date for Anthology Student Activ-
ities (V1) is scheduled for October 2020 and the EOS date is scheduled for April 2021.

During the EOL period, Anthology will only evaluate Severity 1 issues. All other lesser Severity issues will not be
addressed. Once a product version reaches its EOS date, assistance or resolution of any issues reported will no
longer be provided. Anthology will only provide the recommendation to upgrade to a version of the product
that is not currently EOL or EOS.

The EOL and EOS process allows Anthology to focus development and support efforts on a smaller set of
releases, thereby increasing the effectiveness and quality of those releases, while enabling customers to take
advantage of the latest available enhancements and resolutions. We encourage our customers, especially those
who are on an EOS version or a version in an EOL period, to upgrade to the most current version of our soft-
ware.

For previous releases of Anthology Student, the Package Manager in Workflow Composer provided Activities for
the legacy CampusVue object model (V1) and the new object model (V2).

l Activities that were developed in the legacy object model and are required to support events raised out
of Anthology Student were migrated to new namespaces. The migrated activities retain the original activ-
ity names and properties but reside in a new namespace.

l Activities that were developed in the legacy object model and are no longer required to support events
raised out of Anthology Student were not migrated to new namespaces. Activities that were not migrated
are replaced by different activities in the new object model.

Actions Required
Customers using V1 activities in their workflows will need to replace the V1 activities with V2 activities during the
EOL period for V1 Activities. The revised workflows will need to be tested to verify the desired functionality.

The table below identifies V1 activities and their corresponding V2 replacements.

l For activities that have been migrated, simply replace the V1 activity with the V2 activity with the same
activity name but residing in a different namespace.

l For activities that have not been migrated, remove the V1 activity, insert the suggested V2 activities, and
adjust the workflow logic as needed.
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V1 Namespaces and Activities Migrated V2 Namespaces and Activities

Cmc.Nexus.Converters

CVueIdToPersonIdActivity No GetEntity / SaveEntity in Cmc.Core.Work-
flow.Activities.EntityModelPersonIdToCVueIdActivity No

Cmc.Nexus.Workflow

CompleteAction No N/A

CreateDocument Yes CreateDocument in Cmc.Nexus.Crm.Workflow

LookupExtendedProperty No LookupReferenceItem in Cmc.Nex-
us.Common.Workflow

LookupGroup No LookupStudentGroup in Cmc.Nex-
us.Common.Workflow

LookupListItem No LookupReferenceItem in Cmc.Nex-
us.Common.Workflow

LookupPerson No GetEntity in Cmc.Core.Work-
flow.Activities.EntityModel

LookupPersonDocuments No LookupStudentDocuments in Cmc.Nex-
us.Crm.Workflow

ManageGroupMembership Yes ManageGroupMembership in Cmc.Nex-
us.Common.Workflow

SaveDocument Yes SaveDocument in Cmc.Nexus.Crm.Workflow

SaveExtendedProperty No SaveEntity in Cmc.Core.Work-
flow.Activities.EntityModel

SavePerson No SaveEntity in Cmc.Core.Work-
flow.Activities.EntityModel

Cmc.Nexus.Workflow.Crm Cmc.Nexus.Crm.Workflow

CreateTask Yes CreateTask

LookupStudentTasks Yes LookupStudentTasks

SaveTask Yes SaveTask

Cmc.Nexus.Workflow.Sis Cmc.Nexus.Common.Workflow

AssignStudentAdvisor Yes AssignStudentAdvisor

LookupAdvisor Yes LookupAdvisor

LookupStudent No GetEntity in Cmc.Core.Work-
flow.Activities.EntityModel
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V1 Namespaces and Activities Migrated V2 Namespaces and Activities

LookupStudentAdvisors Yes LookupStudentAdvisors

Cmc.Nexus.Workflow.Sis.Academics Cmc.Nexus.Academics.Workflow

ConvertApplicantToEnrollment Yes ConvertApplicantToEnrollment

CreateStudentCourse Yes CreateStudentCourse

CreateStudentEnrollmentPeriod No N/A

LookupAreaOfStudy No LookupReferenceItem in Cmc.Nex-
us.Common.Workflow

LookupClassSections Yes LookupClassSections

LookupCurrentEnrollmentPeriod Yes LookupCurrentEnrollmentPeriod

LookupEnrollmentPeriods Yes LookupEnrollmentPeriods

LookupTerms Yes LookupTerms

SaveStudentCourse Yes SaveStudentCourse

SaveStudentEnrollmentPeriod No N/A

UpdateNsldsWithdrawalDate No N/A

Cmc.Nexus.Workflow.Sis.Academics Cmc.Nexus.Common.Workflow

UpdateStudentStatusToActive Yes UpdateStudentStatusToActive

UpdateStudentStatusToDrop Yes UpdateStudentStatusToDrop

UpdateStudentStatusToEnrolled Yes UpdateStudentStatusToEnrolled

UpdateStudentStatusToGraduate Yes UpdateStudentStatusToGraduate

UpdateStudentStatusToLead Yes UpdateStudentStatusToLead

UpdateStudentStatusToTempOut Yes UpdateStudentStatusToTempOut

Cmc.Nexus.Workflow.Sis.Admissions Cmc.Nexus.Common.Workflow

UpdateStudentStatusToApplicant Yes UpdateStudentStatusToApplicant

Cmc.Nexus.Workflow.Sis.StudentAccounts Cmc.Nexus.StudentAccounts.Workflow

CreateCharge Yes CreateCharge

SaveCharge Yes SaveCharge

Cmc.Nexus.Workflow.Sis.StudentServices Cmc.Nexus.StudentServices.Workflow

CreateStudentDisabilityDetail Yes CreateStudentDisabilityDetail
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V1 Namespaces and Activities Migrated V2 Namespaces and Activities

CreateStudentSportsService Yes CreateStudentSportsService

CreateStudentVeteranDetail Yes CreateStudentVeteranDetail

LookupServiceListItem No LookupReferenceItem in Cmc.Nex-
us.Common.Workflow

SaveStudentDisabilityDetail Yes SaveStudentDisabilityDetail

SaveStudentSportsService Yes SaveStudentSportsService

SaveStudentVeteranDetail Yes SaveStudentVeteranDetail

Note: If workflows that contain V1 Activities have not been updated prior to upgrading to Anthology Student
22.x and installing 22.x Activities and Contracts packages, perform the following steps:

1. Uninstall the V1 and V2 packages for 22.x.

2. Import an earlier version of V1 and V2 packages (e.g., 21.x).

3. Update the workflows to replace the V1 activities.

4. Re-import the 22.x packages.

Run Time Messages About V1 Activities
Workflow Composer 4.x displays warning messages when V1 activities are detected in workflows.

l If no packages with V1 activities are installed —

When you try to open (from File or Server) a workflow with V1 activities, the following messages are dis-
played:
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When you try to run a workflow with V1 activities, the following messages are displayed:

l If packages with V1 activities are installed —
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When you try to run or open a workflow with V1 activities, the following message is displayed. You can
replace the V1 activities and update the workflow.

Note: If you imported packages for Anthology Student 22.0 or later, you will need to install a prior version
of Anthology Student packages to edit workflows that have V1 activities. After you have edited the work-
flows and replaced V1 with V2 activities, you can re-import the newer packages.

Script to Locate V1 Activities
To locate all occurrences of V1 activities in your workflows, you can run the script below. The script identifies the
workflows using V1 activities and, on a per-workflow basis, lists the V1 activities that are being used. It also gives
a count of how many times each activity occurs in the workflow so that you know how many occurrences to look
for in the workflow while updating it.

If you wish to validate the script in an environment, you can do so by opening the XAML for the workflow in a
text editor and searching for all occurrences of V1 activity elements in the document. These elements will have
the following namespace prefixes:

l cnc

l cnw

l cnwc

l cnws

l cnwsa

l cnwsa1

l cnwss

l cnwss1

Example:
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<cnw:LookupGroup DisplayName="Lookup Pending App Group" Group="[groupadd]"
GroupId="314411" sap2010:WorkflowViewState.IdRef="LookupGroup_1" />

LookupGroup is a V1 activity in the XAML because it starts with “cnw:” which is the Cmc.Nex-
us.Workflow namespace.

The results of the manual search should match the results shown by the script in terms of what activities are
identified, and how many of each there are.

/******************************************************************
**
** Find Workflows Using V1 Activities
**
** Author: Mike Carter, Technical Account Manager, Anthology Inc
** Date: 7/16/2021
**
** Locate enabled workflows which are using V1 activities and,
** on a per-workflow basis, list each Activity name and how
** many occurrences of each activity there are in the workflow
**
** Identify the V1 activites by the following namespaces:
** Cmc.Nexus.Converters
** Cmc.Nexus.Workflow (and also namespaces prefixed by this)
**
*******************************************************************/

declare
@WorkflowName nvarchar(max)

,@EnabledVersion int
,@xaml xml

if object_id('tempdb..#AffectedWorkflows') is not null drop table #AffectedWorkflows
select

WorkflowDefinition.Name as WorkflowName
,WorkflowDefinitionVersion.Revision as EnabledVersion
,cast(WorkflowDefinitionVersion.Xaml as XML) as xaml

into #AffectedWorkflows

from
WorkflowDefinition
inner join WorkflowDefinitionVersion on WorkflowDefinitionVersion.WorkflowDefinitionId = Work-

flowDefinition.Id

where
WorkflowDefinitionVersion.IsEnabled = 1
and (

WorkflowDefinitionVersion.Xaml like '%clr-namespace:Cmc.Nexus.Converters%'
or WorkflowDefinitionVersion.Xaml like '%clr-namespace:Cmc.Nexus.Workflow%'

)

--select * from #AffectedWorkflows order by WorkflowName

if object_id('tempdb..#Output') is not null drop table #Output
create table #Output (WorkflowName nvarchar(max), EnabledVersion int, ActivityName varchar(50),
Occurrences int)
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declare Records_Cursor cursor local fast_forward for
select WorkflowName, EnabledVersion, xaml from #AffectedWorkflows

open Records_Cursor

while 1=1
begin

fetch next from Records_Cursor INTO @WorkflowName, @EnabledVersion, @xaml
if @@FETCH_STATUS <> 0

break

;with walkXML
as
( select

startNodes.query('./*') curLevelXml
,startNodes.value('local-name(.)', 'varchar(50)') NodeName
,startNodes.value('namespace-uri(.)', 'varchar(500)') NodeNamespaceUri

from
@xaml.nodes('/*') t(startNodes) --starting with nodes under the root

union all

select
childNodes.query('./*') curLevelXml
,childNodes.value('local-name(.)', 'varchar(50)') NodeName
,childNodes.value('namespace-uri(.)', 'varchar(500)') NodeNamespaceUri

from
walkXML
cross apply curLevelXml.nodes('./*') t2(childNodes) --child nodes descending down into the

xml document
)

insert into #Output(WorkflowName, EnabledVersion, ActivityName, Occurrences)
select @WorkflowName, @EnabledVersion, NodeName, count(1)
from walkXML
where

NodeNamespaceUri like 'clr-namespace:Cmc.Nexus.Converters%'
or NodeNamespaceUri like 'clr-namespace:Cmc.Nexus.Workflow%'

group by NodeName

end
close Records_Cursor;
deallocate Records_Cursor;

select * from #Output
order by WorkflowName, ActivityName
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Entity Mapping
Anthology implements a new domain model that aggregates the entities from the three legacy application
domains into a single unified model. For example, the Anthology domain includes a Person entity. The Student
and Staff entities in Anthology Student will map to the Person entity. The Contact entity in CRM will map to the
Person entity. The Donor entity in Talisma Fundraising will map to the Person entity. Additionally, the Anthology
domain includes functional roles. The end result is that there is a common Person entity which has associated
functional roles.

Common Entity Properties
The common entity properties OriginalValues and ModifiedProperties are only initialized for use in
events when EntityState is Modified.

ExtendedProperties is not currently used by any events.

Converted Entities
Entities that are mapped between Anthology Student and the Anthology domain are marked with the keyword
CONVERTED in the mapping tables. The following conversion formula applies to the converted entities:

For Student:

l PersonId = (SyStudentId * 10 ) + 1

Other entities:

l SyStaffId + '2'
l SyAddressId + ‘3’
l PlEmployerContactId + ‘4’
l AmAgencyContactId + ‘5’
l SyOrganizationContactId + ‘6’
l AmOnlineApplicantId + ‘7’

Class-based Inheritance
Some classes in the Cmc.Nexus.Sis.FinancialAid entity inherit properties of another class. When one class inher-
its from another, all fields from the base class are also available.

Mapping Tables
Refer to the following topics for the mapping of Anthology entities and their associated classes and properties
to tables and fields in the Anthology Student database.
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Cmc.Nexus
The following table shows the mapping of classes and properties in the Cmc.Nexus entity to tables and fields in
the Anthology Student database.

Anthology
Class

Anthology Property
Anthology Student Table.Field
Name

Comments

AddressBase

AddressTypeId N/A This property is required in
the contract; however, the cur-
rent mapping logic ignores
the value provided since the
only address attributes cur-
rently being updated are
those on the SyStudent
record.

City SyStudent.City, SyStaff.City, SyAd-
dress.City

Depends on if SyStudent,
SyStaff, or SyAddress record
is in context.

CountryId SyStudent.SyCountryId,
SyStaff.SyCountryId, SyAd-
dress.SyCountryId

Depends on if SyStudent,
SyStaff, or SyAddress record
is in context.

CountryName SyAddress.Country N/A for SyStudent and
SyStaff records

CountyId SyStudent.SyCountyId, SyAd-
dress.SyCountyId

Depends on if SyStudent or
SyAddress record is in con-
text. N/A for SyStaff

CountyName SyAddress.County N/A for SyStudent and
SyStaff records

DoNotContact N/A

DoNotContactOverride N/A

EffectiveBeginDate SyAddress.BeginDate N/A for SyStudent and
SyStaff records

EffectiveEndDate SyAddress.EndDate N/A for SyStudent and
SyStaff records

FirstName N/A

Id SyAddress.SyAddressId or NULL

Cmc.Nexus Mapping
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Anthology
Class

Anthology Property
Anthology Student Table.Field
Name

Comments

IsNotValid SyStudent.BadAddr N/A for SyStaff and SyAd-
dress records

IsPreferred N/A

IsSeasonal SyAddress.Yearly N/A for SyStudent and
SyStaff records

LastName SyAddress.LastName N/A for SyStudent and
SyStaff records

Note N/A

PhoneNumber SyStudent.Phone, Systaff.Phone,
SyAddress.Phone

Depends on if SyStudent,
SyStaff, or SyAddress record
is in context.

PostalCode SyStudent.Zip, SyStaff.Zip, SyAd-
dress.Zip

Depends on if SyStudent,
SyStaff, or SyAddress record
is in context.

StateId N/A

StateName SyStudent.State, SyStaff.State,
SyAddress.State

Depends on if SyStudent,
SyStaff, or SyAddress record
is in context.

StreetAddress SyStudent.Addr1, SyStaff.Addr1,
SyAddress.Addr1

Depends on if SyStudent,
SyStaff, or SyAddress record
is in context.

TitleId SyAddress.TitleID N/A for SyStudent and
SyStaff records

BusinessUnit

Id SyCampus.SyCampusId

Ethnicity

Id SyStudentAmRace.AmRaceId

FunctionalRole

RoleType N/A An enum property. 0=
Unknown, 1= Prospect, 2=St-
tudent, 3=Staff
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Anthology
Class

Anthology Property
Anthology Student Table.Field
Name

Comments

Group The Group class in Anthology maps to the SyGroups table in Anthology Student. Eventually, the
SyStaffGroup and SyEmpGroups tables will also be mapped to this entity. The Anthology domain
merges Staff Groups, Student Groups, and Employer Groups into one Group and Group Mem-
bership class. This brings consistency to all functionality for the Groups concept in Anthology. Addi-
tionally, Groups in Anthology are able to mix membership between Person and Organizations within
a single Group.

AdvisorRelationshipTypeId SyStaffGroup.AdvisorModule

AssociatedBusinessUnits SyGroups.SyCampusGrpId,
SyCampusList.SyCampusId

Code SyGroups.Code

ExpirationDate SyGroups.DateExpires

Id SyGroups.SyGroupsId Mapping occurs between
Anthology Student and Antho-
logy:
For Student Group: GroupId =
(SyGroupsId * 10 ) + 1

IsActive SyGroups.Active

IsPublic SyGroups.PublicGroup

IsStaffGroup N/A or True if mapping from Staff-
group

No mapping as all Staff
Groups in Anthology Student
are stored in SyStaffGroup;
however, the value in this
Anthology property determ-
ines which table gets updated
in Anthology Student. If this is
True, then SyStaffGroup is
updated.

IsSystem N/A

MembershipFunctionalRoles N/A No mapping. Anthology
Group entity allows mem-
bership in a group from dif-
ferent entities.

Name SyGroups.Descrip

OwnerUserId SyGroups.SyStaffId
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Anthology
Class

Anthology Property
Anthology Student Table.Field
Name

Comments

StaffGroupBusinessUnitId N/A No mapping. Method for
determining which Business
units (Campuses in Antho-
logy Student) a given staff
user is associated with is
implemented differently in
Anthology than in Anthology
Student.

StaffGroupType N/A

Usage N/A

GroupMembership

AddedDate SyStudGrp.DateAdded

AddedUserId StudGrp.UserIdOn

GroupId SyGroups.SyGroupsId Mapping occurs between
Anthology Student and Antho-
logy:
For Student Group: GroupId =
(SyGroupsId * 10 ) + 1

Id SyStudGrp.SyStudGrpId

IsActive SyStudGrp.Active

OrganizationId N/A

PersonId SyStudGrp.SyStudentId
(CONVERTED)

RemovedDate SyStudGrp.DateOff

RemovedUserId SyStudGrp.UserIdOff

Nationality

Id SyStudent.AmNationalityId

Organization No mapping is currently done
for this class.
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Anthology
Class

Anthology Property
Anthology Student Table.Field
Name

Comments

Addresses N/A

DateCreated N/A

Id N/A

Name N/A

Note N/A

OrganizationContacts N/A

OrganizationUrl N/A

OwnerId N/A

Phones N/A

PrimaryContactId N/A

SicCode N/A

Person

Addresses Collection of PersonAddress

BirthCountryId N/A

BirthDate SyStudent.Dob

Cases N/A

Emails Collection of PersonEmail

Ethnicities Collection of PersonEthnicity

FirstName SyStudent.FirstName,
SyStaff.FirstName

Depends on if SyStudent or
SyStaff record is in context.

FunctionalRoles See FunctionalRole Students, Prospects are
added when mapping from
SyStudent.

GenderId SyStudent.AmSexId

HasDisability SyStudent.Disabled

Id SyStudent.SyStudentId
(CONVERTED), SyStaff.SyStaffId
(CONVERTED)
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Anthology
Class

Anthology Property
Anthology Student Table.Field
Name

Comments

Interactions Collection of Interaction (see Inter-
action class in CMC.Nexus.Crm)

Interests N/A

LastContactDate SyStudent.LastActivityDate

LastName SyStudent.LastName,
SyStaff.LastName

Depends on if SyStudent or
SyStaff record is in context.

MaidenName SyStudent.MaidenName

MaritalStatusId SyStudent.AmMaritalId

MiddleName SyStudent.MiddleName

Name N/A

Nationalities Collection of Nationality where Id
field maps to SyStu-
dent.AmNationalityId.

Contract supports multiple val-
ues; however, only the first
value provided is updated to
SyStudent.AmNationalityId.

NickName SyStudent.NickName

Phones Collection of PhoneBase

PreferredLanguageId N/A

Prospects Read-only collection of Prospect This is a read-only collection.
No data provided in this col-
lection will be persisted to the
Anthology Student database.
See Prospect class in
CMC.Nexus.SIS.Admissions
for additional information.

Salutations N/A

Ssn SyStudent.Ssn

Students Read-only collection of Student This is a read-only collection.
No data provided in this col-
lection will be persisted to the
Anthology Student database.
See Student class in
CMC.Nexus.SIS for addi-
tional information.

SuffixId SyStudent.AmSuffixId Not mapped in Saved events.
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Anthology
Class

Anthology Property
Anthology Student Table.Field
Name

Comments

TitleId SyStudent.AmTitleId

Veteran SyStudent.Vet

PersonAddress Inherits from AddressBase.

PersonDocument

ApprovalDate CmDocument.DateApproved

AwardYear CmDocument.AwardYear

CreatedbyUserId CmDocument.AddUserId Documents added via auto-
mated Document Scheduler
processes may not contain a
value for this field.

DocumentCategoryId CmDocument.SyModuleId

DocumentStatusId CmDocument.CmDocStatusId

DocumentTypeId CmDocument.CmDocTypeId

DueDate CmDocument.DateDue

ExpirationDate CmDocument.DateExpires

Id CmDocument.CmDocumentId

ModifiedByUserID CmDocument.UserId Documents added via auto-
mated Document Scheduler
processes may not contain a
value for this field.

Note CmDocument.Comments

PersonId CmDocument.SyStudentId
(CONVERTED)

ProspectId CmDocument.SyStudentId

ReceivedDate CmDocument.DateRecv

RequestDate CmDocument.DateReq

SentDate CmDocument.DateSent

StudentId CmDocument.SyStudentId StudentId and ProspectId are
purposely both mapped to
CmDocument.SyStudentId

WorkflowInstanceId CmDocument.WorkflowInstanceId
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Anthology
Class

Anthology Property
Anthology Student Table.Field
Name

Comments

PersonEmail

DisplayName N/A

EmailAddress SyStudent.Email, SyStaff.Email,
SyStaff.Email_ReplyTo

Depends on if SyStudent or
SyStaff record is in context.

EmailTypeId If SyStaff.Email, set to "1". If
SyStaff.Email_ReplyTo, set to "2".

EmailType is enum for now: 1
= PRIMARY, 2 =
SECONDARY

PersonEthnicity

Ethnicities Collection of Ethnicity where Id
field maps to SyStu-
dentAmRace.AmRaceId.

Multiple values for Ethnicity
can be provided.

IsHispanicLatino SyStudent.IsHispanic

PersonId SyStudentAmRace.SyStudentId
(CONVERTED)

PersonPhone Inherits from PhoneBase

PhoneBase

DoNotContact N/A

DoNotContactOverride N/A

Extension N/A There is an Ext for Work
phone, but not Phone in
SyStudent.

IsNotValid SyStudent.Badphone

IsPreferred N/A

PhoneNumber SyStudent.Phone, SyStaff.Phone,
SyStaff.WorkFaxPhone,
SyStaff.WorkPhone,
SyStaff.HomePhone

Depends on if SyStudent or
SyStaff record is in context.

PhoneTypeId If SyStaff.Phone, set to "1". If
SyStaff.WorkFaxPhone, set to "2".
If SyStaff.CellPhone, set to "3". If
SyStaff.HomePhone, set to "4"

PhoneType is enum for now:
1=HOME, 2=WORK,
3=MOBILE, 4=OTHER
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Cmc.Nexus.Crm
The following table shows the mapping of classes and properties in the Cmc.Nexus.Crm entity to tables and
fields in the Anthology Student database.

Anthology
Class

Anthology Property
Anthology Student Table.Field
Name

Comments

Interaction No mapping currently exists to any Anthology Student table.

BusinessUnitId

CaseId

CaseState

CommunicationChannelId

CommunicationDirection

CreatedbyUserId

CreatedDate

EventHeader

EventType

From

Id

InteractionEmail

MessageBody

PersonId

PhoneNumber

ProspectId

ShowExpandCollapse

Subject

To

Task

CreatedByUserId CmEvent.SetupBy

DueDate CmEvent.DueDate

Cmc.Nexus.Crm Mapping
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Anthology
Class

Anthology Property
Anthology Student Table.Field
Name

Comments

Id CmEvent.CmEventId

Location N/A

Note CmEvent.Comments

OwnerUserId CmEvent.SyStaffId
(CONVERTED)

People People is a collection of Person.
CmEvent.SyStudentId
(CONVERTED)

PersonId is the only property
that is populated.

PercentageComplete N/A

Priority CmEvent.Priority Converted to enum TaskPriority

ReminderDate CmEvent.RemindDate

ReminderInterval N/A

StartDate CmEvent.StartDate The time the activity is sched-
uled to begin. Only the time por-
tion of this value is relevant.

Subject CmEvent.Subject or EmailSub-
ject if Subject is NULL

TaskResultId CmEvent.CmEventResultId

TaskStatusId CmEvent.CmEventStatusId

TaskTypeId CmEvent.CmTemplateId

WorkflowInstanceId CmEvent.WorkflowInstanceId
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Cmc.Nexus.FinancialAid.Services
The following table shows the mapping of classes and properties in the Cmc.Nexus.FinancialAid.Services
namespace to tables and fields in the Anthology Student database.

Anthology
Class

Anthology Property Anthology Student Table.Field Name
Comments

GetIsirRe-
sponse

This contract specifies the ServiceResponse from the service operation called when the LookupIsir
activity is executed. This contract is coupled to the response returned from the GetIsirResponse ser-
vice operation.

Note: GetIsirResponse is a custom service response message and not an entity within the Antho-
logy command model. The GetIsirResponse fields are returned in the OutAr-
gument<IsirMessage> of the LookupIsir activity.

AdditionalFields This is of type Dictionary
and will be a key/value pair
array that holds the data
for all fields from the ISIR
all data view (vw_
FaIsirNewAllIncluded) that
are not separate defined
properties in the contract.

ApplicationCompletedDate vw_FaIsirNewAllIn-
cluded.DateCompleted

ApplicationReceiptDate vw_FaIsirNewAllIn-
cluded.ApplicationRcptDate

AwardYearIdentifier vw_FaIsirNewAllIncluded.FaYearId

CommentCodes vw_FaIsirNewAllIn-
cluded.CommentCodes

Mapping logic would parse
vw_FaisirNewAllIn-
cluded.CommentCodes
and build collection of Com-
mentCodes.

DegreeCertificate vw_FaIsirNewAllIncluded.Degree

DependencyStatus vw_FaisirNewAllIncluded.Model

EnrollmentStatus FaStudentPell.PellEnrollmentStatus

FatherIncome vw_FaIsirNewAllIn-
cluded.FatherIncome

GradeLevel vw_FaIsirNewAllIn-
cluded.CollegeGradeLevel

Cmc.Nexus.FinancialAid.Services Mapping
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Anthology
Class

Anthology Property Anthology Student Table.Field Name
Comments

HasChildrenToSupport vw_FaIsirNewAllIncluded.Children

HasDrugConviction vw_FaIsirNewAllIn-
cluded.DrugOffense

HasHighSchoolDiplomaGed vw_FaIsirNewAllIn-
cluded.HSGedReceived

HasOtherLegalDependents vw_FaIsirNewAllIn-
cluded.LegalDependents

InstitutionalEfc FaStudentPell.InstitutionalEfc

Inter-
estedWorkStudyStu-
dentLoans

vw_FaIsirNewAllIn-
cluded.InterestedInAid

IsActiveDutyArmedForces vw_FaIsirNewAllIn-
cluded.ActiveDutyMilitary

IsAutomaticZeroEfc vw_FaIsirNewAllIn-
cluded.Auto0EFCFlag

IsDodMatch vw_FaIsirNewAllIn-
cluded.DodMatchFlag

IsFirstBachelorDegree vw_FaIsirNewAllIn-
cluded.FirstBachDegree

IsirMatchId FaIsirStu-
dentMatch.FaIsirStudentMatchId

IsirReceivedDate vw_FaIsirNewAllIncluded.DateAdded

IsirSummaryId vw_FaIsirNewAllIncluded.FaisirMainId

IsSimplifiedNeedsTestMet vw_FaIsirNewAllIn-
cluded.SimplifiedNeeds

IsStudentMale vw_FaisirNewAllIncluded.Male

IsStudentMarried vw_FaIsirNewAllIn-
cluded.Stu-
dentMaritalStatusAsOfToday

IsVeteranArmedForces vw_FaIsirNewAllIncluded.Veteran

IsWork-
ingToward-
sMastersDoctorate

vw_FaIsirNewAllIn-
cluded.DegreeBeyond
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Anthology
Class

Anthology Property Anthology Student Table.Field Name
Comments

MotherIncome vw_FaIsirNewAllIn-
cluded.MotherIncome

NsldsActiveBankruptcyFlag vw_FaIsirNewAllIn-
cluded.ActiveBankruptcyFlag

Nsld-
sAggregateLoanBalance

vw_FaIsirNewAllIn-
cluded.AggrCombinedBal

Nsld-
sAg-
gregateSubLoanBalance

vw_FaIsirNewAllIn-
cluded.AggrSubsidizedBal

Nsld-
sAg-
gregateUnsubLoanBalance

vw_FaIsirNewAllIn-
cluded.AggrUnsubBal

NsldsDatabaseResultsFlag vw_FaIsirNewAllIn-
cluded.DatabaseResultsFlag

NsldsDefaultedLoanFlag vw_FaIsirNewAllIn-
cluded.DefaultedLoanFlag

NsldsDischargedLoanFlag vw_FaIsirNewAllIn-
cluded.DischargedLoanFlag

NsldsFraudLoanFlag vw_FaIsirNewAllIn-
cluded.FraudLoanFlag

Nsld-
sPellLifetimeEligibilityUsed

vw_FaIsirNewAllIn-
cluded.PellLifetimeEligUsed

NsldsPellLifetimeLimitFlag vw_FaIsirNewAllIn-
cluded.PellLifeTimeLimitFlag

NsldsPellOverpaymentFlag vw_FaIsirNewAllIn-
cluded.PellOverpayFlag

Nsld-
sPerkinsOverpaymentFlag

vw_FaIsirNewAllIn-
cluded.PerkinsOverpayFlag

Nsld-
sSat-
isfactoryRepaymentFlag

vw_FaIsirNewAllIn-
cluded.LoanSat-
isfactoryRepaymentFlag

Nsld-
sSeogOverpaymentFlag

vw_FaIsirNewAllIn-
cluded.SeogOverpayFlag

Nsld-
sTeachOverpaymentFlag

vw_FaIsirNewAllIn-
cluded.TeachOverpayFlag
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Anthology
Class

Anthology Property Anthology Student Table.Field Name
Comments

Nsld-
sUnusualEnrollmentFlag

vw_FaIsirNewAllIn-
cluded.EnrollmentPatternFlag

Par-
entAdjustedGrossIncome

vw_FaIsirNewAllIn-
cluded.ParentGross

Par-
entBusinessFarmNetWorth

vw_FaIsirNewAllIn-
cluded.ParentBusiness

ParentCash vw_FaIsirNewAllIncluded.ParentCash

ParentChildSupportPaid vw_FaIsirNewAllIn-
cluded.ParentChildSupportPaid

Par-
entChildSupportReceived

vw_FaIsirNewAllIn-
cluded.ParentChildSupportReceive

ParentCombatPay vw_FaIsirNewAllIn-
cluded.ParentCombatPay

ParentContribution vw_FaIsirNewAllIn-
cluded.ParentContribution

ParentDislocatedWorker vw_FaIsirNewAllIn-
cluded.ParentDislocatedWorker

ParentEducationCredits vw_FaIsirNewAllIn-
cluded.ParentEducationCredits

ParentEligibletoFile1040 vw_FaisirNewAllIn-
cluded.ParentElig1040

Par-
entFeder-
alBenefitsFreeSchoolLunch

vw_FaIsirNewAllIn-
cluded.ParentFreeLunch

ParentFederalBenefitsSsi vw_FaIsirNewAllIn-
cluded.ParentSSIBenefits

ParentFederalBenefitsSnap vw_FaIsirNewAllIn-
cluded.ParentFoodStamps

ParentFederalBenefitsTanf vw_FaIsirNewAllIn-
cluded.ParentTANFBenefits

ParentFederalBenefitsWic vw_FaIsirNewAllIn-
cluded.ParentWICBenefits

ParentIncomeTaxPaid vw_FaIsirNewAllIn-
cluded.ParentIncomeTax
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Anthology
Class

Anthology Property Anthology Student Table.Field Name
Comments

ParentInterestIncome vw_FaIsirNewAllIn-
cluded.ParentInterestIncome

ParentInvestmentNetWorth vw_FaIsirNewAllIn-
cluded.ParentInvestment

ParentIraDistributions vw_FaisirNewAllIn-
cluded.ParentIRADistributions

ParentIraPayments vw_FaIsirNewAllIn-
cluded.ParentIRAPayments

ParentLegalResidenceDate vw_FaIsirNewAllIn-
cluded.ParentLegResDate

Par-
entLegalStateOfResidence

vw_FaIsirNewAllIn-
cluded.ParentLegState

ParentMaritalStatus vw_FaIsirNewAllIn-
cluded.ParentMaritalStatus

Par-
entMilitaryClergyAllowance

vw_FaIsirNewAllIn-
cluded.ParentMilitaryAllowance

Par-
entNeedBasedEmployment

vw_FaIsirNewAllIn-
cluded.Par-
entNeedBasedEmployment

ParentNumberInCollege vw_FaIsirNewAllIn-
cluded.ParentNumCollege

ParentNumberInFamily vw_FaIsirNewAllIn-
cluded.ParentNumFamily

Par-
entNumberOfExemptions

vw_FaIsirNewAllIn-
cluded.ParentExemptions

ParentPensionBenefits vw_FaIsirNewAllIn-
cluded.ParentPensionPayments

ParentTaxFormUsed vw_FaisirNewAllIn-
cluded.ParentTaxFormType

ParentTaxReturnStatus vw_FaIsirNewAllIn-
cluded.ParentTaxReturnFilingStatus

ParentUntaxedIncomeOther vw_FaIsirNewAllIn-
cluded.ParentOtherUntaxedIncome

ParentUntaxedIncomeTotal vw_FaIsirNewAllIn-
cluded.ParentUntaxedIncomeTotal
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Anthology
Class

Anthology Property Anthology Student Table.Field Name
Comments

ParentUntaxedPension vw_faisirNewAllIn-
cluded.ParentUntaxedPension

Par-
entVet-
eranNonEducationBenefits

vw_faisirnewAllIn-
cluded.Par-
entvetNonEducationBenefits

PellGrantAmount FaStudentPell.PellAmount

PellGrantEligibilityFlag vw_FaIsirNewAllIncluded.PellEligFlag

PellPaidEfc FaStudentPell.PellPaidEfc

PrimaryEfc vw_FaIsirNewAllIncluded.PEFC

SarCCode vw_FaIsirNewAllIncluded.SarCFlag

SelectedForVerification vw_FaIsirNewAllIn-
cluded.SelectedForVerification

SpouseIncome vw_FaIsirNewAllIn-
cluded.SpouseIncome

Stu-
dentAdjustedGrossIncome

vw_FaIsirNewAllIn-
cluded.StudentGross

StudentCitizenship vw_FaIsirNewAllIncluded.Citizen

StudentDateOfBirth vw_FaIsirNewAllIncluded.DOB

StudentId FaIsirStudentMatch.SyStudentId

StudentIncome vw_FaisirNewAllIn-
cluded.StudentIncome

Stu-
dentLegalResidenceDate

vw_FaIsirNewAllIn-
cluded.StudentLegResDate

Stu-
dentLegalStateOfResidence

vw_FaIsirNewAllIn-
cluded.StudentLegState

StudentMaritalStatus vw_FaIsirNewAllIn-
cluded.StudentMaritalStatus

StudentMaritalStatusDate vw_FaIsirnewAllIn-
cluded.StudentMaritalStatusDate

StudentTaxFormUsed vw_FaIsirNewAllIn-
cluded.StudentTaxFormType
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Anthology
Class

Anthology Property Anthology Student Table.Field Name
Comments

StudentTaxReturnStatus vw_FaIsirNewAllIn-
cluded.StudentTaxReturnFilingStatus

TransactionProcessDate vw_FaIsirNewAllIn-
cluded.TransactionProcessedDate

TransactionReceiptDate vw_FaIsirNewAllIn-
cluded.TransactionReceiptDate

VerificationStatus FaStudentPell.VerifStatus

VerificationTrackingFlag vw_FaIsirNewAllIn-
cluded.VerificationTrackingFlag

IsirMatch

AwardYearId FaIsirStudentMatch.FaYearId

CreatedDateTime FaIsirStudentMatch.DateAdded

Id FaIsirStu-
dentMatch.FaIsirStudentMatchId

IsirSummaryId FaIsirStudentMatch.FaIsirMainId

LastModifiedDateTime FaIsirStudentMatch.DateLstMod

LastModifiedUserId FaisirStudentMatch.UserId

RowVersion N/A

SchoolCode FaIsirStudentMatch.PellId

StudentId FaIsirStudentMatch.SyStudentId
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Cmc.Nexus.Sis
The following table shows the mapping of classes and properties in the Cmc.Nexus.Sis entity to tables and fields
in the Anthology Student database.

Anthology
Class

Anthology Property
Anthology Student Table.Field
Name

Comments

Staff

AdmissionsRepTypeId SyStaff.AmReptypeId

CampusGroupId SyStaff.SyCampusGrpId

Code SyStaff.Code

Department SyStaff.Department

HiredDate SyStaff.HiredDate

Id SyStaff.SyStaffId

IsActive SyStaff.Active

Note SyStaff.Comments

PersonId SyStaff.SyStaffId (CONVERTED)

Position SyStaff.Position

TaskPolicyyId SyStaff.CmPolicyId

Title SyStaff.Title

StaffGroup

AdvisorModule SyStaffGroup.AdvisorModule

Code SyStaffGroup.Code

Id SyStaffGroup.SyStaffGroupId

IsActive SyStaffGroup.Active

IsSystemCode SyStaffGroup.System

Name SyStaffGroup.Descrip

StaffGroupMember

Id SyStaffByGroup.SyStaffByGroupId

StaffGroupId SyStaffByGroup.SyStaffGroupId

Cmc.Nexus.Sis Mapping
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Anthology
Class

Anthology Property
Anthology Student Table.Field
Name

Comments

StaffId SyStaffByGroup.SyStaffId

Student

AssociatedBusinessUnits AdEnroll.SyCampusId The contract allows for mul-
tiple Business Unit IDs.
Anthology Student has only
a single Campus ID that is
populated in this property.

AthleticIdentifier SyStudent.AthleticId

Id AdEnroll.SyStudentId

PersonId AdEnroll.SyStudentId (CONVERTED)

ShiftId AdEnroll.AdShiftId

Stu-
dentEnrollmentPeriods

Collection of Stu-
dentEnrollmentPeriod

When the Student Enroll-
ment Wizard uses a Person
Saving event, each step
only fills out a few fields in
the Person.Students(0).Stu-
dentEnrollmentPeriods(0)
entity based on the step
Context.

StudentExtraCurriculars Collection of StudentExtraCurricular

StudentNumber AdEnroll.Stunum

StudentAdvisor The StudentAdvisor entity is created for the sole purpose of supporting the current domain of
Anthology Student. In the long term vision, student advisors will be persisted as Relationships.
The specific members of the Relationship class in Anthology as well as all of the details around
the Relationships feature in general have not yet been finalized. Thus it is premature to use the
Relationship entity and contract to support the needed workflow functionality for Advisors in
Anthology Student 17.0. For now, the StudentAdvisor class/entity is available and aligned com-
pletely with the existing Anthology Student domain.

AdvisorModule SyAdvisorByEnroll.AdvisorModule

Id SyAd-
visorByEnroll.SyAdvisorByEnrollId

StaffGroupId SyAdvisorByEnroll.SyStaffGroupId

StaffId SyAdvisorByEnroll.SyStaffId

Stu-
dentEnrollmentPeriodId

SyAdvisorByEnroll.AdEnrollId
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Anthology
Class

Anthology Property
Anthology Student Table.Field
Name

Comments

StudentExtraCurricular

ExtraCurricularId Ampro-
spectExtraCurr.AmExtraCurrId

IsPrimary Ampro-
spectExtraCurr.PrimaryExtraCurr

StudentId AmprospectExtraCurr.SyStudentId

Anthology
Class

Anthology Property Anthology Student Table.Field
Name

Comments

Students AssociatedBusinessUnits AdEnroll.SyCampusId The contract allows for mul-
tiple business unit IDs.
Anthology Student has only
a single Campus ID that is
populated in this property.

Id AdEnroll.AdEnrollId

PersonId AdEnroll.SyStudentId
(CONVERTED)

Mapping occurs between
Anthology Student and
Anthology.

For Student, PersonId =
(SyStudentId * 10 ) + 1.
Other entities: SyStaffId +
'2', SyAddressId +
‘3’,PlEmployerContactId +
‘4’,AmAgencyContactId +
‘5’,SyOrganizationContactId
+ ‘6’,AmOnlineApplicantId +
‘7’

ShiftId AdEnroll.AdShiftId

Stu-
dentEnrollmentPeriods

See StudentEnrollmentPeriod
class in CMC.Nexus.Sis.Academics.

StudentNumber AdEnroll.Stunum
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Cmc.Nexus.Sis.Academics
The following table shows the mapping of classes and properties in the Cmc.Nexus.Sis.Academics entity to
tables and fields in the Anthology Student database.

Anthology Class
Anthology Property

Anthology Student
Table.Field Name

Comments

AreasOfStudy Current mapping logic only updates to the AdProgramVersion table. No mapping is currently
done to the AdConcentration table.

AreaOfStudyType N/A

Code AdprogramVersion.Code

GradeScaleId AdPro-
gramVer-
sion.AdGradeScaleId

Id AdProgramVersion.
AdProgramversionId

IsActive AdprogramVersion.Active

MinimumGpa N/A

Name AdProgramVersion.Descrip

ProgramId AdPro-
gramVersion.AdProgramId

RequiredCredits AdPro-
gramVersion.CreditsReq

RequiredHours AdPro-
gramVersion.HoursReq

ClassSection

AddDropDate AdClassSched.Ad-
dDropDate

AllowWaitlist AdClassSched.Al-
lowWaitlisting

AuditAdvisementRequired AdClassSched.
AuditAdvisementRequired

AutoDropCon-
secutiveHoursAbsent

AdClassSched.DropCon-
sAbsent

Cmc.Nexus.Sis.Academics Mapping
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Anthology Class
Anthology Property

Anthology Student
Table.Field Name

Comments

AutoDropCu-
mulativeHoursAbsent

AdClassSched.DropCumAb-
sent

AutoDropEn-
forceAfterLastDateToWithdraw

AdClassSched.
EnforceAttendanceLDW

AutoDropPer-
centageHoursAbsent

AdClassSched.DropAb-
sentPct

AutoWarn-
ingConsecutiveHoursAbsent

AdClassSched.WarnCon-
sAbsent

AutoWarn-
ingCumulativeHoursAbsent

AdClassSched.WarnCumA-
bsent

AutoWarningOnClassRoster
AfterLastDateToWithdraw

AdClassSched.
AutoDropWarningForLDW

AutoWarn-
ingPercentageHoursAbsent

AdClassSched.WarnAb-
sentPct

BusinessUnits Collection of BusinessUnit AdClassSched.SyCam-
pusId will be the only value
populated in this collection.

ClassSectionInstructors Collection of ClassSec-
tionInstructor

Course See Course class.

CreatedbyUserId AdClassSched.UserId

DeliveryMethodId AdClassSched.AdDe-
liveryMethodId

EndDate AdClassSched.EndDate

Id AdClassSched.AdClassSch-
edId

IsActive AdClassSched.Active

LastDayToWithdrawDate AdClassSched.LdwDate

LmsExtractStatus AdClassSched.Lm-
sExtractStatus

MakeupMaxType AdClassSched.MakeupMax-
type
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Anthology Class
Anthology Property

Anthology Student
Table.Field Name

Comments

MakeupMaxValue AdClassSched.MakeupMax-
Num

MaximumSeats AdClassSched.MaxStu-
dents

ModifiedByUserId AdClassSched.UserId

Note AdClassSched.SchedCom-
ment

PassFailType AdClassSched.PassFailSet-
ting

PostAttendancetype AdClassSched.At-
tendancetype

RegisteredStudents AdClassSched.RegStu-
dents

SectionCode AdClassSched.Section

ShiftId AdClassSched.AdShiftId

StartDate AdClassSched.StartDate

Stu-
dentSpecificMeetingSchedule

AdClassSched.
AllowStu-
dentSpecificMeeting

Stu-
dentSpecificMeetingSchedule
DefaultMinutes

AdClassSched.
DefaultMeet-
ingLengthStudentSpecific

TermId AdClassSchedTer-
m.AdTermId

WaitListMaximumSeats AdClassSched.
WaitListMaxnumOfSeats

ClassSec-
tionInstructor

Mapping is applicable to AdClassSchedInstructor only if instructor is secondary instructor.
Primary instructor is stored in column on AdClassSched.

Id AdClassSchedInstructor.
AdClassSchedInstructorId

InstructorId AdTeacher.SyStaffId Join to AdTeacher on
AdClassSchedIn-
structor.AdteacherId

Type N/A
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Anthology Class
Anthology Property

Anthology Student
Table.Field Name

Comments

Course

AddDropDays AdCourse.AddDropDays

AddDropDaystype AdCourse.Ad-
dDropCalendarDays

BusinessUnits Collection of BusinessUnit Join to SyCampusgroup on
AdCourse.SyCampusGrpId
and then to SyCampusList
on SyCampusGrpId to
retrieve the collection of
SyCam-
pusList.SyCampusIds that
are associated to the
instance of Course.

Code AdCourse.Code

CourseLevelId AdCourse.AdCourseLevelId

CourseTypeId AdCourse.AdCourseTypeId

CourseUnits Collection of CourseUnit

CreatedByUserId AdCourse.UserId

GradeLevel AdCourse.GradeLevel

Id AdCourse.AdCourseId

IsActive AdCourse.Active

IsRemedialCourse AdCourse.IsCourseRe-
medial

ModifiedByUserId AdCourse.UserId

Name AdCourse.Descrip

Note AdCourse.Comments

PublishCode AdCourse.CatalogCode

CourseUnit

CourseId AdCourse.AdCourseId
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Anthology Class
Anthology Property

Anthology Student
Table.Field Name

Comments

Id N/A Not sure how to populate
this as there is nothing this
maps to in existing Antho-
logy Student schema. Pur-
posely making this property
nullable in contract because
of this. Normally, Id property
in contract is not nullable.

Type N/A If Credits, then UnitValue is
AdCourse.Credits. If Hours,
then UnitValue is
AdCourse.Hours.

UnitValue AdCourse.Hours,
AdCourse.Credits

Value of Type dictates if
Hours or Credits.

Stu-
dentAreasOfStu-
dy

Current mapping logic only updates to the AdEnroll table. AdConcentrationbyEnrollment is not
updated from this contract in the current implementation.

AreaOfStudyDetails See AreasOfStudy class.

AreaofStudyId AdEn-
roll.AdprogramVersionId

CatalogId AdEnroll.AdCatalogYearId

DeclaredDate AdEnroll.Startdate

Id N/A

StudentEnrollmentPeriodId AdEnroll.AdEnrollId

StudentId AdEnroll.SyStudentId

StudentCourse

ClassSectionId AdEn-
rollSched.AdClassSchedId

ClassSec-
tionSeatAllocationRuleId

N/A

CourseId AdEnrollSched.AdCourseId

EndDate AdEnrollSched.EndDate

ExpectedEndDate AdEn-
rollSched.ExpectedEndDate
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Anthology Class
Anthology Property

Anthology Student
Table.Field Name

Comments

GradePoints AdEnrollSched.Points

GradePostedDate AdEn-
rollSched.DateGradePosted

GradeScaleId AdEn-
rollSched.AdGradeScaleId

Id AdEn-
rollSched.AdEnrollSchedId

IsAudit AdEnrollSched.IsAudit

LastAttendanceDate AdEnrollSched.LDA

LetterGrade AdEn-
rollSched.AdGradeLet-
terCode

Note AdEnrollSched.Comments

NumericGrade AdEn-
rollSched.NumericGrade

PersonId AdEnrollSched.SyStudentId
(CONVERTED)

PreviousStatus AdEn-
rollSched.PreviousStatus

StartDate AdEnrollSched.StartDate
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Anthology Class
Anthology Property

Anthology Student
Table.Field Name

Comments

Status AdEnrollSched.Status The mapping for Anthology
Entity Status to Anthology
Student Status is as follows:

Entity Status Antho-
logy Stu-
dent
 Status

NotTaken Future

Registered Sched-
uled

CurrentlyAttend-
ing 

Current

GradePosted Com-
plete

Withdrawal Dropped

Since each Entity Status
change can raise multiple
events in Anthology
Student, workflows using
the Status property need to
check for multiple status
changes. Please refer to
Check for Stu-
dentCourse.Status
Changes for details.

StudentId AdEnrollSched.SyStudentId

TermId AdEnrollSched.AdtermId

TranscriptNote AdEn-
rollSched.Tran-
scriptComment

UnitValues Collection of Stu-
dentCourseUnitValue

StudentCourseUnitValue

Id N/A Anthology Student does not
have a separate units table.
So this is ignored in map-
ping logic?
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Anthology Class
Anthology Property

Anthology Student
Table.Field Name

Comments

StudentCourseId AdEn-
rollSched.AdEnrollSchedId

Type Used to determine which
AdEnrollSched fields to
update

Valid Values for Stu-
dentCourseUnitValueType -
"Credits" or "Hours"

Units AdEnrollSched.Credits,
AdEnrollSched.Hours

If Stu-
dentCourseUnitValueType
= "Credits" THEN AdEn-
rollSched.Credits ELSE
AdEnrollSched.Hours

UnitsAttempted AdEn-
rollSched.CreditsAttempt,
AdEn-
rollSched.HoursAttempt

If Stu-
dentCourseUnitValueType
= "Credits" THEN AdEn-
rollSched.CreditsAttempt
ELSE AdEn-
rollSched.HoursAttempt

UnitsEarned AdEn-
rollSched.CreditsEarned,
AdEn-
rollSched.HoursEarned

If Stu-
dentCourseUnitValueType
= "Credits" THEN AdEn-
rollSched.CreditsEarned
ELSE AdEn-
rollSched.HoursEarned

StudentEnrollmentPeriod

AccountSummary See AccountSummary on
CMC.Nex-
us.Sis.StudentAccounts.

ApplicantTypeId AdEn-
roll.AmApplicantTypeId

ApplicationReceivedDate N/A

AreasOfStudy Collection of Stu-
dentAreaOfStudy

AssignedAdmissionsRepId AdEnroll.AmRepId

CampusId AdEnroll.SyCampusId

EducationLevelId AdEnroll.AmPrevEducId

EnrollDate AdEnroll.EnrollDate

EnrollmentNumber AdEnroll.StuNum
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Anthology Class
Anthology Property

Anthology Student
Table.Field Name

Comments

EnrollmentStatusId AdEnroll.AdAttStatId

ExpectedGraduationDate AdEnroll.GradDate

ExpectedStartDate AdEnroll.ExpStartDate

ExternshipStartDate AdEnroll.ExternBeginDate

GradeLevelId AdEnroll.AdGradeLevelId

GraduationDate AdEnroll.GradDate

Id AdEnroll.AdenrollId

IpedsTransfer AdEnroll.IPEDSTransfer

Lda AdEnroll.LDA

MidpointDate AdEnroll.MidDate

Note AdEnroll.Comment

NsldsWithdrawalDate AdEn-
roll.NSLDSWithdrawalDate

SapFlag AdEnroll.Sap

StartDate AdEnroll.StartDate

StartTermId AdEnroll.AdtermId

StudentId AdEnroll.SyStudentId

StudentStatusId AdEnroll.SySchoolStatusId

TransferCredits AdEnroll.TransferCredits

Term

BusinessUnits Collection of BusinessUnit Join to SyCampusgroup on
Adterm.SyCampusGrpId
and then to SyCampusList
on SyCampusGrpId to
retrieve the collection of
SyCam-
pusList.SyCampusIds that
are associated to the
instance of Term.

Code AdTerm.Code

EndDate AdTerm.EndDate
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Anthology Class
Anthology Property

Anthology Student
Table.Field Name

Comments

Id Adterm.AdtermId

IsActive AdTerm.Active

Name AdTerm.Descrip

StartDate AdTerm.StartDate
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Cmc.Nexus.Sis.Admissions
The following table shows the mapping of classes and properties in the Cmc.Nexus.Sis.Admissions entity to
tables and fields in the Anthology Student database.

Anthology
Class

Anthology Property Anthology Student Table.Field Name Comments

Prospect Mapping logic does not currently map to SyStudentInquiry.

AssignedAdmissionsRepId SyStudent.AmRepId

AssignedStaffGroupId N/A

AssociatedBusinessUnits SyStudent.SyCampusId Contract allows
for multiple Busi-
ness Unit values;
however, only
first value
provided is
mapped to Antho-
logy Student.

CreatedByUserId SyStudent.UserId

DateAdded SyStudent.DateAdded

DateModified SyStudent.DateLstMod

EducationLevelId SyStudent.AmPrevEducId

ExpectedStartDate SyStudent.StartDate

HighSchoolGpa SyStudent.HsAcademicGPA

Id SyStudent.SyStudentId

LeadDate SyStudent.LeadDate

LeadStatusId SyStudent.SySchoolStatusId

LeadTypeId SyStudent.AmLeadTypeId

Person N/A

PrimaryLeadSourceId SyStudent.AmLeadSrcId

RatingId N/A

SecondaryLeadSource N/A

Tasks N/A

Cmc.Nexus.Sis.Admissions Mapping
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Anthology
Class

Anthology Property Anthology Student Table.Field Name Comments

VendorOrganizationId N/A

ProspectLeadSource

Id AmProspectLeadSrc.AmProspectLeadSrcId

LeadSourceId AmprospectLeadSrc.AmLeadSrcId
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Cmc.Nexus.Sis.CareerServices
The following table shows the mapping of classes and properties in the Cmc.Nexus.Sis.CareerServices entity to
tables and fields in the Anthology Student database.

Anthology
Class

Anthology Property Anthology Student Table.Field Name Comments

StudentEmploymentHistory

EmployerId PlStudentPlacement.PlEmployerId

Id PlStudentPlacement.PlStudentPlacementId

PlacedDate PlStudentPlacement.DatePlaced

Status PlStudentPlacement.Status

StatusReasonId N/A

StudentId PlStudent.SyStudentId

StudentPlacementSummaryId  PlStudentPlacement.PlStudentId

StudentPlacementSkill

Id PlStudentSkill.PlStudentSkillId

SkillId PlStudentSkill.PlSkillId

StudentPlacementSummaryId PlStudentSkill.PlStudentId

StudentPlacementSummary 

Id PlStudent.PlStudentId

PersonId PlStudent.SyStudentId (CONVERTED)

PlacementStatusId PlStudent.SySchoolStatusId

PlacementStatusReasonId PlStudent.PlReasonId

StudentDegreeId N/A

StudentEnrollmentPeriodId PlStudent.AdEnrollId

StudentSkills Collection of StudentPlacementSkill

Cmc.Nexus.Sis.CareerServices Mapping
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Cmc.Nexus.Sis.FinancialAid
The following table shows the mapping of classes and properties in the Cmc.Nexus.Sis.FinancialAid entity to
tables and fields in the Anthology Student database.

Antho-
logy
Class

Anthology Property Anthology Student Table.Field
Name Comments

DirectLoanOrigination

BorrowerDefaultOnLoans FaLoan.BorrowerDefaultOnLoans

PromNoteBorrowerSigned FaLoan.PnSignedByBorrower

DisclosureStatementPrintCode FaLoan.PrintDisclosureCode

IncludeOnManifest FaLoan.PnIncludeOnManifest

InterestRebatePercentage FaLoan.InterestRebatePct

ManifestDate FaLoan.ManifestDate

MpnExpirationDate FaLoan.MpnExpirationDate

MpnIdentifier FaLoan.PnDirectLoanId?

MpnLinkIndicator FaLoan.MpnIndicator

MpnType FaLoan.MpnType

OriginationAcknowledgeDate FaLoan.AcknowledgeDate

OriginationBatchIdentifier FaLoan.OriginationBatchId

OriginationDate FaLoan.OriginationDate

OriginationFeePercentage FaLoan.OriginationFeePct

OriginationRejectCodes FaLoan.OrigRejectCodes

OriginationStatus FaLoan.OriginationStatus

PlusLoan See DirectLoanOriginationPlus
class.

Pre-
par-
atoryProfessionalCourseWork

FaLoan.PrePro-
fessionalCourseWorkIndicator

Cmc.Nexus.Sis.FinancialAid Mapping
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Antho-
logy
Class

Anthology Property Anthology Student Table.Field
Name Comments

PromNoteAcceptedAmountDate FaLoan.PnAcceptedAmountDate

PromNotePrintCode FaLoan.PnPrintIndicator

PromNotePrintedDate FaLoan.DatePnPrinted

PromNoteSignedDate FaLoan.DatePnSigned

PromNoteSignedReceivedDate FaLoan.DateSignedPnReceived

PromNoteStatus FaLoan.PnStatus

RebateAmount

UnsubLoan See Dir-
ectLoanOriginationUnsub class.

DirectLoanOriginationPlus Inherits from Dir-
ectLoanOrigination.

CreditDecisionDate FaLoan.PlusCreditDecisionDate

CreditDecisionStatus FaLoan.PlusCreditDecisionStatus

StudentCitizenStatus FaLoan.StudentCitizenStatus

StudentDefaultOnLoans FaLoan.StudentDefaultOnLoans

DirectLoanOriginationSub Inherits from Dir-
ectLoanOrigination. No
unique properties in this class
other than what is inherited
from DirectLoanOrigination.

DirectLoanOriginationUnsub Inherits from Dir-
ectLoanOrigination.

AdditionalUnsubEligibility FaLoan.UnsubEligibilityFlag

ParentDeniedPlusLoan FaLoan.ParentRejectedForPlus

DirectLoanScheduledDisbursement Inherits from Stu-
dentAwardSched-
uledDisbursement.

ActualDisbursementDate FaSched.ActDisbDate
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Antho-
logy
Class

Anthology Property Anthology Student Table.Field
Name Comments

CodStatus FaSched.DlStatus

DisbursementPercentage FaSched.DlPercentage

OverrideDisbursementDate FaSched.OverrideDisbDate

RebateAmount FaSched.InterestRebateAmt

FundSource

Code FaFundSource.Code

FundSourceType FaFundSource.Type

Id FaFundSource.FaFundSourceId

Name FaFundSource.Descrip

TitleIv FaFundSource.TitleIv

PaidDisbursement

AmountPaid FaDisb.ActualAmount

CheckNumber FaDisb.CheckNumber

Id FaDisb.FaDisbId

Note N/A

PaidDate FaDisb.DateDisb

Status FaDisb.Status

Stu-
dentAca-
demicYearPaymentPeriod

FaDisb.AdtermId, FaDis-
b.FaStudentAyPaymentPeriodId

Depending on what type of
payment period is being asso-
ciated in Anthology Student,
this property may map to mul-
tiple Anthology Student fields.

PellScheduledDisbursement Inherits from Stu-
dentAwardSched-
uledDisbursement.

ClockHours FaSched.ClockHours

CodStatus FaSched.PgDisbStatus

EnrollmentStatus FaSched.EnrollmentStatus
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Antho-
logy
Class

Anthology Property Anthology Student Table.Field
Name Comments

PaymentPeriodBeginDate FaSched.Pay-
mentPeriodBeginDate

Refund

Amount FaRefund.Amount

CheckNumber FaRefund.CheckNo

DueDate FaRefund.DateDue

Id FaRefund.FaRefundId

Note FaRefund.Comment

PaidDate FaRefund.DateSent

ReturnMethod FaRefund.ReturnMethod

Status FaRefund.Status

Stu-
dentAca-
demicYearPaymentPeriod

FaRefund.AdTermId,
FaRefund.FaPmtPeriodId,
FaRe-
fun-
d.FaStudentAyPaymentPeriodId

Depending on what type of
payment period is being asso-
ciated in Anthology Student,
this property may map to mul-
tiple Anthology Student fields.

ScheduledDisbursement

AmountExpected FaSched.NetAmount

ExpectedDate FaSched.DateSched

Id FaSched.FaSchedId

Note N/A

Status FaSched.Status

Stu-
dentAca-
demicYearPaymentPeriod

FaSched.AdTermId,
FaSched.FaPmtPeriodId,
FaSched.FaStu-
dentAyPaymentPeriodId,
FaSched.FaStu-
dentLpPaymentPeriodId

Depending on what type of
payment period is being asso-
ciated in Anthology Student,
this property may map to mul-
tiple Anthology Student fields.

StudentAcademicYear

AcademicYearMonths FaStudentAy.MonthsInAy

AcademicYearSequence FaStudentAy.Sequence
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Antho-
logy
Class

Anthology Property Anthology Student Table.Field
Name Comments

AcademicYearTemplateId FaStudentAy.FaAcademicYearId

AcademicYearUnits FaStudentAy.CreditHoursInAy

AcademicYearWeeks FaStudentAy.WeeksInAy

AwardYears FaStudentAy.AwardYear1, FaStu-
dentAy.AwardYear2

BudgetId FaStudentAy.FaBudgetId

BudgetItems Collection of Stu-
dentAcademicYearBudgetItem

Changes to Budget Items will
trigger a separate event from
changes to main Student Aca-
demic Year event entity. For
example, if you change Hous-
ing from Off Campus to On
Campus, you will receive two
events — one for housing
status change on the main
entity and one for changes to
the Budget Items collection for
Room and Board.

CreatedByUserId FaStudentAy.UserId

EligibleHealthProfession FaStudentAy.HPPALevel

EndDate FaStudentAy.EndDate

FaAdvisorId SyAdvisorByEnroll.SyStaffId Find row in SyAdvisorByEnroll
WHERE AdEnrollId = Stu-
dentEnrollmentPeriodId AND
AdvisorModule = 'FA'

FirstTimeBorrower FaStudentAy.FirstTimeBorrower

GradeLevelId FaStudentAy.AdGradeLevelId

HousingStatus FaStudentAy.HousingStatusCode

Id FaStudentAy.FaStudentAyId

ModifiedByUserId FaStudentAy.UserId
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Antho-
logy
Class

Anthology Property Anthology Student Table.Field
Name Comments

Note Most recent comment is stored in
FaStudentAy.Comment.
Only for Saving event. N/A for
Saved event.

Comments are now stored in
separate table FaStu-
dentAy.Comment and not in
the FaStu-
dentAy.AyComments field.
Additional comments can be
found in that table, but are not
provided within the event.

PersonId SyStudent.SyStudentId
(CONVERTED)

PlusCreditDecision FaStu-
dentAy.PlusCreditDecisionStatus

StartDate FaStudentAy.StartDate

StudentAwardSummaries Collection of Stu-
dentAwardSummary

StudentEnrollmentPeriodId FaStudentAy.AdEnrollId

UnitsExpectedToComplete FaStu-
dentAy.Cred-
itHoursExpToComplete

WeeksEnrolled FaStudentAy.WeeksEnrolledInAy

WeeksNonEnrolled FaStudentAy.WeeksNonEnroll

StudentAcademicYearBudgetItem

Amount FaStudentAy.Tuition, Book-
sSupplies, InstitutionalCharges,
RoomBoard, Travel, Other-
Amount#

Depending on what type of
budget cost item it is will
determine which field in FaStu-
dentAy this is mapped to.

CostDescription N/A Description of budget cost
item. Not mapped to anything
in Anthology Student.

CostTypeChargeCodeId N/A
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Antho-
logy
Class

Anthology Property Anthology Student Table.Field
Name Comments

CostType Not mapped. Is Enum property. Not mapped to field in Antho-
logy Student. However, this
will determine which type of
budget cost item this is, which
will determine which fields in
the FaStudentAy record to
map to.

The valid values for this prop-
erty in Anthology are: Tuition,
Books/Supplies, Room/Board,
Travel, Bank Fees, Other

IsInstitutionalCharge FaStudentAy.OtherInst#

StudentAcademicYearId FaStudentAy.FaStudentAyId

StudentAcademicYearPaymentPeriod This does not map directly to
any table in Anthology
Student. Depending on how
payment periods are defined,
this Anthology class may map
to AdTerm, FaStu-
dentAyPaymentPeriod, or
FaStu-
dentAyLPPaymentPeriod.

Id

PaymentPeriod

PaymentPeriodEndDate

PaymentPeriodStartDate

Sequence

StudentAcademicYearId

StudentAward

AwardAmount FaStudentAid.AmountPackaged

CreateDate FaStudentAid.DateAdded

CreatedByUserId FaStudentAid.UserId

FundSourceId FaStudentAid.FaFundSourceId

Id FaStudentAid.FaStudentAidId
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Antho-
logy
Class

Anthology Property Anthology Student Table.Field
Name Comments

ModifiedbyUserId FaStudentAid.UserId

Note FaStudentAid.Comment

PaidDisbursements Collection of Stu-
dentAwardPaidDisbursement

This entity collection is not
mapped in Saved or Saving
events.

Refunds Collection of Refund. This entity collection is not
mapped in Saved or Saving
events.

ScheduledDisbursements Collection of Stu-
dentAwardSched-
uledDisbursement

This entity collection is avail-
able only in Saving events, not
in Saved events.

Sched-
uledDisbursementsTemplateId

N/A

Status FaStudentAid.Status

StudentAcademicYearId FaStudentAid.FaStudentAyId

StudentAwardSummaryId N/A

StudentAwardGrant Inherits from StudentAward.
No other properties in this
class other than what is inher-
ited from StudentAward.

StudentAwardLoan Inherits from StudentAward.

DirectLoanDetail See DirectLoanOrigination
class.

This entity is available only in
Saving events, not in Saved
events.

GuarantorId FaStudentAid.FaGuarantorId

LenderFee FaStudentAid.BankFee

LenderId FaStudentAid.FaBankId

LoanIdentifier FaLoan.CommonlineLoanId or
FaLoan.DirectLoanId or N/A

If a Direct loan, then
FaLoan.DirectLoanId. If a loan
that will be processed via Com-
monline, then FaLoan.Com-
monlineLoanId.

LoanPeriodEndDate FaStudentAid.DateLoanStart
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Antho-
logy
Class

Anthology Property Anthology Student Table.Field
Name Comments

LoanPeriodStartDate FaStudentAid.DateLoanEnd

ServicerId FaStudentAid.FaServicerId

StudentAwardPaidDisbursement

DepositDate FaDisb.DateDeposited

DisbursementNumber FaDisb.DisbNum

SignedDate FaDisb.DateSigned

StudentAwardPell Inherits from StudentAward.

AcademicCalendar FaStu-
dentPell.AcademicCalendar

AdministrativeRelief FaStudentPell.AdminRelief

EnrollmentDate FaStudentPell.EnrollDate

EnrollmentStatus FaStu-
dentPell.PellEnrollmentStatus

IncarceratedCode FaStudentPell.IncarceratedCode

Life-
timePercentageEligibilityUsed

FaStudentPell.LifetimeEligUsed

Num-
ber-
OfPay-
mentPeriodsInAcademicYear

FaStudentPell.NumPayPeriods

OriginationAmount FaStudentPell.PellAmount

OriginationStatus FaStudentPell.OriginationStatus

PaymentMethodology FaStu-
dentPell.PaymentMethodology

PercentageEligibilityUsed FaStu-
dentPell.TotalEligibilityUsed

StudentAwardScheduledDisbursement Inherits from Sched-
uledDisbursement.
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Antho-
logy
Class

Anthology Property Anthology Student Table.Field
Name Comments

DirectLoanDisbursement See Dir-
ectLoanSched-
uledDisbursement class.

DisbursementNumber FaSched.Disbnum

LenderFee FaSched.BankFee

StudentAwardSummary

AwardDate FaStudentAy.PackageDate

AwardedEnrollmentStatusId FaStu-
dentAy.PackagedToAdAttStatId

AwardingStatusId FaStudentAy.FaPackStatusId or
FaStudentAy.
AwardYear2FaPackStatusId

If AwardYear is in FaStu-
dentAy.AwardYear2, then the
awarding status will be in the
AwardYear2FaPackStatusId
attribute.

AwardMethodId FaStudentAy.FaPackMethId

AwardNoticePrinted FaStudentAy.AwardNoticePrinted

AwardNoticeSigned FaStudentAy.AwardNoticeSigned

AwardRevised FaStudentAy.PackageRevised

AwardRevisedNoticePrinted FaStu-
dentAy.RevisedNoticePrinted

AwardRevisedNoticeSigned FaStu-
dentAy.RevisedNoticeSigned

AwardYear FaStudentAy.AwardYear1 or
FaStudentAy.AwardYear2

AwardYearId FaYear.FaYearId

Id FaStudentAy.FaStudentAyId

IsModelOverride FaStudentPell.ModelOverride

Model FaStudentPell.Model

PersonId SyStudent.SyStudentId
(CONVERTED)
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Cmc.Nexus.Sis.StudentAccounts
The following table shows the mapping of classes and properties in the Cmc.Nexus.Sis.StudentAccounts entity
to tables and fields in the Anthology Student database.

Antho-
logy
Class

Anthology Property
Anthology Student Table.Field
Name

Comments

AccountChargeTransaction

ChargeCodeId SaTrans.SaBillCode Contract property is Id; however,
billcode in SaTrans is char. So, Id is
retrieved from SaBillCode.

InvoiceNumber SaTrans.Ref

AccountSummary

AccountBalance AdEnroll.ArBalance

AccountStatuses Collection of Accoun-
tStatusDetail

Multiple Account Statuses are
allowed. Currently, in Anthology Stu-
dent each different account status
specified for an enrollment is an
instance in SaEnrollAcctStatus.

BillingMethodId AdEnroll.SabillingMethodId

BusinessUnitId N/A

Id AdEnroll.AdEnrollId

PersonId SyStudent.SyStudentId
(CONVERTED)

StudentEnrollmentPeriodId AdEnroll.AdEnrollId

AccountTransaction

AddUserId SaTrans.AddUserId

AccountChargeTransaction
- Derived Type

See Accoun-
tChargeTransaction class.

Accoun-
tPaymentTransaction -
Derived Type

See Accoun-
tPaymentTransaction class.

Amount SaTrans.Amount

Cmc.Nexus.Sis.StudentAccounts Mapping
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Antho-
logy
Class

Anthology Property
Anthology Student Table.Field
Name

Comments

BillingPeriodId SaTrans.AdtermId

BusinessUnitId SaTrans.SyCampusId

Description SaTrans.Descrip

Id SaTrans.SaTransId

PersonId SaTrans.SyStudentId
(CONVERTED)

PostDate SaTrans.PostDate

ProspectId SaTrans.SyStudentId

Reference SaTrans.Ref

StudentBillingPeriodId SaTrans.FaPmtPeriodId

StudentEnrollmentPeriodId SaTrans.AdEnrollId

TransactionDate SaTrans.Date

TransactionType SaTrans.Type

AccountPaymentTransaction

CheckNumber SaTrans.CheckNo

ReceiptNumber SaTrans.ReceiptNo

AccountStatusDetail

AccountStatusId SaCollectionAccountStatus.
SaAcctStatusID

For a CollectionAccount event, the
fields listed in the column to the left
are returned .

For an AccountSummary event, the
following fields are returned:

l SaEn-
rollAcctStatus.SaAcctStatusI-
D

l SaEn-
rollAcctStatus.SaEn-
rollAcctStatusID

Id SaCollectionAccountStatus.
SaCollectionAccountStatusID

CollectionAccount
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Antho-
logy
Class

Anthology Property
Anthology Student Table.Field
Name

Comments

AccountStatuses Collection of Accoun-
tStatusDetail

Multiple Account Statuses are
allowed. Currently, in Anthology Stu-
dent each different account status
specified for a collection account is
an instance in SaCol-
lectionAccountStatus.

BlockStatement SaCollections.BlockStatement

DunningProcessOff SaCol-
lections.DunningProcessoff

Id SaCollections.SaCollectionsId

LastStatementAmount SaCol-
lections.StatementAmount

LastStatementDate SaCollections.StatementDate

PaymentPlanSummaryId SaCollections.FaStudentAidId

PersonId SaCollections.SyStudentId
(CONVERTED)

ProspectId SaCollections.SyStudentId

ReadyForCollectionDate SaCol-
lec-
tions.ReadyForCollectionDate

StatementNote SaCollections.StatementMemo

StudentEnrollmentPeriodI SaCollections.AdEnrollId

StudentPaymentPlan

FirstPaymentDate FaStudentAid.FirstPayDate

FundSourceId FaStudentAid.FaFundSourceId

Id FaStudentAid.FaStudentAidId

InterestOnlyUntilDate FaStudentAid.IntOnlyuntilDate

InterestRate FaStudentAid.InterestRate

Note FaStudentAid.Comment

NumberOfPayments FaStu-
dentAid.NumberPayments
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Antho-
logy
Class

Anthology Property
Anthology Student Table.Field
Name

Comments

PaidPayments Collection of Stu-
dentPaymentPlanPayment

This entity collection is not mapped
in Saved or Saving events.

PaymentAmount FaStudentAid.PaymentAmount

PaymentFrequency N/A This appears to just be a field on the
UI in Anthology Student and is not
persisted in the database.

PaymentFrequencyDays FaStudentAid.PaymentFreq

PrincipalAmount FaStudentAid.PrincipalBalance

Refunds Collection of Refund (see
Cmc.Nexus.Sis.FinancialAid)

This entity collection is not mapped
in Saved or Saving events.

ScheduledPayments Collection of Stu-
dentPay-
mentPlanScheduledPayment

SecondaryInterestRate FaStu-
dentAid.SecondaryInterestRate

Sec-
ond-
aryIn-
terestRateEffectiveDate

FaStudentAid.
SecondaryInterestRateEffDate

StatementAddressId FaStudentAid.SyAddressId

Status FaStudentAid.Status

StudentAcademicYearId FaStudentAid.FaStudentAyId

StudentPaymentPlanPayment

InterestAmount FaDisb.InterestAmount

PrincipalAmount FaDisb.ActualAmount – FaDis-
b.InterestAmount

Field for PrincipalAmount does not
exist in FaDisb schema. Amount is
calculated by subtracting InterestA-
mount from ActualAmount.

StudentPaymentPlanScheduledPayment

InterestAmount FaSched.InterestAmount

PrincipalAmount FaSched.PrincipalAmount

StudentPaymentPlanStatement
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Antho-
logy
Class

Anthology Property
Anthology Student Table.Field
Name

Comments

AmountDue SaState-
mentHistory.StatementAmtDue

AmountPastDue N/A

ClosingDate SaState-
mentHistory.ClosingDate

GeneratedDate SaState-
mentHistory.DatePrinted

Id SaState-
mentHis-
tory.SaStatementHistoryId

StudentPaymentPlanId SaState-
mentHistory.FaStudentAidId
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Cmc.Nexus.StudentServices
The following table shows the mapping of classes and properties in the Cmc.Nexus.StudentServices entity to
tables and fields in the Anthology Student database.

Anthology
Class

Anthology Property Anthology Student Table.Field Name Comments

DisabilityType

Id SsDisabilityType.SsDisabilityTypeId

StudentAthleticDetail

AthleticStatusId SsAthleticDetail.SsAthleticStatusId

Id SsAthleticDetail.SsAthleticDetailId

LastActiveTermId SsAthleticDetail.AdTermId

RecruitmentTypeId SsAthleticDetail.SsRecruitmentTypeId

RemainingEligibility SsAthleticDetail.RemainingEligibility

SportId SsAthleticDetail.SsSportsId

StudentId SsAthleticDetail.SyStudentId

StudentDisabilityDetail

DisabilityStatusId SsStudentDisabilityDetail.
SsDisabilityStatusId

DisabilityType SsStudentDisabilityDetail.
SsDisabilityTypeIds

Collection of Dis-
abilityType

Id SsStudentDisabilityDetail.
SsStudentDisabilityDetailId

IsDisabled SsStudentDisabilityDetail.Disabled

IsPriorityRegistration SsStudentDisabilityDetail.
PriorityRegistration

IsRegistrationAssistanceNeeded SsStudentDisabilityDetail.
RegistrationAssistance

Note SsStudentDisabilityDetail.Comments

StudentId SsStudentDisabilityDetail.SyStudentId

StudentVeteranDetail

Cmc.Nexus.StudentServices Mapping
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Anthology
Class

Anthology Property Anthology Student Table.Field Name Comments

BenefitsReceived SsStudentVeteranDetail.
SsveteranBenefitIds

Collection of Vet-
eranBenefit

Id SsStudentVeteranDetail.
SsStudentVeteranDetailId

LastcertifiedTermId SsStudentVeteranDetail.AdtermId

StudentId SsStudentveteranDetail.SyStudentId

VeteranCertificationTypeId SsStudentVeteranDetail.
SsVeteranCertificationTypeId

VeteranTypes SsStudentVeteranDetail.
SsVeteranCodeIds

Collection of Vet-
eranType

VeteranBenefit

Id SsVeteranBenefit.SsVeteranBenefitId

VeteranType

Id SsVeteranCode.SsVeteranCodeId
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Events
Events thats are captured in Anthology can be used to trigger workflow activities.
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Events Overview
The Event Broker listens for incoming events from clients, determines the name of the event, forwards the
event to the configured event handler, and, if required, returns a response to the event. Event messages con-
tain enough basic information to be handled without the need to retrieve additional data from APIs.

The events that are exposed to the Event Broker can be consumed in custom code (for example, C# event hand-
lers) or workflows that automate tasks and enable data to be exchanged between systems.

Anthology events are grouped in the categories depicted below. 

l Saving events and Deleting events are captured and visible at the UI level. VB .NET code is required to
intercept these events. Data validation occurs. Saving and Deleting event workflows must be stored on
the host that is running the application on which the event is captured, for example, Anthology Student.

l Saved events and Deleted events are captured at the database trigger level. These events are only vis-
ible in the event log of the Windows Service NextGen Nexus Event Workflows. Saved and Deleted event
workflows must be stored on a host that has a direct database connection, for example, COM Server.

l Constructed events are captured and visible at the UI level when the components of a record are
assembled. No data validation occurs. VB .NET code is required to intercept these events.

The available event categories depend on the entities. For example, the Person entity in Anthology CRM is asso-
ciated with Constructed, Saving, and Saved events, while the Student Enrollment Period entity in Anthology Stu-
dent is associated only with Saved and Deleted events.

Forms Builder events fall into a different category. These events are triggered whenever the Raise Event rule is
encountered in a sequence.

Note: The initial Workflow and Eventing versions support Saved events and Saving events for CampusNexus
CRM and Anthology Student and the Raise Event rule for Forms Builder.

Workflow Composer enables you to intercept the events and create activities that are triggered by the events.
Activities in a workflow can be triggered by Saved and Saving events.

Events published to the Event Broker are application-specific, that is, a distinct set of events is available for
Anthology Student (see SIS Events), another set of events is available for CampusNexus CRM, another set for
Forms Builder, and so on. Contracts define the messages that will be exchanged between the applications.
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Cmc.Core Events
The following events are common to all workflows regardless of the application, for example Anthology Student,
CampusNexus CRM, or Forms Builder.

Event Property Description

Time-based
event (e.g.,
duration,
schedule)

Entity: Schedule
Event: Sched-
uleOccurrence

This event enables you to create non-request activated worfklows, that
is, workflows based on time or events that occur outside of IIS. The
SQL Server Agent Job scheduling is used to trigger workflows based
on time.

An example of a time-based event is a Delay activity. Workflows with a
Delay activity can be explicitly paused, unloaded, and resumed by
using persistence. For more information about workflow persistence,
see http://msdn.microsoft.com/en-us/library/dd489420
(v=vs.110).aspx.

Cmc.Core Events

http://msdn.microsoft.com/en-us/library/dd489420(v=vs.110).aspx
http://msdn.microsoft.com/en-us/library/dd489420(v=vs.110).aspx
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SIS Events
The following events are specific to Anthology Student.

l Saving events are triggered just prior to data in an Anthology Student form being saved to the database.

l Saved events are triggered just after data is saved to the database.
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SIS Saving Events

Saving events are triggered just prior to data in a form being saved to database and are most often used to
CreateValidationItems on a form. You can configure Error, Information, or Warning messages that are displayed
if any of the data entered on the form fails the configured validation rules. Event are captured and visible at the
UI level. VB .NET code is required to intercept these events. Saving event workflows must be stored on the host
that is running the application on which the event is captured, for example, Anthology Student. The workflow
Check Approved Grants for Comments is an example of a workflow for a saving event. You can create any com-
bination of workflow activities to formulate custom business rules that the system uses to ensure that quality
data is being entered. You can use workflows to:

l Set, change, or remove values for specific fields.
l Perform validation on one or more fields.
l Trigger additional activities to be performed based on event data.

Contracts Anthology Student Form Entity Mapping

Student Master Form

Cmc.Nexus.Contracts >
Cmc.Nexus > Person

Student > Student Master
(frmAmStudMaster or
frmAMStudMasterShort)

Cmc.Nexus
l Person

This event enables you to create workflow activities that are triggered when the Save button is clicked on the Stu-
dent Master form.

Example: A workflow assigns an email address to a student. When the Status field is changed from New Lead to
Interviewed, the student's primary email address is moved to the Other email field and the primary email field is pop-
ulated with a new email address that is created using the first three letters of FirstName and the first five letters of
LastName followed by @myschool.edu.

Student Enrollment Wizard

Cmc.Nexus.Contracts >
Cmc.Nexus > Person

Daily > Admissions > Enroll Student
(frmAmEnroll)
or
View > Academic Records > Enroll-
ment (frmAmEnroll)

Cmc.Nexus
l Person

Cmc.Nexus.Sis.Academics
l StudentEnrollment Periods

This event enables you to create workflow activities that are triggered when the Next button is clicked on any step
(page) of the Student Enrollment wizard and when the Finish button is clicked. You can create workflows that are
triggered at specific points in the enrollment process.

Example: A workflow checks the student's address when an attempt is made to enroll the student in a program that
is not approved in the state where the student lives. The workflow prevents the enrollment if the student's address is
not in a state where the program is approved.

Financial Aid Academic Year Form

SIS Saving Events
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Contracts Anthology Student Form Entity Mapping

Cmc.Nexus.Contracts > Cmc.Nex-
us.Sis.FinancialAid > Student Aca-
demic Year

Student > Financial Aid > Academic
Year (frmFaStudentAY)

Cmc.Nexus.Sis.FinancialAid
l StudentAcademicYear

This event enables you to create workflow activities that are triggered when the Save button is clicked on the Fin-
ancial Aid Academic Year form.

Financial Aid Loan Form

Cmc.Nexus.Contracts > Cmc.Nex-
us.Sis.FinancialAid > Student Loan
Detail

Student > Financial Aid > Pack-
aging > Add > New Source of Aid
> Loan (frmFaStudLoan)

Cmc.Nexus.Sis.FinancialAid
l StudentAward
l StudentAwardLoan
l StudentAwardSummary

This event enables you to create workflow activities that are triggered when the Save button is clicked on the Fin-
ancial Aid Loan form.

Example: Your institution requires students to complete an online course on financial responsibility if they request
loans of more than $2,500 per academic year. You create a workflow that checks the gross loan amount and alerts
the user when the amount is greater than $2,500 for an academic year so that the loan is not packaged prior to the
completion of the online course.

Financial Aid Grant / Scholarship Form

Cmc.Nexus.Contracts > Cmc.Nex-
us.Sis.FinancialAid > Student Grant
Detail

Student > Financial Aid > Pack-
aging > Add > New Source of Aid
> Grant (frmFaStudGrant)

Cmc.Nexus.Sis.FinancialAid
l StudentAward
l StudentAwardSummary

This event enables you to create workflow activities that are triggered when the Save button is clicked on the Fin-
ancial Aid Grant / Scholarship form.

Example: Your institution requires approvers to add comments when they approve a grant / scholarship for a stu-
dent. You create a workflow that checks for entries in the Comments field when the form is saved with a status of
'Approved'. See workflow example Check Approved Grants for Comments.

Financial Aid Grant / Scholarship Form (Source = Pell)

Cmc.Nexus.Contracts > Cmc.Nex-
us.Sis.FinancialAid > Student
Award Pell

Student > Financial Aid > Pack-
aging > Add > New Source of Aid
> Grant, Source = Pell
(frmFaStudPell)

Cmc.Nexus.Sis.FinancialAid
l StudentAward
l StudentAwardSummary

This event enables you to create workflow activities that are triggered when the Save button is clicked on the Fin-
ancial Aid Grant / Scholarship form with Source selection of 'Pell'.

Example: Your institution requires approvers to add comments when they approve a Pell grant for a student. You cre-
ate a workflow that checks for entries in the Comments field when the form is saved with a status of 'Approved'.

Financial Aid Cash Payment/Other Form
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Contracts Anthology Student Form Entity Mapping

Cmc.Nexus.Contracts > Cmc.Nex-
us.Sis.StudentAccounts > Student
Payment Plan

Student > Financial Aid > Pack-
aging > Add > New Source of Aid >
Student Payment/Other
(frmFaStudCashOther)

Cmc.Nexus.Sis.StudentAccounts
l StudentPaymentPlan

This event enables you to create workflow activities that are triggered when the Save button is clicked on the Fin-
ancial Aid Cash Payment/Other form.

Example: Your institution requires multiple payments if the cash amounts is above $800. You create a workflow that
validates the number of payments when the form is saved with a cash amount above $800.

Post Charges Form

Cmc.Nexus.Contracts > Cmc.Nex-
us.Sis.StudentAccounts > Account
Charge Transaction

Daily > Student Accounts > Post
Charges
OR
Student Accounts > Ledger Cards
> Post Charges
(frmSaTransTrxs)

Cmc.Nexus.Sis.StudentAccounts
l AccountChargeTransaction

This event enables you to create workflow activities that are triggered when the Save button is clicked on the Post
Charges form.

Example: The Academic Year, Term, and Payment Period fields are not required fields on the Post Charges form in
Anthology Student, but your institution requires these fields to be populated when charges are posted.

You create a validation workflow that checks whether the user specified the Academic Year, Term, and Payment
Period. If these fields are not populated, an error message is displayed and the user cannot save the transaction or
adjustment.

See Context Property for hints about how to determine the type of event (PostCharge or AdjustCharge).

Class Scheduling Form

Cmc.Nexus.Contracts > Cmc.Nex-
us.Sis.Academics > Class Section

Daily > Academic Records > Sched-
ule Classes (New/Edit)
(frmAdClassSchedOne)

Cmc.Nexus.Sis.Academics
l ClassSection
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Contracts Anthology Student Form Entity Mapping

This event enables you to create workflow activities that are triggered when the Save button is clicked on the Class
Schedule form.

Proper course section configuration is important for the SIS to function properly. Decisions made on this form such
as attendance type, delivery method, and shift can have a ripple affect in the SIS application if they are not set prop-
erly. Outside of the required fields, workflows can ensure that courses are configured properly.

Examples:

l A workflow checks that the section number starts with the current year of the start date, e.g., 2015SPRING-
01, or checks if the section number already exists, otherwise an information message is displayed.

l A workflow checks that enrollment status credits do not exceed course credits, otherwise an error message is
displayed.

l A workflow checks that courses with a delivery type of 'Online' have the code '-O' at the end of the section
number, otherwise an error message is displayed.

l A workflow checks that courses are only scheduled to start on a Tuesday, otherwise a warning message is
displayed.

Transaction Adjustment Form

Cmc.Nexus.Contracts > Cmc.Nex-
us.Sis.StudentAccounts > Account
Charge Transaction

View > Student Accounts > Ledger
Cards > Adjust Transaction
OR
Student Accounts > Ledger Cards >
Adjust Transaction
(frmSaLedgerAdjustment)

Cmc.Nexus.Sis.StudentAccounts
l AccountChargeTransaction

This event enables you to create workflow activities that are triggered when the Save button is clicked on the Trans-
action Adjustment form. Workflow activities can help to ensure the posting of accurate charges and adjustments on
student accounts. Workflows compensate for the fact that the data dictionary in Anthology Student does not always
allow administrators to set required fields or validate the data of required fields before saving a form.

Example: The Academic Year and Term are not required fields on the Transaction Adjustment form in Anthology Stu-
dent, but your institution requires these fields to be populated when charges are posted.

You create a validation workflow that checks whether the user specified the Academic Year and Term. If these fields
are not populated, an error message is displayed, and the user cannot save the transaction adjustment.

See Context Property for hints about how to determine the type of event (PostCharge or AdjustCharge).

Courses Code Setup Form

Cmc.Nexus.Contracts > Cmc.Nex-
us.Sis.Academics > Course

Lists > Academic Records >
Courses > Add/Edit > Courses
Code Setup (frmAdCourse)

Cmc.Nexus.Sis.Academics
l Course
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Contracts Anthology Student Form Entity Mapping

This event enables you to create workflow activities that are triggered when the Save button is clicked on the
Courses Code Setup form.

Example:

A workflow checks if the PublishCode matches the Course Code. When the codes don't match, a custom validation
message similar to the following appears in Anthology Student: INFORMATION: The PublishCode does NOT match
the Course Code - Students will only see the PublishCode on their transcripts.

Address Form

Cmc.Nexus.Contracts >
Cmc.Nexus > Person Address

Contact Manager > Addresses
(frmSyStudAddresses)

Cmc.Nexus
l PersonAddress

This event enables you to create workflow activities that are triggered when the Save button is clicked on the
Address form. The Entity is the PersonAddress.

Example:

A workflow provides custom validation messages on the fields of the Address form, e.g., Address Type, Title, Last
Name, First Name, Seasonal Dates, Effective Dates, so that Contact Manager activities always use correct address
information.

Athletics Form

Cmc.Nexus.Contracts > Cmc.Nex-
us.Sis.StudentService > Student
Athletic Detail

View > Student Services >Athletics
(frmSsAthletics)

Cmc.Nexus.StudentServices
l StudentAthleticDetail

This event enables you to create workflow activities that are triggered when the Save button is clicked on the Ath-
letics form.

Note: The Context property for this event is "StudentAthleticDetail Saving Com". For more information, see Context
Property.

Disability Services Form

Cmc.Nexus.Contracts > Cmc.Nex-
us.Sis.StudentService > Student
Disability Detail

View > Student Services > Dis-
abilities (FrmSsDisabilityService)

Cmc.Nexus.StudentServices
l StudentDisabilityDetail

This event enables you to create workflow activities that are triggered when the Save button is clicked on the Dis-
ability Service form.

Note: The Context property for this event is "StudentDisabilityDetail Saving Com". For more information, see Con-
text Property.

Veteran Information Form

Cmc.Nexus.Contracts > Cmc.Nex-
us.Sis.StudentService > Student
Veteran Detail

View > Student Services > Veteran
Information(FrmSsVet-
eranInformation)

Cmc.Nexus.StudentServices
l StudentVeteranDetail
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This event enables you to create workflow activities that are triggered when the Save button is clicked on the Vet-
eran Information form.

Note: The Context property for this event is "StudentVeteranDetail Saving Com". For more information, see Context
Property.

Anthology Contract Anthology Student Form Entity Mapping

Student Master Form

Cmc.Nexus.Contracts >
Cmc.Nexus > Person

Student > Student Master
(frmAMStudMasterShort)

Cmc.Nexus
l Person

This event enables you to create workflow activities that are triggered when the Save button is clicked on the Stu-
dent Master form.

Example:

A workflow assigns an email address to a student. When the Status field is changed from New Lead to Interviewed,
the student's primary email address is moved to the Other email field and the primary email field is populated with a
new email address that is created using the first three letters of FirstName and the first five letters of LastName
followed by @myschool.edu.

Student Enrollment Wizard

Cmc.Nexus.Contracts >
Cmc.Nexus > Person

Daily > Admissions > Enroll Student
(frmAmEnroll)

Cmc.Nexus
l Person

Entity: Cms.Nexus.Sis
l StudentEnrollmentPeriods

Cmc.Nexus.Sis.Academics
l StudentEnrollmentPeriods

This event enables you to create workflow activities that are triggered when the Next button is clicked on any step
(page) of the Student Enrollment wizard and when the Finish button is clicked. You can create workflows that are
triggered at specific points in the enrollment process.

Example: A workflow checks the student's address when an attempt is made to enroll the student in a program that
is not approved in the state where the student lives. The workflow prevents the enrollment if the student's address is
not in a state where the program is approved.

Financial Aid Academic Year Form

Cmc.Nexus.Contracts > Cmc.Nex-
us.Sis.FinancialAid > Student Aca-
demic Year

Student > Financial Aid > Academic
Year (frmFaStudentAY)

Cmc.Nexus.Sis.FinancialAid
l StudentAcademicYear

This event enables you to create workflow activities that are triggered when the Save button is clicked on the Fin-
ancial Aid Academic Year form.

Financial Aid Loan Form
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Cmc.Nexus.Contracts > Cmc.Nex-
us.Sis.FinancialAid > Student Loan
Detail

Student > Financial Aid > Pack-
aging > Add > New Source of Aid
> Loan (frmFaStudLoan)

Cmc.Nexus.Sis.FinancialAid
l StudentAward
l StudentAwardLoan
l StudentAwardSummary

This event enables you to create workflow activities that are triggered when the Save button is clicked on the Fin-
ancial Aid Loan form.

Example: Your institution requires students to complete an online course on financial responsibility if they request
loans of more than $2,500 per academic year. You create a workflow that checks the gross loan amount and alerts
the user when the amount is greater than $2,500 for an academic year so that the loan is not packaged prior to the
completion of the online course.

Financial Aid Grant / Scholarship Form

Cmc.Nexus.Contracts > Cmc.Nex-
us.Sis.FinancialAid > Student Grant
Detail

Student > Financial Aid > Pack-
aging > Add > New Source of Aid
> Grant (frmFaStudGrant)

Entity: Cmc.Nexus.Sis.FinancialAid
l StudentAward
l StudentAwardSummary

This event enables you to create workflow activities that are triggered when the Save button is clicked on the Fin-
ancial Aid Grant / Scholarship form.

Example: Your institution requires approvers to add comments when they approve a grant / scholarship for a stu-
dent. You create a workflow that checks for entries in the Comments field when the form is saved with a status of
'Approved'. See workflow example Check Approved Grants for Comments.

Financial Aid Grant / Scholarship Form (Source = Pell)

Cmc.Nexus.Contracts > Cmc.Nex-
us.Sis.FinancialAid > Student
Award Pell

Student > Financial Aid > Pack-
aging > Add > New Source of Aid
> Grant, Source = Pell
(frmFaStudPell)

Entity: Cmc.Nexus.Sis.FinancialAid
l StudentAward
l StudentAwardSummary

This event enables you to create workflow activities that are triggered when the Save button is clicked on the Fin-
ancial Aid Grant / Scholarship form with Source selection of 'Pell'.

Example: Your institution requires approvers to add comments when they approve a Pell grant for a student. You cre-
ate a workflow that checks for entries in the Comments field when the form is saved with a status of 'Approved'.

Financial Aid Cash Payment/Other Form

Cmc.Nexus.Contracts > Cmc.Nex-
us.Sis.StudentAccounts > Student
Payment Plan

Student > Financial Aid > Pack-
aging > Add > New Source of Aid >
Student Payment/Other
(frmFaStudCashOther)

Cmc.Nexus.Sis.StudentAccounts
l StudentPaymentPlan

This event enables you to create workflow activities that are triggered when the Save button is clicked on the Fin-
ancial Aid Cash Payment/Other form.

Example: Your institution requires multiple payments if the cash amounts is above $800. You create a workflow that
validates the number of payments when the form is saved with a cash amount above $800.
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SIS Saved Events - Entity Level

Saved events are triggered just after data has been saved to the database and are most often used to perform
some additional activity such as creating a Contact Manager activity, triggering a document, or adding a student
to a group. Saved events are only generated when one of the “trigger” fields is updated. The events are cap-
tured at the database trigger level.

Saved events are only visible in the Event Log of the Windows Service NextGen Nexus Event Workflows. Saved
event workflows must be stored on a host that has a direct database connection such as the COM server. The
workflow Add Students to a Group is an example of a workflow triggered by a Saved event.

Note: Saved events are triggered off a single main database table, therefore, entity mappings to items in other
tables is not always available in the Saved event data.

Forms can be accessed from multiple paths and some fields exist in multiple forms. This table does not does
not list all possible paths and field occurrences.

The following table lists the SIS Saved events at the entity level, sorted by Contract Entities.

Contracts Anthology Student Form Entity Mapping

Cmc.Nexus.Crm > Task

Task

Cmc.Nexus.Contracts > Cmc.Nex-
us.Crm > Task

Contact Manager > Activities
(Add/Edit) (frmCmTask)

Cmc.Nexus.Crm
l Task

Cmc.Nexus > Group Membership

GroupMembership

Cmc.Nexus.Contracts >
Cmc.Nexus > Group Membership

View > Student Groups
(frmSyStudentGroups)

Cmc.Nexus
l GroupMembership

This event enables you to create an activity that is triggered when a student is added to or removed from a Student
Group.

Workflow example: Add Students to a Group.

Cmc.Nexus > Person

SyStudent Event

Cmc.Nexus.Contracts >
Cmc.Nexus > Person

Student > Student Master
(frmAmStudMaster or
frmAMStudMasterShort)

Cmc.Nexus
l Person

SIS Saved Events - Entity Level
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This event enables you to create workflow activities that are triggered when a value in any field of the SyStudent
table is changed.

Note: Anthology Student databases and much of the business logic send updates to the SyStudent table multiple
times due to triggers, related processes, etc. Therefore, multiple activities can be triggered by one change in the
SyStudent table. To prevent this from happening, in your workflow make sure that a field actually changed before
performing any activity on the event. Use the HasChangedmethod to ensure that the property you care about has
actually been modified. See Checking for Record Inserts and Changes.

Workflow example: Add Students to a Group, which is triggered when the veteran status is changed in the SyStu-
dent table.

Cmc.Nexus > Person Document

PersonDocument

Cmc.Nexus.Contracts >
Cmc.Nexus > Person Document

Contact Manager > Documents
(frmAmStudDocuments)

Cmc.Nexus
l PersonDocument

Cmc.Nexus.Sis.Academics > Student Course

StudentCourse

Cmc.Nexus.Contracts > Cmc.Nex-
us.Sis.Academics > Student
Course

Student Bar: Academic Records
> Schedule (frmAdEnrollSched)
or
Student Bar: Academic Records
> Attendance (frmAdEn-
rollAttend)

Cmc.Nexus.Sis.Academics
l StudentCourse

Cmc.Nexus.Sis.Academics > Student Enrollment Period

StudentEnrollmentPeriod

Cmc.Nexus.Contracts > Cmc.Nex-
us.Sis.Academics > Student Enroll-
ment Period

Academic Records > Enrollment Cmc.Nexus.Sis.Academics
l StudentEnrollmentPeriod

Cmc.Nexus.Sis.CareerServices > Student Employment History

Student Employment History

Cmc.Nexus.Contracts > Cmc.Nex-
us.Sis.CareerServices > Student
Employment History

Career Services > Placement
(frmPlPlacements)

Cmc.Nexus.Sis.CareerServices
l New instance or update to Stu-
dentEmploymentHistory

This event enables you to create an activity that is triggered when a Student's employment history record is added or
updated.

Example: An employer is associated with the placement record.

Cmc.Nexus.Sis.CareerServices > Student Placement Skill
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Student Placement Skill

Cmc.Nexus.Contracts > Cmc.Nex-
us.Sis.CareerServices > Student
Placement Skill

Career Services > Placement
(frmPlPlacements)

Cmc.Nexus.Sis.CareerServices
l New instance or update to Stu-
dentPlacementSummary

This event enables you to create an activity that is triggered when a student's placement skill record is added or
updated.

Example: A placement skill is added to a student record.

Cmc.Nexus.Sis.FinancialAid > IsirMatch

IsirMatch

Cmc.Nexus.FinancialAid.Contracts
> Cmc.Nexus.FinancialAid.Entities
> Isir Matches (IsirMatchEntity)

Daily > Financial Aid > Import
Data > Application Data (select
Update Now)
(Module: ISIRImport1) > Process

Daily > Financial Aid > ISIR
Matching (Module: ISIRMatchl2)
> Auto Match or Manual Match

View > Financial Aid > ISIR 
(Module: ISIRReceived)

Cmc.Nexus.FinancialAid.Services
l IsirMatch

This event enables you to create an activity that is triggered when an ISIR is matched to a student record. The ISIR
can be matched to the student by several processes in Anthology Student:

l During ISIR import (Daily > Financial Aid > Import Data > Application Data (select Update Now)
(Module: ISIRImport1) > Process).

ISIRs are also processed in the back end at a later time by the Windows Service for Global ISIR processing
and if Update Now not selected during ISIR Import.

l Using the ISIR matching wizard (Daily > Financial Aid > ISIR Matching > Auto Match or Manual Match).

l When the ISIR form is loaded (View > Financial Aid > ISIR).

The IsirMatch event provides access to the fields from the IsirMatch entity.

Cmc.Nexus.Sis.FinancialAid > Student Academic Year

StudentAcademicYear

Cmc.Nexus.Contracts > Cmc.Nex-
us.Sis.FinancialAid > Student Aca-
demic Year

Financial Aid > Packaging
(frmFaStudAcadYears)

Cmc.Nexus.Sis.FinancialAid
l StudentAcademicYear

Cmc.Nexus.Sis.FinancialAid > Student Grant Detail

Fund Source - Grant
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Cmc.Nexus.Contracts > Cmc.Nex-
us.Sis.FinancialAid > Student Grant
Detail

Financial Aid > Packaging > Add
New Source of Aid
(frmFaStudGrant)

Cmc.Nexus.Sis.FinancialAid
l New instance or update to Stu-
dentGrantDetail

This event enables you to create an activity that is triggered when a Grant Fund Source is added to a student's fin-
ancial aid package or posted as a ledger transaction.

Note: PaidDisbursements and ScheduledDisbursements collections cannot be mapped in the Saved event. This
can only be done during the Saving event.

Cmc.Nexus.Sis.FinancialAid > Student Loan Detail

Fund Source - Loan

Cmc.Nexus.Contracts > Cmc.Nex-
us.Sis.FinancialAid > Student Loan
Detail

Financial Aid > Packaging > Add
New Source of Aid (FaStudDir-
ectLoan)

Cmc.Nexus.Sis.FinancialAid
l New instance or update to Stu-
dentLoanDetail

This event enables you to create an activity that is triggered when a Loan Fund Source is added to a student's fin-
ancial aid package or posted as a ledger transaction.

Cmc.Nexus.Sis.FinancialAid > Student Award Pell

Dependency Status

Cmc.Nexus.Contracts > Cmc.Nex-
us.Sis.FinancialAid > Student
Award Pell

Student > FAFSA or ISIR data
can change the dependency
status to change on multiple
forms in Anthology Student

Cmc.Nexus.Sis.FinancialAid
l StudentAwardSummary

This event enables you to create an activity that is triggered when a student's dependency status changes.

Cmc.Nexus.Sis.StudentAccounts > Account Charge Transaction

Student Ledger - Charge Transaction

Cmc.Nexus.Contracts > Cmc.Nex-
us.Sis.StudentAccounts > Account
Charge Transaction

Student Accounts > Ledger
Cards > Post Charges
(frmSaTransTrxs)

Cmc.Nexus.Sis.StudentAccounts
l New instance of Accoun-
tTransaction is created >
AccountChargeTransaction

This event enables you to create an activity that is triggered when a Charge Transaction is posted to the student's
ledger. The event message contains the amount, fund source, and date. You can use this information to build vari-
ous workflow activities.

Example: Send an SMS when new charges have been posted to a student's account.

Cmc.Nexus.Sis.StudentAccounts > Account Payment Transaction

Student Ledger - Payment Transaction
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Cmc.Nexus.Contracts > Cmc.Nex-
us.Sis.StudentAccounts > Account
Payment Transaction

Student Accounts > Ledger Card
> Post Payments
(frmSaTransPayment)

Cmc.Nexus.Sis.StudentAccounts
l New instance of Accoun-
tTransaction is created >
AccountPaymentTransaction

This event enables you to create an activity that is triggered when a Payment Transaction is posted to the student's
ledger. The event message contains the amount, fund source, and date. You can use this information to build vari-
ous workflow activities.

Examples: Send an email thanking the student for submitting a payment.

Cmc.Nexus.Sis.StudentAccounts > Account Summary

Account Summary

Cmc.Nexus.Contracts > Cmc.Nex-
us.Sis.StudentAccounts > Account
Summary

Student Accounts > Ledger Card
(frmSaLedger62)

Cmc.Nexus.Sis.StudentAccounts
l AccountSummary

Cmc.Nexus.Sis.StudentAccounts > Collection Account

Collection Account

Cmc.Nexus.Contracts > Cmc.Nex-
us.Sis.StudentAccounts
> Collection Account

View > Student Accounts > Col-
lections (frmSaCollections)

Cmc.Nexus.Sis.StudentAccounts
l CollectionAccount

Cmc.Nexus.Sis.StudentAccounts > Student Payment Plan Statement

Account Statement

Cmc.Nexus.Contracts > Cmc.Nex-
us.Sis.StudentAccounts > Student
Payment Plan Statement

Daily > Student Accounts > Stu-
dent Billing Statements > Student
Payment Statements
(frmSaPrintStatements)

Cmc.Nexus.Sis.StudentAccounts
l StudentPaymentPlanStatement

This event enables you to create an activity that is triggered when a student's account statement is processed.

Cmc.Nexus.Sis > Student Advisor

Student Advisor
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Cmc.Nexus.Contracts > Cmc.Nex-
us.Sis > Student Advisor

Add or edit advisor for an enroll-
ment from the following forms:

l View > Academic Records
> Enrollment

l View > Financial Aid >
Packaging

l View > Student Accounts
> Ledger Card

l View > Career Services >
Placements

l View > Loan Mangement
> Loan Management

l View > Contact Man-
ager> Advisors

l View > Contact Manager
> International

l Daily > Contact Manager
> Advisor Assignment

Cmc.Nexus.Sis
l StudentAdvisor

This event enables you to create workflow activities that are triggered when a value in the SyAdvisorByEnroll table is
added or changed.

Cmc.Nexus.Sis > Student Extra Curricular

Extra-Curricular Activities

Cmc.Nexus.Contracts > Cmc.Nex-
us.Sis > Student Extra Curricular

Student > Student Master
(frmAmStudMaster or
frmAMStudMasterShort)

Cmc.Nexus.Sis
l StudentExtraCurricular

This event enables you to create workflow activities that are triggered when a value in the Extra-Curricular activities
field on the Student Master SyStudent.AmExtraCurrID is added or changed.

Example: A workflow creates a Contact Manager activity for the Athletics Department when a student completes an
application and chooses a sport that populates the Extra-Curricular field on the Student Master form. The Athletics
Department then starts the interview process for sports teams.
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SIS Saved Events - Field Level

Saved events are triggered just after data has been saved to the database and are most often used to perform
some additional activity such as creating a Contact Manager activity, triggering a document, or adding a student
to a group. Saved events are only generated when one of the “trigger” fields is updated. The events are cap-
tured at the database trigger level.

Saved events are only visible in the Event Log of the Windows Service NextGen Nexus Event Workflows. Saved
event workflows must be stored on a host that has a direct database connection such as the COM server. The
workflow Add Students to a Group is an example of a workflow triggered by a Saved event.

Note: Saved events are triggered off a single main database table, therefore, entity mappings to items in other
tables is not always available in the Saved event data.

The following table lists the SIS Saved events at the field level, sorted by Contract Entities.

Contracts Anthology Student Form Entity Mapping

Cmc.Nexus.Crm > Task

Task Status Id

Cmc.Nexus.Contracts >
Cmc.Nexus.Crm > Task

Contact Manager
> Activities (Add/Edit)
(frmCmTask)

Cmc.Nexus.Crm
l Task.TaskStatusId

This event enables you to create a Contact Manager activity that is triggered when the Activity Status is changed
(TaskStatusId field).

Cmc.Nexus > Person

Lead Type Id

Cmc.Nexus.Contracts >
Cmc.Nexus > Person

Student > Student
Master
(frmAmStudMaster or
frmAMStudMasterShort)

Cmc.Nexus.Sis.Admissions
l Prospect.LeadTypeId

This event enables you to create a Contact Manager activity that is triggered when the Applicant Type is changed
(LeadTypeId field).

Cmc.Nexus > Person Document

Document Status

Cmc.Nexus.Contracts >
Cmc.Nexus > Person Document

Contact Manager > Docu-
ments (frmAmStudDocu-
ments)

Cmc.Nexus
l PersonDocument.DocumentStatusId

SIS Saved Events - Field Level
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This event enables you to create an activity that is triggered when the Document Status is changed on a single doc-
ument or list of documents. You can use the LookupReferenceItem activity to identify changed documents.

Example: When an application is received, a workflow activity causes an email to be sent to the Dean of Admissions.

Cmc.Nexus.Sis.Academics > Student Course

Course Status

Cmc.Nexus.Contracts >
Cmc.Nexus.Sis.Academics
> Student Course

Student Bar: Academic
Records > Schedule
(frmAdEnrollSched) or
Student Bar: Academic
Records > Attendance
(frmAdEnrollAttend)

Cmc.Nexus.Sis.Academics
l StudentCourse.Status

This event enables you to create activities that are triggered when a student's Course Status is changed.

Course Status values in Anthology Student are Future, Scheduled, Current, Dropped, Completed, Reserved, Waitl-
isted, and Leave of Absence. An event is raised each time a Course Status value changes.

Note: During certain Course Status changes multiple events may be triggered. To avoid duplication of workflow
activities, add the following condition at the top of your workflow:

entity.HasChanged("Status")

Another, more accurate, option is to specify the property of the entity that has changed:

entity.HasChanged(StudentCourse.StatusProperty)

You may also want to validate the current Status you are looking for with an additional condition.

For more information, see Check for Record Inserts and Changes.

Grade Status and Grade Letter
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Cmc.Nexus.Contracts >
Cmc.Nexus.Sis.Academics
> Student Course

Academic Records
> Final Grades (frmAdEn-
rollGrades)

Cmc.Nexus.Sis.Academics
l StudentCourse.Status
l StudentCourse.LetterGrade

This event enables you to create an activity that is triggered when Grade Status or Grade Letter is changed on a stu-
dent's course record.

Note: The event is raised by any letter grade changes, not just changes from "I" (incomplete) to "F" (fail).

Final Grade

Cmc.Nexus.Contracts >
Cmc.Nexus.Sis.Academics
> Student Course

Academic Records
> Final Grades (frmAdEn-
rollGrades)

Cmc.Nexus.Sis.Academics
l StudentCourse.LetterGrade
l StudentCourse.NumericGrade
l StudentCourse.UnitValues
l StudentCourse.GradePoints

This event is raised when a Course Grade is posted on the Final Grade form. The event is raised by updates in the
AdEnrollSched table.

Example: When a letter grade changes from "B" to "A", a congratulatory note is sent to the student.

Workflow example: Check if a Grade was Posted.

Cmc.Nexus.Sis.Academics > Student Enrollment Period

Enrollment Status

Cmc.Nexus.Contracts >
Cmc.Nexus.Sis.Academics
> Student Enrollment Period

Academic Records
> Enrollment >
Date/Status tab
(frmAdEnroll)

Cmc.Nexus.Sis.Academics
l StudentEnrollmentPeriod.
EnrollmentStatusId

This event enables you to create an activity that is triggered when the Enrollment Status is changed on a student's
record.

Workflow examples: Charge a Fee when the Enrollment Status Changes and Register Students into a Course

Grade Level

Cmc.Nexus.Contracts >
Cmc.Nexus.Sis.Academics
> Student Enrollment Period

Academic Records
> Enrollment > Progress
tab (frmAdEnroll)

Cmc.Nexus.Sis.Academics
l StudentEnrollmentPeriod.
GradeLevelId

This event enables you to create an activity that is triggered when the Grade Level is changed on a student's record.

Graduation Date
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Cmc.Nexus.Contracts >
Cmc.Nexus.Sis.Academics
> Student Enrollment Period

Academic Records
> Enrollment -
Date/Status tab
(frmAdEnroll)

Cmc.Nexus.Sis.Academics
l Stu-
dentEnrollmentPeriod.GraduationDate

This event is raised when a Graduation Date changes. You can use this event to trigger an activity to inform students
of a change in their eligibility for graduation.

Cmc.Nexus.Sis.FinancialAid > Student Academic Year

Packaging Status

Cmc.Nexus.Contracts >
Cmc.Nexus.Sis.FinancialAid
> Student Academic Year

Financial Aid > Pack-
aging
(frmFaStudAcadYears)

Cmc.Nexus.Sis.FinancialAid
l StudentAwardSummary

This event enables you to create an activity that is triggered when the Student's financial aid Packaging Status
changes on a student's record.

Examples:

l A workflow is triggered when a financial aid Packaging Status changes from Partial Packaged to Final
Package.

l A workflow is triggered when a financial aid Packaging Status changes from Not Packaged to Cash.

Note: Changes to Budget Items will trigger a separate event from changes to main Student Academic Year event
entity. For example, if you change Housing from Off Campus to On Campus, you will receive two events – one for
housing status change on the main entity and one for changes to the Budget Items collection for Room and Board.

Cmc.Nexus.Sis.StudentAccounts > Account Summary

Account Status

Cmc.Nexus.Contracts >
Cmc.Nexus.Sis.StudentAccounts
> Account Summary

Student Accounts >
Ledger Card
(frmSaLedger62)

Cmc.Nexus.Sis.StudentAccounts
l AccountSummary.
AccountStatusDetail.
AccountStatusId

This event enables you to create an activity that is triggered when the Account Status is changed on a student's
ledger card.

Cmc.Nexus.Sis.StudentAccounts > Collection Account

Collection Status

Cmc.Nexus.Contracts >
Cmc.Nexus.Sis.StudentAccounts
> Collection Account

View > Student Accounts
> Collections (frmSaCol-
lections)

Cmc.Nexus.Sis.StudentAccounts
l CollectionAccount.
AccountStatusDetail.
AccountStatusId
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This event enables you to create an activity that is triggered when a Collection Status value is changed on a stu-
dent's enrollment.
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Time-based Events
Time-based events are recurring events that aree triggered based on predefined intervals. These events are usu-
ally triggered based on Windows services.

To trigger time-based events in your workflow, include the Cmc.Domain.Entities.Sis.SisSchedule entity when you
create or define the workflow. The SisSchedule entity includes three events that are triggered in specific time
intervals.

Entity Event Occurrence

SisSchedule ScheduleHighOccurenceEvent Every 6 seconds

SisSchedule ScheduleMediumOccurenceEvent Every 6 hours

SisSchedule ScheduleLowOccurenceEvent Every 24 hours

Time-based Events

In a time-based workflow, you do not need to have any entity-related information as in other workflows. You
need to include the following activities to get context information:

l ExecuteDataReader
l ExecuteNonQuery
l ExecuteQuery

To create a time-based event workflow:

1. Start Workflow Composer.

2. Click New Event Workflow. The New Event Driven Workflow window is displayed.

3. Specify a Name for the workflow.

4. In the Entities pane, select the SisSchedule entity, and select the appropriate event in the Events pane.
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5. Click OK.
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Forms Builder Events

This content is applicable to Forms Builder version 2.x only.  

Forms Builder’s eventing integration with Workflow enables you to raise events from Forms Builder sequences
and capture these events using Workflow or any service bus. The information from the events can be used for
validation, setting defaults, creating tasks for staff, and countless other purposes.

Raise Event Rule

Designers of sequences in Forms Builder can choose to raise an event between any form transition. Whenever
the Raise Event rule is encountered, Forms Builder collects the field input from previous forms and raises an
event with these fields as arguments.

The Raise Event rule has one optional configuration field for EventName. This field can be used to distinguish
events coming from multiple Raise Event rules from the same or different sequences.

Event Details

Every event raised from Forms Builderr has some basic properties to work with. You can get details regarding
the event and perform different actions in your workflow.
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Event Property Description

FormEntity() EventName():string

Fields():IDic-
tionary<string,string>

UserId():int

The FormEntity:

l holds the data coming in
from Forms Builder. This
data is arranged in key-
value collections rep-
resenting field names from
Forms Builder forms and
their corresponding values
in text.

l holds the optional
EventName specified in
the Raise Event rule con-
figuration.

Note: To capture a
Forms Builder event in a
workflow, specify the
exact Event Name of the
Raise Event rule. For
example, in the con-
dition field of an If activ-
ity, specify the following:

entity.EventName =
“GM Send Info”

where "GM Send Info"
is the Event Name in
Forms Builder.

l has a UserID, which is
the unique identifier
provided by STS for the
logged in user.

Forms Builder Events
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Event Property Description

FormTransitionEventArgs
()

DefaultFields():IDic-
tionary<string,string>

ValidationMessages():Val-
idationMessageCollection

Subscribers to events from
Forms Builder can communicate
back to the Forms Builder
sequence originating the event
via the FormTrans-
itionEventArgs.

l DefaultFields can be
used to set new defaults
on upcoming forms or
change values on pre-
vious forms. This property
represents a collection of
key-value pairs.

l ValidationMessages
can be used to return mes-
sages in response to
forms validation.

Application Key IDs Used with Anthology Student

FormEntity contains different identities alongside all the Forms Builder fields being collected. These Ids are
created while executing different Forms Builder rules. Some of the Ids are populated based upon the user type.
For example, a student always has SyStudentId populated in StudentIdAppKey.

Field Name Description

ApplicantEmailIdAppKey Email Id

CampusIdAppKey Campus Id

EnrollIdAppKey Student Enrollment Id generated when new Enrollment is created

IsPaymentMadeAppKey Is Payment Made

NumDuplicatesAppKey Number of Duplicates generated from Duplicate Check Rule

OnlineApplicantIdAppKey Online Applicant Id

PaymentAmpountAppKey Payment Amount App Key

PaymentReceiptAppKey Payment Receipt generated upon successful payment

PendingApplicantsAppKey Pending Applicants Flag

PortalUserIdAppKey Portal User Id points to wpUserID

StudentIdAppKey Student Id points to SyStudentID

SyAddressIdAppKey Address Id generated while saving profile information

Application Key IDs
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Workflow for Forms Builder Events

Once the sequence in Forms Builder has been setup with the Raise Event rule, the next step is to create an
event subscriber using Workflow

1. In Workflow, click on New Event Workflow.

2. Under Entities, expand Cmc.FormsBuilder.Contracts and select Forms Builder Form (FormEntity).

Under Events, expand Cmc.FormsBuilder.Contracts and Forms Builder Rule Executed Event
(FormTransitionEvent.

3. Create your workflow using the Activities available in the Workflow Designer Toolbox.

Example

This workflow makes the ZIP code required when the country is USA and a State is selected. Otherwise, a
validation message is created for the applicant.
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The AddToCollection activity sets the default citizenship to "US citizen".

For information on how to create event handlers for Forms Builder events, see Create Event Handlers in .NET.

To see how a Forms Builder event can be used in a workflow, see Populate Fields in a Forms Builder Form.
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Create Event Handlers in .NET
This topic describes how to create a few simple event handlers for the Person entity to perform validations
during the save process.

Subscribe to an Event

In this example we are working within the Logic project. This project contains our event handles and ref-
erences the CMC framework and contracts that define the events.

Step 1: Add Required References

To utilize the CMC framework, you need to add a reference to Cmc.Core.dll.

1. Open the EventHandlers.sln solution in Visual Studio.

2. In Solution Explorer, right-click on Logic\References and select Add Reference…

3. On the Browse tab, click the Browse… button.

4. From the Select the files to reference… dialog, select SDKPath\Cmc.Core.dll and SDKPath\Cm-
c.FormsBuilder.Contracts.dll and click Add.

5. From the Reference Manager dialog, click OK.

Step 2: Make your Assembly Visible to the CMC Framework

To make types defined within this assembly discoverable by the CMC framework, we need to add the Exten-
sionAssembly assembly level attribute.

1. Within the Solution Explorer, open Logic\Properties\AssemblyInfo.cs.

2. Add the [assembly: ExtensionAssembly] attribute to the file.

//...
[assembly: ExtensionAssembly]
//...

Step 3: Create the EventSubscriber Type

During initialization, the EventService uses a container to discover all types that implement the IEventSubscriber
interface. After discovery, the EventService invokes the RegisterHandlers method on each implementation of
the interface, giving the implementer an opportunity to register event handlers.

The EventSubscriber type is an abstract class that simplifies the implementation of IEventSubscriber.

1. In Solution Explorer, right-click on the Logic project and select Add -> Class…

2. In the Name text box, enter FormTransitionEventSubscriber.cs.

3. Click the Add button.
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4. Change the scope modifier of the newly added class to internal.

5. Inherit the class from EventSubscriber.

6. Click on the class name and pull down the smart tag to implement the abstract method, Register-
Handlers.

using Cmc.Core.Eventing;
namespace Logic
{

internal class FormTransitionEventSubscriber : EventSubscriber
{

public override void RegisterHandlers(IEventService eventService)
{

throw new System.NotImplementedException();
}

}
}

Step 4: Register an Event Handler

Next, implement the RegisterHandlers method to register a handler for the FormTransitionEvent that validates
a FormEntity instance prior to it being saved to the database.

1. Implement the abstract method RegisterHandlers to retrieve the SavingEvent from the provided
IEventService. Register a handler for the Person type that does the following:

a. Adds a validation message if there are no items in the Phones collection.
b. Adds a validation message if there are no items in the Addresses collection.

using System;
using Cmc.Core.Eventing;
using Cmc.FormsBuilder.Contracts;

namespace Logic
{

public class FormTransitionEventSubscriber : EventSubscriber
{

public override void RegisterHandlers(IEventService eventService)
{

eventService.GetEvent<FormTransitionEvent>().RegisterHandler<FormEntity>
((e, a) =>

{
if (e.Fields.ContainsKey("CURRCNTRY") && (e.Fields["CURRCNTRY"] == "25"))
{

if (String.IsNullOrEmpty(e.Fields["CURRZIP"]) && !String.IsNullOrEmpty
(e.Fields["CURRSTATE"]))

{
a.ValidationMessages.Add(new ValidationMessage("Current Zip is

required for country USA"));
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}
else
{

a.DefaultFields["CITIZEN"] = "8"; // Default to US
}
}
else
{

a.DefaultFields["CITIZEN"] = "3"; // Default to Non-US Citizen
}

});
}

}
}

Test the Library

Copy the Logic\bin\Debug\Logic.dll to the bin folder of your host application and create a Person
without any phone numbers or addresses. When you save the Person, you should receive two errors.
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Event Scheduling
Event scheduling enables you to schedule an event to occur based on a recurrence pattern. Event scheduling
utilizes the Job Scheduler in SQL Server and the existing stored procedure sproc_Notification_Timer_
ScheduledEvent.

The stored procedure takes the following arguments:

Entity: Schedule

Event: Schedule Occurrence Event

sproc_Notification_Timer_ScheduledEvent @key = ‘Birthdays’ (example)

The stored procedure creates the job that can be scheduled in SQL Server Management Studio.

Create and Attach a Schedule to a Job in SQL Management Studio

1. In Object Explorer, connect to an instance of the SQL Server Database Engine, and then expand that
instance.

2. Expand SQL Server Agent, expand Jobs, right-click the job you want to schedule, and click Properties.

3. Select the Schedules page, and then click New.

4. In the Name box, type a name for the new schedule.

5. Clear the Enabled check box if you do not want the schedule to take effect immediately following its cre-
ation.

6. For Schedule Type, click Recurring. Complete the Frequency, Daily Frequency, and Duration groups in
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the New Job Schedule window.

Attach a Schedule to a Job

1. In Object Explorer, connect to an instance of the SQL Server Database Engine, and then expand that
instance.

2. Expand SQL Server Agent, expand Jobs, right-click the job that you want to schedule, that is, the job cre-
ated by the stored procedure, and click Properties.

3. Select the Schedules page, and then click Pick.

4. Select the schedule you want to attach and click OK.

5. In the Job Properties dialog box, double-click the attached schedule.
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6. Verify that Start date is set correctly. If it is not, set the date when you want for the schedule to start, and
then click OK.

7. In the Job Properties dialog box, click OK.
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Sample Workflows
The sample workflow presented in this section were developed prior to the introduction of the new Anthology
object model. To adapt these workflows to the new object model, please refer to Legacy Workflows.
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Add Students to a Group
In this example, an institution wants to manage its military students by groups. Whenever a student’s veteran
status is set to "Yes", the student is added to a group called "Military Students". If a student's veteran status
changes to "No", the workflow removes the student from that group.

1. In the standard interface of Anthology Student, create a student group as follows:

a. Select the Groups tile. The list of existing Student Groups is displayed.

b. Click New.

c. In the Group Name text box, specify a name, e.g., Military Students.

d. Select an appropriate Expiration Date. Keep in mind that this will be a long running workflow.

e. Select values for additional group properties or accept the defaults.

f. Click Save & Close.

In the legacy interface of Anthology Student, create a student group as follows:
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a. Navigate to View > Student Groups. The Student Groups form is displayed.

b. Click Add.

c. In the Group Name text box, specify a name, e.g., Military Students.

d. Select an appropriate Expiration Date. Keep in mind that this will be a long running workflow.

e. Select values for additional group properties or accept the defaults.

f. Click Save and Close.

2. Start the Workflow application from your desktop.

3. Click New Event Workflow.

4. In the Entities area:

a. Click next to Cmc.Nexus.Contracts.

b. Click next to Cmc.Nexus.

c. Click Person (Person).

5. In the Events area, click Saved (SavedEvent).

6. Specify a Name for the workflow and click OK.
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7. In the Properties pane of the Designer, specify Add Military Students to Group as the DisplayName of
the sequence.

Note: It is a good practice to assign a meaningful DisplayName to each activity as soon as it is dragged
into the workflow. The DisplayName makes it easier to track the workflow in log files and reports.

8. In the Toolbox, under Control Flow, select the If activity and drag it into the sequence.

9. In Properties pane, specify Check if the Veteran Flag was Modified as the DisplayName of the If con-
dition.

10. In the Condition field, specify the following VB expression: entity.HasChanged("Veteran")

Refer to Helpful Hints to learn more about the purpose of this condition.

11. In Properties pane, specify Manage the Military Group as the DisplayName of the Then sequence in the
If condition.
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12. In the Toolbox, under Cmc.Nexus.Workflow, select the LookupStudentGroup activity and drag it into the
"Then" branch of the "If" condition.

13. In Properties pane, specify Find Military Students Group as the DisplayName of the Look-
upStudentGroup activity.

14. Create a variable to pass the GroupId to the activity that will add or remove students from the group.

a. Click the Variables tab in the Designer pane.

b. Add the variable name Group.

c. Choose the Variable type. For groups, it is found under Cmc.Nexus.Group.

d. In the Properties pane of the LookupStudentGroup activity, specify Group as the Name of the vari-
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able in the StudentGroup field.

15. Use the LookupStudentGroup activity to search your Anthology Student system for groups and select the
group created in step 1.

a. Specify Military Students in the Search for Group tab of the LookupStudentGroup activity.

b. Click Search.

c. In the Search for Group window, select the Military Students group from the returned list of
groups.

d. In the Search for Group window, click Select.

16. In the Toolbox, under Control Flow, select another If activity and drag it into the Then sequence of the
first If condition.

17. In Properties pane, specify Check if the Veteran Value is Yes as the DisplayName of the second If con-
dition.

18. In the Condition field, specify the following VB expression:
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entity.Veteran.GetValueOrDefault().Equals(Cmc.Nexus.Veteran.Yes)

The entity.Veteran.GetValueOrDefault() part of this expression gets the veteran status that was passed
when the Veteran value was saved on the Person.

The Equals(Cmc.Nexus.Veteran.Yes) part of the expression calls the enumerated list of Veteran values in
the Cmc.Nexus contract.

19. In the Toolbox, under Cmc.Core.Workflow.Activities, select the LogLine activity and drag it into the Then
sequence of the second If condition.

20. Specify the following expression in the Text field of the LogLine activity:

"**PERSON SAVED EVENT** - " & entity.FirstName.ToString() & " " & entity.LastName.ToString() &
" added to Military Students group"
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21. In the Toolbox, under Cmc.Nexus.Workflow, select the ManageGroupMembership activity and drag it
into the Then sequence of the second If condition.

22. In the Properties pane for the ManageGroupMembership activity, specify the following values:

a. In the Action field, select Add to Group.

b. In the DisplayName field, specify Add to military students group.

c. In the Group field, specify Group.Id.

d. In the Person field, specify entity.Id.

e. In the User Id field, specify the User Id of the staff who is adding the group member.

The Group.Id is a variable from the LookupStudentGroup activity that will be used in the Man-
ageGroupMembership activity.

The Add to Group action will only add the student to the group if the student is not already a group mem-
ber.

23. Drag a LogLine activity into the Else sequence of the If condition named Check if the Veteran Value is Yes.

24. Specify the following expression in the Text field of the LogLine activity:

"**PERSON SAVED EVENT** - " & entity.FirstName.ToString() & " " & entity.LastName.ToString() &
" removed from Military Students group"
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25. Drag a ManageGroupMembership activity into the Else sequence of the If condition named Check if the
Veteran Value is Yes.

26. In the Properties pane of the ManageGroupMembership activity, specify the following values:

a. In the Action field, select Remove from Group.

b. In the DisplayName field, specify Remove from Military Students Group.

c. In the Group field, specify Group.Id.

d. In the Person field, specify entity.Id.

e. In the User Id field, specify the User Id of the staff who is adding the group member.

The Group.Id is a variable from the LookupStudentGroup activity that will be used in the Man-
ageGroupMembership activity.

The Remove from Group action will only remove the student from the group if the student is a group
member.
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27. Check your workflow. Use the fit to screen button located at the bottom of the Designer pane to see the
whole workflow based on your screen resolution.
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28. Click Publish. The New Workflow Definition Version window is displayed.
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29. If you want the workflow to be run as soon as the event occurs on the entity, select Enable This Work-
flow Version, otherwise leave the check box cleared.

30. Click Save, then Cancel to close the publisher window.
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Charge a Fee when the Enrollment Status Changes
This workflow creates a charge when a student's enrollment status changes.

1. Start the Workflow application from your desktop.

2. On the Home tab, click New Event Workflow.

3. In the Entities area:

a. Click next to Cmc.Nexus.Contracts.

b. Click next to Cmc.Nexus.Sis.Academics.

c. Click Student Enrollment Period (StudentEnrollmentPeriod).

4. In the Events area, click Saved (SavedEvent).

5. Specify a Name for the workflow and click OK.

6. Drag an If activity it into the sequence.

a. In the Condition field, specify the following expression:

(entity.HasChanged("EnrollmentStatusId"))

7. Drag a CVueIdToPersonActivity activity into the Then branch of the If condition.

a. In the CVueIDproperty field, specify entity.StudentId.

b. If desired, change the DisplayName property.

c. In the Variables pane, create a variable for personId with the Variable type of Int32.

d. In the PersonId property field, specify personId.

e. In the PersonType property field, specify Cmc.Nexus.Converters.CVuePersonType.SyStudent
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8. Drag a CreateCharge activity into the sequence below the CVueIdToPersonActivity activity.

a. In the Charge Code field, select Administration Fee.

b. In the Transaction Type field, select Invoice.

c. In the Person field, specify personId.

d. In the Amount field, specify a dollar amount, e.g., 75.

e. In the Transaction Date field, specify DateTime.Today.

f. In the Post Date field, specify DateTime.Today.

g. In the Description field, specify a description of the charge, e.g., "Service Charge: Enrollment
Status Change".

h. In the Prospect field, specify entity.StudentId.

i. In the Student Enrollment Period field, specify entity.Id.

j. In the Reference field, specify a reference code for the charge, e.g., "FEE75".
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k. In the Variables pane, create a variable to hold the charge instance object called charge. In the Vari-
able type field, select Browse for type and select Cmc.Nex-
us.Sis.StudentAccounts.AccountChargeTransaction.

Enter the name of the variable in the Charge field of the Properties pane for the CreateCharge activ-
ity.

9. Drag a SaveCharge activity into the sequence.

a. In the ChargeTransaction property field, specify charge.

b. If desired, change the DisplayName property.

c. If desired, specify a VB expression to select a validation message. The example below does not use
validation messages.

d. Enter the name of the charge variable in the ChargeTransaction field of the Properties pane for
the SaveCharge activity.
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10. Check your workflow.

11. Click Publish. The New Workflow Definition Version window is displayed.

12. If you want the workflow to be run as soon as the event occurs on the entity, select Enable This Work-
flow Version, otherwise leave the check box cleared.

13. Click Save, then Cancel to close the publisher window.
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Check Approved Grants for Comments
This workflow checks for entries in the Note/Comments field when a grant or scholarship is saved with a status
of 'Approved'. The workflow is triggered by a saving event that occurs when the Save button is clicked on the
Awards form (standard interface) or on the Financial Aid Grant / Scholarship form (legacy interface).
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1. Start the Workflow application from your desktop.

2. On the Home tab, click New Event Workflow.

3. In the Entities area:

a. Click next to Cmc.Nexus.Contracts.

b. Click next to Cmc.Nexus.Sis.FinancialAid.

c. Click Student Grant Detail (StudentAwardDetailGrant).

4. In the Events area, click Saving (SavingEvent).

5. Specify a Name for the workflow and click OK.

6. Drag an If activity it into the sequence.

a. In the Condition field, specify the following expression:

(String.IsNullOrEmpty(entity.Note)) AND (entity.Status.Equals("Approved"))

7. Drag a CreateValidationItem activity into the Then branch of the If condition.
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a. In the Message field, specify the following string:

"If grant status is Approved, then a comment is required."

This message will be displayed in Anthology Student when an approved grant is saved without a
comment.

b. In the Message Type field, select Error (default).

c. In the Messages field of the Properties pane, enter args.ValidationMessages.

8. Drag a LogLine activity into the Else branch of the If condition.

a. In the Text field, specify the following expression:

"Grant condition check false" & Environment.NewLine

This expression creates a new line in the event log with the text "Grant condition check false".

b. In the Level field, select Information (default).

9. Drag a LogLine activity into the sequence below the If condition.

a. In the Text field, specify the following expression:

"GRANT INFO" & Environment.NewLine & " Award Amount: " & entity.AwardAmount &
Environment.NewLine & " Create Date: " & entity.CreateDate & Environment.NewLine & "
CreatedByUserId: " & entity.CreatedByUserId & Environment.NewLine & " Fund Source ID: "
& entity.FundSourceId & Environment.NewLine & " ID: " & entity.Id & Envir-
onment.NewLine & " Modified By User ID: " & entity.ModifiedByUserId & Envir-
onment.NewLine & " Note: " & entity.Note & Environment.NewLine & " Status: " &
entity.Status & Environment.NewLine & " Student Academic Year ID: " & entity.Stu-
dentAcademicYearId & Environment.NewLine & " Student Award Summary ID: " &
entity.StudentAwardSummaryId

This expression captures the data from the top section of the Financial Aid Grant / Scholarship
form in the event log.

b. In the Level field, select Information (default).
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10. Drag another If activity into the sequence.

a. In the Condition field, specify the following expression:

entity.ScheduledDisbursements.Count > 0

11. Drag a ForEach activity into the Then branch of the If condition.

a. In the Foreach item in field, specify the following expression:

entity.ScheduledDisbursements

b. Drag a LogLine activity into the Body of the ForEach activity.

c. In the Text field of the LogLine activity, specify the following expression:

Environment.NewLine & "SCHEDULED DISBURSEMENT LINE ITEM: " & Environment.NewLine
& " Amount Expected: " & item.AmountExpected & Environment.NewLine & " Disbursement
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Number: " & item.DisbursementNumber & Environment.NewLine & " ExpectedDate: " &
item.ExpectedDate & Environment.NewLine & " ID: " & item.Id & Environment.NewLine & "
Lender Fee: " & item.LenderFee & Environment.NewLine & " Note: " & item.Note & Envir-
onment.NewLine & " Status: " & item.Status & Environment.NewLine & " StudAcadYearPP
Id: " & item.StudentAcademicYearPaymentPeriod.Id & Environment.NewLine & "
StudAcadYearPP PayPer Description: " & item.Stu-
dentAcademicYearPaymentPeriod.PaymentPeriod.Description & Environment.NewLine & "
StudAcadYearPP PayPer Id: " & item.Stu-
dentAcademicYearPaymentPeriod.PaymentPeriod.Id & Environment.NewLine & "
StudAcadYearPP PayPer TermId: " & item.Stu-
dentAcademicYearPaymentPeriod.PaymentPeriod.TermId & Environment.NewLine & "
StudAcadYearPP EndDate: " & item.Stu-
dentAcademicYearPaymentPeriod.PaymentPeriodEndDate & Environment.NewLine & "
StudAcadYearPP StartDate: " & item.Stu-
dentAcademicYearPaymentPeriod.PaymentPeriodStartDate & Environment.NewLine & "
StudAcadYearPP Sequence: " & item.StudentAcademicYearPaymentPeriod.Sequence &
Environment.NewLine & " StudAcadYearPP StudAcadYearId: " & item.Stu-
dentAcademicYearPaymentPeriod.StudentAcademicYearId

This expression captures the data from the Scheduled Disbursements section of the Financial Aid
Grant / Scholarship form in the event log.

d. In the Properties pane of the ForEach activity, specify the following object type in the TypeAr-
gument field: Cmc.Nexus.Sis.FinancialAid.StudentAwardScheduledDisbursement.
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12. Drag a LogLine activity into the Else branch of the If condition.

a. In the Text field, specify the following expression:

"Scheduled Disbursements was Empty" & Environment.NewLine

This expression creates a new line in the event log with the text "Scheduled Disbursements was
Empty".
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13. Check your workflow. Scroll through the workflow or use the fit to screen button located at the bottom of
the Designer pane to see the whole workflow based on your screen resolution.

14. Click Publish. The New Workflow Definition Version window is displayed.

15. If you want the workflow to be run as soon as the event occurs on the entity, select Enable This Work-
flow Version, otherwise leave the check box cleared.

16. Click Save, then Cancel to close the publisher window.
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Check if a Grade was Posted
This workflow checks if a grade was posted for a student who did not attend classes. If a grade was posted, a
task is created to inform the student's advisor.

1. Start the Workflow application from your desktop.

2. On the Home tab, click New Event Workflow.

3. In the Entities area:

a. Click next to Cmc.Nexus.Contracts.

b. Click next to Cmc.Nexus.Sis.Academics.

c. Click Student Course (StudentCourse).

4. In the Events area, click Saved (SavedEvent).

5. Specify a Name for the workflow and click OK.

6. Drag an If activity it into the sequence.

a. In the Condition field, specify the following expression:

entity.HasChanged("GradePostedDate")

b. In the DisplayName property field, specify Check If a Grade Was Posted.

7. Drag an If activity into the Then branch of the first If condition.

a. In the Condition field, specify the following expression:

entity.LetterGrade.Equals("TR") OR entity.LetterGrade.StartsWith("EX")

b. In the DisplayName property field, specify Check if Letter Grade is Not Transfer or EX.

8. Drag an If activity into the Else branch of the second If condition.

a. In the Condition field, specify the following expression:

entity.LastAttendanceDate.HasValue

b. In the DisplayName property field, specify Check if no LDA.
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9. Drag a Sequence activity into the Else branch of third If condition.

a. In the DisplayName property field, specify Assign Activity.

10. Drag a LookupReferenceItem activity into the Assign Activity sequence.

a. In the Reference Item Type field, select Staff.

b. In the Reference Item field, select an advisor.

c. In the DisplayName property field, specify Lookup Advisor.

d. In the Variables pane, create a variable to hold the advisor that was looked up.
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11. Drag a Create Task activity into the Else branch of the If condition.

a. In the Task Type field, select Must Have.

b. In the Task Status field, select Pending.

c. In the Priority field, select Normal.

d. In the Assign To field, specify advisor.Id.

e. In the Related To field, specify entity.PersonId.

f. In the Start Date field, specify System.DateTime.Today.

g. In the DueTo field, specify System.DateTime.Today.AddDays(1).

h. In the Subject field, specify "Grade Posted with No Attendance".
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12. In the Variables pane, create a variable that holds the Task instance object.

Enter the name of the variable in the Task field of the Properties pane for the Create Task activity.
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13. Drag a Save Task activity into the sequence below the CreateTask activity.

Enter the name of the variable that holds the Task instance object in the Task field of the Properties pane
for the Save Task activity.

14. Check your workflow. Scroll through the workflow or use the fit to screen button located at the bottom of
the Designer pane to see the whole workflow based on your screen resolution.

15. Click Publish. The New Workflow Definition Version window is displayed.

16. If you want the workflow to be run as soon as the event occurs on the entity, select Enable This Work-
flow Version, otherwise leave the check box cleared.

17. Click Save, then Cancel to close the publisher window.
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Create a Student Enrollment Period
This workflow creates a new student enrollment period and assigns an enrollment number to a student. The
workflow uses the GetServiceInstance<IStudentEnrollmentPeriodService> activity. This service creates a new
enrollment record with a proper student enrollment number. The service calls the InsertStudentEnrollment
method on the iStudentEnrollmentPeriodService to insert a new enrollment record in the AdEnroll table.

Note: Do not use the SaveEntity<StudentEnrollmentEntity> activity to create a new student enrollment period
record. The saved record will not have a new enrollment number in the StuNum field of the AdEnroll table.

1. Open the workflow where you want to create an enrollment.

2. Create the following variables. Specify default values as needed for your use case.

3. Drag a CreateEntity activity into the sequence.

a. In the TEntity field, select Browse for Types....

b. Select Cmc.Nexus.Academics.Contracts > Cmc.Nexus.Academics.Entities > Stu-
dentEnrollmentPeriodEntity and click OK.

c. In the Result property field, specify the Enrollment variable created above.

4. Drag an Assign activity into the sequence.

a. In the "To" field specify studEnrollRequest (variable created above).

b. In the "Value" field specify new EnrollStudentRequest(Enrollment).

5. Drag a GetServiceInstance activity into the workflow.

a. In the TService field, select Browse for Types...

b. Select Cmc.Nexus.Academics.Services > IStudentEnrollmentPeriodService and click OK.

c. In the Result property field, specify the iStudEnrollSvc variable created above.

6. Insert Assign activities for each row in the following table. Assign values as needed for your environment.
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Note: Use LookupReferenceItem or other methods to find the correct values for these fields. They have
been hard-coded in a test environment for example purposes only.

To Value Value Example

studEnrollRequest.entity.StudentId <StudentID> 20073

studEnrollRequest.entity.SchoolStatusId <SchoolStatusId> 5

studEnrollRequest.entity.CampusId <CampusId> 1

studEnrollRequest.entity.ProgramId <ProgramId> 83

studEnrollRequest.entity.ProgramVersionId <ProgramVersionId> 166

studEnrollRequest.entity.ShiftId <ShiftId> 64

studEnrollRequest.entity.BillingMethodId <BillingMethodId> 52

studEnrollRequest.entity.GradeLevelId <GradeLevelId> 1

studEnrollRequest.entity.StartDateId <StartDateId> 2998

studEnrollRequest.entity.IpedsState <IpedsState> "GA"

studEnrollRequest.entity.AcademicAdvisorId <AcademicAdvisorId> 115

studEnrollRequest.entity.ApplicationReceivedDate <ApplicationReceivedDate> datetime.Today

studEnrollRequest.entity.EnrollmentDate <EnrollmentDate> datetime.Today

studEnrollRequest.entity.MidpointDate <MidpointDate> MidPoint (variable
created above)

studEnrollRequest.entity.GraduationDate <GraduationDate> GradDate (vari-
able created
above)

studEnrollRequest.entity.ExpectedStartDate <ExpectedStartDate> ExpStart (variable
created above)

Assign Properties

7. Optionally, for testing purposes, insert a WriteLine activity with Text = "Before Call".

8. Drag an Assign activity into the sequence. This is the call to the GetServiceInstance activity using variables
created above.  

a. In the "To" field specify studEnrollResponse.

b. In the "Value" field specify iStudEnrollSvc.InsertStudentEnrollment(studEnrollRequest).

9. Optionally, insert another WriteLine with Text = "After Call".

10. Optionally, insert a LogObject activity with Level = Error and Object = studEnrollResponse.

11. Click Publish. The New Workflow Definition Version window is displayed.
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12. If you want the workflow to be run as soon as the event occurs on the entity, select Enable This Work-
flow Version, otherwise leave the check box cleared.

13. Click Save, then Cancel to close the publisher window.



Custom Field Validations on Each Step of Enrollment Wizard
This workflow performs custom validations on each step of the Anthology Student Enrollment wizard. This work-
flow example is described at a high level using screen captures for the main sequences, rather than describing
each step in detail. The workflow is triggered by a Saving event using the contract Cmc.Nexus.Contracts >
Cmc.Nexus > Person.

Note: When the Student Enrollment wizard uses a Person Saving event, each step only fills out a few fields in
the Person.Students(0).StudentEnrollmentPeriods(0) entity based on the step Context.

The top level sequence contains a Switch activity based on the args.Context for each step of the enrollment wiz-
ard, plus a default case.



1. The first case creates an error message when the value "Homeschooled" is selected in the Previous
Education field of the Enrollment wizard.





The custom validation message for this case is as follows:



2. The second case performs custom validations on the Program and Grade Level selections.

l If the student's residence is in Alaska, the student is not allowed to enroll in a "Golf" program.

l If Grade Level High School (8) is selected, an error message states "Grade Level cannot be High
School".

Note: You can hard code the grade level value to compare to (i.e., "8") or use a Look-
upReferenceItem activity instead.



The custom validation message for this case is as follows:

3. The third case checks for an entry in the Start Term field.



The custom validation message for this case is as follows:



4. The fourth case checks for an entry in the Extern Start Date field.



The custom validation message for this case is as follows:

5. The last case checks for an entry in the Comment field.



The custom validation message for this case is as follows:
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Long Running Workflow
A human workflow, or long running workflow, refers to a type of business process where time elapses between
actions, usually waiting for some person to make a decision, which then resumes the workflow. In most cases
these workflows refer to approval processes. For example, a student makes a request and that request requires
a notification to be sent to one or more approvers.

To create a long running workflow, you will need the following:

l Specify the entity and event that will initialize the process, for example, a document being requested.

l Get the workflow instance.

l Save the workflow instance to a location where it can be retrieved.

l Persist the workflow through a bookmark or time delay.

l Trigger an en event that resumes the workflow.

l Fetch the workflow instance.

l Complete the workflow or repeat the persist / resume process.

When designing approval processes, you can have a scenario where a single event can continue the workflow or
several events need to occur to continue the workflow.

l For singular approval, like approved or denied, use the Pick and Pick Branch activities to resume book-
marks.

l For multiple approvals, like approver, document, and fee, use a Parallel activity to resume bookmarks.

Currently, you can only save the WorkflowInstanceId to the CmDocument or CmEvent tables in Anthology Stu-
dent. Most approvals or long running workflows will be related to a Contact Manager activity or a document.

Scenario: Request Approval from a User
We will add a Contact Manager activity to a student and assign it to an advisor. The first workflow will “wait” until
the advisor approves. The second workflow will "wake up" the first workflow when the Contact Manager activity
is closed.

The following flowchart illustrates the business process that is captured in the workflow sequence.
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Prerequisites
l A Contact Manager activity is set up in Anthology Student.
l Access to the workflow logs is available.

Workflow Activities Used
The following activities will be used in the workflow:
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l If
l Sequence
l LookupReferenceItem
l CreateBookmark
l ResumeBookmark
l Pick
l PickBranch
l LogLine
l ExecuteNonQuery
l ExecuteDataReader
l GetWorkflowInstanceId
l FlowChart

Continue with Create a Long Running Workflow.

Create a Long Running Workflow
When the "Approve Drop Request" Contact Manager activity is added to a student’s record, this workflow
detects the event and waits for the activity to be closed before executing the logic in the Pick activity.

Step 1: Create a Contact Manager activity in Anthology Student

a. In Anthology Student, navigate to Lists > Contact Manager > Activities > New.

b. Add a new Contact Manager activity for the workflow. In this example, we created the Other Task activity
with the name WF – Approve Drop Course Request.

c. Navigate to Lists > Contact Manager > Activity Result > New.
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d. Create the following Contact Manager activity results:

l Approve Drop Course Request
l Deny Drop Course Request

Make sure these activity results are assigned to Other Task types.

Step 2: Create a workflow

a. Launch Workflow Designer.

b. On the Home tab, click New Event Workflow.

c. In the Name field, type Demo - How to use a long running workflow.

d. In the Entities area, expand Cmc.Nexus.Contracts > Cmc.Nexus.Crm and select Task {Task).

e. In the Events area, expand Cmc.Core.Eventing and select Saved (SavedEvent).

f. Click OK.

Step 3: Rename the default sequence

In the Properties pane, set the DisplayName to Example: Log Running Workflow.
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Step 4: Create variables

a. In the Variables pane, create a variable named DropActivity. This variable will store the Contact Manager
activity we created in Anthology Student.

b. In the Variable type field, click Browse for Types and navigate to Cmc.Nexus.Common.Workflow >
LookupReferenceItem. This type is required because we are going to look up the Contact Manager activ-
ity using a workflow activity

c. Create a second variable named WorkflowId. This variable will store the workflow instance Id.

d. In the Variable type field, click Browse for Types and navigate to mscorlib > System > Guid.

Step 5: Look up the Contact Manager activity

a. In the Toolbox under CMC.Nexus.Workflow, find the LookupReferenceItem activity and drag it into the
sequence.

b. In the Properties pane, change the DisplayName to Find Activity.

c. In the Reference Item Type field, select Task Template.

d. In the Reference Item field, select WF – Approve Drop Course Request. This is the Contact Manager
activity you created earlier.

e. In the Properties pane, set the Reference Item to the DropActivity variable.

Step 6: Write to the log

a. In the Toolbox under CMC.Core.Workflow.Activities, find the LogLine activity and drag it into the
sequence under the LookupReferenceItem activity.

The LogLine activity writes to the log file as the workflow goes a long. It is a great way to see what is hap-
pening with the workflow and helps during troubleshooting while learning or building your workflow. It is
similar to commenting your code.

b. In the Properties pane, change the DisplayName to Initialize.

c. In the Text field, write any text that you want to show up in the log, for example,
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"Starting Long Running Workflow Example - The Activity we are looking for is " + DropActiv-
ity.Name + " with the TaskTemplateId = " + entity.TaskTypeId.ToString

d. Leave the Level set to Information. Depending on how your Nlog.config file is set up, different levels
are logged in different ways.

Step 7: Make sure this is the activity we are looking for

a. In the Toolbox under Control Flow, find the If activity and drag it into the sequence under the LogLine
activity.

The If condition will check if the event that occurred is the one we are looking for. We are looking for the
DropActivity event (see step 5).

b. In the Properties pane, change the DisplayName to Check to see if this is the drop activity.

c. In the Condition field, type the following:

entity.EntityState = Cmc.Core.EntityModel.EntityState.Added and entity.TaskTypeId = DropActiv-
ity.Id

When a Contact Manager activity is added, this condition checks if the activity is a drop activity; if it is, the
workflow continues, else the workflow ends.

Step 8: Write to the log

a. In the Toolbox under CMC.Core.Workflow.Activities find the LogLine activity and drag it into the Else
block of the If activity.

b. In the Properties pane, change the DisplayName to Terminate Workflow.

c. In the Text field, type “Condition not met, terminating workflow”

d. Leave the Level set to Information.
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Step 9: Get the WorkflowInstanceId

a. In the Toolbox under Control Flow, find the Sequence activity and drag it into the Then block of the If
activity.

You can only have one activity inside the Then and Else blocks of the If activity. But a Sequence is an activ-
ity that allows you to have multiple workflow activities.

b. In the Properties pane, change the DisplayName to Save WorkflowId.

c. In the Toolbox under CMC.Core.Workflow.Activities, find the GetWorkflowInstanceId activity and drag it
into the sequence.

d. In the Properties pane, set the Result field to the variable WorkflowId.

e. Optional: In the DisplayName field, add a space between Get and WorkflowInstanceId to make it easier to
read.

Step 10: Save the WorkflowInstanceId
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We are going to save the WorkflowInstanceId to the CmEvent record in the Anthology Student database so that
we can recall this workflow later. Since we are working with Anthology Student, we will not need a connection to
the database. We just need to update the WorkflowInstanceID column that was added as part of Anthology Stu-
dent 16.1.0.

a. In the Toolbox under Control Flow, find the ExecuteNonQuery activity and drag it into the sequence
under the GetWorkflowInstanceId activity.

b. In the Properties pane, change the DisplayName to Save the Workflow Instance.

c. In the Command field, type the following:

"UPDATE CmEvent SET WorkflowInstanceId =" & WorkflowID.ToString & " WHERE CmEventID =" &
entity.Id

Note: SQL commands need to be strings, that is, quotes are required.

d. In the Toolbox under CMC.Core.Workflow.Activities, find the LogLine activity and drag it under the
ExecuteNonQuery activity.

e. In the Properties pane, change the DisplayName to Update Log.

f. In the Text field, type the following:

“The workflow instance - " +WorkflowId.ToString+ " was added to the CmEventID-" +
entity.Id.ToString”
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g. Set the Level to Information.

Step 11: Pause the workflow

Because we only have two conditions, approved or denied, we will use the Pick activity to pick which business
process will resume once the approver closes the Contact Manager activity with an approved or denied result.

a. In the Toolbox under Control Flow, find the Pick activity and drag it under the If activity.

The Pick activity uses PickBranch activities, one for each branch of the business process that will execute
when the workflow resumes.

b. In the Properties pane, change the DisplayName to Approved or Denied Process.

c. In the Toolbox under Control Flow, find the PickBranch activity and drag it into the Pick activity.

d. In the Properties pane, change the DisplayName to Approved Process.

e. In the Toolbox under Cmc.Core.Workflow.Activities, find the CreateBookmark activity and drag it into
the Trigger section of the PickBranch.

The CreateBookmark activity is saved and referenced later based on the approvers actions.

f. In the Properties pane, change the DisplayName to Pause the workflow.
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g. Set the BookmarkName property to “Approved”.

h. Drag a LogLine activity into the Action section of the PickBranch.

i. In the Text field, type “The Request was Approved”.

j. Right-click the PickBranch activity and select Copy .

k. Right-click next to the PickBranch activity and select Paste. We now have two pick branches.

l. In the Properties pane of the copied PickBranch, change the DisplayName to Denied Process.

m. Drag a LogLine activity into the Action section of the copied PickBranch.

n. In the Text field, type “The Request was Denied”.

Step 12: Save and publish the workflow

a. Check your workflow. Scroll through the workflow or use the fit to screen button located at the bottom of
the Designer pane to see the whole workflow based on your screen resolution.
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b. Click Publish. The New Workflow Definition Version window is displayed.

c. Select Enable This Workflow Version

d. Click Publish, then Cancel to close the publisher window.

We now need to create another workflow that will resume this workflow when the Contact Manager activity is
closed.

Continue with Wake up the Long Running Workflow.
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Wake up the Long Running Workflow
This workflow resumes the long running workflow when an advisor approves or denies a student's request to
drop a course and the Contact Manager activity is closed.

Step 1: Create a new workflow

a. Launch Workflow Designer.

b. On the Home tab, click New Event Workflow.

c. In the Name field, type Resume Drop Course Workflow.

d. In the Entities area, expand Cmc.Nexus.Contracts > Cmc.Nexus.Crm and select Task {Task).

e. In the Events area, expand Cmc.Core.Eventing and select Saved (SavedEvent).

f. Click OK.

Step 2: Delete the default Sequence

This workflow uses a Flowchart instead of a Sequence. Flowcharts are better used when many decisions need to
be considered. In this case, we are really looking for the result of the activity; however, the result is not required
in the database. We need to handle approved, denied, and nothing, or a NULL results. This is best done with
flow decisions.
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a. In the Designer pane, right-click the default Sequence and select Delete.

b. In the Toolbox under Flowchart, find the Flowchart activity and drag it on to the Designer pane.

c. In the Properties pane, change the DisplayName to Resume Drop Course Workflow.

Step 3: Create variables

In the Variables pane, create variables with the following names and types:

Name Variable type (see Note) Default

ActivityResultDenied

LookupReferenceItem
(Cmc.Nexus.Common.Workflow)

ActivityResultApproved

ActivityStatusClosed

DropActivity

BookmarkName String "Denied"

Result Int32

WorkflowId Guid (mscorlib > System > Guid)

Note: If you don’t see the Variable type you need, click Browse for Types.

Step 4: Add the Initialize Sequence

Working with flowcharts is nice because you can really organize the steps and activities.

a. Drag a Sequence activity below the Start circle of the Flowchart.

b. In the Properties pane, change the DisplayName to Initialize.

c. Double-click the Sequence. Inside this sequence, we will add some logging and look up some information
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that we will use in our first flow decision.

Step 5: Write to the log and look up information

a. Drag a LogLine activity into the sequence.

b. Drag two LookupReferenceItem activities into the sequence.

c. In the LogLine activity, change the DisplayName to Begin Workflow.

d. In the Text field of the LogLine activity, type:

"Check event for conditions - the CmEventId is -" + entity.Id.ToString + " the StatusId is - " +
entity.TaskStatusId.ToString + " the ResultId is - " + entity.TaskResultId.ToString

e. In the first LookupReferenceItem, specify the following:

DisplayName: Find the Drop Activity Status

Reference Item Type: Task Status

Reference Item: ActivityStatusClosed (This is one of the variables created above.)

f. In the second LookupReferenceItem, specify the following:

DisplayName: Find Drop Activity

Reference Item Type: Task Template

Reference Item: DropActivity (This is one of the variables created above.)

Step 6: Flow Decision

a. Click Flowchart in the breadcrumbs at the top of the Designer pane.

b. Drag the Flow Decision activity below the sequence we just created.

c. In the Properties pane of the Flow Decision, change the DisplayName to Drop Activity Closed.

d. In the Condition field, type:
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entity.HasChanged(task.TaskStatusIdProperty) and entity.TaskStatusId = ActivityStatusClosed.Id
and entity.TaskTypeId = DropActivity.Id

This condition checks if the Contact Manager Drop activity was closed.

l If it isn’t the Drop Activity, and the status wasn’t what was updated, we will end the workflow.

l If it is the one we are looking for, we will check for the result.

e. Hover the cursor over the Start icon. Little shapes appear around the outside.

l Draw an arrow from the Start icon to the Initialize sequence.

l Draw another arrow from the Initialize sequence to the Flow Decision.

Step 7: True or False

The output of the Flow Decision is a True or False branch. You can change the labels of the a True or False
branches; however, regardless of the labels, the condition is either met or not met. In our case, the condition is
not met if the activity is not the Drop Activity or if the update did not close the status on that activity.

a. Drag a LogLine activity to the right and slightly below the Flow Decision.

b. In the Properties pane, change the DisplayName to Terminate Workflow.

c. In the Text field, type: “The condition was not met, this is not a Drop Activity".

d. Drag a Sequence to the left and slightly below the Flow Decision.

e. In the Properties pane, change the DisplayName to Get Task Statuses.



Workflow Version 4.0.1 593 Help Guide

f. Connect the Flow Decision to each of the sequences.

Step 8: Get the Task Statuses

a. Double-click the Get Task Statuses sequence.

b. Drag two LookupReferenceItem activities and a LogLine activity into this sequence.

c. In the first LookupReferenceItem, specify the following:

DisplayName: Activity Result Approved

Reference Item Type: Task Result

Reference Item: ActivityResultApproved (This is one of the variables created above.)

d. In the second LookupReferenceItem, specify the following:

DisplayName: Activity Result Denied

Reference Item Type: Task Result

Reference Item: ActivityResultDenied (This is one of the variables created above.)

e. In the Text field of the LogLine activity, type:

"The ApprovalID is " + ActivityResultApproved.Id.ToString + " the DeniedId is " + Activ-
ityResultDenied.Id.ToString

f. In the Properties pane of the LogLine activity, change the DisplayName to Log the Result Ids.
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Step 9: More Flow Decisions

a. Drag two more Flow Decisions into the workflow.

b. Connect the Get Task Statuses sequence to the first Flow Decision.

c. In the Properties pane, change the DisplayName to Approved.

d. Connect the False line of the Approved decision to the top of the Denied Flow Decision.

e. In the Properties pane, change the DisplayName to Denied.

f. Set the Condition field for the Approved decision to:

entity.TaskResultId.Value = ActivityResultApproved.Id

g. Set the Condition field for the Denied decision to:

entity.TaskResultId.Value = ActivityResultDenied.Id
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Step 10: BookmarkName

a. Drag the Assign activity near and below the True side of the Approved decision.

When the Approved decision goes down the True path, we are going to set the value of the variable Book-
markName to Approved. Remember, we set the default value to Denied (see step 3).

b. Drag a LogLine activity below the Assign activity.

c. In the Text field, type: “The Bookmark name is “ + BookmarkName

d. In the Properties pane of the LogLine activity, change the DisplayNameto What is the bookmark.

e. Connect the Approved True line to the Assign activity.
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f. Connect the Assign activity to the LogLine activity.

g. Connect the False line of the Denied decision to the Terminate workflow activity.

h. Connect the True line to the What is the bookmark LogLine activity.

Step 11: Resume the sleeping workflow

a. Drag another Sequence into the workflow.

b. In the Properties pane, change the DisplayName to Kick Off the Persisted Workflow.
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We need to get the WorkflowInstanceId and resume the bookmark that is waiting in our Pick Branch from
our long running workflow.

c. Drag the ExecuteDataReader activity into the sequence.

d. In the Command field, type:

"Select WorkflowInstanceId from CmEvent where CmeventId =" & entity.Id

Step 12: Assign the WorkflowInstanceId to the GUID variable

a. Drag the Assign activity into the Get the Workflow Instance activity.

b. In the To property, type WorkflowId. This is the GUID variable we created earlier.

c. In the Value property, type: DirectCast(CurrentRow("WorkflowInstanceId"),GUID)

Results that come from the ExecuteDataReader activity are always strings, but we need a GUID. There-
fore, we are casting the result into the correct data type.

Important: It is critical that the spelling inside CurrentRow() is exactly as it is in our SELECT statement.
Otherwise, the string to string comparison will fail.
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Step 13: Log the output of the logic before resuming the workflow

a. Drag a LogLine activity under the Get the Workflow Instance activity.

b. In the Text field, type:

"What is in the WFInstance? --" + WorkflowId.ToString + " is the value that should be used as the
GUID to get the workflow instance"
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Step 14: Resume the workflow

a. In the Toolbox under Cmc.Core.Workflow.Activities, find the ResumeBookmark activity and drag it under
the LogLine activity.

b. We have the BookmarkName set by our decision logic and we now have our WorkflowId assigned to the
instance we are looking for.

l In the Bookmark field, add the BookmarkName variable.

l In the Workflow Instance Id field, add the WorkflowId variable.

c. Connect the What is the bookmark LogLine activity to the Kick off the Persisted Workflow.
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Step 15: Save and publish the workflow

a. Check your workflow. Scroll through the workflow or use the fit to screen button located at the bottom of
the Designer pane to see the whole workflow based on your screen resolution.

b. Click Publish. The Publish Workflow Definition Version window is displayed.

c. Select Enable This Workflow Version.
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d. Click Publish, then Cancel to close the publisher window.

Continue with Test the Workflow Sequence.

Test the Workflow Sequence
Before you test the long running workflow sequence:

l Make sure the Service Module Host service is running.

l Navigate to the location of your log files for the Service Module Host. There should be one file with
today’s date.

Step 1: Add Contact Manager Activity in Anthology Student

a. Launch Anthology Student.

b. Find a student.

c. Open the student’s Activities folder.

d. Navigate to View > Contact Manager > Activities.

e. Add the activity WF - Approve Drop Course Request.

f. Click Save.
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This will raise the Task Saved event and should kick off the long running workflow named Demo – How to use a
long running workflow.

After you click Save, you can open your log file. It should have logged our all LogLine activities contained ion the
workflow sequence.

Step 2: Check the log and verify the update

a. On the server running the workflow, navigate to Services\Nexus Event Notification Service

16.1\logs.

b. Double-click the most recent log file.
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c. The log shows that two workflows were triggered by a Task Saved event:

l The first workflow checks if it the Drop Course activity is added, saves the WorkflowInstanceId, and
then goes to sleep.

l The second workflow waits for the activity to close with a result.

Because we added the activity and did not close it, the second workflow indicates that the condition is not
met and stops.

Queue, Type: //Cmc/SSBMessage_CmEvent_Saved_Notification

2015-06-16 14:26:04.5788 14 Trace Cmc.Core.Event-
ing.SavedEvent

Raising event 'Saved' on type 'Task' - Entering
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2015-06-16 14:26:04.5788 14 Trace Cmc.Core.Event-
ing.SavedEvent

Executing handler 'Cmc.Core.Workflow.WorkflowEventHandler`2[Cmc.Core.Event-
ing.SavedEvent,Cmc.Nexus.Crm.Task]' - Entering

2015-06-16 14:26:04.5944 14 Debug Cmc.Core.Work-
flow.WorkflowEngine

Running workflow de5f7208-542b-402d-8608-299c9bddfe8e

2015-06-16 14:26:04.6256 86 Info Cmc.Core.Work-
flow.Activities.LogLine

Starting Long Running Workflow Example - The Activity we are looking for is WF -
Approve Drop Course Request with the TaskTemplateId = 272

2015-06-16 14:26:04.6412 19 Info Cmc.Core.Work-
flow.Activities.LogLine

The workflow instance - de5f7208-542b-402d-8608-299c9bddfe8e was added to the
CmEventID-16356

2015-06-16 14:26:04.6568 34 Info Cmc.Core.Work-
flow.Activities.LogLine

Pausing the workflow - awaiting approver result

2015-06-16 14:26:04.6568 15 Trace Cmc.Nex-
us.Utility.ServiceBroker.ServiceModule.ServiceBrokerServiceModule 15: New Message
From Queue, Type: //Cmc/SSBMessage_CmEvent_Saved_Notification

2015-06-16 14:26:04.6568 14 Debug Cmc.Core.Work-
flow.WorkflowEngine

Done running workflow de5f7208-542b-402d-8608-299c9bddfe8e

2015-06-16 14:26:04.6724 14 Debug Cmc.Core.Work-
flow.WorkflowEngine

Running workflow cc8dced3-76ff-4906-85fc-46d3db755789

2015-06-16 14:26:04.6880 25 Info Cmc.Core.Work-
flow.Activities.LogLine

Check event for conditions - the CmEventId is -16356 the StatusId is - 1 the Res-
ultId is - 0

2015-06-16 14:26:04.7036 77 Info Cmc.Core.Work-
flow.Activities.LogLine

The condition was not met, this is not a Drop Activity

2015-06-16 14:26:04.7036 14 Debug Cmc.Core.Work-
flow.WorkflowEngine

Done running workflow cc8dced3-76ff-4906-85fc-46d3db755789
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Step 3: Check the database and verify the update

Use the following SQL statement to verify that the GUID was saved to the CmEvent table:

Select Top 1 WorkflowInstanceId, [Subject], * from CmEvent order by DateAdded Desc

Step 4: Resume the workflow

a. From the student’s Activities folder, find the activity we just added and click Close Activity.

b. Select Approve Drop Course Request as the result.

This will resume the Approved Process Pick Branch.

c. Check the log file again.

[Cmc.Core.Eventing.SavedEvent,Cmc.Nexus.Person]' - Entering

2015-06-16 14:38:38.5729 15 Debug Cmc.Core.Work-
flow.WorkflowEngine
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Running workflow f0a879e3-2d61-48ba-bd60-68a2701eff2a

2015-06-16 14:38:38.5729 13 Debug Cmc.Core.Work-
flow.WorkflowEngine

Running workflow 7aad21e1-d6e2-4307-9916-0636e449977a

2015-06-16 14:38:38.6197 46 Info Cmc.Core.Work-
flow.Activities.LogLine

Starting Long Running Workflow Example - The Activity we are looking for is
WF - Approve Drop Course Request with the TaskTemplateId = 272

2015-06-16 14:38:38.6353 25 Info Cmc.Core.Work-
flow.Activities.LogLine

Condition not met, terminating workflow

2015-06-16 14:38:38.6353 74 Info Cmc.Core.Work-
flow.Activities.LogLine

Pausing the workflow - awaiting approver result

2015-06-16 14:38:38.6353 15 Debug Cmc.Core.Work-
flow.WorkflowEngine

Done running workflow f0a879e3-2d61-48ba-bd60-68a2701eff2a

2015-06-16 14:38:38.6509 15 Debug Cmc.Core.Work-
flow.WorkflowEngine

Running workflow d29cb1c9-337f-4a8c-8b20-2bed86eaf9a9

2015-06-16 14:38:38.6665 13 Debug Cmc.Core.Work-
flow.WorkflowEngine

Done running workflow 7aad21e1-d6e2-4307-9916-0636e449977a

2015-06-16 14:38:38.6665 13 Trace Cmc.Core.Event-
ing.SavedEvent

Executing handler 'Cmc.Core.Workflow.WorkflowEventHandler`2[Cmc.Core.Event-
ing.SavedEvent,Cmc.Nexus.Person]' - Exiting

2015-06-16 14:38:38.6665 13 Trace Cmc.Core.Event-
ing.SavedEvent

Raising event 'Saved' on type 'Person' - Exiting

2015-06-16 14:38:38.6821 25 Info Cmc.Core.Work-
flow.Activities.LogLine

Check event for conditions - the CmEventId is -16356 the StatusId is - 2 the Res-
ultId is - 21

2015-06-16 14:38:38.6977 95 Info Cmc.Core.Work-
flow.Activities.LogLine

The ApprovalID is 21 the DeniedId is 22
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2015-06-16 14:38:38.6977 95 Info Cmc.Core.Work-
flow.Activities.LogLine

The Bookmark name is Approved

2015-06-16 14:38:38.7133 46 Info Cmc.Core.Work-
flow.Activities.LogLine

What is in the WFInstance? --de5f7208-542b-402d-8608-299c9bddfe8e is the value
that should be used as the GUID to get the workflow instance

2015-06-16 14:38:38.7445 44 Debug Cmc.Core.Work-
flow.WorkflowEngine

Running workflow de5f7208-542b-402d-8608-299c9bddfe8e

2015-06-16 14:38:38.7445 44 Debug Cmc.Core.Work-
flow.WorkflowEngine

Done running workflow de5f7208-542b-402d-8608-299c9bddfe8e

2015-06-16 14:38:38.7445 95 Info Cmc.Core.Work-
flow.Activities.LogLine

The Request was Approved

2015-06-16 14:38:38.7445 15 Debug Cmc.Core.Work-
flow.WorkflowEngine

Done running workflow d29cb1c9-337f-4a8c-8b20-2bed86eaf9a9

2015-06-16 14:38:38.7445 15 Trace Cmc.Core.Event-
ing.SavedEvent

Executing handler 'Cmc.Core.Workflow.WorkflowEventHandler`2[Cmc.Core.Event-
ing.SavedEvent,Cmc.Nexus.Crm.Task]' – Exiting

Test Successful!

Check the Contact History In Anthology Student and verify that the Approve Drop Course Request activity is
closed.
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Populate Fields in a Forms Builder Form
When web forms are built with Forms Builder 1.x or 2.x, eventing and workflows can be used to gather data and
push the data into a multi-step form as it transitions from one step to another. Eventing and workflow make it
possible to return information to a user on a Forms Builder web form that is not part of the existing adapter. In
this scenario, we will return all of the courses a student is currently registered in.

Scenario
We built a Forms Builder form that allows a student to drop a course. For the first page of the form we wanted
to make sure we had correct contact information for the student as dropping a course is a retention red-flag.
Once the student verified his or her information, we used a workflow with AddToDictionary<> activity to get the
current list of courses that the student was registered in.

Prerequisites
l A Forms Builder form to request admission was created.
l A student has registered into current courses with a Portal account.

Procedure

Step 1: Create the Forms Builder fields

a. Launch Forms Builder Designer.

b. In the Fields tab, click Add New Field. The Create New Custom Field form is displayed.

c. In the Field Name field, type GetCurrentCourses.

d. In the Display Text field, type Current Courses.

e. In the Input Method field, select Text Area.

f. In the Data Type field, select text.
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g. Click Save.

Step 2: Create a simple form

a. From the Fields tab, search for Name.

b. Drag the First Name and Last Name fields onto the canvas.

Step 3: Save the Form Template

a. Click the Save button in the lower left corner.

b. Save as a Form Template named Demo - Forms Builder and Workflow Step 1.
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c. Clear the canvas.

Step 4: Drag the custom field on to the canvas.

a. From the Fields tab, search for courses. The list of fields is filtered showing the custom field you created
earlier.

b. Drag the Current Courses field onto the canvas.

c. Click Save.

d. Save as a Form Template.
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e. Clear the canvas.

Step 5: Bring it together - Forms & Rules

a. In the Forms and Rules tab, search for demo.

b. Drag the form template named Demo - Forms Builder and Workflow Step 1 on to the canvas.

c. Click the Rules tab

d. Drag the Raise Event rule under the Demo – Forms Builder and Workflow Step 1 form template.

e. When you drag the Raise Event rule onto the canvas, the default configuration requires that you name
the event. This name will initiate the workflow.

Type DemoDictionary in the Event Name field, and click Save.
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f. Drag Demo – Forms Builder and Workflow Step 2 on to the canvas under the rule.

g. Click Save.

Step 6: Save the Sequence

a. Fill out the Save Sequence form.

b. Click Save.
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c. In the upper right hand side, click Publish.

d. Select the Is Repeatable check box and type It Worked! in the Confirmation Text field.

e. Click Publish.

Step 7: Create a workflow

a. Launch Workflow Designer.

b. On the Home tab, click New Event Workflow.
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c. In the Name field, type Demo - Forms Builder and Workflow.

d. In the Entities area, expand Cmc.FormsBuilder.Contracts and select Forms Builder Form (FormEntity).

e. In the Events area, expand Cmc.FormsBuilder.Contracts and select Forms Builder Rule Executed Event
(FormTransitionEvent).

f. Click OK.

Step 8: Rename the default Sequence

In the Properties pane, change the DisplayName to Send data back to the form.

Step 9: Add an If activity to the workflow
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a. In the Toolbox under Control Flow, find the If activity and drag it into the sequence.

b. In the Properties field, change the DisplayName to Check for Forms Builder Event.

c. In the Condition field, type: entity.EventName = "DemoDictionary"

Step 10: Create variables

The first variable will hold the field name from the Forms Builder field we created.

a. In the Variables pane, create a variable named FBField.

b. In the Variable type field, select String.

c. The Scope field should be set to Send data back to the form.

d. In the Default field, type "GetCurrentCourses". This is the name of the Forms Builder field exactly as we
created it in step 1. Because it is a string, we must put it in quotes.

The next variable will hold the data we will send back to the Forms Builder form. Typically, we would query the
information from the database, but for this purpose we will just populate it to simulate the data.

e. In the Variables pane, create a variable named courses.

f. In the Variable type field, select String.

g. The Scope field should be set to Send data back to the form.

h. In the Default field, type "GM101 - Intro to Grilling".
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Step 11: Add to Dictionary

a. In the Toolbox under Cmc.Core.Workflow.Activities, find the Add to Dictionary `2 activity and drag it
into Then part of your If activity.

This activity will pass information from the workflow back to a field inside of a Forms Builder form when a
form transitions from one step to another.

b. When you drag the Add to Dictionary `2 activity into the Designer pane, you are prompted to set the data
type. Forms Builder currently only supports strings.

Select String in the TKey and TValue fields.

c. In the Properties pane, set the Dictionary field to args.DefaultFields. This is the argument that is sending
the data back to Forms Builder.

d. Change the DisplayName to Send info to FB.

e. In the Key field, specify the FbField variable. This is the field name of the custom field we created in step
1.
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f. In the Value field, specify the courses variable. The value of this variable will show up on the Forms
Builder form.

Step 12: Publish the workflow

a. Check your workflow. Scroll through the workflow or use the fit to screen button located at the bottom of
the Designer pane to see the whole workflow based on your screen resolution.

b. On the Home tab, click Publish. The New Workflow Definition Version window is displayed.

c. Select Enable This Workflow Version

d. Click Publish, then Cancel to close the publisher window.

Step 13: Test the workflow
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a. Forms Builder has a link to all of its published sequences, e.g., http://ap-
ply.campusmgmt.com/Home/PublishedSequences

On your Published Sequences page, select the Demo - Forms Builder and Workflow sequence and click
Open.

b. Log in with the student Id. The Demo - Forms Builder and Workflow Step 1 form displays the First Name
and Last Name field for the student.

c. Click Next. The Demo - Forms Builder and Workflow Step 2 form is displayed. The Current Courses field
shows the course the student is registered in.

d. Click Done. The Confirmation page is displayed.
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Register Students into a Course
This workflow finds students with a status of 'Future Start' and registers the students into an introductory
course when their status changes.

1. Start the Workflow application from your desktop.

2. On the Home tab, click New Event Workflow.

3. In the Entities area:

a. Click next to Cmc.Nexus.Contracts.

b. Click next to Cmc.Nexus.Sis.Academics.

c. Click Student Enrollment Period (StudentEnrollmentPeriod).

4. In the Events area, click Saved (SavedEvent).

5. Specify a Name for the workflow and click OK.

6. Drag a LookupReferenceItem activity it into the sequence.

a. In the Reference Item Type field, select Student Status.

b. In the Reference Item field, select Future Start.

c. In the Variables pane, create a lookup type variable (StudentStatus) to contain the results of the
lookup.

7. Drag an If activity into the sequence.

a. In the Condition field, specify the following expression:

entity.HasChanged(StudentEnrollmentPeriod.StudentStatusIdProperty) and entity.Stu-
dentStatusId.Value() = StudentStatus.Id

8. Drag an ExecuteDataReader activity into the Then branch of the If condition.

a. In the Queryfield, specify the following string:

"Select AdClassSchedId from AdClassSched where AdCourseID = 136"
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9. Drop a CreateStudentCourse activity into the ExecuteDataReader activity.

a. In the Student Id field, specify Student.

b. In the Student Enrollment Period Id field, specify entity.Id.

c. In the Class Section Id field, specify DirectCast(CurrentRow("AdClassSchedId"), Int32).

d. In the Variables pane, create a variable to hold the Course object that you are creating and enter
the variable name in the Properties pane for this activity.
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10. Drag a SaveStudentCourse activity into the sequence below the ExecuteDataReader activity.

a. In the Action field, select Register.

b. Enter the variable that holds the Course object that you are creating in the Properties pane for this
activity.
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11. Check your workflow. Scroll through the workflow or use the fit to screen button located at the bottom of
the Designer pane to see the whole workflow based on your screen resolution.

12. Click Publish. The New Workflow Definition Version window is displayed.

13. If you want the workflow to be run as soon as the event occurs on the entity, select Enable This Work-
flow Version, otherwise leave the check box cleared.

14. Click Save, then Cancel to close the publisher window.
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Transfer Students to Another Class Section
Scenario: Active students are enrolled and registered into a course in the current term. The course has multiple
class sections in the current term. The course is in Scheduled status for the target students. The workflow is
used to transfer students from one class section to another class section of the same course.

Similar workflows could be used to balance student populations across multiple class sections; or, if student
groups are created, students could be transferred into a class section based on specific student group criteria.

1. Start the Workflow application from your desktop.

2. On the Home tab, click New Event Workflow.

3. In the Entities area:

a. Click next to Cmc.Nexus.Contracts.

b. Click next to Cmc.Nexus.

c. Click Group Membership (GroupMembership).

4. In the Events area, click Saved (SavedEvent).

5. Specify a Name for the workflow and click OK.

6. Drop a LookupClassSections activity into the sequence.

a. Click the Search button to find and select the course into which the students are transferred.

b. Create a variable for the array of class section values.

Name the variable, e.g., ClassSects, and select the Variable type of ClassSection[].

c. Specify appropriate values for the CourseId and TermId.

Note: Use an SQL query to determine the CourseId and TermId values for your database envir-
onment, e.g.,

select * from AdEnrollSched where AdCourseID = "value from workflow" and systu-

dentid = "current student id"
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7. Drop a For Each<> activity into the sequence.

a. In the TypeArgument field, browse for Cmc.Nexus.Sis.Academics.ClassSection.

The DisplayName field changes to ForEach<ClassSection>.

b. In the Values field, enter the ClassSects variable created in the previous step.

The ForEach<ClassSection> activity steps through the array of class sections and returns the Ids for each
item.

8. Drop a Sequence into the Body field of the ForEach<ClassSection> activity.

9. Drop an If activity into the sequence added in the previous step.
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a. In the Condition field, specify the following expression:

item.SectionCodeEquals("ACC101")

where "ACC101" (case sensitive) is the name of the class section into which you want to transfer
students.

10. Create a variable for the new class section values.

Name the variable, e.g., NewSection, and select the Variable type of Int32.

11. Drop an A+B Assign activity into the Then branch of the If condition.

a. In the To field of the Assign activity, specify the name of the variable created in the previous step
(NewSection).

b. Assign the value item.ID to the NewSection variable.

12. Drop a SaveStudentCourse activity into the sequence below the If activity.

a. In the Action field, select TransferClassSection.

b. In the StudentCourseId field, specify the value of the current class.
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Note: Use an SQL query to determine the StudentCourseId value for your database environment,
e.g.,

select adenrollschedid from AdEnrollSched where AdCourseID = "value from work-
flow" and systudentid = "current student id"

c. In the TransferToClassSectionId field, specify the NewSection variable.

13. Check your workflow. Scroll through the workflow or use the fit to screen button located at the bottom of
the Designer pane to see the whole workflow based on your screen resolution.

14. Click Publish. The New Workflow Definition Version window is displayed.

15. If you want the workflow to be run as soon as the event occurs on the entity, select Enable This Work-
flow Version, otherwise leave the check box cleared.

16. Click Save, then Cancel to close the publisher window.
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Resources
This section contains reference material that may assist you when designing and testing workflows.

Related Help Systems and APIs

https://help.campusmanagement.com/Content/Home.htm

https://www.mycampusinsight.com/Documentation-Center/Help/Help_Home/Content/helphome.htm (logon
required). The Object Library for Anthology Student is available under APIs > Anthology Student Object Library.

API Errors with SyRegistry Authentication
Note: Anthology Student 22.0 introduces an alternate method for the authentication of CampusLink API calls.
The new authentication method does not use the SyRegistry table. For details see Authentication for Cam-
pusLink API Calls.

API Password 
If the below error is received in Workflow Composer and/or in the logs, the API Password that is in the SyRe-
gistry table is not correct.  To sync the password, log in to the Portal Admin Console and update the password
for the API user.

SyRegistry query:

Workflow and Log Error:

https://help.campusmanagement.com/Content/Home.htm
https://www.mycampusinsight.com/Documentation-Center/Help/Help_Home/Content/helphome.htm
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Cmc.Core.Eventing.EventHandlerException: An exception was thrown within an event handler. ---->
System.NullReferenceException: Object reference not set to an instance of an object.
at Cmc.Nexus.Common.Services.StaffService.GetApiUserId()
at Cmc.Nexus.Common.Services.StaffService.GetSessionUserId()
at Cmc.Nexus.Common.Services.StaffService.GetCurrentUser()
at Cmc.Nexus.Common.EventHandlers.CommonEventHandlers.SetAuditableFields(Object entity, Boolean
isNewEntity)

Portal Admin Console:
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API User Permissions
The API User specified in the SyRegistry table has to have permissions to execute the CampusLink APIs.  This
user must exist in Anthology Student and be part of a group other than the Administrator group that has full
permissions to the Daily menu.  This user also needs to be assigned the proper Activity Security and Document
Security  policies.

Possible Error Received in Log File if Permissions are not Correct:
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Anthology Student Configuration:
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API Key – Access Denied Error
If the API keys are not set up correctly, an "Access denied" error will be seen in the Renderer log, for example,
when a Forms Builder workflow calls the Anthology Student activity.

Solution: Ensure that the API keys across all products match. 

<appSettings>
<add key="ConfigureCampusNexusWcfProxy" value="true" />
<add key="ConfigureCVueNexusWcfProxy" value="true" />
<!-- Following will be populated when Crm is enabled for Forms Builder -->
<add key="CmcNexusCrmWebUrl" value="http://<server:port>/" />
<add key="PaymentProvider" value="pilot-payflowpro.paypal.com" />
<add key="AuxiliaryServiceBaseUrl" value="" />
<!-- Following should be set to true only in Azure environments where the Auxiliary service

is installed and required. -->
<add key="UseRemotePdfConversionService" value="false" />
<!-- Following sets a time before conversion to PDF starts. Default 500, increase if blank

documents on a slow server. -->
<add key="ViewCreatorDefaultStartConversionTimerInMilliseconds" value="" />
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<add key="ApiKey" value="<Your API key value>" />
</appSettings>

Authentication for CampusLink API Calls
Many calls from Anthology Student, Portal, Workflow activities, and other integrated applications rely upon a
valid staff account (“APIuser”) to make CampusLink API calls. This account needs to be unique (i.e., not used for
anything else). The user name and password for the account are stored in the database (SyRegistry table). The
account must also exist in Active Directory (AD) or Azure Active Directory (AAD). The account details in the data-
base and in AD/AAD need to be in sync. This can create maintenance and security issues (e.g., multifactor
authentication (MFA) needs to be disabled). Therefore, the existing authentication mechanism using SyRegistry
keys with user name and password will eventually be retired. For the time being, the existing logic based on a
user name and password continues to work to satisfy backward compatibility requirements for integrated
products.

The July 2021 releases of Anthology products introduce an alternate authentication mechanism that relies on
symmetric keys. A new SyApplicationKey table stores the encrypted keys and names of the calling applications.
The keys are decrypted before they are passed to the CampusLink Authentication Service.

At the time of Anthology Student 22.0 installation, a script inserts 1 record per calling application (with Applic-
ationKey value = NULL) into the SyApplicationKey table (see image below). The script also inserts staff users with
the necessary permissions for all Anthology products that use key-based authentication and updates the cor-
responding AssociatedStaffId. The AssociatedStaffId is the identity that will be used for CampusLink API calls.
The script makes the staff users part of the necessary staff groups to apply the required permissions. Insti-
tutions no longer need to manually create staff users for CampusLink API calls.

On the first CampusLink API call, the key-based authentication logic:

l Generates a key for the product identified by the CallingApplicationName,

l Encrypts and saves the key to the SyApplicationKey table, and

l Retrieves the decrypted key.

On subsequent CampusLink API calls, the logic retrieves the existing key and passes it on to CampusLink.

Note: Since Workflow always executes in the context of Anthology Student, workflow uses Anthology_Student
as the CallingApplicationName.
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CampusLink Authentication Service Updates
To support the key-based security, the CampusLink Authentication Service is modified by adding the following
values to the in-message of the GetAuthorizationToken method (see Service Catalog):

l IsKeyBasedSecurity (bool) – set to true if using key based security instead of supplying user-
name/password

l AppKey (string) – plain text value of app key retrieved previously (e.g., you can assign this to the variable
portalApplicationKey)

l CallingAppName (string) – name of the calling application. This needs to exactly match what’s specified in
the SyApplicationKey table (e.g., Anthology_Portal)

When IsKeyBasedSecurity is true and a valid AppKey is passed in, the Authentication Service validates the
AppKey passed in against the CallingApplicationName and generates a token based on the AssociatedStaffId in
the SyApplicationKey table. A token will be returned. Each system-generated application key will be associated
with a system-generated staff user (e.g., PortalApiUser@anthology.local). This user only exists as a Staff record
in the application and will not have a password or be required to be added as an AD/AAD user. As a result, this
staff user will never be used to authenticate against. However, this user’s authorizations in Anthology Student
are used to determine permissions for API calls that are made in the system context, using the key. The user’s Id
is also used to update the database for the calls made by the client application. By default this user will have
admin access. You can adjust the user’s permission based on the needs of your application.

Anthology Student UI Updates
Anthology Student 22.0 provides a form for administrators to manage the CampusLink API key information. The
form is located under Settings > System > Manage Application Keys.

Admin users can create a new record in the SyApplicationKey table, including generating the key. The encrypted
value of the key will be stored in the ApplicationKey column. Once a new record is inserted, the plain text,
decrypted key is shown in the form with a copy to clipboard option. Once the key is copied to clipboard (and
shared with vendor securely), the key value is masked in the form.

https://www.mycampusinsight.com/support/CampusNexus Service Catalog/Content/Authentication/Fields_Authentication.htm


Workflow Version 4.0.1 639 Help Guide



Workflow Version 4.0.1 640 Help Guide

Event Logs
The location of event logs depends on whether workflows are executed in a cloud environment or on premises.

Cloud Subscriptions
Azure blob storage is Microsoft's object storage solution for the cloud. Blob storage is optimized for storing
massive amounts of unstructured data. Unstructured data is data that doesn't adhere to a particular data
model or definition, such as text or binary data. See https://docs.microsoft.com/en-us/azure/stor-
age/blobs/storage-blobs-introduction.

The Azure blob storage container provides logs for all products included in your subscription, e.g., Anthology
Student, Portal, Workflow Events, STS, CampusLink APIs, etc.

To find Azure blob storage logs for your cloud subscription:

1. Log in to the Microsoft Azure Storage Explorer.

2. Select your subscription (900004 in our example).

3. In the panel on the left side, navigate to Storage Accounts > <your subscription>custlog > Blob Con-
tainers > logs.

4. In the panel on the right side, open the prod directory.

Depending on your subscription, you will see folders for multiple products, e.g., CampusLinkAPI, Antho-
logy Student (sisclientweb), Portal (sisportal), Form Designer, Forms Renderer, Staff STS, Web Jobs, etc.
Select the folder for a product and navigate to the log you want to review. These folders contain the last 2
weeks of logs.

https://docs.microsoft.com/en-us/azure/storage/blobs/storage-blobs-introduction
https://docs.microsoft.com/en-us/azure/storage/blobs/storage-blobs-introduction
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5. For workflow logs, select the <your subscription>webjobs folder and then select EventNo-
tificationService.

View or download the workflow log you want to review.

On Premise Installations
Event logs for workflows that are executed on a Anthology Student server are written to the following folder on
the server machine:

Program Files (x86)\CMC\C2000\Services\Nexus Event Notification Service

<version>\logs.
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The logs capture all workflow events including LogLine output, events associated with long running workflows,
and errors captured by the Service Module Host.
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The NLog settings determine the log level and target for event logs.
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GitHub Repositories
Anthology Inc. has created a set of community-driven GitHub repositories to help share ideas, solutions, and
knowledge about Anthology products.

For more information, download the attached PDF and refer to the following links:

Anthology GitHub Repositories https://github.com/campusmanagement

Forms Builder Sequence Templates https://github.com/campusmanagement/fb-sequence-
templates

Workflow Samples https://github.com/campusmanagement/workflow-
samples

Integration Samples https://github.com/campusmanagement/integration-
samples

GitHub Resources https://guides.github.com/

GitHubRepositories.pdf
GitHubRepositories.pdf
https://github.com/campusmanagement
https://github.com/campusmanagement/fb-sequence-templates
https://github.com/campusmanagement/fb-sequence-templates
https://github.com/campusmanagement/workflow-samples
https://github.com/campusmanagement/workflow-samples
https://github.com/campusmanagement/integration-samples
https://github.com/campusmanagement/integration-samples
https://guides.github.com/
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NLog
The default logging provider used by Anthology is NLog. NLog allows you to set up log targets, levels, rules, lay-
outs, etc. through configuration.

Configure Logging
To configure logging, you need to modify the nlog.config file contained within the application’s executing dir-
ectory. For web applications, this file exists alongside the web.config file.

<?xml version="1.0" encoding="utf-8"?>
<nlog xmlns="http://www.nlog-project.org/schemas/NLog.xsd" xmlns:x-
si="http://www.w3.org/2001/XMLSchema-instance">
  <targets>
    <target name="file" xsi:type="File"
      layout="${longdate} ${threadid:padding=3} ${level:padding=-30} ${logger:padding=-30} ${message} ${ex-
ception:format=tostring}"
      fileName="${basedir}logs/${shortdate}.txt"
      keepFileOpen="true" />
    <target name="console" xsi:type="ColoredConsole"
      layout="${date:format=HH\:MM\:ss} ${threadid:padding=3} ${logger:padding=-30} ${message}" />
  </targets>
<rules>
  <logger name="*" minLevel="Error" writeTo="file" />
</rules>
</nlog>

Above is an example of a config file that is configured with two targets: file and console. The logging rules define
which target is executed based on level (Trace, Debug, Information, Warning, Error, and Fatal). The con-
figuration above logs to a subfolder off the base directory whenever an Error or Fatal level is logged by the
application. To log verbose diagnostic information, you can change the minLevel to Trace, which will log all
levels of diagnostic information.

For additional information regarding the configuration file, see https://-
github.com/nlog/NLog/wiki/Configuration-file.

For supported NLog targets, see https://github.com/nlog/NLog/wiki/Targets.

Write Logs
Three public types are associated with the logging framework:

l ILoggerFactory
l ILogger
l LoggerExtensions (extensions methods for ILogger)

https://github.com/nlog/NLog/wiki/Configuration-file
https://github.com/nlog/NLog/wiki/Configuration-file
https://github.com/nlog/NLog/wiki/Targets
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There are two ways to enable logging in your class. The preferred way is to receive an ILogger interface as a con-
structor dependency. The IoC container ensures that this dependency is wired for you.



Workflow Version 4.0.1 647 Help Guide

If your class is a legacy class that does not support DI, you can use the ServiceLocator to retrieve an ILog-
gerFactory to create the logger.
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Add Log Messages to Classes
Once you have a logger in a class, it is important to add the relevant LOG messages to it that will help us all in
debugging and understanding how this class is behaving.

Log Non-Exception Messages

Trace Messages

Use these messages to trace which lines of source code are being executed; they will log what is going on with
the code.

Usage: _log.Trace(“Your message.”)

Debug Messages

Use these messages to output the contents or values of variables or properties during the execution of source
code; they will log the important values of objects that may affect how the code will execute.

Usage: _log.Debug(“Your message. variable1={0}.”, variable1)

Info Messages

Use these messages to log information that may be useful to know about the normal operation of the applic-
ation (such as environment variables, paths, etc.).

Usage: _log.Info(“Your message. variable1={0}.”, variable1)

Warning Messages

Use these messages to log messages that we are not sure are acceptable or to track variable/property values
that may be close to being out of the acceptable range.

Usage: _log.Warn(“Your message. variable1={0}.”, variable1)

Error Messages

Use these messages to log any exceptions we have that are not being handled. This is typically used in the
CATCH of a TRY/CATCH block.

Usage: See Log Exception Messages.

Fatal Messages

Use these messages to log special conditions that indicate that something went terribly wrong in the execution
of the code.

Usage: See Log Exception Messages.
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Log Exception Messages

To properly log an exception, you should follow one of the patterns shown below. This will allow you to capture
the full exception details and also include (if necessary) any other values that may be important for debugging.

Scenario 1: Log a custommessage, a variable value, and an exception

Result log message:

[Your message (if any)]. [Variable Name] = 'abc'. System.FormatException: The string was not recognized as a valid
DateTime. There is an unknown word starting at index 0. at System.DateTime.Parse(String s) at Cmc.UI.We-
b.EcoSysW3C.------() in \DEV\DEV\Cmc\UI\Web\Cmc.UI.Web.EcoSysW3C\------.cs:line xx

Scenario 2: Log a variable value and an exception

Result log message:

[Variable Name] = 'abc'. System.FormatException: The string was not recognized as a valid DateTime. There is an
unknown word starting at index 0. at System.DateTime.Parse(String s) at Cmc.UI.Web.EcoSysW3C.------() in
\DEV\DEV\Cmc\UI\Web\Cmc.UI.Web.EcoSysW3C\------.cs:line xx

Scenario 3: Log only an exception
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Result log message:

System.FormatException: The string was not recognized as a valid DateTime. There is an unknown word starting at
index 0. at System.DateTime.Parse(String s) at Cmc.UI.Web.EcoSysW3C.------() in \DEV\DEV\Cm-
c\UI\Web\Cmc.UI.Web.EcoSysW3C\------.cs:line xx

Note: You must always inject the exception to the string message using {0}!

If you log an exception as shown below, it will fail to include the exception in the log message. See result of this
message below:

Result log message:

message

Read Log Messages to Debug or Troubleshoot
There are three different ways to see your log messages when you wish to debug or troubleshoot an issue:

1. Access the SQL server and get values from the LOGS table (if they are being logged to the DB)
2. Access the local log files being saved in (webroot)/LOGS
3. Use a real-time viewer

You can download the FREE LOG viewer from: http://www.legitlog.com/Products/LegitLogViewer.

Once you install it, you can use it to:

l Read the log text file, or
l View messages in real-time as they are added to the logger.

To enable real-time logging, follow these steps:

1. Select Logs >> Live Capture Log.
2. Select Start capture global.

You should now start seeing any log messages as they are added into the logger.

http://www.legitlog.com/Products/LegitLogViewer
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For additional information, see the NLog website: http://nlog-project.org.

http://nlog-project.org/
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Service Module Host
ServiceModuleHost.exe is a Windows service that allows Saved Events to execute and is responsible for hosting
plugin modules to simplify deployment and maintenance of processes that run in the background. Installation
Manager sets the services to be started automatically; however, when you are building workflows, it is import-
ant to ensure that the Anthology Service Module Host is running on the server.

Stop/Start the Service Module Host Service
1. On the server where the workflows are executed, select Start > Administrative Tools > Server Man-

ager, right-click and select Run as administrator.

2. Navigate to Configuration > Services and select the Anthology Service Module Host service.

By default, the Startup Type of the Anthology Service Module Host is set to Automatic with a Status of
Started.

3. To stop or restart the service, click Stop or Restart the service.

Service Module Host Config File
Installation Manager updates the configuration files to ensure that they point to the correct database and con-
tain proper settings. The configuration file for the ServiceModuleHost.exe and normally does not need to be
modified; however, you should be aware of the SQL Reconnect Setting and Connection Strings.

The Service Module Host config file is located in C:\Program Files (x86)\CMC\C2000\Services\Nexus Event Noti-
fication Service <version>.



Workflow Version 4.0.1 653 Help Guide

SQL Reconnect Setting

The Service Module Host service has logic to limit the reconnection attempts when the Service Module Host ser-
vice senses a connection failure to the SQL database. The time duration is a configured value in seconds that
the Service Module Host service uses to attempt the connection again. The settings contain a Number of Retries
value indicating how many times to retry the connection.

If, after the number of attempts have been tried and the SQL server is still unavailable, the Service Module Host
logs a fatal exception indicating that the Windows service should be restarted after the SQL connection issue
has been resolved. The Service Module Host then needs to be stopped and restarted to re-establish the con-
nection (see Stop/Start the Service Module Host Service).

The following is an example of an error displayed in the workflow Event Log when the timeout expired and a
reconnection was attempted:

2015-08-29 00:00:04.7756 13 Error

#Version%204.0_..14
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Cmc.Nexus.Utility.ServiceBroker.ServiceModule.ServiceBrokerServiceModule Sys-
tem.InvalidOperationException: Timeout expired. The timeout period elapsed prior to obtaining a connection
from the pool. This may have occurred because all pooled connections were in use and max pool size was
reached.

at System.Data.ProviderBase.DbConnectionFactory.TryGetConnection(DbConnection owningConnection,
TaskCompletionSource`1 retry, DbConnectionOptions userOptions, DbConnectionInternal oldConnection,
DbConnectionInternal& connection)

at System.Data.ProviderBase.DbConnectionInternal.TryOpenConnectionInternal(DbConnection out-
erConnection, DbConnectionFactory connectionFactory, TaskCompletionSource`1 retry, DbConnectionOptions
userOptions)

at System.Data.ProviderBase.DbConnectionClosed.TryOpenConnection(DbConnection outerConnection, DbCon-
nectionFactory connectionFactory, TaskCompletionSource`1 retry, DbConnectionOptions userOptions)

at System.Data.SqlClient.SqlConnection.TryOpenInner(TaskCompletionSource`1 retry)

at System.Data.SqlClient.SqlConnection.TryOpen(TaskCompletionSource`1 retry)

at System.Data.SqlClient.SqlConnection.Open()

If errors like this occur frequently and fill up the event logs, you might need to adjust the values for Recon-
nectOnErrorNumberOfAttempts (default value = 5) and ReconnectOnErrorWaitSeconds (default value = 10)
in the config file of the Service Module Host.

Connection Strings

The config file of the Service Module Host contains connection strings for the following databases:

l Anthology Student Database
l Database containing the workflow persistence tables
l Workflow Tracking Database

The connection strings enable workflow tracking and persisted workflows.

#Version%203.1
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The Anthology Student Database connection string is specifically referenced in the following workflow activities:

l ExecuteDataReader
l ExecuteNonQuery
l ExecuteQuery

In general, the connection strings used during workflow execution are retrieved from the web.config of
the product that triggers workflow execution.

Only if you want to run a workflow with ExecuteDataReader, ExecuteNonQuery, or ExecuteQuery activ-
ity in test mode using the Run option in Workflow Composer, would you need to manually add the con-
nection string to the Workflow Composer web.config file.
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Workflow Tracking DB Cleanup Script
If you are using the Workflow Tracking database, you may find that it grows at a rapid pace depending on the
configured tracking level.

The attached script can be run against the tracking database to clean out records on a regular basis. The steps
below describe the parameter that needs to be entered and what is needed to schedule it as an SQL job.

1. Use the script sproc_WorkFlowTracking_Delete_Tables_DateParameter.sql. Download or copy it below.

The script only requires a date parameter to be populated. In the scenario below, anything older than 10
days would be deleted.

IF EXISTS (SELECT * FROM INFORMATION_SCHEMA.ROUTINES r WHERE r.routine_name='sproc_
WorkFlowTracking_Delete_Tables_DateParameter' and r.routine_schema='dbo')

DROP PROCEDURE dbo.sproc_WorkFlowTracking_Delete_Tables_DateParameter
GO

/****** Object: StoredProcedure [dbo].[sproc_WorkFlowTracking_Delete_Tables_DateParameter]
Script Date: 10/9/2015 10:42:47 AM ******/
SET ANSI_NULLS ON
GO

SET QUOTED_IDENTIFIER ON
GO

CREATE PROCEDURE [dbo].[sproc_WorkFlowTracking_Delete_Tables_DateParameter]
-- Add the parameters for the stored procedure here
@NumberOfDays int
AS
BEGIN

/*
Exec [dbo].[sproc_WorkFlowTracking_Delete_Tables_DateParameter] 10
*/

-- SET NOCOUNT ON added to prevent extra result sets from
-- interfering with SELECT statements.
SET NOCOUNT ON;

DECLARE @HowManyRecordsTobeDeleted INT;
DECLARE @InitialSet INT;
Set @InitialSet = 500;

sproc_WorkFlowTracking_Delete_Tables_DateParameter.rar
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SET @HowManyRecordsTobeDeleted = @InitialSet;

WHILE @HowManyRecordsTobeDeleted > 10
BEGIN

BEGIN TRY
BEGIN TRAN

delete top (@HowManyRecordsTobeDeleted) [workflowtracking].[System.Workflow.Tracking].
[WorkflowInstanceEventsTable] from [workflowtracking].[System.Workflow.Tracking].[Work-
flowInstanceEventsTable]

where (DATEDIFF(day,[workflowtracking].[System.Workflow.Tracking].[Work-
flowInstanceEventsTable].TimeCreated,Getdate())>=@NumberOfDays)

SET @HowManyRecordsTobeDeleted = @@ROWCOUNT
print 'deleted WorkflowInstanceEventsTable'
COMMIT TRAN

END TRY
BEGIN CATCH

ROLLBACK TRAN
set @HowManyRecordsTobeDeleted = 0
print 'ERROR in deleting WorkflowInstanceEventsTable'

END CATCH

END
set @HowManyRecordsTobeDeleted = @InitialSet
WHILE @HowManyRecordsTobeDeleted > 0
BEGIN

BEGIN TRY
BEGIN TRAN

delete top (@HowManyRecordsTobeDeleted) [workflowtracking].[System.Workflow.Tracking].[Activ-
ityInstanceEventsTable] from [workflowtracking].[System.Workflow.Tracking].[Activ-
ityInstanceEventsTable] st

where (DATEDIFF(day,st.TimeCreated,Getdate())>=@NumberOfDays)
SET @HowManyRecordsTobeDeleted = @@ROWCOUNT
print 'deleted ActivityInstanceEventsTable'
COMMIT TRAN

END TRY
BEGIN CATCH

ROLLBACK TRAN
set @HowManyRecordsTobeDeleted = 0
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print 'ERROR in deleting ActivityInstanceEventsTable'
END CATCH

END

set @HowManyRecordsTobeDeleted = @InitialSet
WHILE @HowManyRecordsTobeDeleted > 0
BEGIN

BEGIN TRY
BEGIN TRAN

delete top (@HowManyRecordsTobeDeleted) [workflowtracking].[System.Workflow.Tracking].
[ExtendedActivityEventsTable] from [workflowtracking].[System.Workflow.Tracking].[Exten-
dedActivityEventsTable] stc

where (DATEDIFF(day,stc.TimeCreated,Getdate())>=@NumberOfDays)
SET @HowManyRecordsTobeDeleted = @@ROWCOUNT
print 'deleted ExtendedActivityEventsTable'
COMMIT TRAN
END TRY

BEGIN CATCH
ROLLBACK TRAN
set @HowManyRecordsTobeDeleted = 0
print 'ERROR in deleting ExtendedActivityEventsTable'

END CATCH

END

set @HowManyRecordsTobeDeleted = @InitialSet
WHILE @HowManyRecordsTobeDeleted > 0
BEGIN

BEGIN TRY
BEGIN TRAN

delete top (@HowManyRecordsTobeDeleted) [workflowtracking].[System.Workflow.Tracking].[Book-
markResumptionEventsTable] from [workflowtracking].[System.Workflow.Tracking].[Book-
markResumptionEventsTable] stc

where (DATEDIFF(day,stc.TimeCreated,Getdate())>=@NumberOfDays)
SET @HowManyRecordsTobeDeleted = @@ROWCOUNT
print 'deleted BookmarkResumptionEventsTable'
COMMIT TRAN
END TRY

BEGIN CATCH
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ROLLBACK TRAN
set @HowManyRecordsTobeDeleted = 0
print 'ERROR in deleting BookmarkResumptionEventsTable'

END CATCH

END

set @HowManyRecordsTobeDeleted = @InitialSet
WHILE @HowManyRecordsTobeDeleted > 0
BEGIN

BEGIN TRY
BEGIN TRAN

delete top (@HowManyRecordsTobeDeleted) [workflowtracking].[System.Workflow.Tracking].[Cus-
tomTrackingEventsTable] from [workflowtracking].[System.Workflow.Tracking].[Cus-
tomTrackingEventsTable] stc

where (DATEDIFF(day,stc.TimeCreated,Getdate())>=@NumberOfDays)
SET @HowManyRecordsTobeDeleted = @@ROWCOUNT
print 'deleted CustomTrackingEventsTable'
COMMIT TRAN
END TRY

BEGIN CATCH
ROLLBACK TRAN
set @HowManyRecordsTobeDeleted = 0
print 'ERROR in deleting CustomTrackingEventsTable'

END CATCH

END

END

GO

2. The script can also be scheduled as an SQL job to run based on a schedule.
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3. You can control the amount of data being tracked by using trackingProfiles (defined within the Service
Module Host config file).

Notes:

l If tracking is configured to track variables, this database can grow extremely fast.

l If you do not want tracking enabled, you can remove the tracking profile from the config file.

l If you simply want to track the start and stop of a workflow, we recommend the following setting:

<system.serviceModel>
<tracking>

<profiles>
<trackingProfile name="DefaultTrackingProfile">
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<workflow activityDefinitionId="*">
<workflowInstanceQueries>

<workflowInstanceQuery>
<states>

<state name="Started" />
<state name="Completed" />

</states>
</workflowInstanceQuery>

</workflowInstanceQueries>
</workflow>

</trackingProfile>
</profiles>

</tracking>
</system.serviceModel>
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